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puter use. We recognized and selected most of them through their involvement in calls to
the InTrec BBS. We’ve met only a few of our testers face to face, but during testing, we “talk”
almost every day via email and sometimes even have a phone-voice conversation. However,
like pen pals who have never met, we probably would not know each other if we met face
to face, and that is the beauty of telecom — it allows people with similar interests to easily
communicate.
Beta testing is serious business, a commitment of time and dedication, and one of the most
important parts of software development. The testers not only find problems in the software,
they actively suggest software feature and design improvements. The desirable tester is involved in the process, and not just there to enjoy the show and get a free T-Shirt. Really good
software applications are a product of the designer and a good beta team. Dedicated callers
are recognized through their expressed individual talents as well as their call frequency
to a service, their posted messages, their willingness to assist others, the questions and/or
answers they provide and the files they contribute such as, macros or other special interest
files. If you are interested in beta testing InTrec Software products, request an InTrec Beta
Test brochure from InTrec Tech Support.

About the Book

John Bohn, and Barry Prowell helped by reading the original manuscript several times before
final printing. Barry has telecom expertise sensitive to persons with disabilities. His talent
and consideration were an important part of the finished product.
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Trademarks
• ProTERM is a trademark of Greg Schaefer licensed to ProTech Software, Inc.
• Apple, AppleWriter, AppleWorks, DOS 3.3 and ProDOS are registered trademarks of
Apple Computer, Inc.
• Hayes is a registered trademark of Hayes Microcomputer Products, Inc.
• UNIX and Touchtone are registered trademarks of AT&T.
• EXfer is a trademark of Stephen R Corlett.
• The Kermit protocol was developed by the Columbia University Center for Computing
Activities.

Disclaimer
APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESSED OR IMPLIED,
REGARDING THE ENCLOSED SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT
PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS
WARRANTY PROVIDES YOU WITH SPECIAL LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS
YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

Thanks!
ProTERM 3 is the result of intense development, and many people contributed to its success.
While it is not possible to mention everyone, a partial list of those individuals more directly
involved in ProTERM 3.1 include the following.
The ProTERM 3.1 beta test team consisting of Cindy Adams, John Bohn, Don Davidson,
John Edwards, Michael Edwards, Dean Esmay, Jim Ferr, Brian Hansen, Brendan Hoar, Pat
Kern, Rob Meredith, Dale Smith, Sid Stulberg. Without their diligent testing and feedback,
ProTERM 3.0 could not have been completed.
ProTERM 3.1 was developed a year after 3.0 had been released. It includes increased hardware support, new features requested by 3.0 users, changes to some existing features, and a
rewritten, redisigned and expanded manual.

About Software Testing

InTrec Software continually receives requests to be part of the ProTERM beta test cycle. We
are delighted and flattered by the many sincere requests and wish we could honor each and
every one. For each project we select a broad group of testers based on their various talents,
capabilities and equipment configurations. A Beta Test Team necessarily needs a level of
expertise from novice through the casual user to the guru. The input and expertise of the
“power-user” with their usual collection of every kind of equipment plays a big roll in the
overall picture, but the candid questions and suggestions from a less experienced tester, are
just as important. A novice will ask questions an expert will not, and since most new ProTERM customers are beginners, novice testers provide valuable insight on how the different
parts of ProTERM will be perceived by this new user. If you have an interest, please contact us
and ask for an InTrec Beta Tester Evaluation Kit.
We were extremely proud to have had the association of the ProTERM 3 beta teams. They
have been hard working and fun groups and have represented a spectrum of personal com-
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A Very Special Thanks
More than once, I called Mike Fairman and Joe Holt to ask for their technical expertise during the initial preparation of this manual. Mike Golaszewski assisted with the early design of
the program. Dale Smith deserves special recognition for his diligence and perseverance as a
beta tester. The entire beta test group was great, but Dale’s efforts were far beyond the call of
duty. His expertise and advice has always been invaluable to me. Pat and Derek Cline (along
with Jerry) worked hard to keep InTrec running while Jerry and I worked on ProTERM.
My friends and family deserve a very special thank-you for allowing me to spend so much
time developing our new venture. They always know when to leave me to my work and
when to coax me into a needed break. Those people include Harry & Karen Schaefer, Steve
& Rita Graham, Alyssa Graham, Mike Huckeby, Dick Sloan, Evie Harter and Bob Joslin. In
particular, Alyssa. She has supported me since the day InTrec was formed and understood the
importance my saying, “Just let me get this last development idea in…” excuse more times
than I can count.
Most importantly, however, this project could never have been completed or even started
without my friend and partner Jerry Cline (the man who never sleeps). Jerry may actually
have put more hours into this project than I. He is responsible for all the printed materials
and layout as well as helping me with most of the program design. In many respects, the opportunity to work with Jerry has been the most rewarding aspect of this entire project.

Greg Schaefer
Manual: Editor, Layout & Design

Jerry Cline, with assistance from Pat Cline, Derek Cline and Greg Schaefer.

Freeware and Support:
A Note About the reclassification of ProTERM to Freeware Status and continued support.
With the reclassification from commercial software to Freeware status, while InTrec still
retains the Copyright, InTrec is no longer able to continue to provide direct support for
ProTERM A2. Support for ProTERM has been shifted to the community at large, an ‘official’
support forum has been hosted by (16) Sector in addition to community support via usenet
and other forums. Calls to InTrec will be referred to online community support.
The Power ][ Be Your Best - Apple II Forever!
29-December, 2008.
T. Diaz / tdiaz@apple2.org
ProTERM 3.1 is (C) 1991-1993 Greg Schaefer, and the ProTERM package and documentation
are © 1991-2009 InTrec Software.
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The documentation changes between ProTERM 3.0 and 3.1 were substantial and amount
to a complete rewrite. Suggestions and ideas given by ProTERM 3 users are included in
this manual. A couple of ProTERM aficionados, who deserve credit and thanks for their
voluntarily work on suggested changes in the ProTERM documentation. Melinda Bargreen
was instrumental a new look and feel for new users. The result was to split major information areas of the manual into major divisions or parts. Derek Cline took Melinda’s ideas to a
next step and assisted with the development of the new user and Getting Started in Telecom
parts of the documentation including the enclosed Cheat Sheet. Another ProTERM user, Barry
Schwarz sent several pages of excellent suggestions and changes for the documentation.

The Past

ProTERM was originally released by Checkmate Technology as version 1.1 in Spring ‘87.
Checkmate released version 1.2 in the summer of ’87 and 2.0 in the spring of ‘88. ProTERM
2.0 introduced new features including the ProTERM editor, new protocols, IIGS support,
VT-100 emulation, and many other requested features. Version 2.1 released in late ’88, and
included: Zmodem, Global Macros, Rotary Dialing, and File Utilities. Unfortunately, differences of opinion with Greg Schaefer and Checkmate forced the program into a two-year
hiatus, and no new development happened during that period.
Jerry Cline and Greg Schaefer became partners and formed InSync Software in May 1990.
Jerry’s interest and field is marketing and production and Greg interest and field is software
design and development.
InSync Software published ProTERM 2.2 in June ‘90 as Greg immediately set to work and
rewrote ProTERM from scratch as a complete new Apple II telecom application. Starting over,
he took the best ideas from ProTERM 2.2, incorporated all new and state of the art features,
and the result was released as ProTERM 3.0 in October 1991.

ProTERM 3.1

After the release of ProTERM 3.0, we immediately began work on a next version. Hundreds
of great ideas and suggestions were collected from 3.0 customers. We wanted to incorporate
every realistic requested change that we considered valuable to the software.

Name Change

At that time, the decision was also made to change the company name to provide a more
unique identity in the marketplace, we changed three letters in the middle of our company
name, and InSync Software became InTrec Software.

The Future

ProTERM will continue to live on in the Apple II® community for years to come.

Thanks from the InTrec Software crew:
Jerry Cline
Derek Cline

Pat Cline
Greg Schaefer
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Foreword
TELECOMMUNICATIONS
This introductory primer contains the fundamentals of getting started in telecommunications. Hopefully it will help simplify what may initially appear too complex to comprehend.
This text was developed from an article written by Greg Schaefer and Jerry Cline at the
request of Apple Computer, Inc., and was originally published in “The Apple II Guide” –“A
complete resource for users of Apple II computers” and addressed getting started in
telecommunications. This is a more complete version.

Is Telecommunications for Me?
Telecommunications:
The tool that allows
us to easily and
instantly exchange
information around
the world.

You may feel some apprehension about getting started with telecommunications. Not sure
where to get started, or think it may be too expensive or the procedures too difficult? Maybe
you’re concerned about what the phone company thinks about using your computer to
make calls using their equipment. You may feel uneasy because this is all new and foreign.
This ProTERM user manual will introduce you to this new world, ease your concern, and
help you discover the value and enjoyment of telecommunications.
Personal computers are today’s basic communication tools. Telecommunications is the rootlevel of communications between support groups of people with common interests.
Your personal computer is the essential tool to assist with your personal needs and interests
can connect you to most any other computer anywhere in the world. Computers can help
you communicate between people with common goals and shared interests. This used to be
true for only the big corporate mainframe computers, but is now available to all of us. A new
generation of home “telecommuters”* use personal computers to reach out for information,
communicate with friends, exchange email, computer files, and even allow us to work at
home. Thanks to telecommunications, rural areas now have the same access to information
available in their metropolitan counterparts.
* Telecommuter: A person who works (and plays) from a remote location (usually their
home) via a computer, modem, software and a phone line.
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The modem is a
translator: it lets all
computers speak a
common language.

It is important to know that telecommunications allows text information to be exchanged
between all different types of computers. Private electronic mail, public messages and
informative bulletins are almost always available in text form and can be easily exchanged.
This is especially true of text information. The modem is the translator: it allows different
types of computers to “talk” (communicate) with each other regardless of their particular
hardware or software. When using telecommunications, you can access a wide variety of
information, and the modem makes it all possible. There is one exception: even the modem
cannot make computer programs designed for one type of computer operate on a different
type. However, many data files such as word-processor documents, spreadsheets and
databases can be exchanged between computers.
Just as special tools are used to repair a car, build a house, special tools are needed to collect
and distribute information. Mail and delivery services, fax devices, voice phones and
telecommunications are all information distribution tools. Using ProTERM for your Apple II
or ProTERM for your Macintosh computer, you can find and share information. Not just any
information, but the specific kinds of information of interest to you right when you need it.

Using ProTERM:
• A student can obtain information for a report by calling an online encyclopedia.
• Search the library card catalog for availability and location of needed books.
• Use your computer to manage your stocks and get up-to-the-minute quotations, and
enter the info directly into a stock management program for analysis.
• Professional and “armchair” scholars use telecommunications to exchange information,
and special-interest groups “meet” electronically to discuss current interests.
• Telecommunications allow you to easily exchange electronic email or data with a friend.
Compose a letter on your computer, call an online service, and send the letter. The
letter is available the reader within minutes.
Telecommunications is perfect for physically challenged people and contributes to an
improved quality of life, especially for those with limited mobility or motor skills. Telecommunications is a wonderful equalizer because everyone is on a level playing field. It can
enrich the lives of everyone because it offers a unique non-discriminating and nonintimidating environment. Telecommunications allows:
• Access to further education by allowing remote attendance in classes not otherwise
accessible.
• Social development by allowing interaction at conferences, social events, games, and
forums offered by online services.
• Interaction as an individual with the community through local bulletin board services.
• Development of self-esteem from accomplishments and achievements online.
• Allows the hearing impaired to participate in online conversations using an alternate
form of communication besides the Telephone Deaf Device (TDD).
• An easy method to send and receive mail (electronically).

Work-at-home
business owners
depend on fast and
easy communication.

Telecommunications is an extremely important and powerful tool for home businesses. Until
just recently, the words “home-based business” conjured the mental image of a business not
quite able to make it in the “real” world. However, at one time in history, most businesses
(trades) were based out of the home. As businesses become specialized in an era of
industrialization, and transportation also becoming easier with the automobile, it became
profitable for businesses to hire large numbers of employees, and they all worked in one
general location. With the advent of telecommunications and other related communication
and delivery services and technologies, this need for physical centralization of the office is
drastically reduced in many types of businesses. The result is a literal explosion in homePART ONE — GETTING STARTED
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based businesses and employee telecommuting (working from home using communications
technologies). Cottage industry is so large and popular, the home-office business has
spawned an industry relying on services to home-office businesses. Many businesses now
specialize in services just for home-office business.
Since 1990 telecommuters rose from the relatively unheard of, to the commonplace. More
than 35 million home-based businesses are established, and an estimated 10% of the work
force will utilize telecommuting from home instead of going to work “at the office.” Federal,
state and local governments understand the ecological impact of everyone driving from
home to a work location, and encourage work at home whenever possible. Many city, county
and state government offices offer “work at home management information” including well
organized video media for use by business management. Working at home, or “the cottage
industry” as it is called, is not only desirable, it is trendy, fashionable, and coveted.

The Telephone Line
The phone company doesn’t care
who’s talking.

Using the phone line for a telecommunications call is the same as using it for a voice call,
except your computer is “talking” instead of you. The phone company doesn’t know or care
about how you use the phone line as long as the use is reasonable and legal.
The telephone company wants to assist you. They are in the business of selling telephone
service and they are pleased to have a customer who may find a need to request additional
lines and services. The normal voice-quality phone line you have in your home is perfectly
adequate for everyday telecommunications. Additional lines are not needed unless you
prefer the freedom an additional line may give. No changes are needed, other than plugging
a phone line extension cord into a modem, and connecting the modem to your computer.

Modem:
A translating
device.

How Data is Sent Through a Phone Line
Phone lines actually handle computer data calls as voice calls. Normal phone lines were
designed for voice (analog or continuous tone) transmission where frequency and volume
give speech its “color” and “meaning.” During normal speech, frequencies and volume
change gradually in continuous tones. Think of the gradually changing sound of the plaintiff
wail of a wolf as it changes from a low to a higher pitch, and compare that to the clicking
sound of the tap dancer. Phone lines are designed to handle the mellow tones of your voice,
but computers speak in a digital on/off “clicking” language which is sharp by comparison.
Since the computer speaks this digital language of on/off pulse sound, and the phone system
is designed to transmit a range of frequencies and tones, a translation device is needed, and
that is where a modem becomes a necessity.

The Modem
MO-dulator +
DEM-odulator
= MODEM.

MODEM n: a contraction, MOdulate+DEModulate: A device that converts signals from
one type of device (as a computer) to a form compatible with another type of device (as a
telephone).
The modem is the device that connects your computer to the phone line. It uses a process
called modulation to change electronic on/off clicks or pulses from the computer, into
continuously fluctuating sounds—Think of it as a form of highly specialized speech. This
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“modem speech” can be sent across a phone line just like the human voice. Since phone
lines are designed to handle tones, the modulated computer information can be sent via a
voice phone line. When received by another modem, the analog tones of the “modem
speech” are translated back into on/off pulses, in a process is called demodulation.

Serial Port -> Modem -> Phone Line -> Modem -> Serial port
Bits per second
(bps) and baud rate
are measurements
of speed.
The most important
things to know
about a modem;
quality, compatibility and transmission rate.

The transmission rate of a modems is measured in terms of bps (bits per second) (also
referred to as baud rate). At the time this text was written, popular modems support rates
from 300 to 33,600 bps. Higher speed modems can normally communicate at lower speeds,
so a 14,400 bps modem can step down to communicate with 300.
At 300 baud, a computer can send about 30 characters per second. At 14,400 bps, a modem
can send 14,400 characters per second. Obviously, when you are calling long distance or
paying by the minute for an online service, faster is better. However, some commercial
online services charge a higher per-minute fee for higher speed transmission. High speed
modems can almost always be used at any of the lower speeds and connect automatically at
the highest speed supported by both modems.
NOTE: The terms bps and baud are often used interchangeably when referring to modem
transmission rates. Technically, baud means something slightly different and bps is the
correct term.
Good quality 2400 bps modems are extremely affordable and adequate for many telecommunication tasks. New technology and the popularity of telecommunications continues to bring
the cost of high speed to a level we can all afford. Most services can be accessed at 14,400,
28,800 bps or faster. This same statement was being made about 1200 and 2400 bps modems
respectively in the very recent past.
Modems are available in many shapes, sizes and costs. Some computers have internal
connectors that allow the use of “internal” modems. These modems are connected to the
computer’s serial port and draw power from the computer’s power supply. Other computers
use external modems which are connected to the computer’s serial port using a cable. An
external modem has its own case and power supply. Because it is external to the computer,
most external modems can be used with any type of computer while internal modems can
typically only be used with the specific type of computer they were designed for. Whatever
kind of modem you consider, it must be compatible with the intended computer system
(hardware and software).

If you are not sure
what modem to
buy, contact us. We
can help.

We sell only good
value modems at
InTrec.

The “buzzword” for a modem’s compatibility with other modems is “AT-compatible” or
“Hayes® compatible.” Most telecom software is designed for use with “AT compatible”
modems. Often, features such as automatic dialing are lost when non-compatible modems
are used. Before you buy a modem, compare models, ask about features and make sure you
get a modem that matches your needs. A good price does not mean a good value. Like
anything else, if you are not sure what to do, buy what is popular — there is safety in
numbers.

Considerations When Shopping for a Modem
• A modem is NOT a good item to buy cheap—you generally get what you pay for.
Most of the technical support calls to InTrec are to resolve problems caused by cheap
(low quality) modems. Determine whether the product is a good value or is it cheap,
the difference is incomparable.
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The Bottom Line
• Quality products generally give good service, satisfactory results, and last a long time.
• Cheap products don’t cost as much.
NOTE: ProTERM supports an extremely wide variety of modems. For more detailed
information regarding what to look for when purchasing a modem, see the Index: Modems.

The Serial Connection
Internally, a computer moves information around in units referred to as bytes. A byte is a
group of eight smaller parts called bits. A bit is an individual on/off value, think of it as an off/
on switch. A single bit has either the value zero or the value one. In order to represent larger
values, bits are grouped together into larger units such as bytes. Each of the eight bits in a
byte can have an individual value of zero or one. There are a total of 256 different combinations of zero/one bit values within a byte. The following shows the bit values that would
represent the letter “H” within a byte.

H
7
128
0

6
64
1

5
32
0

ON
O FF

4
16
0

3
8
1

2
4
0

1
2
0

0
1
0

0 + 64 + 0 + 0 + 8 + 0 + 0 + 0

Place number
Place value
Off/On
H =72 Total

Example of a Byte
As you can see here, the letter H is the same as a value of 72. See the ASCII Character Chart
in the back of this book for more detailed information.
Normally, computers communicate internally by sending one or more bytes of information
in a “parallel” arrangement (all the bits in a byte are sent simultaneously). However, when
the information must be sent through a modem and phone line, the order of these “side-byside” bits has to be rearranged. To simplify communication with the modem, the bytes are
sent one bit at a time in a serial arrangement (one after another). Computers “talk” to
modems by “serial communications” using an electronic circuit called a “serial port.”
An analogy of how a serial port works would be to think of an eight lane highway with cars
traveling side by side. Each lane represents a single bit and looking across all the lanes at
once represents a complete byte. This is how the computer normally handles bytes within its
own electronic circuitry. The conversion performed by the serial port is similar to forcing all
eight lanes of traffic through a one lane tunnel. Cars from all eight lanes must “peel” off their
individual highway lane, and line up in single file, and go through the tunnel one after the
other, which is slower than traveling abreast. Once out of the tunnel, the cars can again
return to their original lanes side-by-side and continue on at full speed.

PART ONE — GETTING STARTED

34

F O R E W A R D

ProTERM Puts It All Together
ProTERM is your
telecommunications power-tool.

he above is all detail you’ll never have to worry or wonder about because ProTERM provides
the interface between you, your computer, your modem and the service you call. ProTERM
uses the available hardware and gives it instructions, telling it how to connect to the outside
world. Ultimately the software determines how simple or difficult, powerful or limited
telecommunications will be, and ProTERM is extremely powerful software providing the
sophisticated tools needed for a large variety of different telecommunication applications.

ProTERM Telecommunication Features:
• Easy to use allowing new telecom users to quickly adapt to using online services.
• Automatic dialing and sign-on, frees you from remembering and typing phone numbers,
user identifications and passwords. Connecting to a service is as easy, just choose from a
menu.
• Terminal emulation allows your computer to appear as if it is a specialized stand-alone
computer called a “video display terminal.” Some services can only be accessed by the
use of a video display terminal, and ProTERM’s terminal emulation allows you to work
with most of those services.
• An integrated text editor allows letters and messages to be composed in advance before
you call a service which saves long-distance and access charges.
• A full selection of transfer protocols allow files to be transferred.
• Review old information even after it has long since scrolled off the screen, and replaced
by new text. Easy selection of text to be printed or saved for later review.
• Chat mode allows participatation in online chat conferences with others in real-time.

Someone To Call
With ProTERM installed on your computer, you’re ready to explore telecommunications. You
just need to choose and online service to call. A wide range of computer services are
available and many are free. Online services fall into several general classifications, bulletin
board services, library database services, large commercial services and the Internet.

Bulletin board
services run on
personal computers
just like yours.

Bulletin Board Services
Bulletin boards are a popular online service. Also called BBS, they are electronic version of
the message exchange board often found at public places such as the grocery store, where
you can tack a note on the board to announce an item for sale, lost and found, job openings
or other items of specific interest. The subjects of discussion on a BBS vary widely, and as
diverse as the people who call. Most of the interaction on a BBS takes place through public
messages posted by individuals, and the messages are generally categorized according to
subject. Other people interested in the same subject can read these messages and reply. In
addition to public messages, a BBS usually offers private electronic mail (electronic mail
called “email”) which is a kind of private message that can be exchanged between two or
more users. Unlike public messages, private mail is visible only to the recipient. While
visiting a BBS, you can choose to quietly read and not get involved in discussions (this is
referred to as “lurking”). However, if people like yourself never ever participated, there
would not be anything to read. Therefore, don’t just use a BBS—get involved—you will
enjoy it. Remember that everyone has to has to post their first message. Promise yourself that
you will break that barrier early—It really makes a difference.
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Most bulletin board services run on personal computers similar to yours. The difference is
that the individual running the service has dedicated their computer full-time to allow you
and others to communicate. The access to many BBS’s is free, costing only the price of the
phone call (normal local service & long-distance telephone rates apply). A free BBS may have
only a single phone line which means only one caller can use it at a time, so a busy signal
when calling a BBS is not uncommon. Phone numbers for bulletin board services are often
published in the local newspaper. Some of the membership based BBS’s are even listed in
the yellow pages under “Computer-Bulletin Boards.” Also see the Index: User groups.

As time progress,
all information will
be available electronically.

Library Services
Libraries offer a variety of services which are accessible to the public, and many libraries now
have the card catalogs online, and some even include short book summaries. In some areas,
entire books are available electronically with a simple phone call. Call your local library and
ask what online services they provide. They will be happy to assist.

Commercial Services
The large commercial services, provide a wide variety of information. For example, you can
use some commercial services to make travel reservations, get current news, or play games.
You can “chat” with other people online in a group session by typing messages back and
forth. You can post public messages or send private email to be retrieved by someone later.
You can also send and receive software to and from the service (provided the author of the
software has given permission). Commercial services normally charge for usage by some time
limit such as per minute, hour or month. In most metropolitan areas, you can reach the
service with a local phone call and the cost of what is really a long distance call is built into
the overall cost of the service. This may save your paying long distance phone charges if
you’re exchanging files with someone in another city, or even somewhere else in the world.
NOTE: See Appendix F for more information about online services.

What Is Available Online
“Freeware,” “shareware” and “public domain” software have separate meanings, but the
names are often confused and used interchangeably. Some software is available for just the
cost of transferring it to your computer. Some has certain restrictions, including limiting
redistribution, or requiring a registration fee for extended use. You must responsibly read
the documentation regarding the use and redistribution of the software.
Some of this software is good, useful, and even valuable; some is not so good, and may even
crash your computer. Beginning programmers frequently introduce themselves and their
work by using these distribution methods to get their software both tested and recognized.
Technical support may also poor, limited or nonexistent.

Public Domain Software
Public domain software can be used with no responsibility for legal ownership or payment
for its use. The author retains no copyright restrictions on is use or method of redistribution,
does not collect payment for the software, and allows it to be freely redistributed.
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Freeware
Freeware applies when the author allows to be distributed at no cost or obligation to the
user. Freeware is like public domain software, except the author retains the copyright and
may place restrictions on how the software is distributed.

Shareware
Shareware is “try before you buy” software. The user is allowed to use the software on a trial
basis. If the user decides to keep and use the software, they are expected to pay a fee.
Additional documentation and updates may also be provided after payment. Prompt and
proper payment of shareware fees encourages the developers to continue to support and
upgrade the software. Treating shareware developers fairly is an obligation we all share as a
computer community. The author retains full and complete copyright restrictions on is use
or method of redistribution,

Commercial and Copyright Software
Commercial software is protected against copying and electronic distribution by the national
copyright laws. The author of the software has exclusive and legal right to reproduce,
publish, sell and distribute the matter and form. Any other methods of unauthorized
distribution are considered software piracy.

Getting Telecommunications Assistance
If you need assistance getting started, help is available from several sources.
• Contact your local user group. They are sure to have members who can answer your
questions and enthusiastically assist you with locally available services. Many user
groups even run their own bulletin board service. Larger user groups often have special
interest groups (SIGs) dedicated to the subject of telecommunications. For more
information see the Index: User groups.
• This ProTERM manual contains extensive and detailed information on learning to use
telecommunications.
• Telecommunications is popular, there are hundreds of books published. Check your
local library and book store.
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About ProTERM
CHAPTER ONE
“Call-Outs” like this
example “ point at”
important
topics.

Minimum
requirements.

Congratulations
…on your purchase of ProTERM, the most powerful communications program available for
the Apple IIe, IIc, IIc+, II GS, Laser 128 and Mac LC with the IIe Emulator Card. ProTERM
operates under ProDOS and can be used to communicate between your computer and
almost any other computer which is accessible by a modem. You can reach commercial
online services such as CompuServe, GEnie, Delphi, Dow Jones News/Retrieval, Canada
Remote Service, Dialog, BIX, PeopleLink, NewsNET and many more. Likewise, there are
many popular Bulletin Board Systems (BBS) run by individuals in almost every community
and all are easily accessed with ProTERM. If you’re not aware of any privately-run Bulletin
Board Systems in your community, check with your local computer retailer or user group.
For further reference, see “user groups” in the index.
ProTERM is designed to be easily mastered by all levels of users. It is operated through a
series of pull-down and pop-up menus which are never more than a keystroke or mouse
click away. A lot of values can be changed and adjusted for individual needs, but most values
are preset and ready to use.

Overview of the Manual
This manual is divided into four major parts. Each part deals with a different aspect of the
software. For easy reference, each page of the manual is subtitled with the name of the part
in which it occurs. Bending the manual back slightly revels black page edges marking the
start of each part. Also, each chapter is marked with a black band also visible at the page
edges.

The Four Divisions
of this Manual

Part One — Getting Started
Part One (this part) of the manual provides an introduction to telecommunications and
explains how to setup and use ProTERM. When first getting started using ProTERM, all the
information you need is located in Part One. You may not need to reference the rest of the
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manual until you have gained some experience online and want to further explore ProTERM,
but the information is there if you need it.

Part Two — The Major Features
Part Two is organized according to the major features of ProTERM. This part contains the
most detailed information on each of the different major functions of the software.

Part Three — The Menus
Part Three provides information on every command in the pull-down menus. This part is
organized according to the way in which the menus are arranged within ProTERM.

Part Four — Reference
Part Four contains the Appendixes and the Index. The Appendixes have information on
topics including compatibility, troubleshooting and technical support. The Index provides an
extensive cross reference of keywords to page numbers.

Hardware Requirements
ProTERM will run on an enhanced Apple IIe, IIc, IIc+, IIGS, Mac LC with IIe card or Laser
128 computer with most internal and external modems. Apple IIe’s require an 80-column
card in the auxiliary slot, a minimum of 128K of memory and the “IIe enhancement kit.” A
minimum of one 5.25" drive is needed, but two 5.25" or a 3.5" drive or a hard drive make
ProTERM easier to use and more efficient. ProTERM will not operate on an unenhanced
Apple IIe (see the Index: enhanced Apple IIe). Although ProTERM will work with a minimum
of 128K, increasing the memory to just 256K makes a BIG difference in performance. When
anything over 128K of RAM is available, ProTERM will load some of the often used overlays
into this RAM based memory and then operate from this memory rather than accessing the
disk each time. All Apple IIGS memory cards are supported to a maximum of 8 megabytes.
Most Apple IIe memory cards which follow the auxiliary-slot convention of bank-switched
RAM are supported to a maximum of 8 megabytes. Both “slot-RAM” and “Slinky-RAM” cards
are also supported to a maximum of 1 megabyte.

An expanded Index
helps to find subjects easily.

Limitations of Using Just the Minimum of Hardware
ProTERM will function with a minimum of 128K of memory and one 5.25" disk drive, but
when using only the minimum amount of hardware, certain limitations are placed on the
software, including:
• The ProTERM Editor is limited to 24K.
• Scrollback is limited to 23K (equivalent to 10-12 typed pages.
• The transfer buffer shares the same space as the Editor buffer (memory).
• ProTERM commands require additional disk access if theProTERM Program Disk is
removed for operations such as saving or accessing files from other data disks.
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Increasing ProTERM’s Performance
For the best performance, a minimum of 256K of memory and two disk drives (or a hard
drive) is recommended. When used with 256K of memory, ProTERM allows:
• A full 46K Editor (equivalent to 20+ type written pages).
• Approximately 80K of Scrollback.
• A dedicated 46K transfer buffer.
• A 46K code-cache buffer which allows recently used ProTERM commands to be kept in
memory so they are immediately available the next time they are needed. This feature
dramatically decreases the amount of ProTERM disk access. Adding memory beyond
256K continues to increase the size of the Scrollback buffer until it reaches a limit of 8
megabytes.

Hardware Supported

Memory Cards
AE RamWorks, RamFactor, RamExpress and Z-Ram Ultra.
Checkmate MultiRAM (all versions) and Q-Card.
MPD Super Expander “E” & “C”.
Apple Memory Expansion Card.
Chinook Technology C-RAM.
PLUS ALL Apple II GS Memory Cards.

Modems
AE Datalink 1200/2400, Express 2400.
Apple Modem 300/1200/Personal.
Boca Research 14.4K BPS.
CTS Fabri-Tek 1212AD, 2424ADH/AMH.
Epic 2400 Classic II, 2400/Mini/Plus.
Hayes Personal Modem 1200/2400.
Hayes SmartModem 300/1200/2400/V9600.
No Modem in System (for direct-connect use).
Novation Professional 2400.
OKIDATA Okitel 9600.
Prometheus Promodem 1200/1200A/2400A.
Quality Computers Q-Modem 2400.
SupraModem 2400, 2400 Plus.
SupraFaxModem Plus, V32bis.
US Robotics Password.
US Robotics Courier 2400/HST/HST-Dual.
Zoom/Modem MX 2400R.

About Modem Compatibility
While it is not possible to test every modem in today’s developing market, most modems
which are truly “Hayes compatible” or “AT compatible” will operate with ProTERM. Modems
which do not have this compatibility can be supported to some degree by using ProTERM’s
Null Modem configuration.
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Modem Ports and Serial Cards
Apricorn Super Serial Imager.
Apple IIc Modem Port.
Apple IIc+ Modem Port.
Apple II GS Modem Port.
AE Serial Pro.
Laser 128 Modem Port.
Apricorn Super Serial Imager.
Apple Super Serial card.
Practical Peripherals SeriALL.

O ptional Hard w are
Although ProTERM can make use of a clock or a printer, they are considered optional and
neither are required for its operation.

Printer Ports and Interface Cards
Apple IIc Printer Port.
Apple IIc+ Printer Port.
Apple II GS Printer Port.
Laser 128 Printer Port.
Apricorn Parallel Card.
Apricorn Super Serial Imager.
Apple Parallel Card.
Apple Super Serial Card.
AE Parallel Pro.
AE Serial Pro.
Apricorn Parallel Card.
Apricorn Super Serial Imager.
Dumpling 64 Parallel Card.
Epson APL Printer Card.
Orange Micro Grappler Plus.
Practical Peripherals SeriALL.
SMT Printech II.
Star Micronics Grafstar.
Textalker-GS 1.2.

Clock Cards
Apple II GS internal clock.
AE RamExpress, Serial Pro, TimeMaster II HO, Z-RAM Ultra clock.
SMT No Slot Clock.
ThunderWare ThunderClock Plus.
PLUS ALL ProDOS Compatible Clocks.

Want more hardware support in
ProTERM?

About Hardware Support
A great deal of time and effort has been directed at making ProTERM’s hardware support as
broad as possible. However, new hardware products are continually introduced, and
requirements may differ. ProTERM allows the use of “plug-in” code modules and new
modem/hardware operating software (drivers) can be released independent of ProTERM
version releases. As new drivers are developed, they are made available to registered owners
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through the InTrec BBS. These small files can be copied into the ProTERM folder and the
new driver selections will be available from the Install menu after ProTERM is re-started.
If you would like to see hardware support for a particular product, please let us, and the
product vender know. InTrec is always interested in broadening ProTERM’s hardware
support, but it requires customer participation. First, we need to know there is interest in
the support of a product. Second, we need your help in acquiring the product. Usually, if we
initially contact venders, they're reluctant to furnish us with product without apparent need.
However, when customers tell the manufacturer or vendor they want the product supported
by ProTERM, the results differ significantly.

List of Materials Included in the ProTERM
Package
Mail your
warranty card now.

• 1 – ProDOS-formatted 3.5" program diskette (master disk). Make sure this disk
stays write protected.
• 1 – ProDOS-formatted 5.25" program diskette (master disk). The front side of this
disk is the boot side and the backside is the program side. It is not notched
so it is always write protected.
• 2 – Quick reference cards.
• 1 – ProTERM product registration card.
• 1 – ProTERM user manual.

NOTE: If you are not sure on how to make a backup “working” copy of the ProTERM master
disks, just boot the size disk you will be needing and it will automatically go to a disk copy
mode.
If any of the materials are missing or damaged, please contact your software retailer. If your
computer retailer is unable to help you, call:
InTrec Technical Support 602/992-1345
InTrec BBS 602/992-9789
InTrec FAX 602/992-0232
Internet proterm@intrec.com
http://www.intrec.com
ftp://ftp.intrec.com/pub/intrec/

Have your ProTERM
serial number
available anytime
you call for technical support.

Remember to have your ProTERM serial number available anytime you call for support. The
serial number is the number on your original ProTERM master disks, the Warranty Card, the
ProTERM box and the ProTERM manual.
If you have just purchased ProTERM and not yet sent your Warranty Card and need
assistance feel free to call, but have your Warranty information ready to give to the Tech
Support person you speak with:
Your name and address information.
The dealer you purchased ProTERM from.
The ProTERM serial number from the disks, manual,
Warranty card or box.
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Please send your ProTERM Warranty Card as soon as possible. This interim support is limited
to just getting started. We reserve the right to refuse technical support if the caller is not a
registered user.

Textalker-GS
In addition to supporting many different printer and printer Port combinations, ProTERM
also supports Textalker-GS speech software for visually impaired users. The Textalker-GS
driver is selected from the Printer Port installation window (see Installing the Printer Port)
and speech is utilized through the ProTERM printer commands. Detailed information on
using Textalker-GS and ProTERM can be found in the text file “PT3.TEXTALKER” located in
the “UTIL” directory on the ProTERM 3.5" disk.
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The ProTERM
User Interface
CHAPTER TWO
This chapter can help you to become a ProTERM expert in the shortest possible time. It
explains how the ProTERM interface works and gives tips on how to use shortcuts to save
time and make telecommunications easier for you. Even if you’re a telecommuter guru, take
a few minutes and read this chapter now.
The ProTERM user interface (what you see on the screen as you work with ProTERM) is
MUCH easier to use than to explain. While you can just dive in and learn ProTERM without
reading this or any chapter, the tips and pointers given here will save a lot of time and let
you enjoy the power of ProTERM. Just browsing this chapter gives a feel of how the interface
works. As you gain experience using ProTERM, refer back to this chapter for specific
questions regarding the user interface.

The ProTERM
interface works
with either the
keyboard or a
mouse.

The ProTERM interface of pull-down and pop-up menus and windows is easy to learn and
use. This interface is usable with either the keyboard or mouse or both if you prefer. If you
do not have a mouse (or just dislike using it) —no problem. While ProTERM has excellent
mouse support, it is not a “mouse-based” application. Many users find learning the software
is easier when using a mouse, but after gaining experience, they gradually change to just
using the keyboard command equivalents because of convenience and speed. For example, a
file can be saved in at least three different ways:
• The mouse can be used to click on the File menu, pull down to Save and then release
the mouse.
• Press the COMMAND key and then the F key. Choose Save, and press the RETURN key.
• Pressing COMMAND+S is the keyboard equivalent to both of the above.
All three of the above operations execute the save a file function, but as you can see, the
keyboard equivalent is the fastest and the easiest. Read on to find more ProTERM tips and
short cuts.
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The Keyboard
Throughout this manual, reference to keys that need to pressed to a create an action will be
in UPPER CASE, for example, “press the RETURN” key. Also, references will be made to the
COMMAND, OPTION and ARROW keys. The COMMAND key is labeled with the open-apple
“ k ” and/or “c ” (clover or propeller) icon while the OPTION key is labeled with the word
“OPTION” or the Solid-Apple “ K ” (see Open and Closed Apple References below). The
ARROW keys are the four directional arrows, or “cursor keys” located on the keyboard. When
instructed to press a key combination like COMMAND+PERIOD, hold down the COMMAND
key, press the PERIOD and then release both. Like the SHIFT key, the COMMAND and
OPTION keys modify the function of other keys, but have no action when pressed alone. The
CONTROL key is obviously labeled and the ESCAPE key is labeled ESC.

The Mouse
DRAG =
Position the
pointer, press and
hold the mouse
Button. Move the
pointer, and release
the mouse Button.

When using a mouse with ProTERM, interaction takes place bypositioning the pointer and
clicking the mouse button. The pointer is a small arrow which moves on the screen in
response to moving the mouse. When a key is pressed on the keyboard, the pointer is
“obscured” (hidden) so it does not interfere with what is seen on the screen. Moving the
mouse makes the pointer re-appear. Clicking involves pressing and releasing the mouse
button. Double-clicking is two clicks in quick succession.Dragging refers to moving the
pointer while the mouse button held down.

Open and Closed Apple References
While the Open and Solid (also referred to incorrectly as “closed”) Apple are familiar to many
Apple computer owners, there are several reasons this manual does not use or reference the
Open and Closed Apple symbols for keyboard commands. The main reason is due to a style
change request from Apple Computer. Some computers manufactured by Apple do not show
the Apple keys (and the Laser computers have open and closed triangles). We chose to
follow the convention as noted in the Apple Developer Manual, the Apple Publications Style
Guide — Fall 1990 Edition which is directly quoted as follows:

COM MAND =
Open-Apple.

OPTION =
Closed-Apple.

“Open Apple key”

“Don’t use; use Command key for the key on the Apple II and Macintosh computers that is
marked with an Apple symbol, a propeller symbol or both. (On Apple II family keyboards
that have two keys with Apple symbols, the key marked with an Open Apple is now the
Command key; the key marked with the Solid Apple is now called the Option key).”

“Option key”
“Not Solid Apple key or Closed Apple key. (On the Apple II family keyboards that have two
keys with Apple symbols, the Option key is marked with a Solid Apple.)”
In addition, a design change for all Apple II computers manufactured after the fall of 1986
changed certain keys of the Apple IIGS, Apple IIe Platinum, and Apple IIc+): The “solid
Apple” icon was renamed as Option (opt) key. This change allowed all Apple computer
keyboards, Apple II and Macintosh, to have the same look and user reference.
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Reminders for the Open Apple key being the COMMAND key and the Closed Apple key is
now the OPTION key, are provided throughout the manual and on theQuick Reference
Cards. Most newer Apple II keyboards have a hollow (open) Apple “ k ” and/or “c ” (clover
or propeller) icon on the COMMAND key and a key labeled OPTION. We regret any
confusion this policy may cause, but we feel it is important to following Apple’s recommended style guidelines where possible.

Navigating ProTERM

The Menu Bar

Need to see the
Menu Bar while
online?
Press the
COM MAND key.
Misc
Editor
Scrollback

ProTERM commands are accessed through pull-down menus (windows) which are selected
from the MenuBar, the inverse bar (highlighted line) of information at the top of the screen.
The MenuBar is not visible except when needed. Because the Apple II computer screen
displays 24 lines, the line at the top which contains the MenuBar must also be used for the
Status Bar. To issue a command when the MenuBar is not visible, either hold down the
COMMAND Key or move the mouse, to make the MenuBar visible.

E
Z

Answer Phone
Unattended U
Macro File
Read Globals
Transfer Stats
Preferences
Install

I

Commands from the Keyboard, or
Keyboard Equivalents
ProTERM allows the use of combinations of keys to navigate and perform tasks easily. When
menus are pulled down, look for an Apple icon (for example k +E = Editor) next to an
alpha character. These key combinations are known as a keyboard equivalents and they
perform the tasks directly without going to the menu. See the Quick Reference cards and the
chapters explaining the individual menus. Also see the Table ofContents: File and Utility for
more information.
Navigation with keyboard commands is easy and intuitive. Press the COMMAND key and the
first letter in the name of the pull-down menu. For example, press COMMAND+M which
pulls down the Misc menu. The contents of the pull-down menu displays a list of commands
and one is highlighted. Use the Up or Down ARROW keys to highlight different commands
within the menu. The Left or Right ARROW keys to move respectively right or left, selecting
the other pull-down menus. Also, when a pull-down menu is displayed, pressing the first
letter of a command’s name causes that command to be selected (highlighted). For example,
the File pull-down menu shows Open as a visible command in the pulled down menu, and
pressing O selects Open. If several commands start with the same letter, subsequent key
presses cycle between those commands. For example, if the “c” key is pressed repeatedly
while the File menu is visible, Copy and Catalog would be highlighted alternately. Press the
RETURN key to choose the highlighted command or press ESCAPE to cancel the selection. As
noted above, commands which show an Apple icon (k ), for example the Misc menu shows
“Editor k E” which means the ProTERM editor can be accessed directly by pressing
COMMAND+E key without pulling down the menu showing that command.
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Selecting Commands with the Mouse
Mouse terms
• Click

Pressing the mouse button. Double-click means to press twice in rapid
succession.
Positioning the pointer and pressing and holding the mouse button as the
mouse is moved.
Pressing the mouse button down (clicking).
Windows, objects, sections of text and groups of files are selected.
Positioning the pointer on a file or command and pressing and holding the
mouse button down. To choose a command using the mouse, move the
pointer until it is resting on the name of a pull-down menu selection on the
MenuBar. Press and hold the mouse Button while moving the mouse
(dragging the pointer) down into the pull-down menu. As the pointer is
moved in the menu, the commands are highlighted as they are contacted by
the pointer. To choose a command, drag the pointer until the command is
highlighted and release the mouse button.

• Drag
• Press
• Select
• Choose

Windows
An “ object” is a
selectable item in a
window.

ProTERM 3.1

2.25K edit

9.50 sbk

9600 baud Offline 15-FEB-96 13:47:19
Window

Check box

The TAB key highlights different
objects in the
window.

√

Text field

Screen Saver Enabled

Timeout before activation:
Never Activate:
Upper-Left
Upper-Right
Lower-Left
Lower-Right
OK

Objects are the
idividual items
within a window.

MenuBar

Screen Saver

Cancel

2

mins

Activate Now:

Current object
Radio buttons

Example Window 1

Upper-Left
Upper-Right
Lower-Left
Lower-Right
Mouse pointer

Buttons

Everything you do and all input to ProTERM takes place within aWindow. A Window is
defined as having a frame around the window may or may not have a title, see illustrations
Example Window 1 and 2, shown in this chapter. A Window can containButtons, Text
Fields, Check Boxes, Radio Buttons, Pop-Ups, Lists, File and Batch Selectors. Throughout this
chapter the term object is used to refer to all of these different item types. These illustrations
show some example of windows containing the different window objects.
One object in a window is always selected. Unless otherwise noted, input from the keyboard
(keystrokes) always affect the selected object. To select a different object (so it can be
modified), press the TAB key to move to the next selection in a clockwise direction.
COMMAND+TAB moves a counter-clockwise direction, moving the selection to the previous
object. Positioning and clicking the mouse on an object, selects that object. This may have
other effects such as causing a window to pop up. Each individual window object type is
discussed below.
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COM MAND-RETURN
“ presses” the
default Button.

ProTERM 3.1 2.25K edit
File Selector System

9.50 sbk

9600 baud Offline 09-FEB-96 14:52:36

Receive ASCII
Pathname

Menu bar

/HARD1/MY.FOLDER

Filename

Files shown
in directory
can be selected
or a new name
typed in.
Choose to continue

Window

FORUM.NEWS
..<Parent Dir>
AMER.SPORTSNEWS
BIZ.LETTERS
CRTEST.FILE
GAME.README
GOLF.ARTICLE
POSTAL.RATE

Save AS
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Text field
DIR
TXT 3
DIR 9
AWP 14
TXT 57
TXT 5
TXT 1

04-APR-91
05-FEB-93
05-APR-92
03-MAY-91
04-FEB-92
11-FEB-93

Cancel

Example Window 2
Mouse pointer

Buttons
Selecting an object,
makes that object
the “current”
object.

Hotkey feature.

Buttons are objects located along the bottom margin of a window. They consist of a
rectangular frame (box), enclosing the name of the Button.

To select a button:

• Click on the button.
• Press the TAB key to move the clockwise and COMMAND+TAB to move counterclockwise to a button.
• Press and hold the COMMAND key while pressing the letter of the key the name of the
button. For example, COMMAND+M selects the Macro button in the system parms
window. This action moves the cursor directly from the selected object to the desired
button at the bottom of the window. In addition, when theHotKeys feature is turned on
(see Index: HotKeys), the command is complete and immediate because the HotKeys
feature invokes the RETURN key automatically. In other words, the Button is automatically activated by the COMMAND+letter keypress.
• When a button is selected, the ARROW keys select the next or previous button.

To activate a button:

• Double click on the Button.
• Press the RETURN key to activate a a selected Button.
Other keys that activate Buttons which can be used anytime a window is visible are:
COMMAND+RETURN always “presses” the default Button. That is, pressing the keys
COMMAND and RETURN when a dialogue box is open, is equivalent to using the
ARROW keys to highlight the left-most button and pressing RETURN.

ESCAPE and
COM MAND+PERIOD
cancel the window.

Cancel

ESCAPE or COMMAND+PERIOD select and “press” the Cancel Button.

Text Fields
An object is any
item in a window.

Text Fields are window objects which allow text input. Text input is only allowed within
framed input Text Fields. To select a text field (making it the current object), either position
the pointer within the field and click, or press TAB or COMMAND+TAB until the text field is
selected. When selected, a vertical bar (cursor) blinks within the text field. To edit existing
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text, the Left ARROW and Right ARROW can be used to move the cursor in the respective
direction of the ARROW. Typing at the keyboard inserts text at the current cursor position.

Important Commands
The following commands are important and dramatically simplify the task of entering data
into text fields. Since text fields are used throughout ProTERM. Learning these commands
makes the use of ProTERM much easier.

Important:
Text Field
editing
commands.

– Key –
CONTROL+A
CONTROL+S
CONTROL+D
CONTROL+F
CONTROL+Y
CONTROL+X
DELETE key
Left ARROW
Right ARROW
RETURN
OPTION+SPACE

– Action –
Move to the beginning (left) of the text field.
Move to the end (right) of the text field.
Delete the character “under” the cursor.
Insert a space to the right of the cursor.
Truncate the line at the cursor.
Erase the entire line — Clear the field.
Delete the character left of the cursor.
Move the cursor to the left.
Move the cursor to the right.
Accept the text field.
Insert “hard-space.”

Check Box
A Check Box is a window object indicating the option (parameter, feature) is either on or off.
It is displayed as a small box with a name to the right. The current status of the Check Box is
indicated by the presence (on) or absence (off) of a checkmark [√ ] in the box. When a check
box is selected, the SPACEBAR toggles the checkmark on or off. In addition, the 0 (zero) key
turns the checkmark off, and the 1 key turns the checkmark on. Clicking the checkbox also
toggles it on and off.

Radio Buttons
Only one
“Radio Button ” can
be selected at one
time.

Radio Buttons are a collection of options where several choices may be available, but only a
single optoin can be selected at one time. Selecting one, de-selects another (see illustration:
Example Window 1). The name “radio button” is comparative to a car radio where a station
is selected by pressing one of the buttons. Selecting a radio button:
• Clicking on a Radio Button.
• Radio Buttons can also be selected with the TAB or COMMAND+TAB key and then the
ARROW keys can be used to highlight the desired choice. Alternatively, Radio Buttons can be
chosen with the number keys 1 through 9. Number 1 is always the first button and 2, 3, 4…
chooses the corresponding buttons.
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Pop-Up Windows (Menus)
A pop-up menu is used for multiple choice settings. When a pop-up menu is selected, the
ARROW keys change the current choice within the window. The choices appear to “slide by”
and are “exposed” one at a time “through” the window. Clicking on a pop-up window causes
a menu to “pop-up” showing all the possible choices. Drag the pointer until the desired
choice is selected. Releasing the mouse button selects the choice.

List Selector
As the name implies, a List shows a “catalog” of selections and allows the selection of one or
more items from choices in an alphabetized List.
NOTE: Alphabetization can be turned off in thePreferences – More menu. Also see Index:
File List.
Some Lists allow only a single selection while others allow multiple selections. If the List
allows only a single selection, then the hightlighted item is the selected item. If the List
allows multiple selections, items with checkmarks √
[ ] are the selected items. The following
commands can be used with Lists:
• The ARROW keys move the selection (selection) bar up or down.
• Pressing the first (alpha) letter key of the name of an item finds and highlights that item
(if more than one item begins with the same letter, subsequent keypresses of the same
letter cycles between those items). The Modem selection list which you used during the
Install procedure is a good example, and opening a file in the Editor is another. An “A”
selects items towards the top of the list while a “Z” selects items towards the bottom.
Other letters select items in-between.
• Press the COMMAND key and keys 1 through 9 locates items in a range throughout the
list. The number 1 selects the first item while 9 selects the last. The numbers 2 through
8 select relative points in-between the top and bottom.
• Click on an item in the list to select that item.
• Click on the Up or Down Scrollbar Arrow to move the selection up or down the list.
• Dragging within a List does not select items, but scrolls the List showing more items.
When the pointer touches the top or bottom item shown in the window, the items in
the list scroll to the last item.
• To choose a single item, select the item and press the RETURN key, or double-click on
the desired item.
• To select multiple items, highlight the item to be selected and press the SPACEBAR to
place a checkmark [√ ] next to each one.
• Multiple presses of the SPACEBAR select adjoining items. The SPACEBAR selects in the
same direction it was last moved using the ARROW keys.
• Hold the OPTION key down, position the pointer to the desired item and click to select
an item. Doing this to already selected items deselects them.
• Hold the OPTION key down, position the pointer to the desired item, click and drag the
pointer to select or deselect multiple items.
• Press CONTROL+A to select all items.
• Press CONTROL+N to select none of the items or deselect all.
• Press the RETURN key to accept the current selection.
• Press ESCAPE or COMMAND+PERIOD to cancel any action in the window.
PART ONE — GETTING STARTED

50

C H A P T E R T W O

File Selector

COM MAND+ARROW
keys offer a quick
method of navigation through
directories.

A File Selector is a special kind of aList. While it looks very similar to and uses many of the
same commands as a List (which see above), a text field is displayed in addition to the
filename List. This text field allows filenames to be typed in directly, as well as be selected
from the filename List. The following commands can be used with File Selectors:
• The ARROW keys move the selection bar up and down.
• Type a complete filename to immediately select that file.
• Type a partial filename to select the filename which most closely matches the entered
text.
• Press COMMAND+1…9 to locate items throughout the list. The number 1 selects the
first item while 9 selects the last. The numbers 2 through 8 select relative points inbetween top and bottom.
• Click a on filename to select it.
• Click on the up or down scrollbar arrows to move the selection bar in the corresponding direction.
• Click and drag within the filename list does not select items, but scrolls and shows
more filenames. When the pointer touches the top or bottom of the filename window,
the list scrolls.
• Double-click on a directory or select it and press RETURN or COMMAND+Down
ARROW to open it (see Index: ProDOS for details on this method of quick navigation).
• Press COMMAND+Up ARROW or double-click on “<Parent Dir>” or choose it and
press RETURN to close the current directory and open the parent directory (see Index:
ProDOS).
• Press COMMAND+Left ARROW or COMMAND+Right ARROW to close the current
directory and open the main directory of the previous or next volume.
• Press CONTROL+Z to display all filenames regardless of filetype.
• Press CONTROL+X to display the filenames without alphabetization. In this mode,
partial filename selection is disabled. Press CONTROL+X again to show the list as
alphabetized.
• Press RETURN to accept the current selection.
• Press ESCAPE or COMMAND+PERIOD to cancel all action in the window.

Batch File Selector
Just as some Lists allow multiple items to be selected, a Batch File Selector allows multiple
filenames to be selected. However, there is a difference when a directory is selected is part of
the selection. The directory is opened only if no other items are selected, and the directory
was selected with the RETURN key or double-clicked. If other items are already selected, or
the SPACEBAR is used to choose the directory, then it remains selected like any other
filename. In addition to the File Selector commands, the following commands are also
available:
• To select multiple items, highlight each item and press the SPACEBAR to place a
checkmark [√] next to each one.
• Multiple presses of the SPACEBAR select adjoining items.
• Hold down the OPTION key when using the ARROW keys or dragging to select or
deselect multiple items.
• Press CONTROL+A to select all items.
• Press CONTROL+N to select none of the items (deselect all).
PART ONE — GETTING STARTED

THE PROTERM USER INTERFACE

51

• Hold the OPTION key down, position the pointer to the desired item and click to select
an item. This action on a selected item deselects that item.

Choosing Parameters Too Many Choices?
Rule of thumb:
When in doubt,
accept given
choices.

Throughout ProTERM many different parameters can be selected and changed to match
ProTERM to your personal satisfaction. ProTERM perfectly without changes because it always
provides a default value. Simply stated, the rule of thumb for the ProTERM novice is, “When
in doubt, press the RETURN key and accept the defaults.”

Suggested Further Reading
See the on disk
tutorial.

For assistance with an on disk tutorial, See the Index:Suggested Further Reading.
The ProTERM disk contains a file named A60SECOND.WORKOUT. Open this file from within
the ProTERM editor an dfollow the step-by-step instructions.
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Installation
CHAPTER THREE
Introducing ProTERM
to Your Equipment
ProTERM and your
hardware…
matching it all up.

Thank you for the support you’ve demonstrated through your purchase of ProTERM. To
provide the greatest possible flexibility, ProTERM is distributed on non-copy protected
diskettes. The locked, and write protected disks are to encourage you to make working
backup copies so you can preserve your original archive disks. We trust your good faith as a
ProTERM owner, and ask for your support by not distributing copies indiscriminately. Your
support of our products is our incentive to support you, and plan future improvements.
This chapter assists your installation of ProTERM software to match your hardware
configuration.

Your ProTERM Package Is Personalized
If you need technical support.

ProTERM disks are serialized, the serial number is on a small white label, and all of the
important parts of your ProTERM package carry this label and number. This serialized set if
for your use at one station at one time. If you happen to call for technical support, you will
be asked for this number to identify your ProTERM set. Before calling for support, see
Appendix A: Technical Support in this manual.

Mail your ProTERM Warranty Card
Receive the InTrec
email newsletter.
Send us your email
address?

We are very careful and concerned about keeping our ProTERM licensee records accurate
and up to date. If you need Technical Support, we need to verify that the ProTERM is
licensed to you before we can assist you. Our customer list is updated continually as the
serialized ProTERM Warranty Cards are received, and as we communicate with customers. As
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technology changes, and we discover and implement design improvements, changes are
made, and the software is updated accordingly. We want to be able to contact you and advise
you of the changes, but we can only do this for registered owners. In addition, we would like
to keep in contact so we can notify you of new software releases to keep you up to date on
what is new. If your address information changes, let us know and we’ll update your record.
Also let us know how we can communicate with you online, be sure we have your current
email address.

Apple IIGS Modem Port
An Extra Slot
for IIGS users.

When running ProTERM on the Apple II GS, and using an internal modem, or an external
modem with a serial card in Slot 2, change the settings of the Apple IIGS Control to show the
slot of the modem/serial card toYour Card. When using an external modem with the IIGS
serial port, there is no need to change the control panel settings unless it is desirable to
change Slot 2 to “Your Card” to enable another device to be controlled from that slot. Since
ProTERM does not need the settings in the Control Panel’s Slot 2, you can change the Slot 2
settings to whatever you need, including changing it to readYour Card. You can then plug in
a card of your choice, and both the card in Slot 2 and the modem port function normally
with ProTERM. This arrangement gives you the bonus of an extra slot as ProTERM continues
to function from the modem port regardless of the Control Panel settings.

Macintosh LC With IIe Card
Refer to the setup instructions provided with the Macintosh LC Apple IIe card and install the
Apple II software on the Mac hard drive.
• Run the IIe Startup software.
• Press the CONTROL-COMMAND-ESCAPE keys to get to the IIe Option Panel.
• Click on the Serial Card “phone” icon.
• Click the radio button Other Device, (use settings below).
• Open the Serial Card.
• Click on the Interrupts option, and change the Interrupts to On (they are set to Off by
default).
• Click Continue to close Control Panel.

Install ProTERM On an LC With IIe Card:
• Choose the external modem from the Modem Install menu.
• Choose Apple Super Serial Card.
• Choose Generic Printer slot 1.

Copying ProTERM
NEVER use the
original disk;
always work
from a copy.

ProTERM should never be used from the original disks. Copy the disk needed and USE THE
COPY not the master! The only time the original (master) disks should be used is when they
are being copied. After making your working copies, store the master disks in a safe place.
Original ProTERM disks are shipped write-protected. The 5.25" disk is NOT notched and the
small plastic shutter window on the back side of the 3.5 disk is OPEN. These write-protect
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methods keep the original disks from being written to or copied over accidentally. Please
leave them write-protected and protect your warranty.

The original
ProTERM disks
must remain
write protected.

Move Ahead by Backing Up
An old adage called “Murphy’s Law” states, “Whatever can go wrong, will go wrong, and
usually does.” Treat disk media as if it were designed to fail. Eventually it will, and it will
happen at a most inconvenient time (OH PLEASE… NOT NOW!!), and your precious
information will be gone. “Matter will be damaged in direct proportion to its value.” —
Murphy’s Constant.

How to Copy ProTERM
Important!
Always work from
a copy of the
original disk.

ProTERM is designed to automatically create backup copies from the original disks. Boot the
original write protected disk as you would normally boot any new disk following these
instructions. Note there are labels on the front and back of the 5.25" disk. The label on the
front is titled “Boot Side” and the label on the back is titled “Program Side.” Copy both sides
of the disk.
NOTE: To boot the original ProTERM 5.25" disk, be sure to put the disk in the drive with the
”Boot Side” label facing up as you insert it into the disk drive.

Cold Boot
Starting with your computer turned off, put either the 5.25" or the 3.5" disk in your primary
(booting) disk drive and turn the computer on, causing the computer to (cold) boot from
that disk drive.

COM MAND key =
Open Apple key.

Warm Boot

Put either the 5.25" or the 3.5" disk in your primary (booting) disk drive, and hold the
COMMAND and CONTROL keys down, press the RESET key down momentarily and release
it, then release the COMMAND and CONTROL keys. This should cause the computer to
(warm) boot from your primary booting disk drive.

GS/OS Finder
From GS/OS (the Finder), put either the 5.25" or the 3.5" disk in the appropriate drive,
double click to open the “PT3” disk icon, and double click on the “PT3.SYSTEM” file.
NOTE: If you’re using the ProTERM 5.25" disk, be sure to put the disk in the drive with the
label reading “Boot Side” facing up as you place it into the disk drive.
When any of the above procedures are used, ProTERM automatically executes a disk copy
application which can be used to create duplicates of your ProTERM disk for backup
purposes. The application is named FastCopy, it was developed by Apple Computer and
we’ve adopted it for use here to allow you to easily make working copies of your disks.
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If the ProTERM disk
does not boot, See
Appendix B,
Trouble
Shooting.

ProTERM
original disks are
write protected.

ProTERM Disks Are
Write Protected.

Using FastCopy
When the FastCopy title screen appears, a message at the bottom of the screen asks whether
it’s “OK” for FastCopy to erase the contents of your RAM disk. If you don’t understand that
question, its probably safe to assume it does not apply to you, so press the Y key to answer
Yes and press the RETURN Key . If you do understand the question then be aware answering
Yes destroys files you have stored on your RAM disk. If you don’t want to lose the information you have stored on your RAM disk, press N for No and then press the RETURN key.
FastCopy then uses only the unused portion of your Ram Disk. FastCopy works either way,
but depending on how much memory you have, using the RAM disk may copy a little faster.

Copying disks
COMMAND-? gets FastCopy Help files.
1. Press the RETURN key to select Copy Disks
• NEED HELP? — Use COMMAND-? — While using FastCopy, note the instructions
available at every prompt. In the lower-left corner of the screen FastCopy displays an
Open-Apple icon and a question mark. Press and hold the COMMAND key down while
pressing the question mark “?” key for additional instructions.
2. If asked, select the type of drive you want to use for the copy. Highlight the
required option by pressing the Left or the Right ARROW key, then press the
RETURN key.
• The selected number 3.5" or 5.25" indicates the type of disk you want to copy.
• If you select 3.5, the program ejects any 3.5" disks in the 3.5" disk drives connected to
your system as a safety precaution. Insert the disks you want to copy from (source) and
to (target). FastCopy checks to see if one or two 3.5" drives are on line and uses one or
both as found.
• The 5.25" disks drives are not “intelligent” drives and require a little more help from the
user. If you select 5.25, you are asked whether you have one or two 5.25" drives.
Highlight the required option by pressing the Left or Right ARROW and then pressing
the RETURN key. (Once you’ve answered this question, FastCopy remembers your
response and won’t ask again unless the program is quit and restarted.)
NOTE: A 3.5" disk is write protected when the slide tab is NOT covering the square opening
in the corner of the disk (see the label notation on the back of the disk next to the write
protect tab. ProTERM 5.25" original disks have NO notches in the corners. They are shipped
write protected so mistakes cannot happen. Warning – Notching the original ProTERM disks
or using the 3.5" disk unprotected voids the warranty.
3.

Making ProTERM
work disks.

Using the “ built-in ”
copy routine.

A message appears at the bottom of the screen asking you to insert your source disk
(the disk you want to copy).
• Insert the write protected ProTERM 3.5" disk in any of your 3.5 inch disk drives.
• With 5.25 inch disks, put the source disk in your startup drive and press the RETURN
key.
4.

If you are using two drives, a message at the bottom of the screen tells you to insert
your destination disk. Insert a blank disk, or a disk you don’t mind erasing, and
press the RETURN key.
5. If the disk is blank, you see a message asking whether you want to format the disk.
Press the Right ARROW to highlight Yes, then press the RETURN key. If the disk is a
used disk containing information, you are asked for permission to destroy that data.
directions from above. Place tape over the work disk’s notches so the disk is write protected,
make a copy of this configured disk, and mark it “Configured ProTERM Backup.”
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6.

If you are using one drive, swap the source disk for the destination disk when
prompted by messages on the screen.
• How it works: FastCopy reads as much information from the source disk as it can fit
into the memory of your computer. As it is reading information from the disk, a
message is shown to indicate the percentage read from the source disk. (If you have a
memory expansion card installed in your computer, the program is able to read more
information at one time than if you don’t.) After reading as much information as your
computer’s memory can handle, FastCopy writes the information to the destination
disk. As FastCopy is writing information to the destination disk, a message is shown
indicating what percentage of the information written to the destination disk. If you
have two drives of the same size, the reading and writing proceed without any
intervention on your part. If you have only one drive, depending on the amount of
memory in the computer, you may need to swap the source disk for the destination disk
several times.
7. When FastCopy finishes writing all information to the destination disk, a “Copy
complete” message is displayed. Press the RETURN key to go back to the FastCopy
menu.

Making a
“ flippy ” disk.

“Multiple Copies” Message and 5.25" Disks
There are two sides 5.25" disk, a Boot Side (front) and the Program Side (back). Each side
must be copied separately. When asked:
“Make another copy of this disk?” …answer No!

Do not follow the FastCopy directions on making “Multiple Copies” because that procedure
continues to make multiple copies of the of the disk just copied. You need to copy the back
side of the ProTERM 5.25" disk so choose “No” and FastCopy takes you back to its main
menu. When at the FastCopy main menu again, press the RETURN key to accept Copy Disks
and then choose 5.25" disk again. Depending on your computer’s memory capacity, you may
see the statement:
Last source disk still in memory. Use it?

Choose No and press the RETURN key to start the process of copying another disk. This time
turn the original ProTERM disk over and the work copy of the ProTERM disk over and copy
the Program (back) side of the disk.

Be sure to copy
BOTH sides of the
5.25" disk.

WARNING — Don’t
notch the Original
ProTERM disk!

Making a “ flippy ”
5.25 disk.

Copying to the backside of a disk
ProTERM 3 is a large and powerful telecom application and the 5.25" floppy disk storage
capacity is small by today’s standards. ProTERM is designed to store most of its program files
on one side of the disk leaving a little room for data storage on the other side. It is your
choice as to whether you put ProTERM’s second side on another disk or on the flip-side of
the same disk.
If you prefer to use both sides of a single disk for your ProTERM work disk, you must remove
the write protection from the backside of the disk. A double sided “Work-Disk” MUST be
notched on both sides or data cannot be saved to the backside. Devices are sold to assist you
in easily and perfectly notching disks but it can be done using available resources. For
example, lay a notched disk over the un-notched side to see where the notch is to be placed
and use a paper punch, scissors, razor blade what-have-you to notch the disk. It may not be
elegant, but it works.
Proceed through the rest of this chapter using the backup of your original ProTERM disk.
After completing this chapter, you have a configured ProTERM disk read to go to work for
you. Boot the original ProTERM disk to get into the Fast Copy program following the
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Like light bulbs,
disks eventually
fail — Make backup
copies of your work
disks from time to
time.

New user assist!

Because ProTERM handles dialing and logon automatically, you can very quickly become
dependent on the information ProTERM maintains for you. Data such as how you personalize and customize ProTERM plus phone numbers, passwords, system settings and especially
logon macros and personalized global macros become increasingly valuable with use. As you
continue to work with ProTERM, the value of this collection of phone numbers, AutoLogon
Macros and personal preferences become more valuable to you, because of the value of the
information being stored. Plus you tend to forget the details of the information because
ProTERM does all your work for you automatically. This information can become difficult if
not impossible to recreate. Therefore, a practice of periodic updates by making copies of the
working disk is cheap insurance and strongly encouraged. Be safe and backup your working
files often, someday it may prevent you from having to start over from scratch – dread the
thought!

A note to the newcomer
The physical size of a disk is not a demonstration of its storage size. The storage size of the
smaller 3.5" ProTERM disk is at least six and can be up to ten times larger than the physically
larger 5.25" disk. In addition, they are both referred to as “floppies” because even though the
smaller one seems very rigid, the actual disk media inside is flexible (“floppy”). “Hard disks”
are much larger devices with hard (ceramic type) disks (plates) inside. Another difference is
the 5.25" disk must be physically turned upside-down to write to the back side of the disk,
but the 3.5" disk is designed to write to both sides of the disk simultaneously.
One more thing and we’ll let it go. There are a lot of stories about why the backside of a
5.25" floppy disk should not be used, but the real truth is, the only difference between the
front side and the back side is, one side faces up and the other faces down – that is until you
turn them over then the reverse is true. Don’t be afraid to use the back side of your 5.25"
disks, they were manufactured to have the same quality on both sides. One side is guaranteed, but both sides are usually good. As a point of interest, When information is written to a
disk, it is written to the “back” or the side away from what is considered to be the relative top
or “front.” Be careful when laying a disk down that it does not contact any dust or other
foreign matter.If the disk can be formatted on both sides, use both sides. If it can’t try
another.

ProTERM on a 5.25" Floppy
DO NOT NOTCH THE
PROTERM MASTER
DISK.

Because ProTERM is a large application, there is not enough room on one side of a 5.25"
floppy disk for all of the different parts of the program. Because of this, ProTERM is designed
for use on two 5.25" disks, or on two sides of one disk called a “flippy.” The front of the
ProTERM disk is the “BOOT” side, the back is the “PROGRAM” side, and they are labeled as
such. While this arrangement requires a second disk to be inserted when ProTERM is run, it
allows for over 50K of free space on the PROGRAM disk while ProTERM is running. This
“free-space” is needed and used by ProTERM to store system phone numbers, and macros,
and to allow space for small personal files. When ProTERM is used from a 5.25 disk, make
sure the disk is not write-protected as it prevents ProTERM from operating correctly.

ProTERM 5.25" Disk Contents
5.25" Boot Side.

File Name

Filetype

File Description

/PT3
PRODOS
PT3.SYSTEM

DIR
SYS
SYS

(Disk name.)*
(ProDOS Disk Operating System.)
(Runs PT3 when disk boots.)

BOOT DISK:
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PT3.CODE0
PT3.CODE1
PT3.BACKUP

5.25"
Program Side.

SYS
BIN
BIN
SYS
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(PT3 Code, resident portion.)
(PT3 hardware drivers.)
(On both disk sides of the disk.)
(Makes Copy of original PT3 disk.)**

PROGRAM DISK:
/PT3
PT3.CODE1
PT3.CODE2
PT3.CODE3
PT3.CODE4
PT3.CONVERT

DIR
BIN
BIN
BIN
BIN
TXT

(Disk name.)*
(On both disk sides of the disk.)
(PT3 command overlays.)
(PT3 transfer overlays.)
(PT3 Terminal Emulations.)
(Converts old Macro &
Dial List Entries.)
PT3.DIAL
DIR
(Directory with System List entries.)
PT3.GLOBAL
TXT
(Contains defaultGlobal Macros.)
PT3.WELCOME
TXT
(Contains default “Welcome Message.”)
PT3.CLOCK
TXT
(Example of File Macro.)***
*
Both disks must have the same name.
**
PT3.BACKUP need not be on backup copies of the disk or hard drive, but
does not hurt if it is.
***
PT3.CLOCK need not be on the disk. After viewing it, PT3.CLOCK can be
deleted if disk space is needed.
Take care to conserve your /PT3 disk space when using 5.25" floppies. Don’t save any nonessential files to this disk, ProTERM needs the available space.

The modem must
be connected and
electrically
switched on at this
point.

ProTERM Startup from a 5.25" Floppy
To start ProTERM running from the 5.25" disk, insert the BOOT side of the copy of the
ProTERM disk into your booting 5.25" disk drive and turn on the computer. The software
starts up automatically. If the Program side is booted by mistake, no harm is done, but an
alert message “Unable to load ProDOS” is displayed. Insert the appropriate disk side and
reboot.

ProTERM on a
3.5" Floppy & Hard Drive

Don't write protect
your ProTERM
working disk.
Files needed on a
3.5" drive.

ProTERM 3.5" Disk Contents
File Name
/PT3
PRODOS
PT3.SYSTEM
PT3
PT3.CODE0
PT3.CODE1
PT3.CODE2
PT3.CODE3
PT3.CODE4

Filetype
DIR
SYS
SYS
SYS
BIN
BIN
BIN
BIN
BIN

File Description
(Disk name.)*
(ProDOS Disk Operating System.)
(Runs PT3 when disk boots.)
(PT3 Code, resident portion.)
(PT3 hardware drivers.)
(PT3 setup code.)
(PT3 command overlays.)
(PT3 transfer overlays.)
(PT3 Terminal Emulations.)

PART ONE — GETTING STARTED

60

C H A P T E R T H R E E
PT3.DIAL
PT3.CONVERT

DIR
TXT

(Directory with System List entries.)
(Converts old Macro &
Dialing List entries.)
PT3.GLOBAL
TXT
(The default Global Macro file.)
PT3.WELCOME
TXT
(Contains default “Welcome Message.”)
PT3.BACKUP
SYS
(Makes Copy of original PT3 disk.)**
PT3.CLOCK
TXT
(Example of File Macro.)***
*
Disk name can be any name you like.
**
PT3.BACKUP need not be on backup copies of the disk or hard drive, but
does not hurt if it is.
***
PT3.CLOCK need not be on the disk. After viewing it, PT3.CLOCK can be
deleted if disk space is needed.

Files Not Supported by InTrec
Due to the larger storage capacity of the 3.5" floppy, ProTERM uses only a fraction of the
available disk space. Since extra space is available, extra directories of utility applications are
included on the disk. These utility programs are not required for using ProTERM and are
provided only as a convenience. These files include a disk utility also found on theApple
System Disk and ShrinkIt, a file shrink/unshrink utility used by most Apple telecommunicators. Do not contact InTrec for support on these applications. InTrec Software, does not
support any of these utilities, as they are not published, sold or distributed by InTrec. They
are provided only because the disk space was available, and for your convenience. The files
are fairly self explanatory but some documentation is included which can be read and
printed with the ProTERM Editor. After making a backup copy of ProTERM, these directories,
and all the files in them can be deleted from the work disk to provide additional disk space.

ProTERM Startup from a 3.5" Floppy
To start ProTERM running from a 3.5" disk, insert the disk into your primary 3.5" disk drive,
and turn on your computer. ProTERM boots, starts the program and shows the Main Menu.

Don’t forget the
PT3.DIAL Directory.

ProTERM on a Hard Drive
To install ProTERM on your hard drive, create a directory and copy all of the files (except
ProDOS) from the 5.25" or 3.5" disk. The name of the directory you store the ProTERM files
in, is your choice. Note the PT3.DIAL directory is initially empty, but as you use it, all of the
names, phone numbers, parameters and macros for all the systems you call, are stored in this
directory as PTD.systemname files. The PT3.DIAL directory must be either copied with the
rest of the files from the ProTERM disk, or created in the ProTERM files directory as PT3.DIAL
on your hard disk. If this directory is missing or named differently than PT3.DIAL, ProTERM
cannot operate correctly. For example:

Error Message When Booting From Hard “Please insert the
PROGRAM disk (flip disk) and press RETURN.”
Failure to copy PT3.DIAL to the directory containing the PT3 files causes the above error
message. Either copy the directory named PT3.DIAL to the directory the PT3 files are in, or
create a new directory named PT3.DIAL in the directory containing the ProTERM files.
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Files Needed To Run ProTERM From a Hard Drive
Files needed on a
hard drive.

Getting started on
a hard drive.

File Name

Filetype

/PT3
PT3.SYSTEM
PT3
PT3.CODE0
PT3.CODE1
PT3.CODE2
PT3.CODE3
PT3.CODE4
PT3.CONVERT

DIR
SYS
SYS
BIN
BIN
BIN
BIN
BIN
TXT

/HARD.DRIVE/

File Description

(Directory name.)*
(Runs PT3 when disk boots.)
(PT3 Code, resident portion.)
(PT3 hardware drivers.)
(PT3 startup code.)
(PT3 command overlays.)
(PT3 transfer overlays.)
(PT3 Terminal Emulations.)
(Converts old Macro &
Dial List entries.)
PT3.DIAL
DIR
(Directory with System List entries.)
PT3.GLOBAL
TXT
(The default Global Macro file.)
PT3.WELCOME
TXT
(Contains default “Welcome Message.”)
PT3.CLOCK
TXT
(Example of Macro File.)***
*
This directory is made by you and the name chosen is not important to the
function of ProTERM.
***
PT3.CLOCK need not be on the disk. After viewing it, PT3.CLOCK can be
deleted if disk space is needed.

Starting ProTERM from a Hard Drive
To start ProTERM from your Hard Drive, boot your computer as you normally would:
• Running ProTERM from the GS/OS Finder:
Open the directory created for ProTERM and double click on “PT3” or “PT3.SYSTEM.”
• Running ProTERM from a file selector:
Set up file selector to run “PT3” or “PT3.SYSTEM.”
• Running ProTERM from BASIC.SYSTEM:
Set prefix to your ProTERM directory’s name and type
-PT3.SYSTEM (The hyphen “-” is the same as RUN command).
• Running from ProDOS 8 - 1.9 or later.
Use TAB, ESCAPE to navigate to the ProTERM directory, select “PT3” and press the
RETURN key.

PT3.SYSTEM
PT3.SYSTEM is a small module which runs PT3 (ProTERM). It is required for certain system
configurations but works in all configurations.

For more information on hardware
install problem
solving, see the
Index. Also see
Appendix B:
Troubleshooting,
and Appendix C;
Cables and Serial
Ports.

Other ProTERM Files
While using ProTERM, several support files are created.

PT3.BIOS
The first file created by ProTERM as it is started from a new working copy is namedPT3.BIOS
and this file contains the hardware configurations you set up and select, such as which
modem, printer, keyboard and clock definition, function or description files (called drivers)
are chosen during the Install configuration.
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With reference to hardware installation, deleting the file “PT3.BIOS” and starting ProTERM
over is the same as booting a new pristine copy of ProTERM. If ProTERM 3 update files such
as an updated or revised PT3.Code0 file containing new modem or printer drivers are
installed, PT3.BIOS must be deleted. ProTERM must then be rebooted, and it will act the
same as if it were a new program. This is very important if you are installing PT3.1 in an
existing PT3.0 directory, the old PT3.BIOS file must be deleted, or ProTERM will fail to
operate.

PT3.PREF
PT3.PREF is another file created as you use ProTERM and customize it for your personal use
.
When you make a change to ProTERM to personally suit your needs, and then open and save
the Preferences file in the Misc menu, ProTERM saves this change in the PT3.Pref file. The
next time you start ProTERM, this file is read and your preferred changes are in effect.
PT3.Pref contains both the default preferences and operating parameters changed by you.
For more detail, see the Index: Preferences.
Deleting PT3.PREF and restarting ProTERM sets ProTERM’s defaults to “factory” standards (as
if it was a new program).

PT3.DIAL Directory
Each time you create a system dialing entry, a file in the form of “PTD.s
ystemname” is
created in the “PT3.DIAL” directory. Be sure all of the files from the directory “PT3.DIAL” are
copied when making backup copies of your “Working Disk.” All files in the PT3.DIAL
directory should be prefixed with “PTD.”. Any other files are there by mistake.

Before Going Any Further
Make sure the
modem is switched
on electrically or it
can not be initialized.

Before you actually start using ProTERM, make sure your modem is really connected and
ready. When ProTERM starts up, it must be able to communicate with the modem and send
instructions to it so that it will be able to operate effectively. Consult your modem manual
for installation instructions. If you are using an external modem, make sure the modem is
plugged in, turned on electrically, if there are lights, are they on? External modems connect
to the computer via a cable with generally a “D” shaped connector on the modem end. This
“D” connector Base generally contains 25 pins and is called aDB25. for obvious reasons.
The other end of this cable should be plugged into a serial port on the back of the computer
(possibly with a telephone icon next to it) or to a connector connected to a serial card inside
of the computer.
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input from either
the keyboard or the
mouse, or both.
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Install Modem
Please select modem driver:

Pressing the first
letter of a modem’s
name finds all
modems named
with that letter.
When the down
ARROW is pressed,
the menus scroll
revealing more
selections.

Need help understanding ProTERM’s
interface?
See Chapter 2, The
ProTERM Interface.
“Hayes”
or “ AT”
compatibility.

Hayes Smartmodem 2400
Hayes Smartmodem V9600 (CTS/RTS)
N o Modem in System
N ovation Professional 2400
N ull Modem Driver
OKIDATA O kitel 9600
OKIDATA O kitel 9600 (CTS/RTS)
Save

Modem Selection
Window

Cancel

Install Modem Menu
The Install Modem menu displays several different modems for selection. Only seven choices
are visible within the window. Use the ARROW keys or mouse to scroll through the entire
list. When the cursor bar is moved to the bottom of the menu, the list scrolls showing more
selections. In addition, typing the first character of the modem name finds a modem
beginning with that character in the list. Example; typing S locates the cursor on the first
Supra selection. Pressing “S” again moves the selection to the second Supra selection and so
on. After selecting the name and model matching your modem, press the RETURN key, and
your selection is marked with a check-mark √].
[ Click the Save button or press the RETURN
key which invokes the Save button and accepts your choice. To return to modem selection,
press the TAB key.
If your modem is not listed, consult your modem manual for its compatibility with other
modems. Many modems are designed to be “Hayes or ‘AT’ compatible” a term meaning their
modem accepts or reacts to “AT” commands the same or similar to the way a Hayes brand
modem would. If you can’t find the exact name of your modem and it claims Hayes
compatibility, select the Hayes Smartmodem driver respective to the speed of your modem.

None of the Drivers Work?
If you cannot locate a driver in the list that will initialize your modem so that ProTERM can
work with it, you are left with selecting theNull Modem Driver. This has to be a last resort,
because when using the Null Modem Driver, all of the power and automation of ProTERM is
lost and all instructions to the modem, including dialing a phone number and hanging up
after the call, must be entered manually. The Null Modem setup is also referred to as the
dumb terminal or direct-connect mode.

No Modem In System
If you do not have a modem at this time but would like to see what ProTERM looks like, or
even use just the ProTERM word processor alone, select No Modem in System.

For modem driver
explanations, see
the Index: Modems;
drivers.

Installing the Modem Port
If you select an external modem (that is, the modem does not plug directly into a slot inside
of your computer), then ProTERM asks for information about yourModem Port. The modem
port is the serial device which connects the modem to the computer. Some computers have
modem (serial) ports built in while others require additional hardware such as a serial card
in a slot. Use the ARROW keys or mouse to choose the correct modem port, and press the
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RETURN key. The selection is marked with a check-mark [√] and the Save button is selected.
Press the RETURN key to press the Save button.
To return to Modem Port selection, press the TAB key. To return to Modem selection (the
previous menu), press either ESCAPE or choose the Cancel button, choose the Modem
button, and press the RETURN key.
ProTERM 3.1
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Modem Port Slot
Please enter the slot in which your
modem port is located.

Port Selection
Window

Port: Apple Super Serial Card
Slot: 2
Save

Cancel

Installing the Modem Port Slot
If you have an internal modem on a card that is plugged into a slot inside of your computer
or is an external modem, but is attached to a serial card plugged into one of the slots inside
of your computer, ProTERM asks for the slot number in which the modem/port is located.
The slots are numbered from one to seven (the modem/port normally slot two). Enter the
slot number of the modem/port and press the RETURN key. Pressing the RETURN key again
selects Save and accepts your choice. To return to modem port slot selection, press the TAB
key.
To return to modem selection (the first menu), either press ESCAPE or choose the Cancel
button and press the RETURN key.
ProTERM 3.1
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Modem Port Slot
Please enter the slot in which your
modem port is located.
Port: Apple Super Serial Card
Slot: 2
Save

Cancel

Port Slot Selection
Window

Installing the Printer Port
While ProTERM does not need to know what kind of printer you are using, it does need
information about the printer port which connects the printer to your computer.
• If you do not have a printer, select the “No Printer in System” entry.
• If your printer port or card is not listed, select the “Generic Printer Driver” entry.
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• If your printer does not work as expected, select Pascal 1.1.1 Printer Driver.
One of these selections normally give satisfactory results.
To install the printer port, use the ARROW keys to choose your selection and press the
RETURN key. This marks your selection with a check-mark [√ ] and chooses the Save button.
Pressing the RETURN key again invokes Save and accepts your choice.
To return to Printer port selection, press the TAB key. To return to the Install Hardware
menu (the first menu), press either ESCAPE or choose the Cancel button and press the
RETURN key.

Keyboard install
is optional.

Installing the Keyboard
Unlike modem and printer installation, keyboard installation is optional. The default entry,
Autoselect Keyboard at Runtime selects either the Apple II GS or Apple II family keyboard
driver depending on the type of computer you are using. If an Apple IIGS Extended Keyboard
is used, choosing the correct keyboard allows ProTERM take advantage of the keypad and
function keys.
From the Install Hardware window, choose the Keyboard button and press the RETURN
key. Use the ARROW keys or mouse to choose the correct keyboard and press the RETURN
key. This marks your selection with a check-mark √[ ] and chooses the Save button. Pressing
the RETURN key selects Save and accepts your choice.
To return to Keyboard selection, press the TAB key. To return to the Install Hardware
window, press either ESCAPE or choose the Cancel button and press the RETURN key.

Clock install
is optional.

Installing the Clock
The default entry, Autoselect Clock at Runtime selects either the Apple II GS clock driver or
the ProDOS compatible clock driver depending on the type of computer you are using. If a
clock other than the Apple II GS internal clock is in your system, we strongly recommended
you install the correct clock. While ProTERM can generally utilize various clocks by using the
Autoselect Clock at Runtime, unless the correct clock driver is selected, the display clock may
not show the seconds, and other problems related to timing, including the use of a highspeed modem are likely.
From the Install Hardware window, choose the Clock button and press the RETURN key. If
your clock is not listed, then select Autoselect Clock at Runtime. Use the ARROW keys to
choose your clock and press the RETURN key. This marks your selection with a check-mark
[√] and selects the Save button. Pressing the RETURN key invokes Save and accepts your
choice.
To return to clock selection, press the TAB key. To return to the Install Hardware window,
press either ESCAPE or choose the Cancel button and press the RETURN key.

For the experts — If
you do not understand this, ignore
it.

Changing the
Modem Initialization String
This option is only for the advanced user who needs the ability to send special “modem
commands” to their modem. When ProTERM first runs, it initializes the modem by sending
the displayed init (initialization) string to the modem. Modem commands for controlling
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Is all of the displayed information
correct?

modem-specific functions should be included in the existing string. Do not remove any
commands from the existing string or send any commands which change the way the modem
responds to commands (i.e., verbose mode).
ProTERM 3.1
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Install

Modem: N ovation Professional 2400
Port: Apple Super Serial Card
Slot: 2
Init: ATX3
Printer: Apple IIGS Printer Port
Slot: 1

Install Hardware
Summary Window

Init:
Keyboard: Autoselect Keyboard at Runtime
Clock: Autoselect Clock at Runtime
OK

Press the TAB key
to edit the Init
string.

Modem

Printer

Keyboard

Cancel

To change the Init string, press the TAB key. A cursor appears at the end of the Init string.
Use the ARROW keys to move, DELETE to delete characters to the left of the cursor (for more
on this, see the Index: Text Field Editing Commands), and type new information where you
want it inserted. When you are finished changing the init string, press the RETURN key to
accept the changes.
If you decide you want the original init string reinstalled, go through the modem selection
again and ProTERM will reinstall the init string.

Verifying the Installation Information
After installing all hardware, theInstall Hardware window is visible with a summary of your
installation choices. Make sure all of the displayed information is correct. If there are
problems with any of the hardware, use the ARROW keys to choose the appropriate button
(Modem, Printer, Keyboard or Clock) and press the RETURN key to return to that part of
install. When you are confident all of your choices are correct, choose theOK button and
press the RETURN key to start using ProTERM.
NOTE: When the computer ports is selected for the Apple II GS, a slot number is displayed
automatically. Because the computer port is known, ProTERM entered this information.

Using ProTERM
At this point,
the world of telecom is at your
fingertips!

When the installation procedure is complete, ProTERM goes through the startup procedure
and you are shown an introduction screen while ProTERM goes about its other preparations.
Several status windows announce ProTERM’s progress: Loading Drivers, Initializing Modem,
Loading Emulation Names and Building Dialing List. If you have a hard drive, these pass
quickly, whereas floppy disks are slower and take longer. After ProTERM completes its
startup sequence, the Main Menu is displayed and from this point, the world of telecommunications is literally at your fingertips!
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Install Complete
Shows the Main Menu
This completes the installation procedure, and it is saved to disk. You will not have to use
Install again, unless you change equipment.
You can now enter the Dial menu and call your first host system. For the details of how to
quickly and easily use ProTERM, see the Index:Interface. For more details on entering your
first host system to call, see the Index: Dialing. The next chapter is a tutorial which walks
you through using the ProTERM interface and setting up your first call to a host system.
ProTERM 3.1
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Main Menu
F
O
S
R

= File Commands
= O nline Parms
= Send File(s)
= Receive File(s)
Press

D
E
Z
Q

= Dial
= Editor
= Scrollback
= Q uit

Main Menu

to see MenuBar

In Case of Trouble
Modem Failure & Isolating the Problem

In case of trouble,
see Appendix B & C.

If the startup process stops during the Initializing Modem phase and a Modem Failure
window is displayed, the most common causes are listed below. If you can locate the
problem, correct it, choose the Retry button and press the RETURN key. When the problem
is corrected, ProTERM continues on to the Main Menu. Otherwise, the modem failure
window is displayed again. If you are unable to determine the cause of a problem check
these steps:
• The modem is not turned on electrically. Check to make sure electrical power is
available to the modem. If the modem is external, is it turned on? Do any lights show? If
the modem is internal, this is not an issue.
• The modem is not connected to the computer, or is plugged into the wrong port.
Recheck the connections and carefully follow the cables from end to end.
• An incorrectly wired cable, a printer cable for example, is used between the modem and
the computer’s serial port. This is a common problem. See the Index: Troubleshooting.

• An incorrect modem and/or serial port was chosen during Install. SelectInstall and try
again.
1 The Install Hardware window opens and you can verify your modem and port selection
are both correct.
2 If they are not, make the appropriate corrections and then choose the OK button to
return to ProTERM.
3 If this all seems correct see Appendix B: Trouble Shooting and Appendix C: Cables.
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How to boot directly into Install.

If you call the
InTrec Technical
Support, be at your
computer and have
it booted.
Complete details
on calling for Tech
Support are available in Appendix A:
Warranty and
Service.

Program Lockup
It is possible the software may just “lockup” during the startup process. This happens if an
invalid hardware configuration is chosen. ProTERM is following instructions to align itself
with chosen hardware and the hardware specified is not available to act as expected. This can
only be corrected from the Install Hardware window. To return to the Install Hardware
menu, restart ProTERM and holding down COMMAND key as ProTERM begins to boot. As an
alternative, the file “PT3.BIOS” can be deleted before restarting ProTERM.

It Still Doesn’t Work
If you are still unable to get ProTERM to run after checking the modem connections and the
installation parameters, consult Appendix B: Troubleshooting. Appendix B contains answers
to common installation problems. If you’re still unable to find a solution, call the InTrec for
Technical Support Department.

Save Time for Yourself and Tech Support
You can save time for both you and our support staff. Have your computer booted and
ready. This will save your having to pay phone charges while you go through this process.
We can generally determine the problem easily if you are at your computer, but if you are
not, it ads to the difficulty of resolving the problem.
1 Have this manual, information about your hardware and a copy of your modem manual
available.
2 Be at your computer with ProTERM booted up as far as it can proceed. This saves
valuable phone time for you and out Technical Support Dept.
3 Keep the modem turned on and everything up and as ready as it can be under the
circumstances. Using the phone with the modem connected to the line does not cause
any problems. The problems can be usually resolved without having to actually use the
modem to access the phone line, but it must be turned on.

Miscellaneous Notes

Leave Your Modem On
Many users are concerned about leaving their modem on when it is not in use. Generally
speaking, this concern is not justified. Most modems fit the following criteria:
• Low power use.
• Does not answer the phone unless specifically set up and instructed to do so by the
software.
• No parts which wear out when left on.
• Being turned on and connected to a phone line does not impair the phone line or its
quality.
The only time ProTERM instructs your modem to answer the phone is when you purposely
use the Answer Phone or the Unattended Access mode commands. Normally when you
receive a phone call, ProTERM may display the word “RING” on the screen. This is a
verification that ProTERM sensed the phone is ringing, but no other action is taken. If you
control your computer through a power-strip, we suggest you plug your modem into the
power-strip and turn the modem on any time you are using your computer. The benefits for
leaving the modem on outweigh any reasons for turning it off.

PART ONE — GETTING STARTED

INSTALLATION

69

Changing from ProTERM 3.0 to 3.1
When Create System (in the Dial list) is used to create a new host System entry, in ProTERM
3.0 or 3.1, a new file beginning with the prefix “PTD.” is created. The name you enter asSave
System As: [systemname] is appended to a “PTD.” prefix and the file is then named
“PTD.systemname.” This file is stored in the “PT3.DIAL” directory. System Macro, phone
number and other “personalized” information for each System you call is kept in these
PTD.systemname files and they are updated whenever you make changes to any of these
host system’s settings. To have your old PTD. files available for your new ProTERM 3.1 files
to use, it is simply a matter of making sure your old PT3.DIAL directory and the new PT3.1
files are placed together in the same volume or directory. When ProTERM is restarted, your
personalized dial list with all of your System numbers, macros and other information relative
to the systems you call, is complete and functional in ProTERM 3.1. (see the Index:Directory
for more information on directories and pathnames. Also seePT3.DIAL and PTD files)
The ProTERM 3.1 files from the new PT3.1 disks can be copied into the same directory where
the ProTERM 3.0 files existed, but do NOT copy the new PT3.DIAL (empty) directory over
the old one containing your personalized PTD.systemname files. For more information on
PTD.systemname files see the Index: PT3.DIAL; explained.

If You Work From Floppies
If you use ProTERM on 5.25" or 3.25" floppies, you may experience some difficulty getting
the PT3.DIAL directory or its files copied from your “old” PT3 work disk to the floppy
containing the new ProTERM 3.1 files. The reason there may be a problem is, your “old”
work disk and the “new” work disk (copy of the new ProTERM 3.1 master) may both be
named /PT3, and the ProDOS operating system is not capable of copying files between two
disks having the same name. There are several ways to handle this, but the easiest method
may be to use another disk with a different name as a kind of temporary or “intermediary”
disk. Copy the directory named PT3.DIAL and the files it contains, to this intermediary disk,
and then copy the PT3.DIAL directory and its files from the intermediary disk to your “PT3
work disk” containing your new ProTERM 3.1 files. Here is an example of how this process
could be used:
• Format a disk and name it/DATA for use as the intermediate disk. Note that ProTERM
3.0 can be used for this if you do not have any other file or disk utilities: Press
COMMAND-F at the Main ProTERM menu to see the File Utility and Copy menu
selections. For help on this, see the Index: Format Disk and Copy.
• Copy the directory PT3.DIAL and all of its files from your “old” /PT3 work disk to the
intermediary floppy named
/DATA.
• Copy the directory PT3.DIAL and all of its files from the intermediary volume named /
DATA to the new /PT3 work disk, and ProTERM should be ready to go to work for you.

Using An Existing Volume or Directory
When installing ProTERM 3.1 into an existing ProTERM directory, the (old) file “PT3.BIOS”
must be deleted before trying to run the new ProTERM 3.1. A new PT3.BIOS file is created
during the Install procedures of ProTERM 3.1.

PT3.GLOBAL
If you have customized (made changes to) your present PT3.GLOBAL file, you may not want
to replace it, and that is okay. The PT3.GLOBAL files that work with PT3.0 work without
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problem when installed with PT3.1. If you have not customized the PT3.GLOBAL file for
PT3.0, we suggest replacing the old one with the one from the new ProTERM 3.1 disk. We
also suggest you look over some of the changes in the PT3.GLOBAL file on the new PT3.1
disk. Open the file PT3.GLOBAL in the ProTERM Editor and read through the new comments. Global Macros are powerful tools, and reading through this file can give you ideas on
how they can go to work for you.

File Macros
If you have created File Macros for PT3.0, these should work without problem in PT3.1. If
you have problems or questions concerning Macros, we invite you to call the InTrec BBS and
ask for Special PT3 access.

PT3.CACHE
ProTERM 3.1 loads the System Dial List much faster than ProTERM 3.0 and the file
PT3.CACHE is no longer used or needed.

The Conversion of –
Dialing Numbers & System Macros
From PROTERM 2.x To PROTERM 3
ProTERM 3 uses a completely different method for system dialing and macros, and the
following should help you in getting your older ProTERM macros converted and updated.

About PT3.CONVERT
This little application assists you in converting your phone numbers and macros from prior
ProTERM versions, to work with ProTERM 3. Running PT3.CONVERT from a macro is also a
demonstration of the ability and power available in the macro language designed in
ProTERM.
To convert phone numbers and System Macros from ProTERM 2.x versions:
• Install ProTERM 3 and your hardware, as described earlier in this chapter.
• Press OPTION-M ( +M). This invokes a macro from PT3.GLOBAL macros which in
turn runs a file on your ProTERM 3 disk named PT3.CONVERT.
• Read the directions carefully as they are provided at the prompts, they are quite easy to
follow. If there is enough room on the disk; before starting the conversion process, the
older files can be copied to the new disk or directory if that will make finding and
converting easier. Make the older ProTERM and current ProTERM 3 files available by
entering the pathname older PT.DIAL file. If your files are on a 5.25" floppy, there may
not be enough room on the disk. If you only have one drive, and the ProTERM 3 disk
and the older ProTERM 2.x disk must be swapped after each dial number is converted.
If the ProTERM 2.x PT.MACRO file is in the same directory the ProTERM 2.x PT.DIAL resides,
System Macro files are automatically converted as the dial numbers are being converted.

See the Index:
Suggested Further
Reading .

When the conversion is complete, restart ProTERM 3. Choose Dial from the Menu, and the
converted numbers should be ready to choose and dial.

PART ONE — GETTING STARTED

A PROTERM TUTORIAL

71

A ProTERM Tutorial
CHAPTER FOUR
Getting Started
A Service, System,
or System Entry,
references the host
services you will be
calling.

This chapter is an overview of how to create, and customize, a system dial file, and then call a
system (host computer) using your computer, a modem using your phone line. ProTERM is
the software package that puts it together for you and makes it all possible. This chapter is
very general. See the Table of Contents and the Index for details on specific features and
functions.
The most common ProTERM function is to dial and connect with a remote system, and we’ll
start with a hands-on tutorial describing how to:
• Create a System Dialing file.
• Dial and connect with the new host system.
• Use proper etiquette when terminating a call.
• Review the session in scrollback.
• Practice sending and receiving files.
• Call an online service and putting it all together.
This tutorial covers the steps of how to call The InTrec BBS. Calling the InTrec BBS may be a
long distance call for you, but since no two host systems are the same, the attempt here is to
show a generic representation of some popular telecom services. We can tell you what to
expect on the InTrec BBS, but other services are not so predictable. You may prefer to follow
the steps as you call another system and substite changes to fit your needs.
Each System entry you create will contain the name, phone number, baud rate (the relative
speed of the modem) and other important information matching the characteristics of the
host system. This set of characteristics, or “system specific information,” is referred to as
parameters, or just “parms.” ProTERM will take care most of what you need with hardly any
changes, but it will need your help on a few obvious ones like the service’s name and phone
number.
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Parms &
parameters,
what are they?

A System is created by entering the Dial list (Press either the “D” key, or the RETURN key)
and choose Create System. If you have difficulty with this part, see Chapter Two:The
ProTERM User Interface, and Chapter Three: Installation. They will help you get ProTERM
up and working, introduce you to the ProTERM interface, and make the learning process
easy and enjoyable.

See Chapter 2 for
explanations of the
ProTERM interface.

Set up is easy. Most Systems can be set up and called with a minimum of effort by entering
the following:
• Name of the host service.
• Phone number of host system.
• Set the modem speed (usually optional).
• Enter an abbreviated name that ProTERM can use toSave the System As: so ProTERM
cam store the new service’s name and information on disk.
That’s it, you’re ready to make your first call. In most cases it’s that easy because ProTERM
understands how to do the rest. If specialized situations exist, ProTERM will allow you to
deal with each as needed.

User Groups and Local Assistance
You will find references throughout this manual suggest user groups as an information
resource. Learn the value of these groups of knowledgeable computer users. They are an
excellent resource for bulletin board phone numbers, general information and many even
offer telecommunications assistance. Some user groups also have Special Interest Groups
(SIGs) for ProTERM or telecommunications in general. See the Index: user groups.

Making Your First Call
ProTERM’s Main Menu should be displayed on your monitor. If its not, see the Index:
Installing ProTERM, and follow the information on starting up the software.

Press “ D ” or press
the RETURN key to
open the
Dial Menu.
System names
cannot begin with a
SPACE character.

Entering a System
From the Main Menu, press D (for Dial) to pull the Dial menu down. Press “C” or use the
ARROW keys to choose (highlight) Create System and press the RETURN key. A window titled
Enter a System will appear, and prompt for information about your new host System entry.

System Name
Each System or service as they’re usually called, must have an identifying name. The name
you enter as System Name: will be the name that appears in the Dial Menu or list, and is used
to select that System when you call. A System name can have up to 32 characters containing
upper or lowercase alpha characters, numbers, punctuation and symbols. The only
restriction is, System names may not begin with a space. EnterInTrec BBS, or the name of
the system you will be calling, and press the RETURN key. This name is cosmetic and is not
directly used for anything but choosing from your Dial list.
Numbers and other keyboard characters can be used to start a name in the System Dialing
List. See the Index: Dial List; customizing.
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System Number
Each System must have a phone number. Press the TAB key to highlight (choose) the System
Number, and to call the InTrec BBS as a long distance number, enter:
“1-602-992-9789”
…and press the RETURN key (long distance numbers require 1-(area code) just as you
would dial the number with a voice phone.
NOTE: When calling long distance, normal calling charges will be in effect while you are
connected to a long distance called number.
NOTE: Some specialized Systems, such as a direct connect system used on campus where a
modem is not being used, may not require a “conventional phone number” to make the
connection. Leaving the phone number field blank and ProTERM will make the direct
connect for you.
If your phone system does not support Touchtone ® dialing, insert a “P” as the first character
of the phone number.
Example: P1-602-992-9789
This will instruct ProTERM to use pulse (rotary) dialing instead of defaulting to Touchtone
dialing. For more detail on customizing dialing, see the Index:Meta characters.

See the Index:
Editing Text Field
and Editing Commands for entering
and changing text
in a window.

ProTERM 3.1
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Connect Time: 45

Save System As: INTREC
Save

Set the baud
rate high.

9.50 sbk

Cancel

Enter a System
Window

Baud Rate

Press the TAB key to choose (highlight) “Baud Rate” and use the ARROW keys to select the
highest baud rate supported by the remote system. In the case of The InTrec BBS, set the
baud rate to 19,200 and press the RETURN key. Always set the baud rate to the highest
supported by the remote system even if your modem does not support that rate. When
ProTERM dials the system, it will automatically determine the highest baud rate supported by
both modems.

Connect Time
Press the TAB key until Connect Time is chosen. This controls the amount of time the local
modem will wait for a connection when calling the remote system. Normally the default
connect time of 45 seconds is adequate for calling most systems. If you call a system and it
answers, but is not able to connect before the modem times out and hangs up, increase the
Connect Time by using the DELETE key and typing new numbers. See the Index: Editing
Text Fields for quick easy tips on making changes. Increase this number by five or ten
seconds and try again.
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The mouse and or
the keyboard can
be used for selection.

Save System As

Press the TAB key to choose the text input window named Save System As:. The name you
place here will be the name this System information will be saved to disk as, and you
probably never have to do anything with this entry after its entered and saved. Just so you
know where the filename is stored PT3.DIAL directory. All of host System entries are stored
in this directory. Eleven characters will fit in theSave System As: window. This name must be
a valid ProDOS name: it must start with an alpha character, spaces cannot be used, and only
periods can be used for separators or punctuation (see the Index: ProDOS for more details
on ProDOS filenames). Each System’s entry carries all of the system characteristics (attributes
and parameters) needed to call that system, and this information is stored in that System’s
file. Entering a duplicate name causes an alert message to be displayed, and the name can be
revised.
For this example, enter “INTREC” for a Save System As: name and press the RETURN key and
ProTERM will save this System information as a file named “PTD.INTREC” in the PT3.DIAL
directory.

See Chapter Two:
The ProTERM Interface for help on
how to change
settings.
Parms &
parameters
defined.

Saving the System Entry
To correct any information in any of the fields, press the TAB key or use a mouse to point
and position the cursor at the proper text input window and correct the information as
needed. Pressing and holding the COMMAND key while pressing the TAB key moves the
cursor in a reverse, counter-clockwise reverse direction. For details, see Chapter Two —The
ProTERM Interface. When the basic System parameters have been entered, choose the Save
button and press the RETURN key to save the new System entry to disk.
NOTE: Parameter Defined A bit of information whose value characterises a member of a
system or family. Uses here to establish and define perimeter limitations and or boundries.
Sometimes used in a shortened version of “parms.”

Editing the System Parms Window
Press TAB to enter
and move forward
& down in the
System Parms
window.
Press
COM MAND+TAB to
move in the reverse
direction.

After the basic information has been entered for the host system, and the RETURN key is
pressed, a large window namedEdit System Parms (parameters) is displayed. This window
contains information fields that allow you to change information to match the characteristics
needed for that service. The System Name, Number, Baud Rate and Connect Time are filled
in with the values entered when the service was created, and while several other fields are
available to further match the service’s needs, these other settings are generally correct just
as they are preset. For example, the information you’ve already entered to call the InTrec
BBS is all you need, and with a press the RETURN key, ProTERM will dial and connect.

System Name
See System Name above.

System Number
See System Number above.
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9600 baud O ffline 01-FEB-96 18:23:23

System Parameters

To edit fields, press
TAB to enter the
window.

System Name:

The InTrec BBS

System N umber: 1-602-992-9789
Baud Rate: 9600

Data Format: 8 N 1

Break Time: 50 /100

Emulate: ProTERM Special
Delete Key: Emulate
Connect Time:
Dial

Duplex: Full

Flow Off: ^S Flow O n: ^ Q
Answerback:

Backspace: Emulate

√

Status Bar?

System Parameters
Window

45

Redial

Save

Macros

Parms

Cancel

Baud Rate
See Baud Rate above.

Data Format
Normally left unchanged. See Index for more information.

Duplex
Normally left unchanged. See Index for more information.

Break Time
Normally left unchanged. See Index for more information.

Flow Off & Flow On
Normally left unchanged. See Index for more information.

The ProTERM Emulation Feature
If you call a service using what will be referred to as “Emulation” or “Terminal Emulation”
such as VT-100, you will need to choose the needed emulation from this field. Some systems
are capable of showing special graphical interfaces on specialized equipment especially
designed for that purpose. Your Apple computer can call their special terminals, and
ProTERM will convert what is being sent and make your computer system pretend to be, or
emulate, the special system you are calling.
Click on, or Press TAB to move the cursor to Emulate: then press the ARROW keys to choose
the desired emulation.
Certain businesses such as real estate and the airlines allow their employees to call into
special data bases to obtain proprietary information concerning their work, schedules,
listings and other related information. Local public libraries allow searching of their card
catalogs using your personal computer. These systems usually use an emulation called DEC
VT-100 which allows you to see graphical information on the screen which would not be
otherwise visible or viewable. Emulations are covered in depth in other parts of this manual;
see the Index: Emulations and Scrollback; capture.
TIP: When using Apple IIe, IIc and Laser 128 computers to navigate VT-100 screens, the
OPTION key must be pressed when using the Arrow keys .
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ProTERM Special Emulation
If emulations are
not needed for
your call, skip
down to “The First
Call.”

Using Emulations
Emulation controls how ProTERM displays incoming data. Some systems send out special
codes instructing the software to clear the screen or reposition the cursor, draw special
graphics or make sounds. See the Index: Emulation.
To enable an Emulation, choose Emulate in the Edit System Parms window and use the
ARROW keys to choose the required emulation.
Using an emulation is a choice on your part. Enabling an emulation will not show any
immediate visible change, you will only see the results when connected to a system which
controls the emulation. The emulation turns on automatically and is immediately obvious. If
there is no emulation during the call, no changes will take affect.

Use the Online
Menu for temporary settings.

Changing Emulation During the Call
If you are online with a system and decide to you want one of the emulations turned on,
press COMMAND-L, choose Emulate and change the Emulate parameters to the emulation
of your choice while online. Settings made to the Online menu are only in effect during that
call. If settings are found that work as desired, be sure to note the setting used and make
those changes to the System Parms window for that service.
If you’re not sure emulation is offered or needed on the system being called, leave the
emulation set at “No Emulation.” Emulation is sensitive to line noise and can cause strange
effects including sounds and random characters. If you experience problems during the call
and an emulation is chosen, try choosing No Emulation (see paragraph above) to see if it
helps. Also see the Index: Emulations. With regard to line noise, and ProTERM Special, if you
call a system featuring ProTERM Special Emulation but it seems to break up, give strange
noises or other problems, this is probably caused by line noise. Try calling back, sometimes a
second or third call will solve the problem. Also try calling at a lower baud rate. Lower baud
rates are more stable and may give you a slight advantage.

Emulations and the Menu/Status Bar?
If you call a system needing certain emulations such as VT-100 emulation, use the TAB key to
move the cursor to the Status Bar checkbox [√] in the Edit System Parms window and press
the SPACEBAR. This removes the checkmark which tells ProTERM to remove the Status Bar
from the top of your screen as soon as the emulation is detected during the call. Removing
the status bard allows the emulation to use all 24 of the of the lines of the Apple screen. The
Status bar uses or hides one line at the top of the screen, and any information being
presented on the top is hidden. For example, some emulation systems show their prompt on
the top line, and when the ProTERM Menu/Status bar is showing, the prompt would not be
visible. Any time the Status Bar is not visible and ProTERM Menu is needed, press the
COMMAND key ProTERM menu bar. For more information see the Index: Status Bar.

ProTERM Special
emulation.

Some local BBSystems have ProTERM Special Emulations areas demonstrating emulations
graphics and sound shows. To see an example of ProTERM Special Emulations at work see
The InTrec BBS special message board named “The ProTERM Special Showcase.”

Answerback:
See the Index: Answerback.
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Delete Key:
See the Index: Delete; key

Backspace:
See the Index: Backspace.

Status Bar?
See the Index: Status Bar and its subcategories.

Connect Time:
See the Index: Connect; Time.

Dialing a system
also saves edited
changes made to
the system.

Save Changes and Call, or Just Save Changes
Choose SAVE or DIAL. To call now, choose DIAL. Pressing the Dial saves the changes and
dials the system to make the call. If you want to call at a later time, choose
Save and press the
RETURN key and the changes will be saved to disk without dialing.

The First Call

Dialing the New System
After creating and customizing a system, dialing it is easy. From the Main Menu, press the D
key on the keyboard to pull the Dial menu down. Choose the service you wish to call, and
note that the Dial button is selected. A press of the RETURN key dials the service. ProTERM
dials and attempts to establish a connection. If a connection cannot be made (most
commonly because the system is busy), an Unable to Connect window is be displayed. If the
called system does not answer, ProTERM will continue the call, ringing the host until the
time set in the Connect Time field has counted down to zero. Pressing the Dial button again
will redial the system. Pressing the Redial button will cause ProTERM continue to redial the
system until it either makes a connection, or you presss the Cancel button, or pres the
ESCAPE key, which cancels the call.

Navigating the Called System
When the call connects with the remote system, the screen clears except for the top Status
Bar (which now displays “Online”) as ProTERM enters the “Terminal Mode.” At this point,
you are a guest of the host system and can apply for a password, logon, or conduct “Business
as usual.” Valid (host system) commands (for that system) now control the system you are
connected with. Each system is different and commands vary from system to system.

Your email address.

Your System Address
Some systems, such as public library card catalog systems, are usually available with a local
call. They are quite generic and easy to use. Some allow users to call and log in without ever
giving your personal identification, you get your information and terminate the call, but this
is not how all systems work. Normally, the first call to a system is usually different than any
subsequent calls to that system, because during the first call you will be asked for your name
and other information requested by the system’s administrator. After entering this information you should be given an address or number (this will be your system “address”) and a
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you also receive a password which is your “security key” for that service. On some systems,
your pass number or address, is your name, or an abbreviated form of your name. Usually
your access number is your public email address for that system. You can make the “address”
public and when you receive messages on that system, they will be sent to, and received by
your system address. Private electronic notes (email) can also be sent to you, and you can
reply and send email.

Passwords
Passwords are different than your address. A Password is your “private passkey” to that
system. You are usually allowed to change your password, and it is good advice to do that
from time to time.

Access Levels
Some systems want to know who is requesting access, and new callers have restricted or
limited access during the first call, or even subsequent calls, until the new account is
considered by the system administrator. When your account request is processed, your
access level can be changed to allow you to use areas of interest on that system. Access levels
are like “gateways” and allow certain users to different access different areas such as
downloading files, enter game areas, discreet discussions, etc. After your first call and while
you are waiting for access, be patient. System administrators have a life too. While they are
not hovering over the keyboard waiting to process your new account, it is reasonable to
expect them to normally check in within a 24 hour period.

STOP! and GO!

Slow it Down!
While online with the remote system, there may be times when incoming data is displayed
faster than it can be read. Press COMMAND-SPACEBAR to pause the system. The status bar
will display “Paused” and ProTERM will wait until you press another key before more data is
displayed.
If something scrolls off the screen faster than you can read it, press the COMMAND key and
use the Arrow keys to navigate back through the text. For more details on this great ProTERM
power-tool feature, see the notes later in this chapter and the Index: Scrollback

Entering a question
mark “?” will get
help files.

Getting Help

Once you get past the logon (prompted introduction) screens, you can request help. Usually
the host system will have help menus available, and these menus can be called with
conventional commands such as “?” or “Help” followed with a press of the RETURN key at
the prompt line. Look for something like “(?=HELP)” which literally says, pressing the
QUESTION MARK key equals HELP (also press the RETURN key to send the command to the
host).
During this first call, your access will usually be restricted, and you will need to wait for
validation to really be able to do much. You are there, so poke around, you can’t break
anything, and the experience will be good for you.
Think of a host system as a public library building, and follow an analogy of this comparison:
Library
• You enter the front door of the library.
BBSystem
• You enter the host system through the logon procedure.
Library

• You are looking for the general area where the books on telecommunications are kept – you ask at the information desk.
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• You want to know where file transfer utility files are kept – you request
a menu by entering a question mark character (?) at the prompt and
press the RETURN key.

Library

• The information desk person says, “Those books are downstairs: Just
follow the arrows to row one.”
• The menu shows if you enter an “L1” you will be taken to the Utility
files “Library” area.
• You decide to take a book home. You find the number of the book, you
locate the book and take it to the front desk where you follow a
protocol (library’s rules) of removing the book from the library.
• You want a file which is on the host system. You locate the file, instruct
the system to prepare to send it to you using a particular protocol and
tell your computer to follow the same protocol to transfer the file from
the host library to your storage disk.

BBSystem

What is a
protocol?
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Library
BBSystem

Let’s carry this a little further.
Like the library analogy, host systems are comprised of different levels or areas, like a main
floor, a “downstairs area” and even some “upstairs floors.” They generally start off with a
main level as noted above. Consider it as the reading area where the periodicals (general or
timely message boards) and public notice, or message (cork) bulletin boards are.
These “comparative terms” can “develop a mind’s eye picture” of these electronic “libraries”
so consider that host systems a file transfer area which we will state in terms of as being
“downstairs,” but you can also access message areas referred to as “message boards or
branches.” These could be compared to the cork bulletin boards where various messages are
tacked up (posted). For the sake of completing our “mental map,” these message boards are
on the “main floor and adjacent to the information desk.” These boards are generally
grouped, and individual boards carry message themes referred to as “threads.” There may be
a few or several of these message boards, each concerned with different subjects, general
chatter, for sale, tech-talk, social exchange, games and any other imaginable area of interest.
The large online systems have hundreds of interest areas. Menus will generally be available at
each general level, and these menus have the commands for the needs of that level. Use the
menu commands to improve your mental picture and then try the commands to move
around and investigate the different areas within your access level. Each message board may
have several hundred messages, and they are generally arranged numbered and or
sequentially dated files. Host systems usually track your history and keep records on what
you have read. This works to your advantage because you have read the current usually latest
date and/or highest numbered messages. When you call back at a later date, you request the
NEW messages and the messages posted (placed) since the last time you called, scroll into
view.
When you read a message of interest, you can answer or reply or enter your own comments
or questions. (That is how the messages get there in the first place.) New messages are what
makes a host system interesting, and the real fun will start when you get involved.

The Large Online Services
Larger systems such as CompuServe, Delphi or Genie work much the same as the smaller
BBSystems but with much more depth. They are so big, you can access files such as an online
encyclopedia, the stock market, travel, shopping areas and countless large interest specific
forums. These large systems offer extraordinary resources with very little effort, and all of this
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with a local call. Another benefit of the larger services is the ability to join into online
conferences “talking live” to several people at once (see the Index: Split Screen Chat
Emulation). The large services are far reaching — literally! People from all over the world
frequent the larger systems. Messages from wide ranging sources is expected and commonplace. For more information see the Index: Online; services; major.

Say “Good-bye”
with etiquette.

No way out?

Disconnecting
Since you are a guest when calling a host system, it is considered good telecom etiquette to
say good-bye and inform the system you are finished before disconnecting. Common sense
rules of protocol prevail. You would not hang up the phone in mid-conversation with a
friend, and when you finish a call to a host system, it would be considered rude to just shut
down or hang up without warning. Be polite, announce your intentions. From the system
help screen or menu, determine the command to disconnect, enter the command and press
RETURN to take action. Commands to leave a system gracefully are often in the following
forms: TERMINATE, TERM or T, GOODBY, G or BYE, LOGOFF or OFF, HANGUP, H or
HANG Q or Quit, X or Exit, among others (not usually case sensitive – BYE and bye are the
same). In the case of The InTrec BBS, the command is “T” (terminate connection). Once the
remote system disconnects, ProTERM returns the ProTERM Main Menu screen and the status
bar displays “Off line.”

Immediate Disconnect
If you are unable to determine the disconnect command, choose “Hangup” from the Online
menu (COMMAND-H) which promptly disconnects you from the system. This method of
terminating a call is abrupt and can be thought of as “pulling the plug” or “slamming the
door on the way out.” But if the service does not make any obvious way out, you should feel
justified in doing what you have to do.

Saving Preferences
As you use ProTERM and change the way it works for you, the changes can be saved so
ProTERM will always maintain those customized changes. ProTERM has hundreds of
preferential changes that can be saved to fit individual needs. As you change ProTERM to fit
your needs, it will become as comfortable as an old glove. Whenever you want ProTERM to
“remember” to use your new and changed preferences, choose the Preferences from the Misc
menu and choose Save in the Preferences window. For more information, see the Index:
Defaults.

Using Scrollback
Navigating through
Scrollback.

While logged onto a host system, information is constantly displayed on the screen. As more
information is received, ProTERM saves this information into a memory (RAM) based
scrollback file as it scrolls up and off of the screen. Imagine this action as a special kind of
“text reader” that reads the text as it scrolls past the top of the screen and disappears out of
sight.
Some of the information you’ll see online is important and some is not, and it can be difficult
to tell what you may want without reading it all, but that takes time. Perhaps text that scrolls
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out of view shows a command, or important instructions. To find what you’re after it takes
additional time to request the host system to re-display the information uses time. Your time,
the online charges or long distance calling fees can be expensive. Fortunately scrollback is
one of ProTERM’s great features and it offers the optimum way to retrieve and browse this
information online and immediately, or later at your leisure, saving you the frustration, and
even time and money.
To see a sample of scrollback, even before you’ve made a call, just press the Up ARROW key
several times and you will see an intro screen. The Scrollback menus are also visible. Use the
COMMAND key F, E and U keys to pull down and the File, Edit and Utility menus.
Scrollback is a feature dedicated to “remembering” all the information that scrolls off the top
of the computer screen. Choose About ProTERM from the Apple menu, (click on the Apple in
the upper left corner of the screen, or press the COMMAND - ~ keys (COMMAND plus the
TILDE key) and then press the RETURN key: ProTERM will display: “Scrollback Buffer: xxxK”
in size (press any key to return to the Main Menu). This number shows the Scrollback
capacity of your computer to store Scrollback text. Think of this as, ProTERM will remember
the last xxx thousand characters which scrolled off the screen and out of view. This means
you need not be concerned when data scrolls off the screen, since the data is being stored so
it can be viewed later. The number Sbk xxx on in the middle of the Status Bar on the top of
the screen shows how much is in Scrollback at any given time. See the Index:Scrollback.

Scrollback is only
temporary.

Scrollback is not stored on disk, it exists only in the electronic RAM (temporary memory) of
your computer. Quitting ProTERM or turning your computer off causes the contents of
Scrollback to disappear forever. While ProTERM is running, the information is there, waiting
to be called back to the screen.
Text which has scrolled off the top of the screen accumulates in Scrollback memory until the
available memory fills up. Once memory is full, new lines “push” the “oldest” lines out of
Scrollback. Once data has been “pushed out,” it cannot be recalled. The amount of
Scrollback that can be saved in memory is determined by the memory hardware configuration of the computer. For more detail see the Index: Scrollback; size.
To choose Scrollback when you are online and connected to a system host, press COMMAND-Z or COMMAND-ARROW. To enter Scrollback when off line, just press any ARROW key.
When you first enter Scrollback, the contents of the current screen will be displayed. Pressing
the Up ARROW again causes the screen to scroll back one page (screen of text) while the
Down ARROW will scroll forward one page. Depending on the amount of text you have in
Scrollback and the computer’s memory, data from the current screen back to the ProTERM
start up screen will be available for viewing. The Left ARROW and Right ARROW scroll up and
down one line at a time while the numbers “1” through “9” position to various points within
Scrollback (“1” positions to the oldest data at the top, while “9” positions to the most recent
text at the bottom). When you are finished viewing Scrollback, pressESCAPE to return you to
the most current screen or ProTERM’s Main Menu if you are off line.
Scrollback can also be used while off line or online, but when using Scrollback while online,
the remote host system is waiting for input. If you stay in Scrollback too long, the remote
system may time-out and terminate your call. While in Scrollback, ProTERM attempts to
suspend all incoming data. However, service being used does not understand the standard
commands, data continues to come in, and only about 512 bytes (characters) will be saved.
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Need More?
The information above may help you enough to serve all of your telecommunications needs,
and maybe you just need to gain proficiency in accessing online text messages, sending and
receiving Email and perhaps some research. If you need more details on the above
mentioned features, look in the Index under the items of interest. The rest of this tutorial
deals with transferring files between computers.

Send and Receive A File — Practice Session
Practice
transferring
files.
Protocol defined.

The Meaning of Protocol

The word “protocol” is often used in telecommunications, and it may not be a familiar word.
Protocol is a name associated with a particular method of file transfer. As noted below, a
protocol is just a set of rules both sides understand and agree to follow. Moms and dads, and
our governments all have rules (protocols). ProTERM handles several different protocols for
transferring files, you only have to choose the protocol that will be available on both systems
at the time of the file transfer.
Protocol; n a: a code describing strict adherance to rules b: a set of conventions governing
the formatting of data in a communications system c: both sides understand and use a
particular set of rules.
Telommunications must be very exact and precise and the protocols are the rules of
governing, or maintaining the order; sequence, timing, format, error control and order by
which data is exchanged, and how that information travels between computers. Simply
stated, when two people attempt to communicate, they cannot both talk at the same time,
they follow a protocol.

The Names of Protocols used by ProTERM 3:
Zmodem

Ymodem
Xmodem
Kermit
Ymodem-G
Xmodem-CRC
ASCII
Ymodem-4K
Xmodem-4K
Each of these protocols follow specific rules on how data file transfers are handled. For more
details and history see the Index:Protocol. Also, the order of the listing of the above
protocols, the columns from left to right, roughly suggests the ease of use and popularity of
those protocols.

To make transfers
easier, see the
Index: Default
Pathnames.

Practice Sessions

Using a protocol transfer to receive a file from a remote system is a fairly simple procedure,
but the first time you try a file transfer, you may think otherwise. The confusing part is
knowing the exact command sequence of ProTERM’s file transfer procedure and relating
these procedures to those of the host system you’re calling. Eliminate some of this confusion
and frustration by practicing ProTERM’s operations of sending and receiving a file before you
ever make a call. You can press all the keys and go through the scenario just as if you were
online and connected to a host. ProTERM will let you play the roll to the end and then show
the “File was not transferred successfully” message (this happens because you were not
actually connected to a host and the file couldn’t be transferred). Practice these routines
until you feel comfortable and it will ease the tensions when you have your first online
session.
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Send (Upload) a File – Practice
To begin this practice session, you should be at the Main Menu in ProTERM 3. Press the
COMMAND key down and then press the “S” key. A pull-down window will show all of the
protocols available for that operation.

Send
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

Let’s go through a scenario where you are off line, but pretend you are connected to the
InTrec BBS. Pretend you have a file you want to share with others, and we’ll use an example
where you upload (send) this file to the InTrec BBS file library. Let’s also assume you’ve
already made the call, reached the InTrec Main menu and entered theX command to get to
the InTrec BBS file transfer “library” area. You would have also instructed the InTrec BBS
that it should prepare to receive a file from you. These actual steps are covered later in this
chapter, but since this is a practice session to familiarize you with ProTERM, these are the
steps:
1 Press COMMAND-S. A pull-down window appears with a list of the file send protocols.
2 To easily choose one of the protocols, press the first letter of the name of the desired
protocol. Example, press Y which chooses Ymodem on the protocol list, and press the
RETURN key.
3 Assume you will send a file named “PT3.CLOCK” from the ProTERM disk.
Following the above scenario, you should see a window namedSend Ymodem.
1 Make sure the ProTERM disk is in one of your drives, either type /PT3, or choose
<Parent> until you see /PT3, and press the RETURN key.
2 The /PT3 files will list. Select PT3.CLOCK and press the RETURN key. See the illustration
File Transfer Window below for an example.
3 Press the RETURN key. The drive with the ProTERM (/PT3) disk should show that it is
being accessed and then you should see a list of the files on that disk.
4 Using the ARROW keys, choose PT3.CLOCK and press the RETURN key. If you prefer,
you can type the filename PT3.CLOCK, it works either way.
NOTE: If you prefer to let ProTERM find the disk and the file, choosing <Parent Dir>, this
causes ProTERM to search upward and shows the volumes and directories on your disks—try
it now. If necessary, choose <Parent Dir> again until you see the “/PT3” disk online as one
of the choices in the file selection window. For more detail on how this works, see the Index:
ProDOS. <Parent> chooses upwards to the next level and <Select> chooses downwards.
See the Index: ProDOS for details.
ProTERM 3.1

2.25K edit

9.50 sbk

9600 baud O ffline 09-FEB-96 14:52:36
Window
Menu bar
Send Ymodem

File Selector System

Pathname
Filename

Files shown
in directory
can be selected
or a new name
typed in.

/PT3
PT3.CLOCK

Text field

.. <Parent Dir> DIR
PRODOS
SYS 3
PT3
SYS 9
PT3.BACKUP
SYS 14
PT3.BIOS
BIN 57
PT3.CLOCK
TXT 5
PT3.CODE0
BIN 1

Send

Cancel

04-APR-91
05-FEB-91
05-APR-90
03-MAY-91
04-FEB-90
11-FEB-91

Mouse pointer

File Transfer
Window

Choose to continue

5 Press the Send button (press the RETURN key to choose the Send button, and then
press the RETURN key again to “press the button”) to begin the transfer.
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6 While the file is being transferred, ProTERM will display a status window (see the
illustration), with information regarding the status of the file transfer.
Because this is a “mock” file send, ProTERM will time-out with a message stating this file
transfer was aborted. This is due to excessive errors without progress, because you were
really not connected to a host service and ProTERM lets you know that the file transfer was
aborted. Press the RETURN key or ESCAPE, to get back to the Main menu. For more
information and detail, see the Index:File; transfer.
NOTE: The Download and Upload Transfer and Status windows have the same appearance,
except one shows info on outgoing files and the other shows info for incoming files, so to
conserve space, only the Receive window is shown as an example. In addition, with minor
exceptions, the example windows are representative of most all of the protocol Send AND
Receive windows and are generically referred to as “the transfer windows” in this discussion.

Receive (Download) a File — Practice
NOTE: Some of the detail is that was already discussed above is omitted in this part tutorial.
To get the full picture, see the notes above on practice file Sending.
To begin this practice session, you should be at the Main Menu in ProTERM 3. Press the
COMMAND key down and then press the “R” key. A pull-down window will show all of the
available protocols.
Just like the Send File scenario above, you are off line, but pretend you are connected to the
InTrec BBS. You have a file you want from the InTrec BBS file library and you would like to
download (receive) this file and save it to a disk on your computer. Let’s also assume you’ve
already made the call, reached the InTrec Main menu and entered the “X” command to get
to the InTrec BBS file transfer “library” area. You would have also instructed the InTrec BBS
that it should prepare to send a file to you. These actual steps are covered later in this
chapter, but this is a practice session to familiarize you with ProTERM.

Format a Disk
To begin this practice session we will need a formatted disk named /DATA:
1 Place a new disk, or one which can be erased, into an available drive.
2 Hold the COMMAND key down and press F to pull down the File menu. Release the
COMMAND key.
3 Press F again to choose Format from the pull-down menu, and press the RETURN key.
4 Choose the drive with the disk to be formatted, from the list, and press the RETURN key.
5 Type the word /DATA, and press the Format button.
6 If it is a new blank disk, the disk will begin formatting. If the disk was previously
formatted you will see an alert message asking for permission to format.
NOTE: The Download and Upload Transfer and Status windows have the same appearance,
except one shows info on outgoing files and the other shows info for incoming files, so to
conserve space, only the Receive window is shown as an example. In addition, with minor
exceptions, the example windows are representative of most all of the protocol Send AND
Receive windows and are generically referred to as “the transfer windows” in this discussion.

Receive – Practice Cont:
1 Press COMMAND-R. A pull-down window appears with a list of the file send protocols.
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2 To easily select one of the protocols, press the first letter of the name of the desired
protocol.
3 Press Y and press the RETURN key.
4 Following the above scenario, you should see a window namedReceive Ymodem.
5 Type /DATA and press the RETURN key.
NOTE: If you prefer to let ProTERM find the disk and the file, choosing <Parent Dir>, this
causes ProTERM to search upward and shows the volumes and directories on your disks—try
it now. If necessary, choose <Parent Dir> again until you see the “/PT3” disk online as one
of the choices in the file selection window. For more detail on how this works, see the Index:
ProDOS.
1 ProTERM attempts to find and access the disk named /DATA.
2 Press the RETURN key twice to press the Recv button.
3 A Receive Ymodem window appears showing the status and progress of the transfer.
ProTERM 3.1

2.25K edit

9.50 sbk

Filename

9600 baud O ffline 09-FEB-96 14:52:36
Window
Menu bar

Receive Ymodem
Xfer Name: PT31.FEATURES
Save Name:

Save as
filename
if different
(see BNYII)

Status: Transferring file contents
O ptions: CRC-16 PRO D OS 128 1K
Total Bytes
914 4
Total KBytes
8.75K
Estimated Time: 00:00:48
Error:

Bytes Recvd:
KBytes Recvd:
Percent Recvd:

1280
1.25K
14%

Mouse pointer

Transfer Status
Window

Error information if present.

If you were really connected to a host and had prepared the host to send a file, the file
would transfer at this point. Since you are not, ProTERM will note lack of progress, time out
and show an alert message to that effect.

Call the InTrec BBSystem
For Online Experienced & Practice
Now that you have read the above steps and are an expert wanting to practice your new
talent, try your expertise real-time. Call the InTrec BBS, go to the file libraries and when you
get to the main command prompt of the InTrec BBS, follow the directions shown below to
arrange for the file transfer. Then go through the steps you have been practicing and find the
satisfaction of moving a file from one computer to another. The InTrec BBS is available
anytime, and you can call at any speed from 300 to 14,400 bps. Call the least expensive time
for you, like late at night or early morning or weekends. Check with your long distance
carrier, the call could cost a lot less than fifteen cents per minute. Ten minutes is a lot of
time online and you can do some serious experimenting for less than the cost of a burger
and fries — try it.
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NOTE: See the above mock file Send and Receive tutorial for practice before you call.
Main Command (?=Help):

Example of a system’s main prompt.

InTrec BBS Main Menu (List of supported commands)
Example of a
transfer library
menu.

InTrec BBS Main Menu — (List of supported commands)
B Goto the Bulletin Boards
R Read Your Email
G Global QuickScan
S Send Mail
T Terminate Session
F Feedback to SysOp
*
I
U
P

News & Current Information
ProTERM Information
See the User List
Change Your Password

H
D
E
X

Detailed HELP Files
Display Phone Number
Examine Your System Stats
Goto the File Transfer Libraries

[XXmins left]Main Command (?=Help): X

“X” is entered at the Main Prompt to enter the file transfer area.
The screen changes here and Shazam! You’re in the file transfer area.

Example of a
transfer library file
list.

Library #1: Main Transfer Area
#Name Type
1. PT3.FEATURES
TXT
2. ICONED.GS.SHK
BIN
3. PROTERM.ICON.SHK LBR
4. PT3.CHAT2.BXY
LBR
5. PT31.FEATURES
TXT
6. PT3REVIEW
TXT

Size
Date
Time
Dwnld
10.0K
01-AUG-91 23:26 DL=9
55.0K
30-OCT-91 17:21 DL=2
1.5K
08-DEC-91 14:59 DL=5
2.5K
06-MAY-92 19:39 DL=7
9.5K
01-MAR-93 00:09 DL=9
12.5K
20-AUG-92 16:54 DL=8

[XXmins left][Library #1] Xfer (?=Help): _
Enter a QUESTION MARK “?” for Help.

Example of a
Transfer menu.

##
D
SPACE
J
J?
K
I
U or R
V
Y
X
A
G

Read file description. Just type the file number.
Show Directory of files.
Stop Directory scroll.
Jump to another file library.
List all Libraries available.
Kill (delete) a file you uploaded.
Enter information description about a file you uploaded.
Upload (command host to Receive) files from your computer.
View information about a file.
Download files using Ymodem (Send a file to you).
Download a file using Xmodem (Send a file to you).
Add file to directory
Global new upload scan
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Configure Xfer
Quit to the Main Command Prompt (Exit Xfer).
Terminate this call (sign-off of the InTrec BBS).

[XXmins left][Library #1] Xfer (?=Help): _

Receive
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

Receiving – a File Real-Time
The information above covers the details from installing a system to practice file transfers.
Now put this all together and actually transfer a file to and from your computer, we’ll go
through a real online session to make it all happen.
At this point we can assume you’ve successfully called the InTrec BBS, logged in and are at
the Main menu. Enter a QUESTION MARK to call up the Help Menu and have experimented
with navigation by using menu the host system menu commands to move around.
Note: the InTrec Main Menu shows this command:
“X

Goto the File Transfer Libraries”

As a reference to the InTrec system commands and navigation to the file Libraries, “L” and
“X” are the same command. Also, “X12” and “L12” are the same command and would take
you directly from the Main menu to Library 12 on the InTrec BBS. EnteringJ and then the
number of the Library to jump (J4 for example) would take you to that Library. Enter “J?” for
a list of the libraries available to you. When you see this list:
1. Main Transfer Area
2. ProTERM Public Files Library
3. ProTERM Macros Library
Jump to Library (1-100 or ? for Library list) _

…enter the number of the Library and press the RETURN key. For example, you enter the
number 2 and when RETURN is pressed, you jump (are moved) to Library 2.
Check the host menu to find the command to list the available Library areas. For the InTrec
BBS enter a J? to see the Library list:
Library #2: ProTERM Public File Library
# Name
Type Size
1. PRINT.MARGINS
TXT 8.0K
2. PT31.DEMO3.5SHK LBR 154.5K
3. PT31.FEATURES
TXT 10.0K
4. PT31DEMO525.SHK LBR 166.5K
[XX][Library #2] Xfer (Press ? for Help):

Date
22-SEP-92
24-JUL-92
01-AUG-91
24-JUL-92

Time
18:47
20:06
23:24
19:59

Downloads
DL=28
DL=31
DL=10
DL=9

From the menu, you see that Y is the command to begin a Ymodem download on the InTrec
BBS. Since plain Ymodem is a popular and an easy protocol to use, enter Y and press the
RETURN key. The host should be ready to send files to you, and Ymodem will allow you to
download several files (a batch) in one session. The prompt will look something like this:
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Ymodem Download

Enter the name or number of a file you see in the list. For this example, you would enter 3 to
download the file PT31.FEATURES. As noted, Ymodem will allow you to download several
files as a batch, but try one for now. Press the RETURN key with no additional entries to
finish the list and you will see a prompt something like this:
Start your Ymodem receive now...

This is the point where you started your practice session noted above. Instruct ProTERM to
receive the file from the host. Press COMMAND-R and the Receive pull-down window will
appear with a list of the file receive protocols. To easily choose one of the protocols, press
the first letter of the name of the desired protocol Y and press the RETURN key. Place a
formatted disk (see the Index: Format; Disk) named /DATA in one of the available disks
drives.
NOTE: If you have one drive and only 128K memory, you will have to work out the timing of
when to remove the ProTERM (/PT3) disk and put in your /DATA disk. ProTERM will need to
provide instructions before the disk is removed as there is “extra” no space to store the
instructions when there is minimal memory and one drive. ProTERM works better with at
least two drives and is at its best with a minimum of 256K RAM.
You should see a window named Receive Ymodem. Type /DATA and press the RETURN key.
As you begin typing /DATA, you will see what you typed in thetext field (see the Illustration
File Transfer Window). Press the RETURN key. A window “Receive Ymodem” will open. The
drive with the
/DATA disk should show it is being accessed.
NOTE: If you prefer to let ProTERM find the disk and the file, choosing <Parent Dir>, this
causes ProTERM to search upward and shows the volumes and directories on your disks—try
it now. If necessary, choose <Parent Dir> again until you see the “/PT3” disk online as one
of the choices in the file selection window. For more detail on how this works, see the Index:
ProDOS.
A window named Receive Ymodem will open. In the middle of the window, and <Select>
is highlighted, press the RETURN key which will “select” the Recv button. Press the RETURN
key again to start the file transfer to the /DATA disk on your computer.
While files are being transferred, ProTERM displays a status window with information
regarding the status of the file transfer. For more information, see the Index:Transfer
protocol.

Let’s See The New File!
After you have terminated your call, and you are at the ProTERM Main Menu, enter the
ProTERM Editor (see the Misc menu). To
open the new file, see the File menu and
choose Open. A window titled “Open” will appear. Type /DATA and press the RETURN key.
The new file you just downloaded should be visible on the /DATA disk. Select the file using
the ARROW keys, and press the RETURN key. The file will open and you have completed
your first lesson.
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Summary
You have called a service, downloaded a file, and opened it with the most full featured word
processors ever developed for telecommunications. Choose Print from the File menu, and
Press the RETURN key to print the file. Try editing and saving the file under another name
using the Save As command. For more information, see the Index: Editor.

Send a File – Real-Time
Follow the directions above for calling the InTrec BBS and type X1 to enter the InTrec
practice library.
1 Enter the J1 command on the InTrec BBS to Jump to Library 1. The files in Library 1 will
scroll and a prompt will be shown.
2 Enter the letter U to instruct the InTrec BBS you will be Uploading a file, and it will
prepare to receive the file: Press the RETURN key to enter the command.
Upload File(s)
1. Xmodem
2. Xmodem CRC
3. Xmodem-1K
4. Xmodem-4K
5. Ymodem
6. Ymodem-4K

A protocol list is presented and since plain Ymodem is a popular and an easy protocol to
use, choose plain Ymodem and press the RETURN key. The host should be ready to receive
the file:
Upload Files (Y/n)

Enter Y and press the RETURN key and you will see this prompt:
Start uploading now...

At this point you have just over 30 seconds to inform ProTERM to start the file upload from
the InTrec host. After that, this service times out and returns to its normal prompt. No harm,
if it times out, start over again and chalk it off to practice.
Instruct ProTERM to send the file to the host. Press COMMAND-S. A pull-down window
appears with a list of the file send protocols. To easily select one of the protocols, press the
first letter of the name of the desired protocol. Press Y and press the RETURN key. Assume
you will send a file named “PT3.CLOCK” from the ProTERM disk. Make the ProTERM disk
available in one of the drives. Following the above practice scenario, you should see a
window named Send Ymodem. Type /PT3 and press the RETURN key. With the ProTERM disk
in the drive you will see a list of files, selectPT3.CLOCK and press the RETURN key and the
file will begin to transfer. See the illustration belowFile Transfer Window for an example.

Enter T to Terminate
To terminate the call, enter T which is the command for Terminate, and enter the Y to
answer Yes to end the session. ProTERM will automatically “hang up” the modem and take it
off line. At this time you can use the voice phone normally to receive calls or call out. The
modem can be left plugged in and turned on and it will not interfere with normal phone
use.
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NOTE: Anytime you see an upper case letter and lower case letter together in a prompt,
example; Y/n, this means if the RETURN key is pressed, the upper case letter, “Y” in this
example, is the default command provided by the called host, and is automatically selected
by pressing RETURN.

Receiving and sending Email
Also see the Index: Scrollback: Minimizing Online Time
The Reply Format filter in the ProTERM Editor edit menu is an extremely useful ProTERM
feature. Reply Format works like a power tool doing most of the work for you when it creates
a special format using text from the original message. Reply formatting has special markings
that clearly shows the quoted text, showing that it is separate from your reply. This formatted
text provides a reference for the receiver of their message, reminding them of their previous
remark by showing the text that prompted your reply. Here’s how it works:
1 Make sure the text to be reformatted is flush with the left margin, or it will not react to
the formatting procedure. Depending on the amount of text, you can either place the
cursor just right of the space and then use the DELETE key to edit the spaces out. For
larger blocks of text, see the Index: Reply Format.
2 Select the text to reply to from their message in Scrollback, and paste it directly to the
ProTERM Editor.
A- Selecting the text in Scrollback by holding the OPTION key down will using the arrow
keys, or click-drag using the mouse.
B- Use the Copy to Editor command from the Edit menu (shortcut, press COMMAND+D
after selecting the text in Scrollback).
2 Press the ESCAPE key to return to ProTERM’s Main Menu.
3 Press COMMAND+M to pull down the Misc menu. Choose Editor to enter the ProTERM
Editor (shortcut, press COMMAND+E at the Main Menu)
4 Select the text to be formatted in the ProTERM Editor by placing the cursor above or
below the text and while holding the OPTION key down, use the ARROW keys to select
the text or use mouse to click and drag. For details, see the Index: Select; text; editor.
5 Move the cursor just above your reply and choose Paste from the Edit menu (COMMAND+V).
6 Select the text again and choose Reply from the Edit menu to convert the text to Reply
Format.
NOTE: For more details on how to use Reply Formatting, see the Index: Reply.
One or several messages can be prepared in the ProTERM Editor.

Sending a Single M essage
As this is probably your first experience at this, type one message in the ProTERM editor, call
the service, navigate to where the message is to be sent, and at the point where you would
normally begin to type your message online at the host’s editor prompt, press OPTION+S to
send (upload) the text directly from the ProTERM editor.

Sending M ultiple M essage in a Session
If you wish to send several messages in one session, create all of your messages in the
ProTERM editor, call the service, navigate to where the first message is to be sent, and at the
point where you would normally begin to type your message, press COMMAND+E to enter
the ProTERM editor. Select the text you want to send using selection techniques mentioned
above and press COMMAND+D to “dump” the selected text to the host’s message editor.
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When the message is finished uploading, press the ESCAPE key to get out of the ProTERM
editor and return to the host’s editor (the terminal or online screen).
Here are the steps by the number:
1 Choose Editor from the Misc menu (COMMAND+E).
2 Highlight the reply you want to send (you can use the pointer to click and drag, or
CONTROL+C and the ARROW keys).
3 Choose Send ASCII from the File menu (COMMAND+D).
4 Adjust the Send ASCII parameters, if necessary, select Send and press RETURN.
This will send your reply to the remote system far faster, easier and with more perfections
and satisfaction than you could ever type it into the hosts’s editor while online.
Continue the above described process until all of your replies have been sent. Terminate
from the system and your work is complete. You may want to choose Save from the ProTERM
editor File menu, and save the file to disk. You can then clear the text from the ProTERM
editor by choosing Close from the File menu.

Utilizing Paste to Modem
Another great Scrollback feature is the ability to copy and paste to the modem port. This
process is described in the following example:
You have just called a favorite online host, perused the library files, and you see several files
you wish to download. Select and Paste to Editor, the list of files from ProTERM scrollback to
the the ProTERM editor using the commands explained earlier in this chapter. Edit (delete
unwanted text, add back what may be needed) the text in the ProTERM editor until it
contains the exact file identification information you need. When you’re ready to send the
information to the host, select the text, and choose Copy from the ProTERM editor’s Edit
menu which places the text in the ProTERM clipboard file. Press theESCAPE key to return to
the terminal mode that shows the screen containing the host’s prompt.
TIP: Use COMMAND+D to quickly and easily “dump” all of the information in the ProTERM
editor directly to the host. This sends the all of the text in the ProTERM editor directly to the
host at the cursor.
At the prompt where the host asks you to write the filename information, choose Paste from
the Edit menu. This will paste the contents of the clipboard at the cursor in the terminal
window. This also works if you are sending a letter to someone and they have a complex
name or number address. Just cut and paste the information string from Scrollback! If it is
long or has other extraneous characters on the same line, paste the line to the Editor, reselect only the needed text, Copy it to the clipboard and its ready to paste. This process is
referred to as pasting through the modem port. For more details open how to use this
feature, see the Index: paste.

Quitting ProTERM
To quit ProTERM, press COMMAND-Q. Choose the OK button, ProTERM will quit and place
you at the “ProDOS Quit Code.” From here you can run other applications. More information on the ProDOS Quit Code is available in the “ProDOS reference Manual” published by
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Apple Computer, but one of the most complete help files written in layman language on the
use of ProDOS 8 is the ProDOS chapter in this manual.
NOTE: The InTrec BBS is a support BBS for the products of InTrec Software. Whenever new
information is available about InTrec products, it will be available on this system first.

Next Steps
Also see the Index for:
Macros: AutoLearn: Genie and CompuServe.

Replicating Systems
The systems you call may be very similar and instead of creating each new system individually. It may be more convenient to make one system that generically matches your needs, and
then replicate it. You can then make the needed changes in the copied system file, such as
name and phone number, and you’re ready to call the new service.
The easiest way to do this is to use the ProTERM File – Copy command to copy the files
FROM the PT3.DIAL directory, TO the PT3.DIAL directory — REALLY!
This is how it works: When ProTERM copies files to a directory where they already exist, it
can allow you to copy over the existing files, but by default, ProTERM allows you to rename
the files. So a file named “PTD.INTREC” would be renamed as PTD.JIMSBBS as it is copied.
Copy the number of files needed to create your replicated systems and then make the
individual changes.
There are just a couple of rules that must be followed exactly.
• Dialing filenames MUST begin withPTD.
• The total numbers of the characters in the name cannot exceed fifteen.
• Only periods are allowed for name separation or punctuation. See the the Index:
ProDOS; names for more details on proper ProDOS names.
Reboot ProTERM when finished, and each of these new files will be a new system but they
will all have the same name in theDial List. This is not a problem. Enter each system and
look at the name at the bottom of the window:
Filename: PTD.systemname
The replicated system will have the new name you entered when the files were copied. TAB
to the name field and edit theSystem Name:, Phone Number: and any other specific
parameters needed for your new system.

Customizing the Dial List
As your Dial list grows, you may want to rearrange the order of names. The Names can be
edited and changed at will. The list is shown alphabetically and inserting different letters of
the alphabet in front of the name in the list will change the relative arrangement of the list.
Non-alpha characters for example: dollar, percent, pound, tilde, exclamation and any others
can be placed in front of the system’s name. Most non-alpha characters come before (a few
come after) the alpha characters and can cause these names to be alphabetically arranged at
the top of this list, if used as first characters (see the hierarchical arrangement in the ASCII
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chart at the back of this manual). Leading the name with a number or other than alpha
character will also cause it to place accordingly in the “alphabetized” list.

Default Service
You may have one service you prefer to be the default service, or the one that is always
selected when you enter the Dial List.
1 Choose the service by highlighting it in the list.
2 Press the RETURN key to open the window’s Edit System Parms window for that service.
3 Press ESCAPE to return to the Main Menu.
4 Press COMMAND+M to pull down the Misc menu.
5 Press to choose Preferences and press the RETURN key to open the Preference window.
6 Note that the Save button is selected. Press the RETURN key to press the Save button.
This saves all recent preference changes made in ProTERM during this session.
Return to the Main Menu and press the D key to pull down the Dial menu. The service you
selected as your default service is selected and ready to dial.

Print a ,Menu from a Called Service
Directly from the Screen
This neat trick can help navigate unfamiliar services. When you are online with the called
system and request the help menu or any other information of interest and it is on the
screen, press hold the CONTROL and OPTION keys, and then press the letter P keys to print
an image of the screen. See Index: Screen print.

Listing a Library’s Files
When you enter a host system’s library area, some automatically scroll a directory of files and
some do not. You may have to enter a command to request the directory of files. Use “?” to
see the Library Menu for the directory listing command. To see the Directory list on the
InTrec BBS enter a D and press the RETURN key.

Print a Screen of Information
Pressing CONTROL+OPTION+P prints the screen being viewed. This can help you work
with online help menus, file directory lists and other items of reference.

Delete a System
“House cleaning.” To delete a service:”
1 Select the system from the Dial list.
2 Choose the Parms buttons.
3 Choose Delete and press the RETURN key.
4 Choose Delete when presented with the prompt “ Do you really want to delete this
system?”

Running a Sample Macro
How to run
PT3.CLOCK.

A macro is a script, a set of instructions, a string or phrase of commands, which can be
invoked with a keystroke to perform a set of complex tasks or many keystrokes with just a
single keystroke. The file “PT3.CLOCK” is placed on the ProTERM disk as a kind of “show off”
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example of what a macro file can do. This example does require a clock in your computer, or
it cannot work. The file is just a text file which you could load into the ProTERM Editor and
explore and play with. For more on this see Index: Macro.
To run PT3.CLOCK, from ProTERM’s Main menu, choose Macro File from the Misc menu
and press the RETURN key. Choose PT3.CLOCK from the Exec a Macro File menu, and press
the RETURN key. A full screen graphic digital clock appears and ticks off the seconds.

AutoLogon Macros
Let ProTERM do the repetitive tasks of calling your favorite host systems. See the Index:
AutoLearn and AutoLogon for instructions on how to call and enter all of the log in
information with a single keystroke.

Suggested Further Reading
For assistance with an on disk tutorial, See the Index:Suggested Further Reading.
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The Editor
CHAPTER

FIVE

Composing and working with text files is one of the most important parts of telecommunications and ProTERM’s integrated editor/word-Processor is designed especially for this
purpose. The utility value of the ProTERM Editor becomes apparent when considered its
features:
• Composing documents offline.
• “Cleaning up” data received from remote host systems.
• Opening files with wrong file types and then saving them as TXT (text) or AWP
(AppleWorks word processing) files.
• Editing.
• General overall formatting or reformatting into
“> Reply Mode.”
• Formatting.
• Adding margins.
• Stripping, or removing, or replacing unwanted CONTROL characters.
• FIND & REPLACE COMMANDS .
• Customizing TABs and document widths.
• Previewing and printing documents.
• Uploading (sending) entire or selected parts of a document to another computer with
“on-the-fly” formatting.
One of ProTERM’s most popular features is its ability to send ASCII text directly from the
Editor. This allows ProTERM to prepare, and custom format the text as it is being transferred.
Because an entire document or just selected portions can be sent, it is possible to compose
several letters in the Editor as one long document, call a remote host system and then select
and send selected parts of text as individual letters or messages, one at a time.

About the Editor
COM MAND = OpenApple & OPTION =
Closed-Apple.

The size of the ProTERM Editor memory (buffer) varies between 23K and 46K depending on
whether the computer has the minimum 128K or more memory available. As ProTERM is
booting up, all available memory in the system is examined. The amount of available memory
is automatically allocated and used to its best advantage. To find the size of the Editor on
your computer, choose About ProTERM from the Apple “ K ” menu. While the size of the
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ProTERM Editor may limit its ability to open extremely large documents, virtually any size
document can be manipulated using Segmented Loading which is described later in this
chapter.
File Edit Utility
File: YO UR.FILENAME Cursor: 31,

12/ 503

[Editor] 10-FEB-96 09:18:56
Used: 15/ 577 Free: 45756

Ruler
Press the C O M MAN D key plus one of the noted keys for these menus:
~ TILDE = Apple Menu:
<> About ProTERM, Key Function and Screen Saver.
Scrollbox
F File = File Menu:
<> New, O pen, Save, Save As – Print, Print Preview, Print to Disk and
Send ASCII.
E Edit = Editing Menu:
<> Cut, Copy, Paste, Clear – Select All – Upper Case, Lower Case,
Line Format, Paragraph Format, Reply Format and Strip Controls.
U Util
= Utility Menu:
<> Find, Find Next, Replace – Change Ruler, Show Scrollbar and
Selection Size.
Flashing Cursor:
Scrollbar
Note “Cursor” on Status Line above.
Mouse
Column 31, Row 12, Position in text 577.
pointer
Lines Used 15, Characters Used 577.
Characters Free (yet to be used) 45756.

ProTERM Editor
Screen

Using the Editor
To use the ProTERM Editor, choose Editor from the Misc menu. The screen will change and
the Editor MenuBar, Status Bar and TAB-ruler will be displayed at the top of the screen.
These three lines contain information pertaining to the status and management of the Editor.
Because the MenuBar (the topmost highlighted line containing the pull-down menus) is
changed to Editor related commands, Terminal mode commands are not visible or available
from within the ProTERM Editor. The Editor command pull-down menus replace the
Terminal mode commands. The total number of keys available for keyboard commands is
limited, so many keyboard commands available within Terminal mode have different
functions within the Editor. For example, COMMAND-S is the Send command in Terminal
mode but is the Save command in the Editor. For more information on keyboard commands,
see the latter part of this chapter, the ProTERM Quick Reference and the PROTERM EDITOR
REFERENCE cards. To exit from the Editor and return to the Terminal mode (Main Menu),
press the ESCAPE key or choose Quit Editor from the File menu.
When the Editor is entered for the first time in a session, the MenuBar, Status Bar, TAB-Ruler
and a blank screen are displayed. As you begin to type, the new text is entered at the position
of the cursor (the flashing vertical bar). After each character is entered, the cursor moves to
the right. When a line becomes full and the next full word will not fit on the line, that word
“wraps around” and automatically moves to the start of the next line. Also see
Insert and
Overstrike Mode below for more information and alternate ways to enter text into the Editor.

Open, Save and Close a File
Choose the Open command from the File menu to open (load) a text file document stored
on disk. When finished working on a document, choose Save from the File menu. To clear
the current document and begin something new, choose Close from the File menu. Each of
these commands are described in more detail later in this chapter.
NOTE: The ProTERM Editor does not have an “undo” command. When text has been deleted
it is gone. You can mimic an “undo” command by using the Cut command (see the Edit
menu) instead of Delete to remove data. In this way, data can be retrieved through the Paste
command. See Cut and Paste later in this chapter.
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Editor Menu Bar Commands
The following section contains details on all of the ProTERM Editor commands available
from the pull-down menus. Most of these commands are not for editing, but rather for
functions such as opening, saving, printing, searching and sending (uploading or transferring
an ASCII text file). Most text entry and editing commands are controlled via the keyboard
and are described under Keyboard Commands later in this chapter.

About ProTERM

The Apple Menu

Key Function
Screen Saver

The Apple menu is the only pull-down menu which remains the same in Terminal mode,
Scrollback and the Editor. Refer to The Apple Menu chapter for complete information on the
Apple menu.

File
New
O pen
Close
Save
Save As

The File Menu
O
W
S
M

Print
P
Print Preview I
Print to Disk J
Send ASCII
D
View Files
Q uit Editor

Q

The terms “Open ”
and “Load ” are
synonymous.

The File menu contains commands which open and save documents as well asPrint and
Send ASCII. All of the commands in the File menu are listed below.

New
To clear the Editor of all text, choose New from the File menu. If the current document has
not been changed, the screen is cleared immediately. If the document has been changed,
ProTERM asks if the changed document should be saved before clearing the Editor. When
the Editor is cleared, the Ruler automatically resets to TAB stops at every 8th column and the
width equal to the Send Width parameter for the current System host entry in the Dial menu
(see Index: Parms).

Open
The Open command opens a new document and places the text in the ProTERM Editor. If
text already exists in the Editor, the one or more files being opened are inserted into the
current document at the current cursor location. If multiple files are selected for opening,
they are opened in the order they appear. Files normally appear alphabetically, but using
COMMAND-X will show the files as they are stored on the disk. This command opens both
text, AppleWorks and even non-text files (see below).

Opening Non-Text Files
Sometimes it is desirable to load non-text files into the Editor. This can occur if a text file
“loses” its “TXT”filetype during transfer. ProTERM allows any file to be loaded into the
Editor, regardless of its filetype. To open a non-text file into the Editor, choose Open from
the File menu, select the directory containing the file to be opened and press CONTROL-Z
(this displaysall files including non-text files). Select the name of the file to open and press
the RETURN key.
When a non-TXT file is opened, it either looks like a normal file (is totally readable) or it may
contain strange looking “garbage” characters. If the file does not look normal, then it is
probably not a text file. To change the filetype to “TXT” choose Save from the File menu. The
Save command writes the file with the new filetype as specified (TXT or AWP) in the Save
window. Take care when using this procedure, do not use the Save command on a non-text
file unless you’re sure the file should be saved as a “TXT” or “AWP” file. Also see the Set File
Info command in The File Menu chapter for another method of changing filetypes.
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The New and Close
commands are
identical.

Close
To clear the current document from the Editor, choose Close from the File menu. If the
current document has not been changed, Close clears the Editor immediately. Otherwise, it
allows the document to be saved prior to clearing the Editor.

Save
To save the current document (the file in the Editor), choose Save from the File menu and
the document will be saved to disk using the filename displayed in the Status Bar.
If there is no filename shown in the Status Bar, (on the left just next to File:), the Save As
command is automatically chosen. Typing a filename and pressing the RETURN key will
choose the Save As button.
If Save is chosen while text is selected, then the Save Selection As window is displayed, see
below: Save As and Save Selection As .

Filetypes: TXT =
text & AWP =
AppleWorks Word
Processing.

Save As
The Save As command allows the current document to be saved using a filename of your
choice. Choose Save As from the File menu, select the filetype (“TXT” or “AWP”) and press
Save As. If a file of the same name already exists, ProTERM prompts you toAppend to, or
Delete the existing file. If Save As is chosen while text is selected, then the Save Selection As
command is automatically used (seeSave Selection As below).

Save Selection As
Save Selection As, saves just the current selected text in either a “TXT” or “AWP” file. To save
the current selection, choose Save or Save As from the File menu while the selection is
highlighted. When the Save Selection As window is displayed, enter the filename, select the
filetype (“TXT” or “AWP”) and press Save. If a file of the same name already exists, ProTERM
prompts you to Append to or Delete the existing file.

Print
The Print command prints the whole current document or just text selected within the
document. If the Print command is chosen while text is selected, then only the selected text
is printed, otherwise, the entire document is printed. To print a document or selected text,
choose Print from the File menu, adjust the print parameters if needed and press Print.
Normal parameters are already set up in this window and unless the way the page is printing
does not suit you, no changes are needed. To cancel printing, press ESCAPE. See Printing
and Dot-Commands later in this chapter for more information on print formatting.

Print Preview
Print Preview displays the current document or selected text as it would look if it were
printed. All formatting, including Dot-Commands, page breaks and many special print modes
are displayed as “What You See Is What You Get” (WYSIWYG). Attributes which would
change the printed characters, such as underline and bold type do not show. The entire
document is previewed unless a portion of the text is selected, in which case just the
selection is previewed. To preview a document or selection, choose Print Preview from the
File menu. Within the preview display, press:
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Scroll one line at a time.
Scroll four lines at a time.
Scroll 10 lines or one half page at time.
Scroll twenty lines or one page at a time.

Print Preview is a viewing command and only scrolls forward. Press Cancel or ESCAPE to exit
Print Preview and return to the Editor.

Print to Disk
The Print to Disk command formats the current document or selection as if it were to be
sent to the printer, but the formatted file is saved to disk. If Print to Disk is chosen when text
is selected, only the selection is saved (printed to disk), otherwise, the entire document is
saved (printed to disk). To print to disk, choose Print to Disk from the File menu, enter a
name for the file and press Save As. If a file of the same name already exists, ProTERM
prompts you to Append to or Delete the existing file.
The file saved by the Print to Disk command contains RETURN characters at the end of every
line and all Dot-Commands are processed and removed. The Print to Disk command is
normally used to create files which are subsequently uploaded in their formatted form with
one of the file transfer protocols. While the Send ASCII command can format documents
“on-the-fly”, protocols such as Xmodem cannot. The protocols transfer a file exactly as it is
saved, Dot-Commands and all.

Send ASCII
As previously mentioned, one of ProTERM’s more powerful features is its ability to send files
directly from the Editor, formatting them as they are sent. TheSend ASCII command sends
the current document or selection to the remote host system performing formatting “on-thefly.” To send a document or selection, choose Send ASCII from the File menu, change the
parameters if needed and press Send. To cancel the send, press ESCAPE. For more
information on file transfer and Send ASCII parameters see the Index:Send ASCII.

View Files
The View Files command appears in the File menu for both the Editor and Terminal mode. A
complete description of this command can be found under View Files in the File Menu
Chapter. Other than the convenience of being able to work directly from the Editor, there is
one major differences between using View Files from Terminal mode and from the Editor
mode. The View command from the Editor mode allows text to be inserted at the cursor
position, while the View command in Terminal mode will only Append text to the end of the
current document. The commands are identical in all other respects.
NOTE: The View option is significantly faster from Terminal mode than from the Editor. For
opening large chunks of data, it may be advisable to use this command from Terminal mode.

Quit Editor
Quit Editor exits the Editor and returns to Terminal mode. Quitting from the Editor does not
alter or destroy the document in the Editor. Upon return to the Editor, the document will be
unchanged. Choose Quit Editor from the File menu to return to Terminal mode. An alternate
method to exit the Editor is to press the ESCAPE.
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Edit
Cut
Copy
Paste
Clear

X
C
V

Select All

A

Upper Case
Lower Case
Line Format
Paragraph Format
Reply Format
Strip Controls

The Edit Menu
The Edit menu contains commands for operating on selected text and for working with the
clipboard. All of the commands in the Edit menu are listed below.

Cut
The Cut command removes (cuts) the current selection from the document and pastes it to a
memory area referred to as the clipboard. Each time Cut is chosen, the current memory
contents of the clipboard are replaced. Select the text to be cut and then choose Cut from
the Edit menu. Place the cursor at the point of insertion for the new text and choose the
Paste command to paste data from the clipboard back into the document.

Copy
The Copy command copies the current selection to the clipboard. Each time Copy is chosen,
the current contents of the clipboard are replaced. Select the text to be copied and choose
Copy from the Edit menu. The Copy command does not change the original selection. Use
the Paste command to insert data into the document from the clipboard .

Paste
The Paste command inserts the contents of the clipboard at the cursor location. Position the
cursor to the insertion point and then choose Paste from the Edit menu. The current
clipboard contents are inserted into the document to the right of the cursor. The clipboard
data is not changed when the paste command is used and can be pasted multiple times.

Clear
The Clear command deletes a selection from a document. Because the ProTERM Editor has
no “undo” command, once a selection is cleared, it is gone and cannot be retrieved. Using
the Cut command instead of Clear is often a good alternative since Cut can be “undone” by
following up with the Paste command. Using Clear has no effect on the contents of the
clipboard.

Select All
The Select All command creates a selection of the entire document. After choosing Select All,
any command which operates on a selection can be used. Choose Select All from the Edit
menu to select the entire document.

Upper Case
The Upper Case command converts the current text selection to upper case. Select the text to
be converted and then choose Upper Case from the Edit menu. The conversion changes all
alphabetic text in the selection to upper case.

Lower Case
The Lower Case command converts the current text selection to lower case. Select the text to
be converted and then choose Lower Case from the Edit menu. The conversion changes all
alphabetic text in the selection to lower case.
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Line Format
The Line Format command places a RETURN character on the end of each line in a selected
block of text. The length of each line is dependent on the width of the Editor Ruler. Select
the text to be formatted and then choose Line Format from the Edit menu. Any line which
does not have a RETURN at the end will have one appended.
The method of dividing paragraphs using a single RETURN character to mark the end of a
paragraph is not recommended for a document which will be Line Formatted. Since each
line has a RETURN appended to it, each line takes on the appearance of an individual
paragraph and all of the text tends to flow together into large continuous blocks which can
be very difficult to read. A simple method for avoiding this problem is to use two RETURN
characters between paragraphs. This separates the paragraphs by putting a blank line
between them. The method of using two RETURN characters between paragraphs is
commonly used in telecommunications because it is easier to read and a single RETURN
character uses less disk storage space than multiple SPACE characters.

Paragraph Format
The Paragraph Format command selectively deletes RETURN characters from a text
selection thus converting it from Line Format to Paragraph Format. After conversion,
RETURN characters are present only at the end of paragraphs, not at the end of each
individual line. Individual lines are “wrapped” at the right margin of the Editor until the end
of the paragraph where they drop to the next line. To convert a selection to Paragraph
Format, select the text and choose Paragraph Format from the Edit menu.
Paragraph Format removes RETURN characters from all lines except where two RETURN
characters occur in succession or where a RETURN is followed by a non-alphabetic character.
Both these conditions are considered end of paragraph indicators. Depending on the
original formatting of the text, it may still be necessary to do some manual formatting after
Paragraph Format is used.

Press OPTION-R for
Reply Format.

Reply Format
A common convention used for referencing text in message replies includes a sample of the
original text along with a designator to indicate the original author. The ProTERM Editor
includes a special conversion routine which reformats the original text and inserts a small
“header” at the start of each line. The header can be up to six characters long and usually
includes a text separator character (such as“ >”). To format text for message reply, select
the original text and chooseReply Format from the Edit menu or press OPTION-R.
When text is converted to reply format, the selection is reformatted by shortening the right
margin and inserting the reply header at the start of each line. Consider the situation where
you want to reply to a post, but unless a question from the original post were associated with
your reply, your comments may seem out of context. Using Reply Format to include a sample
of the original message solves this problem. The following shows how a sample paragraph
would be formatted with a reply header of“ GS>”.

— Example of above text reformatted —

GS> When text is converted to reply format, the selection
GS> is reformatted by shortening the right margin and
GS> inserting the reply header at the start of each
GS> line.
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The concept of “hard-spaces” can also be used to insert leading and trailing SPACE characters
into the Reply Format. “SPACE” characters do not really “take up space” but pressing
OPTION-SPACEBAR will insert a “real” “space” character. Inserting at least one SPACE
character BEFORE the “ >” will prevent replies from being reformatted on systems such as
Delphi, GEnie and CompuServe.

Creative
formatting.

Reply Format can also help with creative formatting. For example, if all but the top line of a
paragraph were selected and then reformatted using several space characters, the finished
product would be a paragraph with a “hanging” indent.
NOTE: A customized Reply Format can be saved as a personal Preference. See the Index:
Preferences; saving personal changes.

Strip Controls
Text files from other sources (such as those downloaded from an IBM PC oriented BBS) may
include unwanted control characters imbedded throughout the file. These are generally
visible as unfamiliar highlighted characters. Since control characters can cause unwanted
problems especially if the document is printed, it is generally desirable to remove them.
Select the text containing the control characters and chooseStrip Controls from the Edit
menu to automatically remove them. To only replace certain control characters, seeFind and
Replace later in this chapter.
Utility
Find
Find Next
Replace

L
G
H

Change Ruler
R
Show Scrollbar
T
Show Special
Z
Selection Size
Paste to Modem Y

A “string ” is a
sequence or phrase
of characters.

The Utility Menu
The Utility menu contains commands for search and replace, changing the Editor width and
toggling other assorted Editor options. All of the commands in the Utility menu are listed
below.

Find
The Find command searches within the current document for a string of characters. The
search can start from the current cursor location or the beginning of the document and the
search string can optionally be made case sensitive. To find a string, chooseFind from the
Utility menu. Enter the search string including spaces, numbers and non-alpha characters. If
upper and lower case do not matter in the search, place a check √
[ ] in the Ignore Case
option. To start the search from the beginning of the document, place a check [√] in Search
from Start. Press the Find button and ProTERM will search for the string. If a match is found,
the matching word is selected (highlighted). Otherwise, an alert messageThe specified text
could not be found in the Editor is displayed. To find the next occurrence of the string, see
Find Next below.

Find Next
The Find Next command finds the next occurrence of the “Find” search string (see above).
The difference between Find and Find Next is, Find Next uses the last search string used by
Find and always searches from the current cursor location. To do a complete search of the
document using Find Next, move the cursor to the beginning of the document prior to using
Find Next. To find the next occurrence of the search string, choose Find Next from the Utility
menu.
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Finding Control Characters
To search for a string containing CONTROL characters, use ProTERM’s CONTROL character
prefix notation using a CARET character as a CONTROL character indicator. For example, to
search for a CONTROL-M, enter “^M” (CARET-M) as the search string. The CARET indicates
the following character should be seen as a CONTROL character. To search for the CARET
character itself, enter “^ ” (CARET followed by SPACE). The SPACE occupies the spot where
the CONTROL character would normally be.

Replace
The Replace command allows one string (set of characters) to be replaced by another. To
replace a string, choose Replace from the Utility menu. All characters including SPACE and
CONTROL characters can be used as search and replace characters. Enter the searchReplace
what? and replace stringsWith what? (each can be up to 20 characters long). While the
search string is mandatory (there must be a text entry in the box), the replace string can
remain blank. Entering a search string and no replace string has the effect of deleting that
string from the document. Like the Find command, Replace allows the search string (upper/
lower) case to be ignored with the option of being able to start searching from the beginning
of the document or the current cursor location.
Replace has two different modes of operation. Press Replace to be prompted prior to the
replacement of each string. Press Repl All (Replace All) to have all the strings replaced
automatically. When Replace is pressed, each occurrence of the search string is displayed in
the document and you are prompted whether or not to replace the string.

Finding and Replacing Spaces
The are many instances where it is desirable to find and replace SPACE characters. However,
doing this is not as easy as it might initially appear. Unlike other characters, when SPACE is
entered in a text field the SPACE character does not actually use a “space.” For example,
choose Find from the Utility menu and enter three SPACE characters for the search string
and press TAB. The search string appears to still be blank. This is because SPACE characters
are normally used as separators between other characters, not as characters themselves.
To solve this problem, ProTERM supports the concept of “hard-spaces” which are SPACE
characters which actually take up “space.” For example, choose Find from the Utility menu
again. However, this time press OPTION-SPACE three times. Three checkerboard characters
will be inserted into the search string. These characters function exactly the same as normal
SPACE characters except they are visible. Hard-spaces can be used within both the Find and
Replace command as well as in the Reply Format string.

COM MAND = OpenApple & OPTION =
Closed-Apple.

Change Ruler

Change Ruler allows the document width and TAB stop locations to be changed throughout
the document. The Editor Ruler width can be changed from a minimum of 20 to a maximum
of 249 characters (columns) wide and TAB stops can be placed anywhere along the Ruler. To
alter the Editor Ruler, choose Change Ruler from the Utility menu and the cursor will move
from the document text onto the Ruler. Use the following keystrokes to change the Ruler:
ARROW keys Move the cursor left or right.
SPACEBAR Toggle TAB stops on or off.
CONTROL-D Decrease the Ruler width.
CONTROL-F Increase the Ruler width.
RETURN Ruler changes are complete.
ESCAPE Cancel Ruler changes.
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Changing the width of the Editor Ruler changes the width of the document. If the document
is transferred as Send ASCII or printed, it is formatted according to the Editor Ruler width.
Dot-commands imbedded within a document override the default Ruler width.
+ --------+
+ --------+
+ --------+
+ --------+
+ --------+
+ --------+
+ --------®
®--------+
+ --------+

Show Scrollbar

The Editor Ruler

The Show Scrollbar command toggles the display of the Scrollbar on the right side of the
Editor window. To toggle the display of the Scrollbar, choose Show Scrollbar from the Utility
menu. When the Scrollbar is visible, the “scroll box” or “thumb” (the little square box with a
dot in the middle) reflects the relative cursor position within the document. Clicking in the
shaded region above or below the scroll box moves the cursor up or down a page (one
screen). Clicking on either of the Scrollbar Arrows moves the cursor up or down a line. Drag
the scroll box to any part within the Scrollbar to position the cursor to a relative part the
document.

A “>” may indicate
a hidden character.

The Apple computer can only display 80 columns (characters) on a line and when the
Scrollbar is visible, it covers two of these columns. As a result, text may extend off the right
edge “under” the Scrollbar. A full 80 column wide document is still allowed, but ProTERM
shows an arrow “ >” pointing at the Scrollbar indicating text extends “under” the Scrollbar
(text beyond the 78th column). These arrows are only indicators and are not part of the text.
The Scrollbar is visible by default. To make the Scrollback invisible by default, turn it off with
the Toggle Scrollbar command and then save the change as a Preference (see Index:
Preferences).

Show Special
The Show Special command toggles a display of characters which are normally invisible in a
document. When Show Special is turned on, the following characters become visible as
noted:
SPACE Shows as a dotted underline character.
TAB Shows as a right facing arrow character.
RETURN Shows as a down-and-left facing arrow character.
The Show Special display is toggled on and off by choosing Show Special from the Utility
menu. The status of Show Special is saved whenever the Preferences are saved (see Index:
Preferences).

Selection Size
Selection Size displays the size of the current selection of text in both lines and bytes
(characters). This is especially useful when preparing text to be sent to a remote host system
which imposes a size restriction on messages. Many remote host systems have message size
limitations either expressed in lines (i.e., 100 lines maximum) or in characters (i.e., 4000
characters maximum). To determine the size of the current selected text, choose Selection
Size from the Utility menu.
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NOTE: Selection Size shows TAB characters as using one byte of memory. However, when
using Send ASCII to send a document to a remote host system, TABs are often expanded to
use up to 8 bytes of memory. See Judging Document Size later in this chapter for more
information.

About the Clipboard
The clipboard is an invisible buffer (special memory area) used by the Cut, Copy and Paste
commands to store small selections of text (approximately 2500 characters or 30 lines). Text
is placed “on the clipboard” when the Cut or Copy commands are used. Text stays on the
clipboard until the next Cut or Copy command at which time the old clipboard contents are
discarded and replaced by the new. Text from the clipboard can be inserted into a document
with the Paste command at any time. Attempts to Cut or Copy a selection larger than the
clipboard’s capacity results in an error message. In such a case, reduce the size of the
selection and try again. The clipboard is not cleared between exiting and entering the Editor.
However, the contents of the clipboard are lost upon quitting ProTERM.

Judging Document Size
The size of a selection as displayed by theSelection Size command or the size of a document
as displayed by the Editor Status Bar is in raw bytes, (actual number of characters used).
When such a file is sent to a remote host system, the size may increase due to “TAB
expansion.” If a remote host system imposes a message size limitation and you routinely use
TAB characters in your documents, it is worth understanding how this expansion works.
A TAB character uses only a single byte (character) of memory in the Editor. However, when
such a document is transferred to a remote system with the Send ASCII command, the TAB
characters are converted to SPACE characters (since most host systems don’t understand
TABs). The amount of expansion is equal to the number of SPACES which a TAB causes text
to be spaced over. For example, assuming there are TABs on every eight character positions,
a TAB in one column turns into eight SPACE characters while a TAB in another column turns
into four SPACE characters. As a result, when a document is transferred with the Send ASCII
command, the TABs would be expanded into their respective SPACE characters increasing
the size of the document. By keeping messages slightly under the maximum message size
limitation, potential problems can be avoided. It is also possible to pre-format a document
(change TABs to SPACEs and other Send ASCII related conversion) prior to sending using the
Print to Disk command (see the Index). After a document has been “processed” (printed to
disk), opening the resulting document in the ProTERM Editor will show the correct and
exact character count on the Status Bar.

Editing Wide Documents
Most text used in telecommunications does not exceed 80 characters per line. This is
convenient because the Apple screen is only 80 characters wide. However, on occasion you
may encounter or even need to compose documents with lines wider than 80 characters.
Fortunately the Editor can handle documents with line widths up to 250 characters through
a technique called “panning.” The idea is, while the Editor can only display 80 characters of
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the document at a time, it is possible to“pan” from side to side, thus changing the view of
the document. Think of the text being stationary with the screen as a “sliding window” which
moves across the text. Panning allows you to place the 80 character wide “editing window”
anywhere along a 249 character line. If text goes “under” the Scrollbar or off the right edge
of the screen, a right facing arrow“ >” at the right edge of the screen “points” to the
“hidden” text.
When the Scrollbar is visible, the effective width of the screen is dropped from 80 characters
to 78 characters (the Scrollbar uses two characters). As a result, when the Scrollbar is visible,
80 character wide documents may also show the“ >” to indicate the end of a line of text
extends “under” the Scrollbar. Choose Show Scrollbar from the Utility menu to toggle the
Scrollbar off and on.
There are two steps involved in working with wide documents. The first is to use theChange
Ruler command to set the Editor Ruler (and thus the document) to the desired width. The
Editor can handle documents from 20 to 250 characters wide. The second step is to decide
whether to use automatic panning. In manual panning mode, it is necessary to press
CONTROL-Q and CONTROL-W to pan the screen left and right (change the view of the
document). As a default mode of operation for the Editor, the screen never pans of its own
accord. In automatic panning mode, the screen is automatically panned so the blinking
cursor is always visible. When the cursor is moved off the visible screen, the screen pans
making the cursor visible again.
The panning mode preference is set by the Preference command in the Misc menu from
Terminal mode (see Index: Preference for more information). By default, “Pan Editor on
Cursor Movement” is set to None. That is, the screen does not pan when the cursor is moved
off the visible screen. If you use documents wider than 80 characters, you may want to set
this parameter toHoriz or All. The Horiz parameter forces panning only after horizontal
cursor movement has moved the cursor off the screen. The All parameter forces panning
anytime the cursor moves off the screen.
The following is an example use of wide documents: Many airline personnel download flight
schedules and bid sheets from an online service. These documents are typically around 135
characters wide. By setting the Editor Ruler to the proper width, these documents can be
viewed in their normal full-width perspective (versus having lines “wrap” at 80 columns). By
sending special codes to the printer to enable condensed printing, the document can even
be printed at full width (see Printing Wide Documents later in this chapter).

Removing Unwanted Rulers
Whenever the Editor saves, prints or sends a document, it checks to see if the document
ruler is “standard” meaning the ruler is 80 characters wide and has TAB stops every 8
characters. If the width or TAB stops are different, then a copy of the ruler in the form of a
Dot-Command is included with the document when it is saved, printed or sent. Normally,
this is not a problem because the Print, Send ASCII, and Open commands all automatically
extract the ruler from the document and use it for formatting. However, if such a document
is saved and then opened using an application other than ProTERM or sent using a file
transfer protocol, the ruler will be present as the first line of the document.
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See example of the
ProTERM Editor
Screen earlier in
this chapter.

.RRL--------|--------|--------|--------|--------|--------|--------|--------|--------R

A Dot-Command Ruler

Don’t Save the Ruler
Some users prefer the ruler to never be saved with a document. This is not normally a good
idea since the reason ProTERM saved the ruler was because it was non-standard (using a
special width or TABs). If a document is saved without a ruler, when it is subsequently
reopened, it is formatted to a width of 80 with TAB stops every 8 characters. If this action is
desired, choose the Preferences command from the Misc menu in Terminal mode. Press the
More button and disable the “Allow Editor to Save Ruler” option. This prevents the Editor
from ever saving the ruler with a document.

Removing a Ruler
This procedure can be used to remove an existing ruler from a document resetting it to a
standard width of 80 with TAB stops every 8 characters:
• Use the New command from the File menu. This removes any text in the Editor and
resets the Ruler to normal.
• Press the RETURN key to insert a single blank line into the Editor. This step is important
because it instructs ProTERM to use a new standard Ruler.
• Choose the Open command from the File menu, select the file needing its ruler
removed and press Open.
• After the file is opened, press COMMAND-1 to move the cursor to the beginning of the
file.
• If the document had a Ruler saved with it, the Ruler will be on the second line of the
Editor. Use the CONTROL-X command twice, once to delete the first (blank) line and
the second time to delete the ruler line and then save the document.
• The Save As window will open and the (new) document must be given a name. The
document can be saved as the same name by just typing it in again.

The Editor Status Bar
The Status Bar is displayed on the second line of the screen anytime the Editor is in use. It
contains simple statistics regarding the current document. The following explains what each
status indicator actually means.
File:

Cursor:

0,

0/

0

Used:

0/

0

Free:

46333

The Editor Status Bar
File:
When a document is opened using the Open command, the filename is displayed in theFile
field. When the Save command is used, the document is saved using this filename. If theFile
field is blank, and the Save command is used, theSave As window opens to enable you to
name the file being saved.
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Cursor:
The cursor position is shown in bytes (characters) using three different measurements:
• The first field is the position of the cursor on its current line in spaces (columns) from
the left margin. More correctly, it shows how many characters are to the left of the
cursor on that line. When the cursor is at the first character position, this field shows
zero (since there are no characters to its left).
• The second field is the line the cursor is on within the document. More correctly, it
measures the number of lines above the cursor. When the cursor is on the first line of
the document, this field shows zero. This field shows a correct line count regardless of
whether each line is wrapped or each line has a RETURN character at the end.
• The third field is the current byte (characters) position within the document. More
correctly, it measures the number of bytes before the cursor. When the cursor is at the
beginning of the document, this field shows zero.

Used:
The Used field displays the total lines and characters (bytes) in the entire document:
• The first field is the total number of lines in the entire document. This field shows a
correct line count regardless of whether each line is wrapped or has a RETURN
character at the end.
• The second field is the total number of characters (bytes) in the entire document.

Free:
The Free field displays the number of characters (bytes) remaining until the Editor is full.
This varies according to the amount of available memory in the computer. See the About
ProTERM command for information on the amount of memory available to the Editor.

Keyboard Commands
The majority of the editing commands are controlled from the keyboard and consist of using
the CONTROL, COMMAND, OPTION and ARROW key sequences. The keyboard commands
are grouped according to function. The Quick Reference Cards also contain a complete
summary of editing commands.

Cursor Movement Commands
The blinking cursor acts as a “pointer” showing where the next editing transaction will take
place. If the cursor is moved to the top or bottom of the screen, the screen scrolls up or
down respectively as the cursor moves further in that respective direction. If the Editor Ruler
is set wider than 80 columns, some text may not be visible on the screen. When this
happens, an arrow “ >” indicates more text is present beyond the right edge of the screen
(see Editing Wide Documents and Scrollbar above for more information). The following
commands change the cursor position:
Left ARROW Move left one character.
Right ARROW Move right one character.
Up ARROW Move up one line.
Down ARROW Move down one line.
COMMAND-Left ARROW Move left one word.
COMMAND-Right ARROW Move right one word.
COMMAND-Up ARROW Move to previous page (scroll up).
COMMAND-Down ARROW Move to next page (scroll down).
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Move to previous page (page up).
Move to next page (page down).
Move to the beginning.
Move to the end of the document.
Place cursor at beginning of current line.
Place cursor at the end of current line.
Move to beginning of the document.
Move to points between beginning and end.
Move to end of the document.
Pan window left (does not move cursor).
Pan window right (does not move cursor).

Moving Within A Line
To move one character in any direction, press the appropriate ARROW key. Moving to the left
at the start of a line places the cursor at the end of the previous line. Moving to the right at
the end of a line places the cursor at the start of the next line. Holding down the COMMAND
key while pressing one of the ARROW keys increases the range of the movement. The Left
and Right ARROWS move backward and forward a word, while the up and down ARROWS
move up and down one page. CONTROL-A and CONTROL-S move to the beginning and end
of the line respectively.

Moving Within The Document
CONTROL-R and CONTROL-T provide a fast way to page through a document. They move up
and down a page just as COMMAND-Up ARROW and COMMAND-Down ARROW do, but they
are very fast because they do not scroll the screen. To move quickly through the document,
hold down the COMMAND key and press “1” through “9”. COMMAND-1 (or CONTROL-B)
moves to the beginning of the text, while COMMAND-9 (or CONTROL-E) moves to the end
of the text. COMMAND-2 thru COMMAND-8 moves to intervals between the top and bottom
of the document.

Inserting Text
As you type, characters are inserted at the cursor location and the cursor advances to the
right. When the cursor reaches the end of a line, you can either press the RETURN key to
force the cursor to the next line, or continue typing and allow the Editor to wrap the text to
the next line. When the Editor wraps a line, the line “breaks” between two words (this is
referred to as “word-wrap”).
CONTROL-G Toggle between Insert and Overstrike mode.
TAB TAB or move to the next TAB stop.
RETURN Move cursor down to next line (mark end of line or paragraph).
CONTROL-P Insert a CONTROL character at the cursor position.
CONTROL-F Insert a space at the cursor position.
CONTROL-D Delete a character at the cursor.
CONTROL-N Insert a RETURN character at the cursor position.

Insert and Overstrike Mode
When entering text from the keyboard, the Editor operates in one of two modes: insert or
overstrike. In insert mode (denoted by a flashing I-beam cursor), new text is inserted to the
right of the existing text. Old text is never deleted or replaced by new text. In overstrike
mode (denoted by a flashing solid block cursor), new text replaces old text as it is typed
over. Overstrike and insert modes toggle by pressing CONTROL-G. Within either mode,
CONTROL-F inserts a blank space at the cursor and CONTROL-D deletes the character at the
cursor.
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The RETURN key works differently in insert mode than in overstrike mode. In the insert
mode, a RETURN character is inserted into the text at the point of the cursor and other text
to the right of the cursor on that line is moved down to the beginning of the next line. In
overstrike mode, the cursor moves to the next line, but a RETURN character is not inserted
and the existing text is not moved. In either mode, press CONTROL-N to insert a RETURN
character at the cursor, but leave the cursor in the same position.

Inserting Control Characters
Since typing CONTROL characters from the keyboard results in issuing commands directly to
the Editor, (instead of inserting the characters), a special method is needed to insert control
characters. For example, pressing CONTROL-A does not insert it into the Editor but rather
moves the cursor to the start of the line (see Cursor Movement Commands above). To insert
a CONTROL character into a document, position the cursor to the desired point and press
CONTROL-P followed by the “letter” of the CONTROL character to insert. For example, to
insert a CONTROL-A into the document, press CONTROL-P followed by A. To insert an
ESCAPE press CONTROL-P followed by “[” (open bracket). The “Null” and “Delete”
characters cannot be embedded in a document.

Deleting Text
The following commands can be used to delete varying amounts of text from a single
character, up to an entire line. To delete more than a line at a time, see theClear and New
commands.
DELETE key
CONTROL-D
CONTROL-V
CONTROL-Y
CONTROL-X

Delete the character left of the cursor.
Delete the character “under” the cursor.
Delete the current word. This command deletes from the position
of the cursor to the end of the word.
Delete from the cursor to the end of the line.
Delete the entire line.

The DELETE key is similar to the Left-ARROW except when it moves left, it deletes the
preceding character. As the character is deleted, the cursor and any text to the right of the
cursor moves left. CONTROL-D deletes the character “under” the cursor. The text to the right
of the cursor moves left to fill the deleted character’s space, but the cursor does not move.

Selecting Text
Since many Editor commands operate on text selections, the ability to select text is very
important. The Editor has several different ways to select text, both using the mouse and
from the keyboard. Selections are displayed as highlighted text and consist of all the
highlighted text contained therein. A selection must be at least one character long and can be
as large as the entire document. After a selection has been highlighted, choose the
appropriate menu command to operate on the selection.

COM MAND-A
selects ALL text.

Selecting Text from The Keyboard
ProTERM supports three different methods of creating selections from the keyboard. The
first and simplest is to choose the Select All command from the Edit Menu. While quick and
easy, it is not always helpful since it always selects the entire document. However, the Select
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All command can be used to select ALL of the text and then while holding the OPTION key
down the ARROW keys can be used to de-select a part of the text (see below).
NOTE: Holding the COMMAND key down during this operation, extends the range of the
ARROW keys.
The second method is to hold down the OPTION key while moving the cursor with any of
the cursor movement commands. The selection extends from the cursor location where the
OPTION key was pressed to the cursor location where the OPTION key is released. To deselect selected text, release the OPTION key and press one of the ARROW keys.
The third method of selecting from the keyboard is to position the cursor to the start of the
selection and use the CONTROL-C command to create an “anchor point.” After creating an
anchor point, use any of the cursor movement commands to highlight the selection in any
direction. The selection extends from the anchor point to the current cursor location. To
toggle the selection off, press CONTROL-C again.

Selecting Text with The Mouse
To select text with the mouse, position the mouse pointer adjacent to the first character of
the text to be selected, click to start the selection, and drag to the last character of the
desired text. As you drag, the selection is highlighted on the screen. When attempting to drag
the pointer off the top or bottom of the screen, ProTERM scrolls the screen making more text
available for selection.
To create large selections with the mouse, move the pointer to the first character of the
desired text and click, positioning the cursor at that point. Next, hold down the OPTION key
and position the Scrollbar to the page of text where the end of the selection should be. Place
the pointer in the text at the end of the desired selection, click and then release the OPTION
key. This technique allows large selections to be created very quickly.

Segmented Loading —
Opening Large Files
Segmented loading
can access huge
documents.
Also see Open: nontext files.

ProTERM is unable to open documents which are larger than the Editor’s memory. However,
through the use of segmented opening, any segment or portion of a large file may be opened
(up to the size of the Editor memory). To use segmented opening, choose View Files from
the File menu, select the file to be opened and press View. View Files initially displays the
first page of the file along with the choices: Next, Prev, Goto, Edit, Done and Cancel. Use the
Next, Prev and Goto buttons to position to the first screen of text which should be loaded
into the Editor. Press the Edit button and enter a number for theNumber of Pages to Copy:
of text to be loaded into the Editor (20 lines is considered one page or “screen”). After
pressing OK, ProTERM opens as much of the text as fits into the Editor. When finished
loading text into the Editor, press Cancel to return the Editor window. After the text has
been edited, it can be saved to a file using the Save As command. By repeatedly using the
View Files command to read a file, save it to a new name, then use View File to position to
the next consecutive part, editing and then saving to the new renamed file and appending to
it, it is possible to open and edit a very large file piece by piece. For more information, see
View Files in The File Menu chapter.
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Editor Command Summary
The following summary lists all the Editor commands divided by subject along with their
COMMAND key equivalents (where applicable).

Opening and Saving Documents
New Clear the Editor. Choose New from the File menu (COMMAND-W – “Close
Window”).
Open Load a document into the Editor. Choose Open from the File menu
(COMMAND-O).
Close Save the current document and clear the Editor. Choose Close from the File
menu (COMMAND-W).
Save Save the current document using the filename in the Status Bar. Choose
Save from the File menu
(COMMAND-S).
Save As Save the current document under a new name. Choose Save As from the File
menu (COMMAND-M).

Cursor Movement Commands
Left ARROW
Right ARROW
Up ARROW
Down ARROW
COMMAND-Left ARROW
COMMAND-Right ARROW
COMMAND-Up ARROW
COMMAND-Down ARROW
CONTROL-R
CONTROL-T
CONTROL-B
CONTROL-E
CONTROL-A
CONTROL-S
COMMAND-1…9

Move left a character.
Move right a character.
Move up a line.
Move down a line.
Move left a word.
Move right a word.
Move to previous page (scroll up).
Move to next page (scroll down).
Move to previous page (page up).
Move to next page (page down).
Move to the beginning of the document.
Move to the end of the document.
Move cursor to beginning of current line.
Move cursor to end of current line.
Position within the document (1=start, 9=end).

Inserting Text
Typing
CONTROL-G
TAB
RETURN
CONTROL-P
CONTROL-F
CONTROL-N

Insert or overstrike text into document.
Toggle between insert and overstrike mode.
Insert TAB and move with the TAB character.
Insert a RETURN character and move to the next line.
Insert a CONTROL character into the text.
Insert a space to the right of the cursor (move text right and away
from cursor).
Insert a RETURN character at the cursor (move lines down and away
from cursor).

Deleting Text
DELETE
CONTROL-D
CONTROL-X

Delete the character left of the cursor.
Delete the character “under” the cursor.
Delete the entire line.
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Delete from the cursor to the end of the line.
Delete the current word.

Text Selection Commands
OPTION
CONTROL-C
Select All
Save
Print
Print Preview
Print to Disk
Send ASCII
Cut
Copy
Clear
Upper Case
Lower Case
Line Format

Hold down to create or extend a selection by using the cursor
movement commands or positioning and clicking the mouse.
Anchor the beginning of a selection.
Select entire document. Choose Select All from the Edit menu
(COMMAND-A).
Save a selection to a file. Choose Save from the File menu
(COMMAND-S) while text is selected.
Print the selection. Choose Print from the File menu (COMMAND-P)
while text is selected.
Preview the selection with formatting. Choose Print Preview from
the File menu (COMMAND-I) while text is selected.
Format the selection and save to disk. Choose Print to Disk from the
File menu (COMMAND-J) while text is selected.
Send the selection to a remote system. Choose Send ASCII from the
File menu (COMMAND-D) while text is selected.
Remove selection and place in clipboard. Choose Cut from the Edit
menu (COMMAND-X) while text is selected.
Copy selection to the clipboard. Choose Copy from the Edit menu
(COMMAND-C) while text is selected.
Remove selection from document. Choose Clear from the Edit
menu while text is selected.
Convert selected text to upper case. Choose Upper Case from the
Edit menu while text is selected.
Convert selected text to lower case. Choose Lower Case from the
Edit menu while text is selected.
Add RETURN characters and convert selected text to lines. Choose
Line Format from the Edit menu while text is selected.

Paragraph
Format Remove RETURN characters and convert selected text to paragraphs.
Choose Paragraph Format from the Edit menu while text is selected.
Reply Format Insert a reply header at the start of selected lines. Choose Reply
Format from the Edit menu while text is selected.
Selection Size Display size of selection. Choose Selection Size from the Utility
menu while text is selected.

Other Commands
Change Ruler

Adjust text width and TAB stops. Choose Change Ruler from the
Utility menu (COMMAND-R).
Display Special Display special characters. Choose Display Special from the Utility
menu (COMMAND-Z).
Toggle Scrollbar Toggle the display of the Scrollbar. Choose Toggle Scrollbar from
the Utility menu (COMMAND-T).
Print Print the document or selection. Choose Print from the File menu
(COMMAND-P).
Print Preview Preview the document or selection. Choose Print Preview from the
File menu (COMMAND-I).
Send ASCII Send the document or selection to remote host. Choose Send ASCII
from the File menu (COMMAND-D).
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Quit Editor Exit Editor back to terminal mode. Choose Quit Editor from the File
menu (COMMAND-Q or ESCAPE).
Find Find a word or phrase. Choose Find from the Utility menu
(COMMAND-L).
Find Next Move to the next match during a find. Choose Find Next from the
Utility menu (COMMAND-G).
Replace Replace a word or phrase with another word or phrase. Choose
Replace from the Utility menu (COMMAND-H).

Printing
“Parameters” =
“ values.”

Printing from the Editor, Scrollback or Print File are all similar operations. In each case, after
selecting the text to print and choosing the appropriate print command, a window of print
parameters is displayed. These parameters control print options such as margins and page
breaks. In addition, ProTERM supports a much more powerful method of print formatting
called Dot-Commands. These allow sophisticated documents to be created and can include
elements such as headers, footers, page numbers and margins. Dot-Commands are described
in depth later in this chapter. To print a document, choose the appropriate print command,
change the following parameters as needed and press Print.

Print Parameters
COM MAND-P
opens the Print
Parameters
window.

Left Margin
The Left Margin parameter controls how many character spaces the text will indent on the
left side of the page when it is printed. A setting of 0 provides no indent at all, while a setting
of 10, indents 10 character positions (one inch at 10 CPI). A setting of 12 indents one inch at
12 CPI.
ProTERM 3.1

2.25K edit

9.50 sbk

9600 baud Offline 10-FEB-96 21:08:10

Print Parameters
Left Margin:

10

Right Margin: 10

Top Margin:

0

Bottom Margin: 10

Page Width: 104
Page Length:

Printer Init String:
√ Interpret Dot Commands
Strip Control Characters: N one
Print

CPI =
Characters Per Inch.

Eject Final Page

66

Print Parameters
Window

Cancel

Right Margin
The Right Margin parameter controls how many character positions are left blank on the
right side of the page when text is printed. A setting of 0 instructs the printer to print all the
way to the right edge, while a setting of 10 leaves 10 character positions blank (one inch at
10 CPI).
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NOTE: How the printer pin-feed guides are positioned right or left affects the margins. Check
the printer’s owner’s manual.

Top Margin
The Top Margin parameter controls the number of lines the paper is advanced (left blank)
from the top of a page. A setting of 0 starts the printing on the first line (at the position of the
print head when printing begins), while a setting of 6 advances the paper 6 lines before
printing. Usually printers advance the paper 1/6" for each line. For such printers, a setting of
6 leaves a top margin of one inch.

Bottom Margin
The Bottom Margin parameter controls the number of lines to be left blank at the bottom of
a page. A setting of 0 prints to the bottom edge of the page, while a setting of 6 typically
leaves a bottom margin of about one inch.

Page Length
The Page Length parameter tells ProTERM the total length of the paper in lines. To calculate
the length of your paper in lines, you must know how many lines your printer prints in one
inch and the length of the paper in inches. Most printers print at 6 LPI (lines per inch) and
standard paper is 11" long. Multiply the LPI value by the paper length. For most applications,
this is: 6 LPI multiplied by 11" for a total of 66 lines.

Continuous Printing (W ithout Page Breaks)
When both the top and bottom margins are set to zero, the printer prints continuously and
does not advance (form feed) over the perforation (page break). When printing begins, the
paper is not advanced. Printing begins at the point where the print head is set. When using
continuous printing, Eject Final Page should be Off (see below).
Top Margin

Page Width
Left Margin

Right Margin

Page Margins as set
by Print Parms
Page Length

Text print area (frame) controlled by
" Margins" in Print Parms Window.

Bottom Margin

Normal Printing (W ith Page Breaks)
Generally, the printer paper is manually advanced five or six lines above the print head
before the printer is turned on. This presets a “header space” which appears on each
successive sheet. Set the Top Margin to 0 and the Bottom Margin to 10 (or something close
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depending on how much white space you like at the top and bottom of each sheet). As the
printer advances the paper and comes to the 56th line (the last printable line), it “form
feeds” the current sheet, skipping over the perforation and resumes printing on the next
sheet. The Bottom Margin controls the space between “the last printable line” and how many
lines you advanced the first sheet of paper when you started. To maintain the “header space”
between print commands, Eject Final Page should be On (see below).
Why does this work? The page length is set at 66 lines (six lines per inch times eleven inches
of paper equals sixty-six lines). With the paper manually advanced five or six lines prior to
printing and the Top Margin set at 0, printing starts at the location of the print head without
advancing any blank lines. Since theBottom Margin is set to 10, ten lines are subtracted
from the 66 available leaving 56 printable lines. When the printer finishes the 56th line, it
advances 10 lines which takes it from the 56th line on the first page to the 5th line on the
second page. From there, the whole process starts over again at line zero.

Sheet Feeder Printing
If your printer has a sheet feeder attached, then both the top and bottom margin parameters
must be set. Normally, they are both set to 6 to allow a one inch top and bottom margin. In
addition,Eject Final Page should be On (see below).

Also see
Embedding
Control
Characters.

Dot-Commands are
powerful formatting commands.

Printer Init String

The Printer Init String is sent to the printer prior to printing a document and can be useful
for enabling or disabling printer options. For example to cause the ImageWriter II to print
slashed zeros, put “^[D^@^A” in the Printer Init String field. The string is entered as
normal text and CONTROL characters use CARET prefix notation (i.e., use“ ^M” for
RETURN). To make an ImageWriter print 17 CPI (135 characters across), enter“^[Q” as a
printer init string. For more information see Printing Wide Documents below.

Interpret Dot-Commands

While the page margins provide one mechanism for formatting, ProTERM also supports DotCommands which provide ways to emphasize text, control justification, print headers and
footers, and much more. ProTERM’s Dot-Commands are a subset of those supported by
AppleWriter II and its “Word Processing Language (WPL).” Unless the document you are
printing contains Dot-Commands created by a word processor other than by ProTERM, this
option should be left on.

Eject Final Page
The Eject Final Page parameter controls whether ProTERM advances a document to the end
of the final page before it stops printing. This option makes the resulting printout easier to
tear-off since it automatically positions the perforation at the tear off point when printing is
finished. Otherwise, you must advance and align the paper manually after each print session.

Strip Control Characters
Some of the text coming from remote host systems contains invisible CONTROL characters.
While these hidden characters do not bother ProTERM, CONTROL characters can send
instructions to a printer and seemingly give it a mind of its own causing weird garbage to be
printed. Often, when a printer starts printing unintelligible characters and going into and out
of “special” print modes, form feeds and more, the cause is hidden CONTROL characters.
When Strip Control Characters is set to All, no CONTROL characters are sent to the printer.
Also see Index: Control; Character; removing.
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Making Print Parameter Changes Permanent
If you have made changes to the printer options and want the changes to remain permanently, print at least one page to see if everything is correct. Then choose the Preferences
command from the Misc menu in Terminal mode (this requires quitting from the Editor or
Scrollback). Press Save in the Preferences window and the most recently used print
parameters (excluding the Init String) are saved as future defaults.

Changing How the Printer Prints
While the print parameters and Dot-Commands provide a way to control how ProTERM
formats text as it is sent to the printer, it is a different issue altogether to control how the
printer prints. For example, while the print parameters control the number of characters and
lines to be printed per page, they cannot control the printing font, the number of characters
per inch, the number of lines per inch, the quality of the printing and many other printer
specific options. Control characters are the language of the printer. All of the enhancements
of the printer such as character size, font, print quality and more can be changed or invoked
with CONTROL characters. ProTERM provides three different methods for sending
CONTROL characters to the printer:
• Printer Init String: Both the Install window and Print Parameters window contain Init
String fields. These strings can be entered using CARET prefix notation (i.e., “^M” is
RETURN) and are sent to the printer prior to any document text.
• Dot-Commands: The “.SC” command allows a string of characters (using CARET prefix
notation) to be sent to the printer. The string is sent at the point in the document
where the “.SC”command is encountered (see Special Characters under DotCommands below).
• Embedded Control Characters: By embedding CONTROL characters directly into a
document it is possible to control the printer (see Inserting Control Characters above).

Printer Control Characters
Your printer manual should have a section which lists the CONTROL character sequences
used to activate the different options available for your printer. For example, the
ImageWriter II Owners Manual lists the sequence “ESCAPE-a-2” as causing the ImageWriter II
to print in near-letter-quality mode. This CONTROL character sequence could be sent to the
printer using any of the three methods listed above:
• Set the Printer Init String to “^[a2” and print the document.
• Insert the Dot-Command “.SC^[a2” as the first line of the document and then print it.
• Move the cursor to the beginning of the document and press CONTROL-P (to insert a
CONTROL character) followed by “[” followed by “a2” and then print the document.
All of these methods work equally well, though some have advantages over others. In
particular, changing the Printer Init String does not require changing the document itself. If
the Print File command is being used, this is the only option available. The “.SC” DotCommand is preferable to embedding CONTROL characters directly into the document
because the “.SC”command knows to send the CONTROL characters directly to the printer
without any formatting. When CONTROL characters are embedded in the text, ProTERM uses
them in calculating formatting requirements and this can cause problems in certain
circumstances.
While the Printer Init String is only sent once each time a document is printed, multiple
“.SC”commands or embedded CONTROL characters can be placed throughout a document.
Each time one of these sequences is encountered, the CONTROL characters are sent to the
printer and the printer can change its operating mode according to the sequence.
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Printing Wide Documents
By instructing the printer to print smaller characters, more characters can be printed on each
line. As discussed above under Changing How the Printer Prints, CONTROL characters are
used to give instructions to the printer. This example deals specifically with the Apple
ImageWriter II printer. If you are using a different printer, consult your printer manual to
find the CONTROL character sequence for condensed mode printing. In the case of an
ImageWriter II, the control sequence for ultra-condensed mode is ESCAPE-Q and results in
17 CPI print. To set ProTERM to print at maximum width using an ImageWriter II printer,
choose one of the Print commands and make the following changes to the Print Parameters
window:
• Change the Left Margin to 0.
• Change the Right Margin to 0.
• Change the Page Width to 140.
• Change the Init String to “^[Q” (CARET followed by an open-bracket followed by an
uppercase Q).
Once these changes have been made, press Print to print the document in ultra-wide mode.
This same technique can also be used to print narrow documents in a larger font if the
printer supports one. Ultimately, the different possibilities for printing are limited by your
printer and your imagination.

Permanent Init String
If you want a special printer initialization string such as the above example to be permanent,
go to the Install text field and place the needed init string (information) in the Printer Init
window. ProTERM will use that info as the default for setting up the printer when you boot it
up, but it can still be changed for small jobs by following the above instructions.

Dot-Commands
ProTERM’s Dot-Commands easily provide a powerful method of performing sophisticated
print formatting. ProTERM prints perfect without Dot-Commands, but they area an
extraordinary tool which can give the user total command over text being transferred or
printed. Placing a Dot-Command on a page, referred to as “embedding” the command,
allows formatting including margins, left, right and center justification, character emphasis,
page numbering, forced form feeds and much more.
Dot-Commands must occur after a RETURN character and the first “dot” must be the first
item on the left margin containing the command. Dot-Commands cannot be preceded by
even a SPACE character. After pressing the RETURN key to establish a new line, they start
with a period (dot) “.”, in the left-most space followed by a two-character alpha command,
any parameters (additional instructions to that command), and a RETURN character to end
the line. Dot-Commands can be chained together (concatenated) on the same line (one
immediately following the other. No other (unrelated) text can be on the same line with a
Dot-Command.

Dot-Commands can
be in UPPER or
lower case.

The seven different Dot-Commands which control page layout:
.LM
Left Margin
.BM
Bottom Margin
.RM
Right Margin
.PM
Paragraph Margin.
.TM
Top Margin
.TL
Top Line (Header)
.BL
Bottom Line (Footer)
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When used in printing, the most important thing to remember about Dot-Commands is, they
operate relative to the margins imposed by the Print Parameters window (see illustrations).
When used to format ASCII transfers or print text files to disk, the margins are generally
imposed by an 80 column screen width (79 characters plus a RETURN character for ASCII
uploads), although they could be set to widths up to 249 characters wide for special
application. Margins set within the Print Parameters window can be considered as a “frame”
of “hard set” values while Dot-Commands should be considered as “soft set” values, that is
they can easily be set within the document to fit the text within the “frame” of the Print
Parameters window. For example, a Left Margin can be specified both in the Print Parameters
window and by the “.LM” Dot-Command in the document, but adjustment of the Left Margin
as specified by a Dot-Command is confined inside of frame of the Left Margin specified in the
Print Parameters window. This rule applies for all the margins.

Page Margin Dot-Commands
.BL///#/ Bottom Line to print (Page Number) Left Justified.
.BL//// Set a Bottom Line Footer.
.BMxxx Bottom Margin is used to change the number of lines between the footer
(if there is one) and the last line of text (the default is 1).
.CJ Center Justify text.
.EP0 Disable printing. Stop printing text until .EP1 command is given.
.EP1 Enable printing.
.FF Form-Feed to next page.
.FFxxx Conditional Form-Feed. Unless xxx number of lines are available from
this command to the end of the page, Form Feed to next page to keep
related text together.
.LIxxx Line spacing: 0=single, 1=double, 2=triple etc..
.LJ Left Justify text.
.LM Set Left Margin to normal (default).
.LMxxx Number of characters from the left edge of the page to the start of the
text (the default is 0).
.LM+xxx Increase Left Margin xxx chars.
.LM-xxx Decrease Left Margin minus xxx chars.
.PIxxx The Page Interval is the total number of lines available on the length of a
page. An 11" page with the normal 6 lines per inch would have 66 lines.
.PLxxx The number of Printed Lines is normally, set to 58 lines. The Top and
Bottom Margins (where page numbers and such are printed) each take
one line, leaving 56 lines of actual printed text. The “.PL” parameter must
always be smaller than the “.PI” parameter. The additional lines (8 on a
normal page) are those which skip over the perforation to make the
space between the bottom page and top page margin.
.PMxxx Number of characters (positive or negative) from the left margin to the
start of the text on the first line of a paragraph; this parameter can be
used to create either indented or hanging paragraphs (the default is 0 or
just .PM).
.PNxxx Set Page Number to a beginning number.
.RJ Right Justify text
.RRxxx Set ruler: New custom Ruler with Left and Right Margin and Tab settings.
.RM Set Right Margin to normal (default).
.RMxxx Number of characters from the left edge of the page to the end of the
text. The default is the page width, minus the Left and Right Margin value
as specified in the Print Parameters window. This usually results in a
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value of 80 characters across the page, which is the screen width of an
the monitor.
.RM+xxx Increase Right Margin xxx chars.
.RM-xxx Decrease Right Margin minus xxx chars.
.SCxxx Send a Special Command (an instruction) to printer or host system.
.TL//// Set a Top-Line header.
.TL//#// Top Line to print (Page Number) Center Justified.
.TMxxx Top Margin is used to change the number of lines between the header (if
there is one) and the first line of text (the default is 1).
.UTxxx Set the Underline Token to xxx.

Take control with
Dot-Commands.

.RM
(Right
Margin)

.LM
(Left
Margin)

.PL
(Printed Lines)
.PI
(Page Interval)

Text print area
controlled by
Dot Commands.

Margin area controlled by Dot Commands.

.TM
(Top
Margin)

Setting Margins With
Dot-Commands

.BM
(Bottom
Margin)
Margin area controlled by " Margins" in Print Parms Widow.

While the “.LM” (Left Margin) and “.RM” (Right Margin) alter margins on different sides of
the page, these measurements are ALWAYS expressed in terms of offsetting the margins from
the left edge of the page. Margins are set in terms of character positions, not inches. For
example, ImageWriter printers normally default to 12 characters per inch (CPI), so think of
measurements in terms of characters (12 characters equal one inch) and to create a Right
Margin, “.RM70” (70 characters to the right of the starting left margin) might be an example,
not “.RM10” as you might think.
As an example of how a Dot-Command works, the command
“.LM10.RM70.PM5” could be included as part of a document and would set the Left
Margin to 10, the Right Margin to 70 (for a print width of 60 characters) and a
Paragraph Margin (indent) of 5, something like the example of this paragraph. When
using Dot-Commands, margins are always measured from the left side of the page
and are effective inside of the margins (see metaphor of “frame” above) set in the
Print Parameters. As a result, if you have left and right margins set to 10 both in the
Print Parameters window (starts counting at the raw edge of the page) and the same
in Dot-Commands (starts counting at the edge of the Left Margin Print Parameter),
the margins are added together resulting in left and right margins of 20 instead of
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10. See the illustration Setting Margins With Dot-Commands for a graphic
representation.
Hanging indents on paragraphs like this example paragraph can be an attractive way to
present lists of information. To create a hanging paragraph with ProTERM, use the
sequence “.lm5.pm-5” (any number can be substituted in place of 5). This causes the
first line of a paragraph to be flush with the left side of the page, while subsequent
paragraph lines are indented. Use “.lm.pm” below the paragraph to disable the set
(embedded) command, and set it back to default (using a Dot-Command without a
number “.lm” is the same command as “.lm0”).
The math of the defaulted page setup looks like this. There are eleven lines on the page and
at six lines per inch, 66 lines are available. Of the 58 designated lines for use in the body of
the text, 2 are set aside for TL and BL headers (one each for Top Line and one for Bottom
Line). The remaining 8 lines are divided between spacing from the Bottom Line (a space held
to be used for footers such as Page Numbers) of the page and the Top Line (a space held
which can be used for headers such as Page Numbers) of the next page.

Page Breaks
To force ProTERM to begin printing on a new (the next) page, use the “.FF” command.
Regardless of the current position on the page, ProTERM skips down, prints the footer (if
there is one), advances to the next page and resumes printing. By specifying a value after the
Form Feed command, e.g., “.FF12”, ProTERM conditionally breaks the page depending
whether there are 12 lines left on the page. If less than 12 lines (in this example) remain on
the page than were specified following the “.FF12”, ProTERM advances to a new page.
Example of a conditional Form Feed Dot-Command:
.FF Advance to a new page and continue printing.
.FF7 If there are less than 7 lines remaining on the page, advance to a
new page.
NOTE: A conditional form-feed command is normally placed prior to a paragraph which
should not be broken up. To keep a paragraph unbroken, precede it with “.FFxxx” where
“xxx” is the number of lines in the paragraph. Instead of breaking up the paragraph, it is
printed in its entirety on the next page.

Line Spacing
The “.LI” line interval (line spacing) command controls whether text is printed single,
double, triple, or quad spaced. By default, ProTERM prints text single-spaced. The line
interval is set with “.LIxxx”.
.LI0 Single Space all subsequent text.
.LI1 Double Space all subsequent text.
.LI2 Triple Space all subsequent text.
.LI3 Quad Space all subsequent text.
.LI4, .LI5, .LI6, etc..

Justification
ProTERM supports three types of justification:
• Left justification, the most common and considered “normal” forces all lines flush along
the left margin and ragged on the right.
• Right justification forces all lines flush along the right margin and ragged along the left.
• Center justification forces lines to be centered between the left and right margins.
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.LJ
.RJ
.CJ

Left Justify all subsequent text.
Right Justify all subsequent text.
Center Justify all subsequent text.

Text Emphasis
Besides being able to print normal text, ProTERM can also underline and double-strike text
as well. This is done by defining a “token” and marking all text to be emphasized by that
token. By default, neither the underline nor double-strike token is defined.
.UT\ Underline text which is surrounded by backslash characters. The
sentence, “This is an \underline\ test” would print as “This is an
underline test.”
.UT There is no underline token. The backslash can now be used as a
normal character.
.DT~ Bold print (Double-strike) text which is surrounded by the TILDE
[~] character. The sentence, “This is a ~bold~ test” would print
as “This is a bold test.”
.DT Bold print token off. The tilde can now be used as a normal
character.

Headers, Footers and Page Numbers
ProTERM allows a header and/or a footer to be printed on each page. A header is printed as
the top line of a page, and a footer is printed as the bottom of a page. These lines of
information can contain text related to the overall document or information specific to the
page such as the page number. The actual position of the lines on the page is determined by
the page margins (see above). The header and footer text is entered as part of a line divided
into three-fields: Left, Center and Right. The placement of the text on the header or footer
line is determined by what field the text is placed in. The fields are divided by using a slash
character “/” as a delineator (see the examples below). If the pound-sign “#” is used as part
of the text, it is replaced by the current page number when printed.
.TL/xxx/// Print the header “xxx” left-justified.
.TL//xxx// Print the header “xxx” center-justified.
.TL///xxx/ Print the header “xxx” right-justified.
.BL//#// Print the page number as the footer, center-justified.
NOTE: The header and footer accept only a single string. If text is placed in more than one
field, only the first field encountered is formatted and printed.

Page Numbering
To start page numbering from other than 1 (or change the current page number), enter the
Dot-Command “.PN” followed by the number of the next page. For example, to number the
next following page as page 6, insert the Dot-Command “.PN5” in the current page.
.PN5 Give the current page the number 5.

Disabling Printing
There are times when it is desirable to disable a portion of a document from printing. To
support this, there is a “.EP” or “.EP0” (enable printing) Dot-Command which can be placed
around a block of text to prevent it from printing. When printing is disabled, ProTERM scans
the document until it encounters the Dot-Command “.EP1” which resumes printing.
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.EP0 Keep scanning the document for printable text, but do not print
until “.EP1” is encountered.
.EP1 Continue to print text as normal.

Changing TAB Stops
When a document is printed or sent via ASCII from the Editor, the Dot-Command module
interprets the width and TAB stop locations within the Editor Ruler settings for that
document. Although this can be changed in the Print Parameters or Send ASCII windows,
normal settings allow the Dot-Command module to use this information for determining
formate width and where TAB stop locations. This is why documents are formatted the same
whether they are printed or sent via Send ASCII.
It is also possible to change TAB stop locations within a document (as well as the left and
right margins) by including a “.RR” Dot-Command followed by a ruler. This Dot-Command
can be embedded in the document as many times as needed to perform multiple TAB stop
changes. After a “.RR” Dot-Command is encountered, all subsequent TAB characters are
formatted according to the ruler. The syntax and format of the “.RR” Dot-Command are:
• The “.RR” Dot-Command.
• The ruler starts with an uppercase “L” which marks the left margin.
• Character spaces are made up of HYPHEN characters “-”.
• TAB stops are made up of VERTICAL BAR characters “|”.
• The ruler ends with an uppercase “R” which marks the right margin.
Each HYPHEN represents a column space, and each VERTICAL BAR represents a TAB stop.
The new width of the document is determined by the number of HYPHEN plus VERTICAL
BAR characters. The ruler can be up to 249 characters wide. Both the leading “L”and
trailing “R” are mandatory in order for the ruler to be processed.
.RRL--------|--------|--------|--------|--------|--------|--------|--------|--------R

An Example .RR Dot-Command
Special Characters
Add Power to Send
ASCII.

Special Characters
While the Dot-Command interpreter provides a powerful formatting system, it is also useful
to have a mechanism to allow output of untouched (“raw”) unformatted text. This procedure
is used to send CONTROL characters to the printer to enable and disable special print
modes, and it is also used to facilitate the Sending of ASCII text to a remote host. The ability
to send CONTROL codes and Dot-Commands to remote host systems within an ASCII file ads
another dimension to ASCII file uploads. The Special Command “.SC” Dot-Command allows
a string of text to be sent directly to a printer or a remote host system without any formatting
or processing by the Dot-Command interpreter. The string can contain CONTROL character
using CARET prefix notation (i.e., “^M” is RETURN).
Example commands for printing:
.SC^[N Print Pica (10 CPI) on an ImageWriter II.
.SC^[Q Print Ultracondensed (17 CPI) on an ImageWriter II.
.SC^[E Print Elite (12 CPI) on an ImageWriter II.
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Example commands to place at the end of a file as a direct command to the host that this is
the end of the file, save it!
.SC^Z Send “CONTROL-Z” (save a message on the Delphi message
boards).
.SC.s^m Send “.s” to save a message for high speed ASCII send on the InTrec
BBS).
.SC.p^m Send “.p” to start prompt “ >” for high speed ASCII send on the
InTrec BBS.
Special Dot-Commands are not needed on the following systems but because this information is covered here and the procedure is the same, they are included here:
*s^m Send “*s” (save a message on GEnie).
/send^m Send “/sen” (save a message on CompuServe EMail).
/post^m Post “/pos” (save a message on CompuServe message boards).

Suggested Further Reading
• At the ProTERM Main menu, press COMMAND-E (Open Apple-E) to open the ProTERM
Editor (a very powerful word processor especially designed for use with telecommunications).
• Temporarily remove other disks from your drives and insert either the 3.5" or the
Program side of the 5.25" ProTERM Master disk into any one of your disk drives.
• Type the following:
/PT3/A60SEC.WORKOUT
…to open this instructional file and load it into the ProTERM Editor. When the file is
loaded and you can see it on the screen, you can remove the ProTERM Master disk from
the drive and replace any disks you had just removed.
• Read through this tutorial file and follow the suggested practice routines for a quick
lesson on how to get the most from ProTERM.
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Scrollback
CHAPTER SIX
From the moment you connect to a remote system, information is displayed on the screen,
and as you work with the remote system, new information causes old information to scroll
off the screen. Some information is important and some is not, but it’s often difficult to tell
which is which without spending a lot of time reading. In addition, after the information
scrolls off the screen, it takes time to request the host system to resend (re-display) the
information. If you’re paying for time online (through access time charges or long-distance
charges), the additional time can be expensive. ProTERM’s scrollback feature allows you to
browse information at your leisure without the costs, or the pressures of thinking you should
hurry and get off line.

Also see Scrollback
in the Tutorial
Chapter.

COM MAND =
Open-Apple
&
OPTION =
Closed-Apple.

Using Scrollback
ProTERM’s scrollback feature is dedicated to “remembering” all information that has scrolled
off the top of the computer screen. You can find out how much scrollback your computer
can store by choosing the About ProTERM command. This displays a line which says,
Scrollback Buffer: xxxK, and tells you that ProTERM can remember up toxxx thousand
characters that scroll off the screen. The information that scrolls off the top of your
computer’s screen accumulates in the computer’s memory banks until the RAM available for
scrollback memory fills up. When the available memory is full, the newest lines “push” the
oldest lines out of scrollback. Any data “pushed out,” is gone, and cannot be recalled.
Scrollback is only temporary electronic (RAM) memory, and quitting ProTERM or losing
power to your system causes the irretrevable loss of the contents of the current scrollback
session.

Entering and Navigating in Scrollback
To enter scrollback, choose Scrollback from the Misc menu, or enter COMMAND+Z or
COMMAND+ARROW from the keyboard. After entering scrollback, the MenuBar changes to
reflect the available scrollback commands, the current screen of scrollback data is displayed,
and a highlighted bar (inverse line) the width of the screen appears. The highlighted bar acts
as a one line cursor and indicates the current position within scrollback. While in scrollback,
all of the data that previously scrolled off the screen is available for review in scrollback. As
noted, the scrollback’s capacity is limited only by RAM memory available to ProTERM.
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Minimum memory of 128K constrains and slows ProTERM, while 256K adds to available
scrollback capacity with the additional benefit of allowing ProTERM to keep more of its
immediate chores in memory minimizing disk access. Up to 8 megabytes of memory can be
used to increase and enhance ProTERM’s scrollback capacity.
File

Edit

Utility

[Scrollback]

10-FEB-96 09:18:56

ProTERM Version 3.1
The very top screen
(first screen) of
Scrollback shows
the ProTERM
introductory screen.

Copyright 1991-1993 by Greg Schaefer
Licensed to ProTech Software, Inc.
Published by InTrec Software, Inc.

Scrollbox

Scrollback Window
Highlighted bar
mouse
pointer

Scrollbar

Viewing Data from The Keyboard
Use the ARROW and NUMBER keys to move the highlighted cursor bar to different points
within the scrollback data. The Left and Right ARROW keys move the bar up or down one
line, while the Up and Down ARROW keys move up or down one page. The NUMBER keys 1
through 9 position the cursor bar to relative points within scrollback. The number 1 key
places the cursor at the beginning, and the number 9 key places the cursor at the end, or
most current screen.

Viewing Data with The Mouse
Scrollback data can be viewed through the use of the mouse pointer and thescrollbar.
Positioning the pointer on either the up or down arrows on the scrollbar and clicking, moves
the highlighted bar up or down one line. By clicking in the “grey area”between either the
top or bottom scrollbar arrows and the “scroll box” (the small square in the scrollbar), the
bar moves up or down one page. Clicking and dragging the scroll box along the length of the
scrollbar moves scrollback relative to the distance of the drag. The top of the scroll bar is
relative to the beginning of the available scrollback and the bottom is the end, most current
(the information that is the current terminal mode display).

Selecting Data
Besides being able to view scrollback, data can also be selected, saved, printed, clipped or
copied to the ProTERM word processor. This is done by creating a selection, and then
choosing a command to operate on the selection. Scrollback displays a selection by
highlighting the data, which makes the screen data reverse from normal. One line is always
selected — The highlighted cursor bar which is normally moved through scrollback is always
a selection of one line. Selection size ranges from a single line to 32000 lines, and can be
created from the keyboard or by clicking and dragging.

Create an anchorpoint to begin
selecting text.

To create a selection of more than one line, an anchor-point must be created and then the
scrollbar is moved. Text is selected starting from an “anchor-point” which is a point in the
text where the selection begins. Pressing and holding the OPTION key, or pressing the
SPACEBAR one time, or pressing CONTROL+C, creates an anchor-point.
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Selecting Data from The Keyboard
• Hold the OPTION key down and press the ARROW keys to create a selection from the
point at which the OPTION key was pressed to the point at which it is released (the
selection is the highlighted text). To deselect the text and continue navigating in
scrollback, press an ARROW or NUMBER key without holding down the OPTION key.
To extend a selection, hold down the OPTION key and use the ARROW keys to continue
selecting data. The Up and Down ARROW keys select one full screen in their respective
direction each time they are pressed. The Left and Right ARROW keys select one line at a
time. Left selects upward and Right selects downward. Holding the ARROW keys down
causes them to repeat their action.
• To select ALL or a proportion of the text, press the NUMBER keys. Pressing 1 in
scrollback moves from the current position to the top or the beginning of scrollback,
and pressing 9 moves from the current position to the bottom or end of scrollback (the
last, or most current screen). Holding the OPTION and COMMAND keys down, and
pressing 1 through 9 selects a proportional range relative to the number pressed. The
lower numbers 1,2,3… selects toward the beginning and higher number 9,8,7… select
toward the end. Try pressing COMMAND+OPTION+number, to get a feel for how the
selecting process works.
• The second method of selecting from the keyboard is to press SPACEBAR or
CONTROL+C both create an “anchor point” in scrollback. After creating an anchor
point, use the ARROW and NUMBER keys to select the desired text. To remove, or
“toggle” the selection off and return to the single highlighted bar, press SPACEBAR or
CONTROL+C.

Selecting Data with The Mouse
To select data with the mouse, position the mouse pointer on the line where a selection is
desired, hold the mouse button down and drag the pointer to the last line of the desired
data. This is referred to as “click-drag.” As you “drag” the mouse, the selection is highlighted
on the screen. Positioning the pointer near the top or bottom of the screen causes the data
to scroll on the screen and continue the selection.
Large selections can be made quickly and easily using the mouse. Move the pointer to the
first line of the selection and click. This places the highlighted bar at the position of the
pointer. Hold the OPTION key down to lock the anchor point, and click at another point in
the text. All lines between the position of the two clicks are selected.
Another selection method is to drag the scroll box while holding the OPTION key down.
To remove a selection, release the OPTION key and click the mouse.
NOTE: It is also possible to select data by using the Find command. See the Find command
below for details.

Scrollback Menu Bar Commands
About ProTERM
Key Function
Screen Saver

When scrollback is entered, the menu bar changes allowing access to scrollback commands.
Although the Apple menu is also available on the status bar while in scrollback, all other
commands are specific to scrollback.
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File
New
O pen
Close
Save As

About ProTERM
O
W
M

Save Selection As
Print Selection

S
P

Q uit Scrollback

Q

Click on the Apple and choose About ProTERM display general information about ProTERM
as well as memory allocation information. One line of the lines shows the amount of memory
allocated to scrollback storage. Press any key, or click the mouse button to exit About
ProTERM. For more information, see the Index: About ProTERM.

File Menu

New
WARNING: The New command clears the current contents of scrollback, and once cleared,
the file is irretrevably gone. If New is issued while off line, scrollback is cleared to a single
blank page. If issued while online, the current terminal mode screen is saved. To save a copy
of the current scrollback to disk as ascrollback file, choose the Save As command prior to
using the New command.

Clear the current
contents of scrollback.

Open
The Open command opens an existing scrollback file from a disk, and replaces the current
scrollback contents displayed on the screen. Using the Open command while online,
appends the current terminal screen to the end of the new loaded scrollback file. The Open
command in scrollback can only open scrollback files that were created in scrollback and
saved in scrollback using the Save As command.

Close
Close saves the current scrollback contents into a file and then clears the current scrollback.
It operates the same as choosing Save As followed by the New command. Close prompts for
a Save As filename. Enter a name and pathname if necessary to save the existing scrollback as
a disk file. For more details on this command see Save As.

Save As
Save As saves the entire scrollback contents as a special file with an SKB file type. This file
can then be reopened as a scrollback file using theOpen command. The file saved is NOT a
text file, but rather a special binary file which preserves all the special mouse-text and inverse
characters which may be part of the scrollback data. To save the current scrollback contents,
choose the Save As command, enter a filename, and pathname if necessary, and press the
Save As button. If the filename already exists, a choice is given: Append to this same file,
Delete the existing file or Cancel. To save the file as another name, choose Cancel, choose
Save As again, and enter an unused filename. To save the file as a text file, see Save Selection
As.

Convert scrollback
to a text file using
Save Selection As...

Save Selection As
Save Selection As is very different than Save or Save As. When selected text is saved, the file is
not saved as a scrollback file SKB filetype (see Save and Save As above), the file is saved as a
text (TXT filetype) or AppleWorks (AWP filetype) file (your preference). To save the current
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selection, select the text in the scrollback file, and choose Save Selection As from the File
menu, enter the filename, select the file type TXT for normal or AWP if you intend to use the
file in AppleWorks, and select the Save As button. If the filename is already in use, the
choices are, Append to the existing file, Delete the existing file, or Cancel the operation. To
save the file as another name, choose Cancel, choose Save As again, and enter an unsused
filename.
Quick Tip! After selecting text in scrollback, use COMMAND+D to paste the text directly to
the Editor.

Quick Tip!
With text selected,
press the RETURN
key for a “ quick”
menu.
Use the ESCAPE key
to exit scrollback.

Print Selection
Print Selection sends the current selected text to the printer. After creating a selection,
choose Print Selection from the File menu, press RETURN, and press the Print button. Press
the ESCAPE key to cancel the operation while printing. For detailed information on print
parameters. See the Index: Printing.

Quit Scrollback
Quit scrollback exits scrollback and returns to terminal mode.
NOTE: The ESCAPE key also exits scrollback and is the same as choosing Quit Scrollback .

Edit Menu

Copy
Edit
Copy

C

Add To Editor

D

COM MAND+D.
Paste text
directly to the
Editor from Scrollback with a keystroke.

Copy places copy the current selection in the clipboard RAM memory. If the selection is too
large, ProTERM displays an alert message that all of the information was not copied. The
clipboard can only contain one item at a time, and subsequent Copy commands replace the
previous clipboard contents. Copy does not require any option or parameter settings or
changes.

Add To Editor
Add To Editor is perhaps one of ProTERM’s most valuable quick and effective power-tool
commands. It copies and pastes the current text selection from scrollback, directly and
invisibly to the Editor with a keystroke. If text already exists in the Editor, new pasted text is
appended to the end of existing text.
If the editor does not have enough space to hold the pasted selection, ProTERM displays an
alert message. Add To Editor does not require any option or parameter settings or changes.
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Utility Menu

Find
Utility
Find
Find Next

L
G

Show Scrollbar

T

Find searches scrollback for a string of text starting from the position of the highlighted
cursor bar. Prior to using Find, the cursor bar must be positioned at the point where the
search should begin.
Searching scrollback using Find:
• Position the highlighted bar to the start of the search area (press the 1 key to search
from the start of scrollback).
• Choose Find from the Utility menu.
• Enter the find parameters to match your needs, and select the Find button.
• Find either locates a matching string of information, or displays an alert message: The
search string could not be found in the scrollback text.
To create a selection using Find:
• Position the highlighted bar to the start of the selection.
• Anchor the selection pressing the SPACEBAR or CONTROL+C.
• Choose Find from the Utility menu.
• Enter the find parameters and press the Find button.
• The selection extends from the anchor point to the location of the found search string.

A search string
means an exact
text mat c h .

Find What?

Enter the text for the search into the Find What field. The search string will match both
normal and highlighted (inverse video) data. Detection of upper and lower case is controlled
by Ignore Case in the Search parameter. Since scrollback works in terms of an entire line at a
time, each occurrence of a search can only include an item which occurs within a single line.
Each character entered in Find What must exactly match a character in the scrollback data
including spacing and punctuation.
NOTE: Whenever using search, it is best to keep search strings as small and unique strings of
text. Longer text strings introduce opportunity for error.

Search for a single
unique word.

Whole Words Only?
Using the Whole Words Only search command is a way of performing a very precise string
search. When Whole Words Only is checked to “On”, scrollback only matches a string if it
occurs as a complete word or string of words within the data. Within the scrollback data, the
string must be surrounded by space(s) or occur at the start or end of a line. For example,
without the Whole Word parameter, a search for “TOM” may find “aTOM“ or “TOMmy” but
when Whole Words Only is used (or if leading and trailing spaces were included in the
search string), the search would find only “TOM” as a “whole word.”

Ignore Case in Search?
When Ignore Case in Search? is checked “On”, the search string will match the data
regardless of the case in which it appears (“a” matches “A”). Otherwise, each character
(upper or lower case) of the string must be an exact match (“a” does not match “A”).

Find Next
Find Next could also be called “Re-Find” since it finds the next occurrence of the string
previously searched for with Find.Find Next does not require any options or parameters. If
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another occurrence of the string is found, Find Next positions the highlighted bar to the line
containing the match. An alert message is displayed when there is no further match.

Toggle (Show) Scrollbar
The Toggle Scrollbar command removes or displays the scrollbar from the right side of the
scrollback display. The scrollbar can be toggled off and on as desired. Since the Scrollbar
hides hides the 78th and 79th colum and some prefer to toggle the scrollbar off by default
and toggle it on when its needed. The current or default state of the scrollbar is one of the
many preferences saved, when the Preferences window is saved (see the Index: Preferences).

Save preferences to
save the scrollbar
setting.

Scrollback Hints
Scrollback is an extraordinarily powerful telecom tool and time-saver when understood. The
following are some suggestions for taking full advantage of ProTERM’s scrollback.

Locating Individual Sessions
If adequate RAM is available, scrollback can be quite large, and although it can be, scrollback
is normally not cleared (removed from RAM) between calls to different systems. When files
are very large locating information from a particular online session can be difficult and time
consumming just to scroll and look. ProTERM places a special header message in scrollback
each time a system is called and this makes finding sessions easy. Use the Find command to
locate this header to position the cursor at the point of the start of a call to a particular
system. A header message which is added to scrollback on each call has the following format:
Connected With: System Name
Connected At: Connect Date Connect Time

Use Find to search for the string “Connected With:”, and quickly locate the start of each
online session. Use Find Next to find the next session.

Minimizing Online Time
To minimize online time, call a system, stay online as briefly as possible, let all incoming
information be captured in scrollback and terminate from the system. After terminating the
call you can read, select, clip, save the entire file or parts of it, paste to the editor, and print
the stored scrollback text at your leisure.
Warning: Scrollback is stored in RAM memory. Do not quit ProTERM or turn off your
computer until you have saved or preserved all or parts of what is important. When you quit
ProTERM, the scrollback text is gone. To save scrollback see Save As above.
We suggest not trying to read or reply to messages when online with the remote system. Use
the host’s commands which show all new messages without pausing. When you have all the
information retrieved, terminate from the system. After terminating, enter scrollback and
browse the material at your leisure. Even when calling systems without online charges (such
as local BBS’s), there are reasons to get your information quickly and sign off, for example, if
the called service is a small system, there may be other users waiting to connect with that
system. Practical consideration and use of your online time can be considered frugal and
courteous.
When the call is finished and you are off line, there is no need to hurry — the pressure is off.
Without time limits and accumulating costs, you can scroll, search and read data at any speed
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you like. You can even use Save As from the File menu to save the entire scrollback file, and
reload it at a later date.
When reading the scrollback file and you encounter information of interest, select the text
and then save or print it.
When you find a message or mail you want to reply to, select it and press COMMAND+D
(see the Edit menu) to copy/paste the text into the ProTERM editor. After adding all of the
“reply” messages to the editor, press ESCAPE to exit scrollback and COMMAND+E from the
ProTERM Main Menu (see the Misc menu) to enter the ProTERM editor.
After the above steps have been completed, the ProTERM editor, will contain all the
messages you pasted directly from scrollback. Use the editor to type your response below
each message. You can use all of ProTERM’s power-formatting commands; margin controls
and even dot commands (see Index: Dot commands). Use the Print Preview command (see
File menu) to see how the reply will look when it is uploaded. When your replies are
completed, press ESCAPE to exit the editor and call online to the system to upload your text.
For more information on sending online messages, see the Index: Send; ASCII.
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Setup For
Incoming Calls
CHAPTER SEVEN
While ProTERM is primarily used for outgoing calls, it can easily accept incoming calls. There
are two supported modes of operation for incoming calls and they are both available from
the “Misc” menu:

Misc
Editor
Scrollback

E
Z

Answer Phone
Unattended U
Macro File
Read Globals
Transfer Stats
Preferences
Install

• The Answer Phone command goes into a manual terminal mode when it connects with
the remote caller.
• The Unattended command is an automatic version of terminal mode which allows the
caller to command ProTERM from a remote location.
Both Answer Phone and the Unattended mode offer methods to change from a voice call to a
data call without terminating the current call. Each topic is described in detail in this chapter.

Answer Phone
I

The Answer Phone command is used to establish a connection with an incoming modem call
and then resume terminal mode where the callers will each be in control of their own
machines in a manual terminal mode where no automation is involved or required.
The Answer Phone terminal mode allows the users on either end to interact with, and
control their individual computers, with both computers acting as local terminals and
remote hosts at the same time. Since both systems are in a direct connect terminal mode,
users communicate by typing messages to one another.

Can’t See Text Typed at Local M onitor
Both users will need to choose Duplex: “Half” from the Online/Parameters menu, because in
terminal mode, what is being typed on the local keyboard will be sent to, and be visible at
the host (called) monitor, but will not be sent to or seen on the local monitor. Half duplex
sends local keyboard input to the host and also echoes the same information at the local
monitor. For more information on half and full duplex and how they work, see the Index:
Duplex.
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Since Answer Phone terminal mode is a manual operation on both ends, the operators
coordinate their file transfer actions via “on-screen chat.” To transfer a file, one operator
must manually set their system up to send a file, and the other operator must manually set
their system up to receive a file. When everything is set, ProTERM detects the requirements
of the file transfer, and begins, completes, and ends the file transfer.

Setup for A nsw er Phone
To set up for an incoming call to be handled in terminal mode, choose Answer Phone from
the Misc menu. The Connect Time: [ 30 ] secs parameter has a default time of 30 seconds
which is usually more than adequate time for a modem to connect with your system. This
time can be changed as needed. Enter the Pathname information, choose the OK button, and
ProTERM sets up the Waiting for Call mode. These and the other parameters in the
Unattended Access window are discussed in detail below. To cancel the Waiting for Call
mode, press the ESCAPE key or choose the Cancel button. Choosing the Answer button will
force the modem to “pick up the phone” (go online) and attempt a connection.
When using the same phone line on a voice call, the Answer Phone feature can be used to
change from a voice to a data call. When both parties are ready to begin the “data call,” they
each choose Answer Phone from the Misc menu, and hang up their phones.

Call-Back or “Secure” Systems
Answer Phone can also be used to provide an additional level of security for some those
systems using a technique referred to as “call-back” or “secure call-back.” When you register
with one of these systems, you are given password information which will act as your
credentials or “key” to the system. Part of this registration process requires you to enter a
phone number where the system can call your modem. To operate this type of system, you
call in, a connection is made and when prompted, you enter your account and password
information. After verifying this information, the call is terminated by the host, and the
secure system then calls back at the predefined telephone number.

Using ProTERM Answer Phone
and a Call-Back System
As soon the call is terminated, choose Answer Phone from the Misc menu. When the remote
system calls back, ProTERM answers the phone, connecta with the system in terminal mode
and is ready for your input.
Although very unusual, some services may need special parameter changes such as an
emulation change, data format change, phone number setup or others when they call back.
If this situation occurs, some changes can be made while online. Open the Online >
Parameters window and make the needed adjustments while connected to the host. For
more detail, see the Index: System and its various sub-listings.

M ake Call-Back a O ne Key O peration
Use a M acro
To create an AutoLogon Macro for use with a call-back system, first use AutoLearn (see the
Index) to create a macro which will automatically enter the account and password information for all future calls. After using AutoLearn to create AutoLogon Macro, go to the System
Macros (see the Index) for that system and add this macro statement to the end of your
AutoLogon macro:
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wh $o { wt 1 } do “MIsc:ANswer”,“[ ]”

This addition to the current logon macro consists of two parts:
• The WH (while) statement waits until the remote system has disconnected from
ProTERM.
• The DO statement “pulls” the Misc menu down, chooses Answer Phone, accepts the
default of OK “[ ]” to wait for the call-back.
See the Index: AutoLearn and AutoLogon Macros for more.

Unattended Access
ProTERM offers the capability of allowing your computer to be used as an automatic remote
system. Users can call this system and exchange information with your computer. Unattended Access is also Unattended Operation since the local operator (you) need not be
present. Certain security precautions may also be used to limit access by the caller.
To set up your system in the Unattended mode, choose Unattended from the Misc menu. Set
up the Unattended window, adding to or changing the parameters (information) needed for
an intended session. Path 1: MUST be filled in with a proper pathname or the operator will
be prompted with the following message:
NOTE: Path 1 must be filled in with a valid ProDOS pathname. Use “/” to give access to all
directories.
See the chapter on ProDOS for information on the use of pathnames.

Restricting Access To The System
A proper ProDOS pathname must be on Path 1. An important factor of using pathnames in
the Unattended mode is the Unattended caller can always go to deeper directories from the
listed pathname, but can never go higher than the listed pathname. For example, if the
pathname was set at /HARDDISK/LETTERS, the caller could access any files within the
“LETTERS” directory or if there were additional directories within the LETTERS directory,
they could be appended (opened) with the Log command (see below). The caller would
have upload and download file transfer privileges within the set pathname. An additional
pathname can be listed on Path 2, and the same rules apply.

Allowing Access To The Entire System
To make all drives on the entire system available to the Unattended caller, a single slash can
be put on one of the lines. This is a kind of “pass-key” to the entire system which allows the
caller to use the Log command to change to any part of any directory (disk) attached to the
system.

Unattended Mode &
Going Online With A Voice Caller
Several commands are available to the remote caller from the host computer (use the “?” for
a help menu), including all of the commands needed to change ProDOS paths if set, and
Send or Receive (transfer) files with various protocols.
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From a Voice Call – To a Data Call
An Added Feature of Unattended —
During a voice phone conversation with an associate, you may find the it convenient to
exchange computer files with the other party. Changing from a voice conversation to a data
exchange is easy if both parties have ProTERM 3. Typically, you would have to terminate the
voice call, setup your respective computer systems, and then call back using your computer
and the modem. ProTERM allows you to convert the present call directly from a voice
conversation call to a data transmission call.
This assumes both parties are using the same phone lines that they will be using for their
modems. To go from a voice call to a data mode, both parties must have modems connected
to the same phone lines being used for the voice call. One caller of this “online” connection
will need to act as the “caller” and the other will act as the “receiver” (also referred to as the
host). As explained below, it’s not important who decides to be which because the
“direction” of the call can be changed during the call allowing either party to be in the
position of the host or the caller after the initial connect.

Making the “Connect”
• First party:
1 Choose Quick Dial from the dial menu.
2 Enter a lone comma,in the System Number text entry field.
3 Press the RETURN key until the Dial button is selected and ready to for action.
• Second party:
1 Choose Unattended mode from the Misc menu.
2 Press TAB to select the fields in the Unattended Access window.
3 All of the fields can be used with the information that is already in them, or changed to
your preference.
4 A Pathname must be set in Path 1: to allow the caller to access the disk or directory they
will be calling for.
5 When the Unattended Window is set up and ready, press TAB or RETURN to select the
OK button and press RETURN to accept the this window and open the Waiting for Call
window.
• First party:
1 Press the RETURN key which presses the Dial button in the Quick Dial window and
hang up the phone.
• Second Party:
1 Hang up the phone when the modem from the first party is heard.
When the modems connect, the change from voice to data mode is complete.

Changing From Caller To
Unattended And Vice Versa
To change ends of the respective host and caller, both operators press the ESCAPE key and
then the party wanting to be the Unattended system, chooses Unattended mode from the
Misc menu. Change the pathnames as necessary and chooseOK. Instead of showing the
Waiting for Call window, ProTERM will be connected with the other commputer in the
“called mode.”

Unattended and Passw ord
If left blank, a password is not required, and the caller will see a terminal window in the
Unattended Command and ready for action. If a password is requested by the host, it will
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have to be entered before the caller can resume use of the Unattended mode. The password
can be typed in by either user.

Unattended Operator and Changing
The Pathname During The Call
Changing the Pathname must be done on the Unattended (host) end of the call, the caller
cannot change the pathnames established by the Unattended operator. To make the change,
press the ESCAPE key and choose Unattended from the Misc menu to get back to the
Unattended window again. Change the pathnames as needed and press the RETURN key to
return to the terminal window.

The Unattended Window Settings
Connect Time
The Connect Time parameter controls the length of time ProTERM will wait for a remote
modem to make the connection after the local modem has gone online (picked up the
phone). A Connect Time between 30 and 40 seconds is usually adequate. Some high speed
modems may require additional time. The time can either be changed to a higher value, or if
the modem is just about to connect, but more time is needed, see the Index: Connect time;
extend countdown.

Inactivity Timeout
The Inactivity Timeout parameter controls the length of inactive time before ProTERM
disconnects the remote user, and resets to the Waiting for Call menu. If the remote caller
does not show input within the specified time, the host computer terminates the call. In
addition, ProTERM cannot always detect when a remote user hangs up, and this timeout acts
as a safety in this instance. The default time of 2 minutes is normally adequate, but the
Inactivity Timeout can be set to a value from 1 to 9 minutes.

For easy fast editing tips and commands within a
text window, see
the Index: Editing,
c ommands and text
window .
The ProTERM Editor
can be used to view
or change the
current contents of
the welcome file.

Password
For obvious security reasons, access to a called host system usually requires a password of
some type. When ProTERM is set to the Unattended mode, the host computer can use the
default password (HELLO), offer a custom password or leave the Password blank, allowing
the caller to call directly in without having to enter a password. Passwords are not casesensitive (i.e., “HELLO” is the same as “hello”) and may be up to 8 characters in length.
Callers are given three chances to enter the correct password before they are disconnected.

Welcome File
The Welcome File is optional. Its purpose is to show your personal announcement to callers
when your computer is set up to receive incoming calls in the Unattended mode. After a
caller connects and enters the correct password, a “Welcome File” (a text file of your own
creation which displays information to the caller) will be displayed if present. If used, the
welcome file must reside in the main ProTERM directory with all of the other “PT3” files, be a
TXT filetype and its filename must be entered into “Welcome File:” field in the Unattended
Access window. A file called PT3.WELCOME is provided with the ProTERM files. You can use
PT3.WELCOME as is, delete it and have no welcome file, use the ProTERM Editor to alter this
file, create a new one to fit your needs, or use other PT3.WELCOME files under other names.
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Personalizing the W elcome File.
The Welcome File name can be any name you choose. You can have several welcoming text
files each with a different name, stored in the PT3 folder and have the file of your choice be
the one which shows during a particular Unattended call setup. To show the file of choice,
enter the name of the chosen file in the Welcome File: text window and the next call will
receive the chosen welcome message. The welcome file name of choice can be saved as the
default name for future calls by saving the Preference window.
After changing the setup of the Unattended Winow, you may want to save the new
configuration and even a different Welcome File: name. For more information, see the Index:
Preferences; saving personal changes.

Take care when
setting up pathnames.

Path
ProTERM can allow the caller to access up to two pathnames on your system, butPath 1:
MUST contain an accurate pathname in order for the Unattended feature to work (see the
Index: ProDOS; about pathnames). The caller may access any files or subdirectories which
reside in either of the pathnames. Specifying a pathname of “/” allows the caller access to all
volumes and subdirectories on your entire system. When a caller first connects with
unattended, ProTERM will set the default directory to the pathname in path1. The
pathname can be changed to the second designated pathname by entering the “L” (Log)
command (see below in this chapter).
NOTE: To select a specific slot/drive combination for use, you can also enter “/slot,drive” as
one or both of the pathnames (i.e., by entering /6,2 as a pathname, the caller will have access
to the contents of slot 6, drive 2 no matter what the disk is named). See the Index:ProDOS;
about pathnames.
Be very careful when allowing others to call into your system in the Unattended mode. If the
pathnames are not set correctly, you may allow access to any and all of the files in your
system. For example, the ProTERM files themselves could be downloaded including sensitive
files such as system numbers and macros with your private passwords to those systems. If
you fill in the pathnames for the exact areas you expect your callers to access, ProTERM’s
Unattended mode is totally secure.

Send Options
The send options parameter controls how files are encoded during protocol sends. If set to
anything but query, the selected mode will be used during all protocol sends. Otherwise,
ProTERM will prompt the caller as to which protocol send mode to use (ProDOS, Binary II or
neither).

Receive Options
The receive options parameter controls how files are decoded during protocol receives.
Normally, this should be set to Binary II to allow automatic decoding of Binary II files. This
does not mean ProTERM will only accept Binary II files. Rather, ProTERM will accept all files,
but will also decode Binary II files. For more information see the Index:Binary II.

Calling into Unattended
Once your modem and the remote modem are connected, ProTERM sends the message
“ProTERM Unattended.” If a password was entered in theUnattended Access Pathname
window, ProTERM gives the user three chances to enter it correctly. If the password is
entered correctly (or none was set), ProTERM displays the optional “Welcome”
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(PT3.WELCOME) file if a PT3.Welcome text file exists in the ProTERM folder, and then the
“Command:” prompt is displayed. At this point, the caller can issue commands to your
“Unattended” system.
If the Preferences window is saved while thePathname text window is changed or blank, the
change will be in effect for future uses of Unattended. See the Index: Preferences.
NOTE: At this point, your entire system could be available to the caller. Be sure you
understand how you have it set up and to whom you have allowed access (see Path above ).

Unattended Commands
In the Unattended mode, the remote user can issue commands from the Command: prompt.
Commands are issued by typing the first letter of the command name followed by pressing
the RETURN key. At any time, the caller may press CONTROL-S to pause the current output
display or CONTROL-C to cancel a command. When data is typed on the host or local
keyboard (the computer being called), the input is the same as if it was typed by the remote
user. The commands listed under “?=Help” are available to the caller while in the
unattended mode:
NOTE: If the local user presses Escape, ProTERM will quit or exit from the Unattended mode
and go into Terminal mode with the remote caller still connected. One user can choose
Unnatended to get back to the automated mode.

?=Help – The Unattended Access Control Menu
Entering a question mark “?” displays the list of the valid unattended commands to the caller:
PT3 Unattended Commands
S = Send
R = Receive
L = Log
D = Dir
C = Chat
V = View
H = Hangup

The Unattended Access Control Menu

NOTE: A often used convention in telecommunications is to show the command’s first letter
shown separated from the rest of the word by a parenthesis “)” for example: C)hat,
D)irectory etc.. Another often used convention is to show an upper case letter as the default,
and a lower case letter as the alternate choice, example: Y/n where Yes would be entered if
either the Y or y key or the RETURN key is pressed. To enter no, the N or n key must be
pressed.

S)end
Begin a file transfer to the caller. See more detail below.

R)eceive
Begin a file transfer from the caller. See more detail below.

L)og
The log command allows the caller to set the current prefix. ProTERM will display the
current pathname and either accept the new path entered or show the available paths. If a
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new path is entered, it will be checked for legality. If the path is legal, the new prefix is set
and displayed; otherwise, the current path is re-displayed.

D)irectory
The directory command displays all of the files in the current directory. The directory display
can be canceled by pressing CONTROL-C.

C)hat
When the caller selects the Chat command, a bell on the local (Unattended) host rings
(beeps) several times when the Chat command is given. To chat with a caller, the user on the
host end can enter the Chat command “C” from the host keyboard and messages can be
typed back and forth between users. Press CONTROL-C from the local keyboard to exit Chat
mode. Also see the Index: Split Screen Chat.

V)ie w
View allows any text file in the current directory to be displayed (and placed into Scrollback).
Press CONTROL-C cancels view.

H)angup
The Hangup command allows the caller to terminate the call. After entering an “H” at the
“Command” prompt, the caller will be asked for verification “Hangup?” and the caller can
reply “Y” and press the RETURN key to terminate the session. ProTERM disconnects the
caller and returns to theWaiting for Call screen.

File Transfer
In The Unattended Mode
Perhaps one of the most difficult concepts to grasp when first starting to use Unattended is
the fact that the caller is in charge of both systems. In order to transfer a file (in either
direction), the caller must first instruct ProTERMUnattended mode to Send or Receive, and
then instruct their own system to do the opposite. For example, you would like a file from an
associate so you call their system which has been set up in the Unattended Mode. After
connecting and entering the password, you choose the Send command, which makes their
system the sender. After entering the transfer protocol and filename if necessary, you must
give the commands to your own system to Receive the file. More specifics on file transfers
follow:

Send
The send command allows one or more files to be sent to the caller. When Send is selected,
the protocol and optionally the send mode, must be specified. All of ProTERM’s protocols
are supported in unattended mode. After specifying the protocol and mode, the file name(s),
must be entered. The following example session is shown from the perspective of a user
calling into ProTERM Unattended to download some files. For all of these commands, the
caller is controlling both systems.
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Example of Unattended Mode:
ProTERM Unattended
Password:

ProTERM does not show the actual password being typed, so the password is not displayed
on the host or the caller’s screen.
This is PT3 Unattended Mode.

At the Command Prompt, select the L for the Log Command
and enter “?” to see a list of available pathnames.
Command (?=Help): ?
(Question mark always shows the Help menu.)
PT3 Unattended Commands
S = Send
R = Receive
L = Log
D = Dir
C = Chat
V = View
H = Hangup
Command (?=Help): D

The Directory command is used to get a list of available files.
Directory
/LETTER.FILES/
(Pathname)

LETTER.GREG
LETTER.JERRY
BALL.GAME.SHK
BIG.FILE.SHKLBR

Free = 185 blocks

TXT
TXT
LBR
13

24
13
21

Command (?=Help): S

(Use the send command to instruct Unattended to send one or more files to the caller.)
(X)modem, (Y)modem, (Z)modem, (K)ermit
Send Protocol: Z

(“Z” is entered to instruct ProTERM Unattended to use the Zmodem file transfer protocol.)
Use (P)roDOS Extensions,
(B)inary II Encoding, or (N)either: B

(If the Send Options are set to “query,” the line shown above prompts the caller to decide
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which mode to use when sending the file. Entering “B” use Binary II encoding. See the
Index: Binary II for other reference.)
Send File(s): LETTER.GREG LETTER.JERRY

(The names of the files to be sent are entered separated with spaces and the line is
terminated when the RETURN key is pressed. When ProTERM Unattended displays the Begin
receiving now message, the caller should should choose Zmodem from the Receive menu.
When the transfer is complete, the Unattended mode will display a newCommand prompt.)
Begin receiving now...

Receive

The Receive command allows one or more files to be received from the caller. AfterReceive
is selected, the protocol must be specified. All ProTERM protocols are supported in
ProTERM’s Unattended operation. The following example session is shown from the
perspective of a user calling ProTERM in the Unattended mode to upload some files. Again,
and as noted above, the caller is controlling both systems.
ProTERM Unattended
Password:

ProTERM does not show the actual password being typed, so the password is not displayed
on the host or the caller’s screen.
Command (?=Help): R

The Receive command is used to tell the ProTERM Unattended mode to Receive one or more
files from the caller.
(X)modem, (Y)modem, (Z)modem, (K)ermit

(The above protocols are offered for selection.)
Receive Protocol: Y

Enter “Y” for Ymodem file transfer protocol.
Begin sending now...

When the Unattended mode displays the “Begin sending now” message, the caller should
choose the protocol from the Send menu.

For more information on file transfers, protocols, and
more, see the
Index: Transfer;
files.

TIP: We recommend Zmodem or Ymodem protocols (in that order) whenever available.
NOTE: For the more experienced. - If only a single file is uploaded using the Xmodem
protocol and the file is not Binary II encoded, ProTERM will prompt the user for a filename
to be entered once the transfer is finished. After the transfer, Unattended displays the
“Command” prompt again.
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Terminal Emulation
CHAPTER EIGHT

What is Emulation?
Terminal emulation refers to ProTERM’s ability to appear to a remote host as a specific type
of “terminal” by emulating (imitating or simulating) the keyboard and display of that
terminal. In this context “emulation” refers to display and command specifications
developed by the manufacturer of the original stand-alone terminal. For example, when DEC
VT-100 emulation is selected, ProTERM communicates with the host terminal by making your
Apple II appear to be a VT-100 terminal using the specifications set forth by the manufacturer
Digital Equipment Corporation.

Using Emulation
To use terminal emulation, select the system to edit. With the Edit System Parms window
open, choose the parameter Emulate (to edit, see Index: pop-up; windows) and choose the
desired emulation. The next time the system is called, ProTERM will automatically begin to
use the specified emulation at the point the emulation is encountered. There are also four
additional parameters which relate to the use of terminal emulation:
• AnswerBack
• Delete key
• Backspace
• Status bar

AnswerBack
Answerback is seldom used, and unless the terminal you call explicitly requests an
AnswerBack code, ignore AnswerBack. Many terminal emulations support an AnswerBack
String which is a string of characters sent to the remote host whenever a special enquire
character is received. Typically the enquire character is a CONTROL-E (though this varies
from emulation to emulation). The information provided by the AnswerBack String will be
specified by the remote host. Enter the required information into the AnswerBack string
field. To send a control character, use the caret-prefix notation (i.e., ^M (caret-M) for the
CONTROL-M notation). See the Index: Control; Character.
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Delete Key
The DELETE key is located in the upper right corner of the keyboard, and is often the
preferred backspace key (used for correcting data entry errors). Some hosts require the
DELETE character (ASCII value 127) to correct errors while others require the BACKSPACE
character (ASCII value 8). When set to Send BS (BACKSPACE) or Send DEL (DELETE),
pressing the DELETE key will send either BACKSPACE or DELETE respectively. When set to
Emulate, the character sent by the DELETE key will be determined by the current terminal
emulation.

COM MAND key =
Open Apple
&
OPTION key
= Closed Apple.

NOTE: Depending on the setting of this value, the DELETE key will send either DELETE or
BACKSPACE. OPTION+DELETE always sends the character which is not sent by DELETE
(i.e., if the DELETE key sends the DELETE character, OPTION + DELETE sends the
BACKSPACE character and vice-versa).

Backspace
The backspace parameter controls whether an incoming backspace character is treated as
destructive (delete) or non-destructive (back-over) to the character left of the cursor.
Normally, an incoming backspace character is treated as non-destructive – It moves the
cursor to the left, but does not change any of the display data. When this parameter is set to
Destruct, an incoming backspace deletes the character under the cursor as the cursor is
moved “onto” it.

Status Bar?
All terminal emulations supported by ProTERM expect to display an 80 column (across) x 24
line (deep) video display. Unfortunately, this is the same size as the Apple II 80 column
screen. As a result, displaying the ProTERM status bar hides the top line of information. The
information under the status bar is not lost, just obscured by the Status Bar. The ability to
use the Status Bar will be determined by whether the remote host normally displays
meaningful information on the top line. If it does, then theStatus Bar should be turned off
so all 24 lines of the display are visible. The parameterStatus Bar in the Edit System Parms
window shows check box with a [√] if the Status Bar is on, and a blank check box if the
Status Bar is off. The SPACEBAR toggles the Status Bar on and off. When the Status Bar is
turned off for a particular emulation, the information on the “normal” MenuBar can be made
visible by holding the COMMAND key down or moving the mouse.

Scrollback Capture
Because Terminal Emulation influences the way in which text is displayed on the local
screen, it also has an effect on how text is captured by Scrollback. Normally, text is captured
by Scrollback as it “scrolls” off the top of the screen. However, in some situations requiring
emulation, scrolling may not take place. Instead, new text is displayed directly on top of the
old (by clearing the screen or repositioning the cursor). In such situations, you may find the
expected information is not captured by Scrollback (when Scrollback is entered you find
none or very little text). To accommodate these systems, the method ProTERM uses to
capture text for Scrollback can be customized.
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Customizing Scrollback Capture
To customize how Scrollback text is captured, it is necessary to add a command to the
AutoLogon macro for the particular host system. The macro command consists of the text
“SET $C=value” where value is explained below. This command works when inserted
anywhere within an AutoLogon macro for the host system. For more information on Macros
see the Index: Macro; AutoLogon. There are five different methods which can be used to
capture Scrollback text. Any combination of the five can be used simultaneously. Each
individual method has a “value” associated with it. The method can be selected by substituting this value into the “SET $C=value” command. To select multiple methods, the values are
added together and placed in the “SET $C=value” command.
For example, ProTERM uses three different methods for capturing Scrollback text by default.
These methods are:
• Capture on Scroll Down” (value 1)
• Capture on Clear to End of Screen” (value 4) and
• Capture on Clear Screen” (value 16).
Adding these values together (1+4+16) gives a total of 21. When ProTERM is operating
normally it is just like having the command “SET $C=21” in the AutoLogon macro for each
host system. The following lists each of the capture methods and the corresponding values.
NOTE: ProTERM 3.0 had a preference called “Capture Lines on Cursor Reposition”. The
effect of this preference can be achieved by adding “SET $C=149” to the AutoLogon macro
of a host system.

Capture on Scroll Down (1)
This is the most common Scrollback capture method and operates by capturing lines that
normally “scroll” off the top of the screen. This method has a value of 1 and it is one of the
default methods used by ProTERM.

Capture on Clear to End of Screen (4)
This method captures text normally erased when a host system sends an emulation code to
clear all text from the cursor position to the end of the screen. This method has a value of 4
and it is one of the default methods used by ProTERM.

Capture on Clear Screen (16)
This method captures text normally erased when a host system sends an emulation code to
clear the screen. This method has a value of 16 and it is one of the default methods used by
ProTERM.

Capture on Clear Line (64)
This method captures text normally erased when a host system sends an emulation code to
clear the line with the cursor. This method has a value of 64. It is useful on some host
systems that never scroll the screen or clear it, but clear each line individually before
displaying new text.
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Capture on Cursor Reposition (128)
This method captures text whenever the cursor is moved to a new line. This method has a
value of 128. It is useful because it captures text from almost any host system. The drawback
of this method is that it often captures more text than is desired.

Keyboard Emulation
The concept of the emulation of keyboards may sound a little complex as you get started, but
the following should help to ease your apprehensions and give an understanding of how it
all works.

The Virtual Keyboard
Keyboard Emulation allows ProTERM to emulate (imitate or simulate) keyboards used by
host terminals which are very unlike Apple computers, but can be imitated by ProTERM with
excellent results.
Many terminals have special “function” or “editing” keys not available to an Apple computer.
When one of these keys are pressed on one of the “real” host keyboards, a series of
programmed events from the host computer are envoked. To produce these keys on the
Apple II, ProTERM uses some creative “keyboard mapping” features to make the main-frame
terminal think it really is connected to another computer just like itself.
There are two general models of the Apple II: The Apple IIe and IIc, (with at least two
versions of each of those between the early and later stages) plus the Apple IIGS. Each model
has a slightly different keyboard, and the IIGS was shipped with at least two differently
configured IIGS keyboards. In addition, the IIGS can utilize the regular IIGS, or the extended
IIGS keyboard of which there are also multiple configurations. Together with the fact that
each host terminal has a different key layout, the combinatino of all of those variables makes
more of keyboard layout combinations than could ever be illustrated. Instead of supplying a
separate catalog of keyboard illustrations, the ProTERM user manual uses the concept of a
“virtual keyboard.”

These illustrations
are NOT pictures of
keyboards, they are
maps showing key
combinations.

The Concept of the Virtual Keyboard
Three Apple II keyboard illustrations are shown below and none of them look like the
keyboard you use on your computer because they are not graphic representations of real
keyboards, they are cross reference maps showing emulated key combinations. That is, each
of the Apple keyboard illustrations show the key or the key combinations needed which
allow that style of keyboard to imitate the needed emulated keys on all of the various hosts
they can imitate.

Finding Your Keyboard
To “read” the map for your Apple computer, first determine which keyboard you are using
by looking at the name captions, not the pictures:
• Apple II (any apple IIe, or IIc) keyboard
• Apple II GS keyboard
• Apple II GS extended keyboard.
As noted above, the keyboard illustrated will NOT “look” like your keyboard, so match the
caption instead of the illustration. Now find the keyboard illustration for the emulation you
want to emulate.
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Finding the Keyboard to Emulate
Each terminal supported emulation includes an illustration (map) of a virtual keyboard
labeled with that terminal’s specific keys. The keys display command specifications
developed by the manufacturer of the original terminal hardware.
To send a specific key command for the terminal to emulate, look at the keyboard illustration for that terminal. Find the name and respective location of the keys needed to make the
terminal perform, and note the key label on that key and its exact position (placement) of
that key on the emulated keyboard map. Now look at the Apple Keyboard map captioned as
the same computer you are using. See the key in that same exact key, and note its label.

Virtual Keyboard Illustrations
Simulated Apple II Keyboard Map
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Apple II Keyboard Mapping
Simulated Apple IIGS Keyboard Map
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Apple IIGS Keyboard Mapping
Simulated Apple IIGS Extended Keyboard Map
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Apple IIGS Extended Keyboard Mapping

Apple II Keyboard Mapping
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As an example, note the DEC VT-100 keyboard shows keys labeled PF1, PF2, PF3 and PF4.
These are the keys which are NOT on the Apple keyboard and will need to be emulated. Now
look at the map of the keyboard captioned as describing your computer and see where those
four “PF” keys are located. Note the keystrokes listed on those keys. For example, the Apple
II keyboard map keys tell you, in order to create the emulation of a VT-100 PF1 key you
would press OPTION-! (actually the keystrokes would be OPTION-SHIFT-1 to get the
OPTION key plus the EXCLAMATION POINT). With DEC VT-100 emulation chosen in the
Edit System Parms window and when connected to a VT-100 host, this key combination
instructs ProTERM to send the exact needed command to the emulated host. Also see the
Index: other function keys.
Unlike the Apple IIgs, the Apple IIe and IIc keyboard have a limited number of keys available
for alternative use. However, there are ways to work around the problem.
One difference is immediately obvious on the IIgs is that it has a number keypad as well as
the number keys set across the top of the keyboard. Less obvious is the fact that the number
keypad keys are wired separately, from the keyboard number keys, and this allows those keys
to take on special functions. There were some Apple IIe computers manufactured with
keypads, but alas, they are wired directly to the number keys along the top of the keyboard,
so they cannot be used like the IIgs keypad keys.
Because the IIgs keypad is a separate set of keys, they can be used for separate emulation
functions without modification, for example, the top number pad keys: Clear, Equals, Slash
and Multiplication, are respectively dedicated as PF-1, PF-2, PF-3 and PF-4 key when using
certain emulations such as VT-100. In addition and less obvious, the IIgs arrow keys are also
wired separately from the keyboard keys. Where an Apple IIe and IIc arrow keys are really
nothing more than a control key modification of four keyboard keys, e.g.: Cnt-H, Cont-J,
Cont-K and Cont-L are used for arrow keys.
Because the IIgs has keys that can be used directly for certain functions, e.g., arrow keys, the
arrow keys are used directly and unmodified. However, because of the limitations of the IIe
and IIc keyboards, it is necessary to use one of several key modifiers to make up the
difference, and achieve the same effect.
Modifier keys (those held down to change the action of another key) available on Apple IIe
and IIc keyboards are the:
• OPTION (Closed-Apple) key
• SHIFT key
• CONTROL key
Certain popular emulations such as VT-100 as set up in ProTERM for the Apple IIe and IIc,
allow arrow keys to become a different key when the OPTION key is held down during their
use. This modification allows the keys to act differently and give direct and desired
interaction with the service being emulated. This key modification allows the user to move a
cursor to react with the emulated interface.
Keys on the Apple II Keyboard Mapping chart showing a caret (^) prefix require the
CONTROL key as part of the key sequence and keys with “opt” prefix require the OPTION
key.
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Apple IIGS Keyboard Mapping
The Apple II GS Keyboard is a little different than the Apple II keyboard because its physical
construction supports ARROW and KEYPAD keys which are wired separately from the other
keys. For example, the numbers on the keypad can be used (mapped) by software differently
than the numbers across the top of the alpha character set. These keys allow some key
combinations without additional keystrokes. The FUNCTION keys require the use of the
OPTION key with the TOP-ROW NUMBER keys. The editing keys require the use of the
OPTION key with the KEYPAD NUMBER keys.

Apple IIGS Extended Keyboard Mapping
The Apple II GS Extended Keyboard supports the ARROW keys, KEYPAD keys, EDITING keys
and FUNCTION keys with only minor modifications. The FUNCTION keys F11 thru F20
require using the OPTION key while pressing F1 thru F10. The three EDITING keys on the
top row also require the OPTION key while pressing the equivalent of the THREE BOTTOM
ROW editing keys.

Printer Emulation
In addtition to offering Display Emulation and Keyboard Emulation, ProTERM also offers
Printer Emulation for those terminals which can utilize a printer. Many terminals have a
printer port attached and include commands to allow the remote host to print data on the
local printer. When applicable, ProTERM emulates these printer codes and allows the remote
system to print data on your local printer.
NOTE: While ProTERM emulates the printer port, it does not emulate the printer codes. If
the remote host wants to invoke special printing features such as underline or double-strike
on the printer, the host must be told what type of printer is being used.

Terminal Emulation
The following, lists the different terminals emulated by ProTERM along with capabilities and
features. Those emulations which include keyboard emulation include a picture of the virtual
keypad mapping. See Keyboard Emulation and The Concept of the Virtual Keyboard (above)
for more information on how to determine which keystrokes produce which terminal inputs.
Each emulation also provides a list of capabilities which are and are not supported.
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ADDS Viewpoint
ADDS Viewpoint
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ADDS Viewpoint Keyboard Emulation
The Viewpoint is manufactured by Applied Digital Data Systems. It consists of an 80x24 video
display, a detached keyboard and a printer port. ProTERM will emulate the display, keyboard
and printer port.
All Viewpoint keys can be emulated with ProTERM. The ~F1…~F3 represents the SHIFTF1…F3 keys. The function keys are located in two different positions for convenience.

ANSI BBS
ANSI BBS
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ANSI BBS Keyboard Emulation
The ANSI BBS emulation models an emulation which has evolved out of the PC Compatible
world of computing. Many bulletin board systems use ANSI BBS emulation as a standard way
of doing display control. ProTERM supports both the display and keyboard emulation.
ProTERM cannot handle color text display since this capability is not supported by the Apple
II hardware.
• Cursor Up
• Cursor Down
• Cursor Left
• Cursor Right
• Cursor Position
• Enquire
• Forward/Reverse Tab
• Beep
• Clear Screen
• Reset
• Insert Char
• Delete Char
• Cursor to Start of Line
• Home Cursor
• Clear to Start of Screen
• Clear to End of Screen
• Clear to Start of Line
• Clear to End of Line
• Clear Line
• Insert Line
• Delete Line
• Scroll Up
• Scroll Down
• Set/Reset Tab Stop
• Clear Character
• Save/Restore Cursor
• Redefine Function Key
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…are all supported by ProTERM. Set Video Mode is processed by ProTERM, but has no effect
(only the 80x24 video mode is supported).
All ANSI BBS keyboard keys which are present on an “AT” style keyboard are emulated by
ProTERM. The emulation also allows custom function key values to be setup by the remote
host.

Control Show
When set to Control Show, ProTERM displays all incoming data in a special format so that all
characters (including control and high-bit) are visible. Normal printable characters (those in
ASCII range 32…127 are displayed as normal characters. Control characters (those in ASCII
range 0…31) are prefixed by the ellipses character “…” and displayed as the corresponding
normal character (ASCII code + 64). High-bit characters are displayed in inverse (those in
ASCII range 128…255).

DEC VT-52
DEC VT-52
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VT-52 Keyboard Mapping
The VT-52 is manufactured by Digital Equipment Corporation. It consists of an 80x24 display
and includes special character graphics and an extended keyboard.
• Cursor Up
• Cursor Down
• Cursor Left
• Cursor Right
• Cursor Position
• Identify Terminal
• Index
• Reverse Index
• Clear to End of Line
• Clear to End of Screen
• Clear Screen
• Home Cursor
• Set/Reset Graphics Mode
…are all supported by ProTERM.
All VT-52 keys can be emulated with ProTERM. The PF1…PF4 keys are present in two
different locations for convenience.
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DEC VT-100
DEC VT-100
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DEC VT-100 Keyboard Mapping
• Cursor Up
• Cursor Down
• Cursor Left, Cursor Right
• Cursor Position
• Cursor Position Report
• Device Attributes
• Identify Terminal
• Save/Restore Cursor
• Set Vertical Margins
• Device Status Report
• Erase in Display
• Erase in Line
• Set/Reset Tab
• Index
• Reverse Index
• Reset
• Select Character Set
• Set Graphics Rendition
• Linefeed/Newline Mode
• Cursor Key Mode
• Origin Mode, Wraparound
• Keypad Mode
…are all supported by ProTERM. Smooth Scrolling Mode, 132 Column Mode and VT-52
Mode are not supported by ProTERM. To use VT-52 Mode, select the VT-52 emulation.
All VT-100 keys can be emulated with ProTERM. The PF1 thru PF4 keys are present in two
different locations for convenience.

Other Function Keys
Real VT-100 terminals only have four function keys labeled PF1…PF4. However, some host
systems require the use of additional function keys (often labeled PF5…PF12 or F5…F12).
These function keys are specific to the individual host system being used. ProTERM cannot
provide direct support for these function keys since they are specific to individual systems.
To send one of these “special” function keys, you need to contact the administrators of the
host system and enquire what ASCII characters are required to activate each function key.
For example, instead of pressing the ProTERM key that represents PF3, you could press
ESCAPE followed by “O” followed by “P”. These are the ASCII characters which makeup the
VT-100 PF3 function key. As mentioned above, the ASCII character sequences used for
PF5…PF12 vary from system to system so ProTERM can provide no translation.
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Let Macros Perform as Function Kyes
System Macros and Global Macros can be used to send specific key combinations (extraordinary or customized function keys) once the key combinations are found. See the Index:
Macro; Global and/or System.

Heathkit H-19
Heathkit H-19
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Heathkit H-19 Keyboard Mapping
The H-19 is a powerful terminal which uses a superset of the DEC VT-52 emulation. While it
does not support a printer port, it has many different display features and commands.
Because it is not an ANSI terminal, it has very short escape sequences which often makes text
display on the H-19 faster than on an ANSI or VT-100 terminal. ProTERM supports the 80x24
display along with the special character graphics.
• Cursor Up
• Cursor Left
• Cursor Position
• Home Cursor
• Index Down
• Clear Screen
• Clear to End of Screen
• Clear to End of Line
• Delete Line
• Identify
• Set Display Mode

• Cursor Down
• Cursor Right
• Report Cursor Position
• Tab, Index Up
• Set/Reset Insert Mode
• Clear to Start of Screen
• Clear to Start of Line
• Clear Line, Insert Line
• Delete Char
• Reset, Save/Restore Cursor
• Set Keypad Mode and
Show/Hide Cursor
…are all supported by ProTERM. While the H-19 has an ANSI mode, ProTERM does not
support this. To use ANSI, select either VT-100 or the ANSI emulation.
All H-19 keys can be emulated with ProTERM. The keypad will function based on emulation
settings from the remote host. The editing keys are always available.
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Lear Siegler ADM-3a/5
ProTERM’s LSI ADM-3a/5 emulation emulates both the ADM-3a and the ADM-5 terminals.
ProTERM supports the 80x24 display, the printer port option and the ADM-5 editing keys.
• Cursor Up
• Cursor Down, Cursor Left
• Cursor Right
• Cursor Position
• Home Cursor
• Index Up
• Index Down
• Clear Screen
• Clear to End of Screen
• Clear to End of Line
• Aux Port On and Aux Port Off
…are all supported by ProTERM.
All ADM-3a/5 keys are supported by ProTERM. The “rubout” key on the ADM is the same as
the ProTERM DELETE key.

No Emulation
When set to No Emulation, ProTERM will use a default “teletype” style emulation (also
known as TTY ). No assumptions will be made with regards to the incoming data. All
printable characters will be displayed, and all other control characters will be suppressed
with the following exceptions:
^M Move to start of next line
^H Backspace one character
^L Clear the screen

ProTERM Special Emulation
ProTERM Special
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ProTERM Special Emulation Keyboard
The ProTERM Special Emulation (also called PSE) was designed to give BBS SysOps an easy
way to take advantage of special programming effects involving graphics and sound which
can be demonstrated to the caller. As a caller, PSE can be used instead of No Emulation. If
the remote system supports PSE, then it will be used. Otherwise, PSE functions just as No
Emulation. There is no harm in selecting it.
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NOTE: If line noise is present, its effects may be amplified by the use of ProTERM Special
Emulation. If there is a problem, PSE can be turned off by using the Emulation menu (see
the Index: Online; Menu).
• Cursor Up
• Cursor Down
• Cursor Left
• Cursor Right
• Cursor Position
• Cursor to Start of Line
• Cursor to End of Line
• Home Cursor
• Enquire
• Repeat Character
• Sound Single Tone
• Sound Dual Tone
• Normal, Inverse
• Mousetext
• Tab
• Delete Character
• Delete Line
• Insert Space
• Insert Line
• Clear Screen
• Clear to End of Screen
• Clear to End of Line
• Bell
…are all supported by ProTERM. ProTERM Special Emulation has no special keyboard
requirements.

ProTERM Special Emulation Programming
Controlling ProTERM Special Emulation consists of sending simple control character
sequences. To allow compatibility with the Datamedia 1500 (the only thing approaching a
standard in the Apple II world) PSE does not use a lead-in character. The following table lists
all of the control codes supported by PSE along with any required parameters:
CONTROL-N Set: inverse off, mousetext off.
CONTROL-O Set: inverse on, mousetext off.
CONTROL-P Set inverse off, mousetext on.
CONTROL-H Move cursor left one character.
CONTROL-U Move cursor right one character.
CONTROL-K Move cursor up one line.
CONTROL-J Move cursor down one line.
CONTROL-I Move cursor to next tab stop (every 8 chars).
CONTROL-A Move cursor to beginning of line.
CONTROL-B Move cursor to end of line.
CONTROL-X Move cursor to upper-left corner.
CONTRO L - ^ [X+32 Y+32]
Position cursor to the X, Y coordinates.
To position the cursor to any position on the screen (X can be 0 to 79, Y can be 0 to 23), just
send the position code followed by the X and Y location, offset by 32. When the X, Y codes
are sent, add 32 to the values to get the proper offset. For example, to position to column
27, line 5, you would send [CONTROL-^ ; %]. The “;” is the ASCII code for 59 (27+32),
and “%” is the ASCII code for 37 (5+32).

ProTERM Special Emulation (Cont:)
CONTROL-D
CONTROL-F
CONTROL-Z
CONTROL-V
CONTROL-Y

Delete current character (under cursor).
Insert space at cursor.
Delete current line.
Insert blank line.
Clear to end of line.
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CONTROL-W
CONTROL-L
CONTROL-E

Clear to end of screen.
Clear the screen (and home cursor).
Inquire if using ProTERM Special Emulation.

When you send out [CONTROL-E] to a caller using ProTERM Special, the caller’s ProTERM
will send back [CONTROL-“]”] (ASCII code 29). This allows a BBS to transparently detect the
use of PSE.
CONTROL-R [character count]
Display character, count times.
This allows a three character code to be used to display multiple characters. For example, to
display a window frame, it is necessary to show the top and bottom borders which are long
lines of the same character (dashes, underlines, etc.). To draw a 64-character line consisting
of equal signs, send [CONTROL-R = @] where “@” is the ASCII code for 64.
CONTROL-G Sound the bell.
CONTROL-T [tone1 CONTROL-A duration]
Sound single-tone for duration.
CONTROL-T [tone1 tone2 duration]
Sound dual-tone for duration.
The tone command has two forms. The first invokes the single-tone generator, which
produces relatively pure tones. The second invokes the dual-tone generator, which produces
some rather interesting sounds. The three parameters, tone1, tone2, and duration, can all
take values from 1 through 127. There is currently no known translation between pitch/
duration values and actual frequencies/times.

Split Screen Chat
ProTERM offers a split screen chat mode where the screen is divided into two parts: one for
incoming data, and one for outgoing data. This is normally used in a situation where you
have several parties “chatting” together in real-time on a large service. You compose all of
your text on the lower screen, while incoming text from the service is shown on the upper
screen. The split screen keeps text from the service from interrupting what you are typing.

Split Screen Chat — Editing
When using Split Screen Chat, the text you type is not sent to the remote system until the
RETURN key is pressed. When the RETURN key is pressed, all of the text visible in the lower
window is sent to the host. This allows you to compose and edit the text before sending it to
the host. Although the host may not be able to accept it, you may enter up to 240 characters
before pressing RETURN.

Split Screen Chat Editing Commands
Left
Right
Up
Down
CONTROL-B
CONTROL-E
CONTROL-A
CONTROL-S
CONTROL-D

Move cursor left one character.
Move cursor right one character.
Move cursor up one line.
Move cursor down one line.
Move cursor to first character of first line.
Move cursor to last character of last line.
Move cursor to first character of current line.
Move cursor to last character of current line.
Delete character under cursor.
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Insert space at cursor location.
Delete character to left of cursor.
Delete all text, move cursor to first character of first line.
Truncate text at current cursor location.

Using the ESCAPE key in the Split Screen Chat Emulation mode will toggle between Chat
Mode and full-screen emulation. So when Split Screen Chat is selected, and the Escape key is
pressed, the screen will toggle between Split-Screen Chat mode and the No Emulation mode.
Split Screen Chat can be applied in different ways. By entering instructions in the
AnswerBack: dialogue box, ProTERM will allow system connect options to be specified. The
following characters can be placed as an AnswerBack string for the following special
applications:
Four functional characters can be used in theAnswerback window:
ASTERISK *
Loggin with Full Screen active mode even though a “$” may be
used in the Answerback window to turn Split Screen Chat on.
Using * alone will start in “No Emulation” mode. Pressing Escape
will toggle into Split-Screen Mode.
DOLLAR $
Allow toggle from full screen to Split Screen Chat mode using the
ESCAPE key. When the $ is used, there will be no echo data locally
when entered in Split-Screen Mode while in half duplex.
QUESTION
?
Used to Show Special Line to assist blind users so that TexttalkerGS can “read” the line and tell the unsighted user they are in Split
Screen Chat.
AMPER & This can assist Delphi Apple users to deal with the 80 character
line so that when the RETURN character is inserted, the line does
not wrap single words to the next line when the last character
falls on the end of the line.
TIP: Try putting an ASTERISK and a DOLLAR "*$" which allows you to log on and be in Full
Screen as you log on. The emulation remains normal (half duplex and full screen) until you
press ESCAPE which toggles you to full duplex and Split Screen Chat mode.
As an example of how this works, place an ASTERISK (*) in theAnswerback: dialogue
window of the system you use to call with an emulation. Try calling one of the online
systems such as CIS, or Delphi with Split Screen Chat chosen and an ASTERISK in the
“Answerback:” window. For a Half Duplex system such as GEnie, use both the * and the $
(their order does not matter). When you connect, you are not in the Split Screen mode, but
pressing the ESCAPE key toggles in and outSplit Screen mode.

Split-Screen Chat M ode – A Navigational Aid
Split Screen Chat mode can be a time saver when calling a host system that is slow to change
prompts between commmands. Pressing the ESCAPE key toggles the screen into the Split
Screen mode and while the system has you on hold waiting to go to the next prompt, you
can type in the next command. When the host system finally reaches the next prompt, just
press the RETURN key to enter your waiting command.

PART TWO — THE MAJOR FEATURES

160

CHAPTER

EIGHT

TeleVideo 910+
TeleVideo 910+

F1

F2

F3

F4

esc

!
1

@
2

#
3

tab
control
shift
caps

Q

W
A

$
4
E

S
Z

F5

%
5
R

D
X
~
`

F6

C

^
6

T
F

F7

&
7
Y

G
V

*
8

U
H

B

F9

F8

(
9
I

J
N

Spacebar

)
0
O

K
M

F0

P
:
;

L
<
,

—
–
{
[

>
.

"
'
?
/

+
=

del
}
]

^H

7

8

9

return

4

5

6

shift

1

2

|
\

0

3
.

entr

Arrow Keys

TeleVideo 910+
The 910+ supports an 80x24 display, arrow and function keys and a printer port.
Cursor Up
• Cursor Down
• Cursor Left
• Home Cursor
• Report Cursor Position
• Vertical Position
• Beep
• Insert Char
• Insert Line
• Clear Screen
• Clear to End of Line
• Display Control Character
• Cursor On/Off
• Printer Control
…are all supported by ProTERM.

Cursor Right
• Position Cursor
• Horizontal Position
• Forward/Reverse Tab
• Set/Clear Tabs
• Delete Char
• Delete Line
• Clear to End of Screen
• Set Display Mode
• Toggle Word-Wrap Mode
• Set Display Mode

All 910+ keys can be emulated with ProTERM. The keys labeled F1…F10 would be invoked
by pressing the Function key and a numeric key on the 910+ keypad.

Installing New Emulations
One of the most flexible aspects of ProTERM is, additional terminal emulations can be
installed independent of ProTERM releases. To install a new emulation, copy the emulation
file (PTE.xx) to the main ProTERM directory. The next time ProTERM is run, the emulation
will be available. No other changes are necessary. Additional emulation files will be made
available through The InTrec BBS, the official support platform for ProTERM.
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Macros
CHAPTER NINE
Macro = A set of
instructions which
operate an
application.

A macro is a small computer program which can be activated within an application
(program) to perform repetitive tasks simply by typing a key combination. A simplified
description of a macro: a set of instructions for your computer, to do many keystrokes by
pressing one, or at least very few keys (which start the macro). For example, when calling a
remote host system, ProTERM can use a logon macro to automatically send account and
password information. Alogon macro or AutoLogon macro is a set of instructions which
informs ProTERM what information to send (the account and password) and when to send it
(after the appropriate prompt is given) when calling a host system.

Macros are part of
ProTERM’s REAL
power.

NOTE: Correct punctuation calls for ending quotes (") to be on the outside of periods,
exclamation marks and question marks as a sentence is ended. However, this chapter deals
with macro language and the use of strings, commands and phrases which are complete as
stated. To separate and set off these command notations when used in the context of
explaining their use or function, they are placed within quotes in the sentence. Since placing
a period or question mark (correctly) within the quoted command could alter the meaning
of the command, the convention of this chapter is to let the quotes fall where they may and
leave the command syntactically correct.
While simplifying its use, Macros greatly increase the use and flexibility of an application by
allowing a user to create custom “commands” and “programs” for individualized needs. A
couple of keystrokes can perform simple tasks like sending a simple string (set) of characters
(such as a name) or even complete complex tasks like calling a remote system at a predetermined time, logging on, reading mail, reading new bulletins and other online chores all
without user intervention. This ability to create macros to perform tasks not envisioned by
the program designer is what makes them so powerful. Macros literally provide the power to
extend the functionality of an application beyond its original design.
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About the ProTERM Macros
ProTERM is equipped with a very complete macro language as well as a tool for automatic
logon macro generation. The macro language includes over 60 different commands and
functions, supports both string and numeric variables and can directly control the user
interface. Users are often wary of macros since they apparently require “programming.”
While its true ProTERM does require programming for complex macros, auto logon macros
used for automatically logging onto a system, plus the management of any redundant task
can easily be created using ProTERM’s AutoLearn command.
Reading about and experimenting with AutoLearn Macros and System Macros will get you
started and make this documentation the most effective for you. Consider using AutoLearn to
generate macros and then customizing them. Run the “PT3.CLOCK” macro file and invoke
some of the “PT3.GLOBAL” macros. Use the ProTERM Editor to open and examine these
files, see how they are written and change them to suit your needs. Work with copies of
these files, add and subtract commands and text phrases, and see what makes them work.
Use the example macros in this chapter to gain further insight on customizing ProTERM to fit
your own needs. ProTERM supports the following three types of macros. Each type is
explained in-depth later in this chapter. Also, we've taken advantage of some unused disk
space on the 3.5" ProTERM disk and have provided some additional macros in a folder
named “Utility.” These and many more macros, examples and a lot of discussion and
assistance is available by calling the InTrec support BBS. See the number on the back of this
manual.

Three General Types of Macros
System Macros

A relatively short macro or set of macros directly associated with a specific host system’s
entry in the Dial menu. These macros are available for use while online with the corresponding system. System macros can be edited by selecting the host’s system entry from the Dial
menu and then pressing the Macro button.

Global Macros
These are short to medium sized macros available for use anytime ProTERM is running.
Global Macros can be edited by opening the file “PT3.GLOBAL” with the ProTERM Editor,
and then changing and saving it to disk and then trying it again. See
Read GLOBAL Macros
below.

Macro File
These are typically medium to large macros designed for a specialized purpose. These
macros reside in individual files and must be run via the Macro File command. Macro Files
can be edited using the ProTERM Editor.

AutoLearn Macro Generator
AutoLearn is a macro generator which creates System Macros automatically (without any
programming on the part of the user). It does this by recording keystrokes during logon to a
remote host system and uses that information to “learn” the logon procedures for that
system. After the keystrokes are recorded, the information is compiled into a macro and the
result is saved. After ProTERM goes through this “learning experience,” subsequent logons to
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that host are automatic. Select the system entry to be called from the Dial menu, press the
Dial button and ProTERM does the rest. All the work of sending account numbers, passwords
and other instructions required for logon is handled automatically. Once created, these
macros can also be customized. If it becomes necessary to create a new logon macro
(possibly because the host system changes, or your needs on the system change and the old
macro no longer does what needs to be done), just use AutoLearn again and it replaces the
existing logon macro.

Creating Macros with AutoLearn
Select a system entry from the Dial menu and press the Macros button from the Edit System
Parms window. When the System Macros window is displayed, change the “Macro to Execute
after Logon:” to Learn and press the Save button. The next time you connect and logon to
that system, ProTERM will be “watching.” When you connect with the system, the message
“AutoLearn Macros On” is displayed at the top of the screen. If it is not, “Macro to Execute
after Logon” was not set to Learn prior to the call.

COM MAND-N
finishes the AutoLogon Macro and
writes it to disk.

After connecting to the system, logon as you normally would. For the best results, type
slowly and deliberately. Certain systems have a delayed echo and typing too fast may confuse
the signals ProTERM is looking for. Be careful to type accurately as AutoLearn is recording
everything you do. If you make a mistake and correct it, both the mistake and correction are
recorded as part of your logon macro. When the logon procedure is completed (the system
is at the point you want it to be after subsequent automatic logon), press COMMAND-N.
AutoLearn processes the information it has recorded and presents the new macro for
approval. Press Save and AutoLearn saves the new macro as part of the corresponding system
entry in the Dial menu. If you made mistakes during the logon process, press Cancel and
repeat the process by calling the system again. Future calls only require choosing the host
system entry from the Dial menu and pressing Dial. Everything else is automatic.
NOTE: When a remote host system is called the first time, the logon procedures are typically
specific to that call because you may be asked some questions to establish your account on
that system. After the initial call, call back a couple of times just to get a feel for how the
logon procedure works. When you are familiar with the logon process, call back with
AutoLearn turned on and the logon procedure can be completed without mistakes.
It is also possible to use AutoLearn to create useful macros for purposes other than logon.
While online with a remote host system, AutoLearn can be used to automate a frequently
used set of keystrokes. To use AutoLearn in this way, choose AutoLearn Macro from the
Online menu. When prompted for the AutoLearn Macro Element, enter the System Macro
line number where the macro should start. Normally, this should be a line not currently
containing any other macro information. If it does, the old information is replaced when
AutoLearn generates the new macro. To check this, chose the system from the Dial list, chose
Macros and note which lines of the system’s macros are being used. If an AutoLogon Macro
has been created, it will use the lines starting with line one and work down a line at a time
until it is complete.
When an AutoLearn Macro is being created, a highlighted bar is displayed towards the top of
the screen indicating AutoLearn is in operation. At that point, perform the online operations
you want to automate. PressCOMMAND-N when the operation is complete, and ProTERM’s
AutoLearn will generate the new macro and display it for approval. Press
Save to save or
Cancel if you are not satisfied. To run the macro, while using that host system, press
COMMAND-x (where “x” is the System Macro line number entered above).
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AutoLearn Examples
The following System Macro sets were created using AutoLearn. The first macro set performs
automatic logon for CompuServe. The second macro set performs automatic logon for
GEnie. The third macro set includes an additional logoff macro generated for GEnie. An
“English translation” of each macro set is provided to give an intuitive feel as to how each
macro operates.
NOTE: Users of half-duplex systems such as GEnie should read through the GEnie example
below which explains how to keep account and password information from being displayed
on half-duplex systems.

CompuServe AutoLogon Macro
COM MAND = Open
Apple & OPTION =
Closed Apple.

k -1: WT 2 PR "^C" WT ": " PR "12345,123^M" WT ": " \
k -2: PR "PASS.WORD^M"
k -3:
k -4:
k -5:
k -6:
k -7:
k -8:
k -9:
k -0:

Translated, this macro set reads:
• Wait 2 seconds (WT 2).
• Send a CONTROL-C (PR "^C").
• Wait for a colon (WT ": ").
• Send the account number followed by RETURN (PR "12345,123^M").
• Wait for a Colon and a Space character (WT":")
• Go to line 2 and continue executing the macro (\).
• Send the password followed by RETURN (PR "PASS.WORD^M").
• The macro terminates because it has run out of instructions.

GEnie AutoLogon Macro
On half-duplex systems such as GEnie, each key pressed on the keyboard is immediately
displayed on the screen. This is known as “local-echo” since ProTERM (which is local)
provides an “echo” (displayed on the screen) for each character sent to GEnie. (See the
Index: Half Duplex for more detail.) Unfortunately, when half-duplex is used, everything
typed at the keyboard (or sent by a macro) is echoed, even if it is sensitive information like
accounts or passwords. Fortunately, it is possible to modify a logon macro so the account
and password information is not displayed.
When AutoLearn generates a macro it uses the “PR” (print) command in order to send data
to a remote host system. On half-duplex systems, the PR command also displays the data on
the local screen. By contrast, the “PR #1” (print without local echo) command sends data to
a remote host system, but does not display the data on the screen. To generate a logon
macro for GEnie which does not display the account and password information, follow the
steps outlined above to create a logon macro using AutoLearn. When COMMAND-N is
pressed and the macro is presented for inspection, press the TAB key to highlight the line of
the macro which contains the PR command which prints (sends) the account number and
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password information. Use the arrow keys to position the cursor following the PR command
and type #1, (pound sign followed by 1 followed by comma). Press the TAB key until the
Save button is highlighted and press the RETURN key.
NOTE: For more information about the PR command and its different options, read about
device channels and PRint.

Change “PR” to “PR
#1” to hide sensitive information on
half-duplex systems.

k -1: WT 2 PR "HHH" WT "=^Q" PR #1,"XXX1234,PASSWORD^M"
k -2:
k -3:
k -4:
k -5:
k -6:
k -7:
k -8:
k -9:
k -0:

Translated, this macro set reads:
• Wait 2 seconds (WT 2).
• Send HHH (PR "HHH").
• Wait for the string “=^Q” (EQUAL followed by CONTROL-Q) (WT "=^Q").
• Send the account/password followed by RETURN without displaying it on the console
(PR #1,"XXX1234,PASSWORD^M").

GEnie Logoff Macro
After a logon macro has been generated, it may be desirable to generate some other simple
macros to aid your navigation of the system. An example of this is a macro which logs off of a
system. While this is trivial in the case of GEnie, it serves to illustrate the point. This macro
was created using the AutoLearn command while online with GEnie. The number “9” was
entered in response to AutoLearn Macro Element. To invoke the logoff macro, press
COMMAND-9 ( k -9). As you begin to see what makes the macros work, you can experiment
by selecting an empty line and write your own.
k -1: WT 2 PR "HHH" WT "=^Q" PR#1,"XXX1234,PASSWORD^M"
k -2:
k -3:
k -4:
k -5:
k -6:
k -7:
k -8:
k -9:PR "bye^M"
k -0:

Translated, this macro set reads:
• Print “BYE” followed by a RETURN character, CONTROL-M (PR "bye^M").

Changing AutoLearn Macros
AutoLearn is not a “type” of macro. Rather, it is a tool for generating System Macros. When
reference is made to an “AutoLearn Macro”, it is really a reference to a System Macro
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generated by AutoLearn. As a result, changing an AutoLearn Macro is the same as changing a
System Macro. See the next section for information on changing System Macros.

System Macros
System Macros are a set of ten individual macros, each up to 63 characters in length. They
may be tailored to suit each system entry in the Dial menu and are generally used for
automatic logon and system specific commands. Each individual System Macro can be
executed from terminal mode by entering COMMAND-x where x is one of the ten numbers
of the macro (there are ten System Macros numbered 1…9 and 0). The System Macros differ
in appearance from other text fields because they have no “wire frames” which are omitted
due to space constraints.

Changing System Macros
Changing a System Macro involves selecting a system entry from the Dial menu and pressing
the Macros button. The System Macros associated with the selected system are then
displayed. They can be edited in the same way other text fields are (see Index:Text; Fields).
When editing is completed, press Save. If a mistake occurs during editing, Cancel exits the
System Macros window without saving any changes.

System Macro Syntax
All the different types of macros (System Macro, Global Macro and Macro File) share a similar
syntax. Each are entered as “free-form” text (spacing does not matter) and commas are
optional (except between numbers). Syntax characteristics common to all the different
macro types are discussed below under Macro Syntax. One item of note with regard to
System Macros is the “\” (backslash) operator. This is used to indicate continuation to the
next line of a macro. When a System Macro is run, each instruction in the line is executed in
sequence until a “\” is encountered or the end of line is reached. When a “\” is encountered,
execution continues at the first instruction on the next line.

Running System Macros
Each individual System Macro can be run from terminal mode by entering COMMANDX
where X is the number of the macro (there are ten System Macros numbered 1…9 and 0).

System Macro Examples
The following System Macro examples illustrate how to logon to SprintNet and Delphi.
Macro element k -9 is an example of an autologoff maccro.

SprintNet Logon Macro (Also see Delphi Login Appendix F)
k -1: WT "0^M^J” PR "@D^M” WT "L=" PR "^M" "^J@" PR "delphi^M"\
k -2: WT ": " PR "youraccountname^M" WT ": " PR "password^M" EX
k -3:
k -4:
k -5:
k -6:
k -7:
k -8:
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k -9: PR "bye^M" WT "in:" DO "O:H","[]" EX
k -0:

Translated, this macro set reads:
• Wait 50/100 (1/2) second and send SPACE D RETURN with 5/100 second delay between
each character (PR 50,5," D^M").
• Wait for “L=” (from the TERMINAL= prompt) from Telenet. If it is not received within
2 seconds, go to the start of line 1 (WT 2,~1,"L=").
• Send “d1” as the terminal identifier (PR "d1^M").
• Wait for a LINEFEED @ prompt (WT "^J@").
• Go to line 2 and continue executing the macro (\).
• Send the name of the service for Telenet to connect with (PR "C service^M").
• Terminate macro execution (EX).

Terminal Server Logon Macro
k -1: SY "^m" WT 2,~1,"resource:" PR "campus.vax^m" \
k -2: WT "login:" PR "greg^m" WT "word:" PR "xxx^m" EX
k -3:
k -4:
k -5:
k -6:
k -7:
k -8:
k -9:
k -0:

Translated, this macro set reads:
• Send a RETURN character (^M) until a response is received from the system (SY
"^M").
• Wait 2 seconds for the string “resource:” to be received. If it is not received, go back to
the start of line 1, otherwise continue executing line 1 (WT 2,~1,"resource:").
• Send the name of the system to be connected to (PR "campus.vax^m").
• Go to line 2 and continue executing the macro (\)
• Wait for “login:” (WT "login:").
• Send an account name of “greg” (PR "greg^m").
• Wait for “word:” (from Password:) (WT "word:").
• Send “xxxx” as a password (PR "xxx^m").
• Terminate macro execution (EX).

Global Macros
Global Macros are a set of resident macros available for use anytime ProTERM is running
(thus the name “Global Macros”). Global Macros are generally used as shortcuts to allow a
single keypress to activate complex ProTERM functions, such as automatically starting a
protocol transfer. Since they are always (globally) resident, Global Macros can be used as a
“macro subroutine library.” Global Macros are activated by holding down the OPTION key
and pressing a letter key. The activation key for each Global Macro is individually definable
among the 26 upper and lower case alpha keys giving a possible 52 Global Macro combinations.
When a Global Macro is running, it executes instruction after instruction until an “EXit”
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command (see Macro Commands below) is encountered. Unlike System Macros, Global
Macros do not stop running when one macro runs into another. If two or more macros in
the Global Macro file are not separated by “EX” commands, the top-most macro can run into
the macro(s) below running the next macro(s) in sequence.

Changing Global Macros
Global Macros are stored in a text file called “PT3.GLOBAL” which resides in the ProTERM
directory (the area of the disk containing the other ProTERM files). On a 5.25" disk it is on
the PROGRAM side of the disk. Since this file is read into memory every time ProTERM is run,
Global Macros are always available for use. The Global Macros file can be edited with the
ProTERM Editor. However, changes made to the Global Macros file do not affect the Global
Macros resident in memory. To make the macros in the changed Global Macros file ready for
use, see Loading Global Macros below.

Loading Global Macros
“PT3.GLOBAL” is the default filename for the set of Global Macros which loads when
ProTERM starts, but it is also possible to load different sets of Global Macros stored under
other filenames. To load a different Global Macro file automatically during startup, name the
file “PT3.GLOBAL.” To load a different set of Global Macros (or if you have edited the current
set and need to update the set currently in memory), choose the Read Globals command
from the Misc menu. Enter the Global Macro filename to be read into the file selection
window and press the Read button. The new Global Macro set replaces the existing Global
Macro set and remains resident until a new set is loaded or ProTERM is restarted. As a
shortcut, one of the default Global Macros automatically reloads the “PT3.GLOBAL” file with
a single keystroke. To run the Global Macro which reloads “PT3.GLOBAL”, press OPTION-Z.
Global Macro Syntax
All the different types of macros (System Macro, Global Macro and Macro File) share a similar
syntax. Each are entered as “free-form” text (spacing does not matter) and commas are
optional (except between numbers). Syntax characteristics common to all the different
macro types are discussed below under Macro Syntax. The most important item to note with
regard to Global Macros is, a macro executes until it reaches an explicit EXit command.
Unlike System Macros which stop executing at the end of a line, Global Macros continue to
execute until an EXit command is encountered.

Running Global Macros
Global Macros are activated by holding down OPTION and pressing a letter. The activating
letter for each Global Macro is individually definable for the 26 upper and lower case alpha
keys giving a possible 52 Global Macro combinations. If there is only one Global Macro using
a certain alpha character, it can be run by press OPTION-letter where letter iseither upper or
lowercase. However, if there are two Global Macros, one using the upper case letter and the
other using the lower case letter, pressing OPTION-letter runs the Global Macro corresponding to the exact case of the letter. For example, if there was a Global Macro “a” but not “A”
(or vice versa), either Option-a or OPTION-A would run that macro.
NOTE: The label of the Global Macro represents how you invoke the Macro. For example,
consider a label “@@x” (where “x” equals any upper or lower case alpha key “a” through
“Z”). Since its possible to use upper and lower case labels in Global Macros, e.g. “@@A”
and “@@a” (respectively) create separate distinct Macro Labels. This makes it possible to
use the 26 lower and 26 upper case letters (called Macro Labels) for a total of 52 different
Global Macros.
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Global Macro Examples
The following examples demonstrate the versatility of the Global Macros. Because they are
always resident and only a keystroke away, Global Macros allow extra functionality to be
added to ProTERM.

Online Toggle Macro
@@T * toggle between offline and online *
SEt $O=128-$O
* $O is online control: <128=offline, >127=online *
EXit

Translated, this macro reads:
• Run macro when OPTION-T is pressed (@@T).
• Set the value of variable $O to 128 minus its old value (SEt $O=128-$O).
• End the macro (EXit).
• Text between “*” are comments and do not affect the way a macro runs.

Reload “PT3.GLOBAL” Macro
@@Z ; reload the pt3.global file
IF ($D),{ DO "File:Quit" }
DO "Misc:Read","<%sPT3.GLOBALS> []",<PAth>
EXit

Translated, this macro reads:
• Run macro when OPTION-Z is pressed (@@Z).
• Text to the right of a “;” and extending to the end of the line are comments and do not
affect the way a macro runs.
• If variable $D (ProTERM area: 0=terminal, 1=editor, 2=scrollback) is not zero,
choose the Quit command from the File menu (IF ($D),{ DO "File:Quit" }).
• Choose the Read Globals command from the Misc menu and pass the ProTERM
pathname followed by the filename PT3.GLOBAL (DO
"Misc:Read","<%sPT3.GLOBALS> []",<PAth>).
• End the macro (EXit).

Default Global Macros
ProTERM includes a default set of Global Macros which perform many useful functions. The
following lists the default Global Macros and the keyboard commands which run them:
OPTION-a:
OPTION-A:
OPTION-C :
OPTION-K :
OPTION-l :
OPTION-L :
OPTION-M :

OPTION-N :

Open a Receive ASCII file under the name “SAVED.FILE”. If the file
already exists, append the new data.
Toggle Receive ASCII “Hold” (On/Off) with a single keypress.
Requires OPTION-a (above) to start the Receive ASCII first.
Run the “PT3.CLOCK” Macro File.
Clear the Editor from terminal mode.
Launch a program called “MY.PROGRAM”.
Launch a different application (bypass ProDOS quit code).
If “PT3.CONVERT” is Present, run it (used to convert an old
ProTERM 2.2 Dialing List to current ProTERM format). NOTE: After
the “PT3.CONVERT” program has been used, this macro may be
removed and “PT3.CONVERT” can be removed from the disk.
Print the Answerback string to the remote system or the ProTERM
Editor. This little macro is useful because it allows the Answerback
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OPTION-p :

OPTION-P :

OPTION-q :

OPTION-r :

OPTION-s :
OPTION-S :

Toggle Online/
Offline.

OPTION-T :

field to be used as a name field. Enter your name or handle
(however you are called on a particular system) into the Answerback
field. Then, press OPTION-N to send that name to the remote
system (from terminal mode) or to insert it into the ProTERM
Editor.
Set the print parms for “Wide-Mode” and print a file from within the
ProTERM Editor. This macro changes the print parms to allow an
ImageWriter printer to print up to 136 characters on one line. Open
the document with the ProTERM Editor and enter OPTION-p
(lower-case p) to print.
Set the print parms for “Wide-Mode” and print a file from disk. This
macro changes the print parms to allow an ImageWriter printer to
print up to 136 characters per line. To use this macro, the AutoSave
pathname should be filled in with a directory name (see Index:
Preferences). Make sure the disk containing “MY.FILE” (this name
can be changed by changing the Global Macro) is online and enter
OPTION-P (upper-case P) to print.
Paste a user’s online name or address from a line in the Editor to
the online prompt. An “address book” file can be kept for often
used names on various systems. It can be named anything
convenient for you, but the name “ADDRESS” will make it rise close
to the top of the file selector when you need to open it with the
Editor. The syntax and form of the user-names and the addresses are
as follows: The identifying name is to the right and the address part
of the line must be to the left and separated by at least 5 (or more)
spaces or a TAB equaling at least 5 spaces. Do not use when
COMMAND-Z (Show Special) is turned on. The file “ADDRESS”
should be formatted something like this example:
InTrec - Tech proterm@intrec.com
InTrec - Sales sales@intrec.com
InTrec - Delphi Tech proterm@intrec.com
InTrec - GEnie Tech proterm@intrec.com
InTrec BBS Jerry 1
When you need a user’s address while online, press COMMAND-E to
goto the ProTERM Editor. Then, move the cursor to the line
containing the user’s name and online address. Once the cursor is
on this line, press OPTION-P to send the address to the remote
system.
Change selected Editor text to Paragraph mode and then select the
Reply Format command. This is useful because text captured from a
remote host system needs to be changed to Paragraph mode prior
to changing to Reply Format so short leftover lines are not
intermixed with longer lines.
Send the text in the Editor to a remote system directly from
Terminal Mode.
Send the text in the Editor to The InTrec BBS using prompted send.
This macro instructs The InTrec BBS to provide prompts by sending
“.P” command, sends the actual text from the Editor and then saves
it by sending “.S”.
Toggle between the online and offline mode. When used in the
online state, the command returns to the Main Menu. When used in
the offline state, the command removes the Main Menu returns to
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the online state (command mode) with an active cursor. Use the
Online Parameters to change the current mode as needed for the
online manipulation.
OPTION-V is a one-key shortcut to view files.
Show the time connected with Mark/Log buttons.
Format a text file and upload it via Xmodem. If you want to use
Xmodem to post a text file to a remote system, use this Global
Macro. It takes the text file and first formats for the remote system
(using Print to Disk). Then, it uses Xmodem to upload the resulting
file.
Reload the current “PT3.GLOBAL” file. Use after making changes to
the “PT3.GLOBAL” file to read the updated file into memory.

Macro Files
Macro Files are macros stored as a text file and provide an efficient method of performing
complex tasks. Because Macro Files are stored in individual text files, they can be highly
specialized. There are no limits on the number of different Macro Files which can be used.
Individual Macro Files have a length limitation (around 8000 characters not counting spaces
and comments) but multiple Macro Files can be “chained” together allowing large macro
systems to be developed. The “8000” character limit may seem small but is somewhat
deceiving. While ProTERM Macro statements such as “PRint” and “REpeat” can be written in
“longhand” making them easier to read, when writing these easy-to-read commands only the
characters “PR” and “RE” are actually counted. In addition, commas, spaces (except between
quotes) and comments are not counted, so when the macro is actually “digested” it ismuch
smaller than it seems.

Changing Macro Files
Macro files are just text files containing macro commands. They can be changed using the
ProTERM Editor or any other text editor.

Macro File Syntax
All the different types of macros (System Macro, Global Macro and Macro File) share a similar
syntax. Each are entered as “free-form” text (spacing does not matter) and commas are
optional (except between numbers). Syntax characteristics common to all the different
macro types are discussed below under Macro Syntax. The most important item to note with
regard to Macro Files is, a macro executes until it reaches an explicit EXit command. Unlike
System Macros which stop executing at the end of a line, Macro Files continue to execute
until an EXit command is reached. To run one macro file from another, refer to the CHain
command below in Macro Commands.

Running Macro Files
To run a Macro File, choose the Macro File command from the Misc menu and select the
name of the Macro File. Execution begins at the first macro command in the file and
continues until an EXit command is reached.
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Macro File Examples
The following examples show two different uses for Macro Files. The first is an automated
Email and bulletin retrieval system for CompuServe. In normal use, a System Macro would
perform automatic logon to CompuServe and would then chain to this Macro File. The
second example is a stand alone macro which displays a digital clock on the screen. While
the clock macro has no real practical value related to telecommunications, it is an interesting
example of the flexibility and power of the ProTERM Macros.

CompuServe Auto-Retrieve Macro
DO "receive:ascii","<CIS.INFO> [] [] [] [] su:1 [] [append] []"
WT "choice",%20,"Mail waiting."
WT "choice" PRint "go mail^M"
WT "choice!" PRint "read all^M"
%%10
WT "enter choice!",%20,"<CR> to continue"
PRint "save^M"
GOto %10
%%20
PRint "go appuser^M"
WT ":>" PRint "rea new^M"
WT ":>" PRint "go apiiven^M"
WT ":>" PRint "rea new^M"
WT ":>"
DO "receive:ascii","[close]"
PRint "bye^M"
EXit

Translated, this macro reads:
• Open a Receive ASCII file of the name CIS.INFO. If it already exists, append the
following to it. (DO "receive:ascii","<CIS.INFO> [] [] [] [] su:1 [] [append]") []. The
“su” selects the Suppress Control Characters option and the “1” puts a [√] checkmark
in that box. The “[]” is the same as pressing the left-most button in the window.
• When logging onto CompuServe, if mail is waiting, it displays the message “You have
Electronic Mail waiting.” Otherwise, the menu of commands is displayed followed by
the prompt “Enter choice!” or “Enter choice number!”. The macro waits for either
“choice” or “mail waiting.” (IF "choice", %20, "Mail waiting."). If “choice” is received,
the macro continues executing at macro label %%20. If “mail waiting” is received, the
macro continues to run on the next line.
• At this point, the macro knows there is mail waiting on CompuServe. It waits for the
“Enter choice number!” prompt (WT "choice") and then sends “go mail” to go to the
mail system (PRint "go mail^m").
• The macro waits for the “Enter choice!” prompt which CompuServe displays within its
mail system (WT "choice!"). After getting the prompt, the macro sends “read all” to tell
CompuServe to display all the mail (PRint "read all^m").
• After CompuServe displays a letter, the prompt “Enter command or <CR> to
continue” is displayed. At this point the caller (the macro in this case) must specify
whether the letter should be saved or deleted. This macro saves letters (print
“save^M”) but could be made to delete them by changing this command to (PRint
“delete^M”). If there are more letters, the next letter is displayed and the cycle
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repeats. However, if this letter is the last one, “Enter choice!” is displayed by CompuServe. To handle these two possibilities, the macro waits for either “choice!” or
“<CR> to continue” (IF "enter choice!" ,%20, "<CR> to continue"). If it gets
“choice!”, it knows there is no more mail and jumps to the label %%20. Otherwise, if
“<CR> to continue” is received, it sends “save” to save the letter (PRint "save^m")
and repeats this cycle (GOto %10).
• After the mail has been read, the macro sends the command to go to one of
CompuServe’s forums (PRint "go appuser^m").
• Wait for a prompt “:>” before sending the next command (WT " :>").
• Tell CompuServe to display the new forum messages (PRint "read new^m").
• Wait for a prompt “:>” before sending the next command (WT " :>").
• Close the Receive ASCII file since all the information has been received (DO
"receive:ascii","[close]").
• Send “bye” to logoff of CompuServe (PRint "bye^m").
• Exit the macro (EXit).
If you decide to use the preceding macro and don’t want the new messages continually
appended to the old ones, replacing the word “[append]” with “[delete]” to cause the file to
be deleted each time. This forces the macro to create a new Receive ASCII file each time the
macro is used. To change the name of the Receive ASCII file or the path where it is saved,
change the macro text “<CIS.INFO>” to the desired pathname such as “</MY.DISK/
COMPUSERVE>” where MY.DISK is the name of the disk to save the file named
COMPUSERVE. If you don’t want to save the text in a file, remove the following lines from the
macro or place a SEMI-COLON “;” in front of each of the following lines:
DO "receive:ascii","<CIS.INFO> [] [] [] [] su:1 [] [append] []"
DO "receive:ascii","[close]"

PT3.CLOCK Macro File

Because of the size of this particular Macro File, its contents are not included within the text
of the manual. You can examine the actual file by using the ProTERM Editor to open the
“PT3.CLOCK” file.

Translated, this macro reads:
• The first part of the macro checks to see if there are enough string variables free for the
macro to run. The number of string variables available for use is inversely proportional
to the size of the Global Macros. The macro asks the user if it is ok to unload
“PT3.GLOBAL” if there are not enough strings available. By removing “PT3.GLOBAL”
from memory while the macro is running, more string space is made available to the
macros.
• The next part sets up string variables with data representing the digits on the screen.
The sequence of numbers used for each digit represent a horizontal line of data:
(1=•__ , 2=__•, 3=•_•, 4= •••)
• The next part sets up numeric variables in an array to represent the horizontal position
on the screen where each digit is displayed.
• Next, the macro loads ProTERM Special Emulation (which is used for the drawing and
sound), clears the screen and draws the dividing colons for the time.
• Next is the loop which reads and displays the time. It starts by comparing the current
time to the previous time displayed on the screen and makes a count of the number of
changed digits. If the time has not changed, the macro loops and checks again.
• By using device channel #4 (output to emulation), the macro sends a code to ProTERM
Special Emulation to make the “click” sound.
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• Then the macro displays the time from right to left (since the right-most digits change
the most frequently). Only the changed digits are re-displayed.
• After the user presses SPACE, the macro quits by resetting the emulation and reloading
“PT3.GLOBAL” if it was previously unloaded due to memory constraints.

Writing a Macro
Writing a macro can be a challenging experience for the first-time user, and like any
challenge, the results are very satisfying for even the most simple macros. The design of the
ProTERM macros allows a great deal of programming flexibility. All of the macros (System,
Global, and Files) use the same commands and obey the same formatting rules. This section
gives some ideas on developing macros. Keep the ProTERM Quick Reference Guides handy
while writing macros as they are valuable resources.

Strategy
Writing a macro is a matter of providing ProTERM with a set of instructions to perform a
particular task. When attempting to write a macro, the first thing to do is to separate and
break the problem into small simple steps, write the steps as a series of notes and then
refine the notes until they are, in effect, the needed macro. For example, a macro to perform
an automatic logon macro for CompuServe might be decomposed into the following steps:
(1) Get the attention of the remote host system.
(2) Send the account information.
(3) Send the password.
This is a reasonable first attempt, but the problem needs to be divided to each occurring
event. Starting with the above steps, the problem can be changed to:
(1a) Announce our presence by sending an attention string to the remote host.
(2a) Wait for an account number prompt.
(2b) Send the account number information.
(3a) Wait for a password prompt.
(3b) Send the password information.
At this point the problem can be translated into a macro. The key is to make the individual
steps simple enough so there are macro commands which can implement the task. For
example, the preceding steps might be changed into a macro which looks like:
PRint "^C"
WT "User ID:"
PRint "12345,678^m"
WT "Password:"
PRint "abcdefg^m"

The evolution from idea to macro is now complete. The most important concept is
decomposing a problem into simple steps. While there is no macro command to “logon to
CompuServe”, there are macro commands which can send data and wait for prompts. By
taking a problem and decomposing it into simple steps, a single complex problem can be
broken into many simple problems. Depending on the complexity of a problem, it may take

PART TWO — THE MAJOR FEATURES

MACROS

175

multiple tries before a problem is made simple enough to translate into a macro. However,
there are very few problems which can not be solved using this approach.

The
DO Command!

The DO Command
The DO command merits special attention because it is the mechanism by which macros can
perform really useful functions. It provides an interface between the macros and the
ProTERM User Interface by which the macros can choose commands, enter text, change
options and press buttons. In short, the DO command allows the macros to operate
ProTERM just as a user does.
The syntax of the DO command is:
DO “pulldown:command”,“parameters…”
The first string consists of the name of the pulldown menu containing the command
followed by a colon followed by the command name. However, the entire pulldown menu or
command name is not required and the text is not case sensitive. Use just the characters
needed to insure the name is not ambiguous. For example, DO “File:Catalog” or DO “f:ca”
are equally valid while DO “f:c” is not (since it gets confused with “File:Copy”).
The second argument to the DO command is the one which normally gives users problems.
It does not have a specific format like the first argument. Instead, its format is determined by
the chosen command. The following example analyzes a complex DO command in depth to
try and give an intuitive feel to how it operates. The command DO “@:Screen”,“Screen:1
Timeout:<10> Activate:3 [OK]” may seem complex but it is really just a translation of the
text in the Screen Saver dialog. The first argument is the name of the pulldown followed by
the name of the command (the name of the Apple “” menu is represented by the @
character). The second argument is a step-by-step procedure on how to set each parameter
in the dialog. “Screen:1” selects the check box [√] “Screen Saver Enabled” (“S”, “s”, “scr”,
“screen saver”, and similar derivations would allow the check box to be selected because
they all match the label of the check box) and turns the option on (the possible values for a
check box are 1=On, 0=Off). “Timeout:<10>” selects the text field “Timeout Before
Activation” and enters a value of 10 (the contents of a text field, list or pop up are enclosed
by “<” and “ >”). In this example since that label does not appear in the DO command, no
value is assigned to the “Never Activate” radio buttons and it remains unchanged. “Activate:3”
selects the Lower-Left value (the 3rd value) for the “Activate Now” radio-buttons. Finally,
“[OK]” presses the OK button and accepts the changes to the dialog.
The following summary lists the “rules” for writing the second argument to a DO command:
• The basic form of an argument is “label:value”. The label field is not case sensitive and
only enough characters are needed to make it clear which item in the window is being
accessed.
• A “label:” reference is analogous to pressing TAB until the dialog item with that label is
highlighted.
• Not every dialog item needs to be assigned a value. Like a normal dialog, all the items
have default values which remain if they are not changed.
• A File Selector does not have a label associated with it. However, when a window
containing a File Selector is displayed, the File Selector is selected by default. As a result,
no label is needed to specify a filename. For example, to write a DO command to delete
a file, you could write DO “File:Del”,“ </pathname/filename> [delete]”. To select
multiple filenames in dialogs allowing it, just list each file in a row surrounded by
“<”
and “ >” (DO “File:Del”,“<filename1> <filename2> … <filenameN>”, “[delete]”).
• The order in which dialog items are changed is not important (except for file selection
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as mentioned above). Just as you can TAB to the last item, then the first, then one in the
middle, etc., the same thing applies to the DO command. The only exception is the
“[button]” reference must be the last item (obviously, after you have pressed a button, it
is a bit late to keep making changes).
• Legal values for a check box are 0 (off) and 1 (on). Note these values also work directly
from the keyboard in normal dialog entry.
• Legal values for a radio button are 1 thru the number of buttons. Note these values also
work directly from the keyboard in normal dialog entry.
• Legal values for text entry, lists, file selection and pop-ups are enclosed within “<” and
“>”. In the case of lists, file selection and pop-ups, only as many characters as are
needed to uniquely identify the desired item are required.
• To press a button, enclose its name with brackets “[button]”.
• Specifying “[]” presses the left-most button and is the same as pressing COMMANDRETURN from the keyboard.
One interesting function of the DO command is to use it to specify some of the parameters
to a dialog, but allow the user to fill in others. For example:
DO “Misc:Unattended”,“path 1:</> connect:<45> password:”
looks incomplete, but where the command ends, the user takes over. In this case, the DO
command selects the Unattended Access window, fills in the “Path 1” and “Connect Time”
fields, highlights the “Password” and then waits for the user to make any other changes and
press the OK button.

Learning to
write macros.

A lot of users get lost writing DO commands because while typing them, they cannot
remember what the windows really look like. Again, as noted above, break the problem
down. Solve it by creating a visual image on a work sheet using pencil and paper. Go
through the command to be automated, and write down the names of the fields and the
values which are displayed in the dialog. Then start at the top and write the DO command.
When you have it written out, compare your notational steps with the DO command and
then try it. It may not work the first try. If it doesn’t, look at the values which did get changed
and those which didn’t. It takes some patience, but with some experience most DO
commands can be coded into functional commands in a couple of attempts. It may help to
print a picture of the screens you are referencing by using the CONTROL-OPTION-P
command.

Macro Trace Mode
Macro Trace Mode is enabled by adding a BAr command to a macro (see BAr below in Macro
Commands) and allows you to monitor execution of a macro as its runs. When macro trace
mode is enabled, the current macro statement being executing is displayed in a highlighted
bar at the top of the screen. A further enhancement to tracing issingle-step mode in which
ProTERM pauses and waits for a keypress between each macro command so the trace
information can be analyzed. This is a very valuable tool for diagnosing macros while they are
being developed.
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Macro Syntax
All three different types of macros (System Macros, Global Macros and Macro Files) share a
similar syntax. The differences between them is discussed above in the corresponding
sections. The following items make up the Macro Syntax and each is explained below in
detail:
• Formatting
• Code blocks
• Label declarations
• Label references
• Keywords
• Numeric expressions
• String expressions
• Device channels

White space and
RETURN
do not affect
macros.

Macro Formatting
Macros are entered in a “free-form” text format meaning the macro commands can be
arranged in any format. Spaces, tabs, character case, and other formatting elements are
ignored (except within quotes). For example, both macros in this example are equally valid:
wt "command?" print "quit^m"
* Long comments can be
hidden between two
ASTERISKS. *
WT "command?"PR"quit^m"
;This is a hidden comment.
*This is a hidden comment.*
Comments are an important part of macros because they allow a way to document code for
later reference. Comments are invisible to the macro language and are included only for
human convenience. Text surrounded by asterisks “* comments *” – or – to the right of a
semi-colon and going to the end of a line “; comments” are transparent to the macro
language. They do not influence the limits on the size of macros and are ignored when the
macro is run. When editing macros, comments are visible for reference.
NOTE: Because of formatting limitations in this manual, some comments wrap to the next
line. With exception of placing a SEMICOLON (see above) at the head of a line for a
comment, formatting does not matter, it is not an issue in the real macros. The commands
can be entered and executed regardless of the formatting.
The comma is normally an optional character and is treated just as “white-space” except
when delimiting numbers. For example, the function (EQ 2 3) is not valid because the “23”
is seen as 23 (the “white-space” is ignored). The valid syntax would be (EQ 2,3) with the
comma separating the numbers. However, the function (EQ $2 $3) is legal since by removing
the white-space (EQ$2$3) still has the same meaning. In addition to using the comma to
delimit numbers, feel free to use it anywhere it makes code easier to read. Like comments,
commas do not use extra memory.

Label Declarations
A label declaration identifies a location in the macros which can be referenced later. Both
Global Macros and Macro Files use label declarations (System Macros have pre-declared
labels). The three valid forms of label declaration are:
@@key Declare a Global Macro keyboard binding (key = A…Z or a…z)
@@num Declare a Global Macro label (num = 1…127)
%%num Declare a Macro File label (num = 1…127)
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Global Macros can be invoked from terminal mode, from within the Editor or while using
Scrollback by pressing OPTION A…Z or a…z (use the SHIFT key if there is an upper and
lower case label for the same key). Execution of the Global Macro begins at the point where
the corresponding label is declared. For example, if OPTION-D is pressed on the keyboard,
ProTERM searches the current Global Macros for the label “@@D”. If it locates the label,
execution begins at that point. Otherwise, it changes the case of the label (“@@D” to
“@@d”) and searches again. If it locates the label, execution begins at that point.
Otherwise, the keypress is ignored.
Within the Global Macros, the 52 keyboard bindings (equivalents) are supplemented by 127
Global Macro labels. These labels must be declared as @@num within the Global Macros
and can be referenced from any type of macro. The keyboard bindings and Global Macro
labels correspond to each other via the ASCII value of the keyboard binding. For example,
“@@A” and “@@65” are the same label (the ASCII value of “A” is 65). Therefore, the label
values between 65…127 are shared between the labels and the keyboard bindings. Global
Macro variables “@@1” thru “@@9” are reserved for special functions and should not be
used as normal Global Macro labels. See Special Global Macros at the end of this chapter for
more information. Within Macro Files, labels are declared as “%%num” (where num is in the
range 1…127). Make sure you use “@@” declarations in Global Macros and “%%”
declarations in Macro Files.

Label References
Within a macro, a label is referenced by using a form similar to its declaration. The valid
forms of label reference are:
~ num
\
@key
@num
%num
~0

References System Macros 1…10
References the next System Macro line.
References “@@key” declaration (key = A…Z, a…z)
References “@@num” declaration (num = 1…127)
References “%%num” declaration (num = 1…127)
Continue execution at end of current command.

Labels “~1”…“~10” reference System Macros 1…10, “@1”…“@127” reference Global
Macro label declarations and labels “%1”…“%127” reference Macro File label declarations.
Because the label references all have different forms, any kind of label can be referenced
from any kind of macro. For example, you can reference “@23” (a Global Macro label) from
a Macro File or “~5” (a System Macro label) from a Global Macro. The label “~0” causes
execution to continue at the end of the command in which it appears. For example, in the
command (WT "x1",~0,"x2") a match on the string “x1” causes execution to continue
following the WT command.

Keywords
A Keyword is the two-character letter sequences which corresponds to a macro command.
Only the first two characters of a keyword are used by ProTERM as a part of a macro
command name but for the sake of clarity and understanding, the entire keyword can be
spelled out. Any letters of a keyword after the first two are “white-spaces” as far as the macro
is concerned. In addition, the case of the characters does not matter. For example, PR, pr,
PRI, pri, PRIN, PRint, prINT and PRINT all access the “PR”int command. When Global Macros
or Macro Files are loaded, the extra characters are automatically removed (so the only “cost”
associated with using full command names is the extra text or disk space required to store
the file). Throughout this chapter macro keywords are shown using the full keyword, but
only the first two characters capitalized.
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Literal Values
Literals are values included as a literal part of the macro text (versus variables which are
symbolic values). For example, 5, "Hello", 978, and 'X' are all literal values.

Literal Numbers
Literal numbers must be in the range 0 to 65535 (negative numbers are not accepted).
Numbers greater than 65535 assume random values. Keep in mind a “white-space” is not a
valid delimiter for literal numbers. Functions requiring two numeric arguments
must be
separated by commas. For example, <MID “abcde”,2,3> and <MID “abcde” 2 3> are
interpreted differently. After processing, the second function becomes <MI“abcde”23>.

Literal Strings
Literal strings are 0…250 characters in length and are enclosed by delimiting characters.
Legal string delimiters are ' (single-quote) and " (double-quote). In order to use delimiters as
part of the string data or to include characters which can not be normally typed, ProTERM
uses the caret (^) as a special prefix character. Control characters in the ASCII range 0…31
can be included by including “^@”…“^_” as part of a literal string. To include the caret
character itself you must use “^ ” (caret followed by SPACE) since “^^” represents a
CONTROL-caret (ASCII 30) character. To include a delimiter, prefix it with a caret (“^'” or
“^"”). The delete key (ASCII 127) can be included by using “^?”. The ASCII character chart
located in the appendix gives the appropriate notation for each character.

Macro Variables
Variables are a mechanism by which a value can be represented by a symbol. The ProTERM
macros support three different types of variables: user numeric, system numeric and user
string. As the name implies, the user numeric and user string variables are available for
general use by the user. The system numeric variables provide information about ProTERM
directly to the macros. Certain macro DO commands also return values via the macro
variables “$0” and “&0”. As a result, these variables should generally not be used for
persistent values. See DO below in Macro Commands for a list of functions which return
values in “&0” and “$0”.

User Numeric
There are 31 user numeric variables numbered 0…30. They are accessed as “$number”
(dollar sign followed by the variable number). For example, “$0” is numeric variable 0 and
“$30” is numeric variable 30. Like literal numbers, numeric variables can contain values in
the range 0…65535.

System Numeric
There are 26 system numeric variables numbered A…Z. They are accessed as “$letter”
(dollar sign followed by the variable letter). For example, “$A” is system variable A and “$Z”
is system variable Z (system numeric variables are not case-sensitive). Like literal numbers,
system variables can contain values in the range 0…65535. The meanings of the different
system variables is listed at the end of the chapter under Macro Summary.

User String
String variables are of the form “&number” (AMPERSAND-number) and can store strings
from 0…80 characters in length. All string variables are user definable and none have preset
values (values such as the date, time and pathnames are handled as string functions).
Because the number of string variables varies (depending on the size of the current Global
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Macros), there is a variable which returns the current number of string variables available.
The larger the Global Macros is, the fewer the strings which will be available. The “$S” system
numeric variable returns the number of string variables.
If you are writing a macro-file application requiring a large number of string variables, it is
possible to unload the Global Macros (read in an empty Global Macro file) so all strings are
available. Before your application finishes, you simply need to read back in the default
“PT3.GLOBAL” file. When Global Macros are reloaded, all string variables except “&0” will
lose their values. See the “PT3.CLOCK” macro file for an example of this technique.

Expressions
An expression is a way of combining literals, variables and functions into a new form. The
word expression refers to anything which can be “expressed” within a language. The macros
support both numeric and string expressions.

Numeric Expressions
Numeric Expressions can include literals, variables, functions, symbols and parenthesis.
Functions are of the form “(keyword arg1, arg2, …)” such as “(EQual $1,$3)”. The use of
open and close parenthesis surrounding a function indicate its result is numeric.
Numeric expressions can also include the symbols “!, +, -, ( and )” (such as “!(5+6-7)”). The
plus “+” and minus “-” signs are used to indicate addition and subtraction within an
expression. The exclamation point “!” returns the logical-not of a value (!0 = 1 and !1 = 0).
Parenthesis can be used both for functions and for specifying order of evaluation. “((4+5)6)” and “(4+(5-6))” are both valid. The following are some example expressions:
3
$5
$3+1
128-$O
(VAl "24")
(EQual 4,$2)
!(EQual 4,$2)

The number 3.
The contents of variable 5.
Contents of variable 3 plus 1.
128 minus contents of variable O.
The value of the string "24" which is 24.
If variable 2 equals 4 then 1, else 0.
If variable 2 equals 4 then 0, else 1.

String Expressions
Macros are
not case
sensitive
except
between quotes.

String Expressions can include literals, variables, functions and symbols. Functions are of the
form “<keyword arg1, arg2, ….>” (such as “<LE &4, 4>”). The use of less-than “<” and
greater-than “ >” symbols around a function indicate the result is a string. String expressions
can also include the plus “+” sign which means concatenation (i.e., "yes"+"no" is "yesno").

^M = RETURN

NOTE: Within literal strings, control characters are inserted using caret-prefix notation (for
examples, a CONTROL-M is entered as “^m”). A full list of all the caret-sequences is
included in the ASCII Character Chart in the appendix.

"Hello"
'Hello'
"Hello"+"^m"
<STring (5+7)>
<CHar (AS "*"), 40>

The literal string Hello.
The literal string Hello.
The string Hello with a RETURN character appended.
The string "12."
A string of 40 asterisks (*).
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Device Channels
A device channel is used to specify where data is read from or written to. A device channel is
specified as “#number” where number is zero through seven. If a device channel is not
specified in a command where it is optional, channel zero is used. The eight channels are:
01234567-

Modem: Send data directly to the modem port, but provide a local echo if half
duplex is selected. This is the default channel for output.
Modem Only: Send data directly to the modem port, but do not echo even if half
duplex is selected.
Console: Display data on the local console. The macro variables $X,$Y,$Z all affect
or are affected by this channel.
Incoming: “Stuff” data into the modem input buffer. This makes the data appear as if
it is coming from the remote system.
Emulation: Send the data through the emulation. The emulation interprets control
codes and handles the data based on its own emulation-specific rules.
Disk: After a file has been opened using the OPen command, data can be written to
it via this channel. See OPen and CLose below in Macro Commands for more
information.
Editor: If used in terminal mode or Scrollback, data is appended to the end of the
Editor. If used from within the Editor, the data is inserted at the cursor location.
Printer: The data is sent directly to the printer. Note the printer init string is not sent
as part of using this channel.

Code Blocks
Commands which act on a condition such as WT (wait for), IF, WHile or REpeat/UNtil
execute macro code based on the result of some condition. The code executed can be in the
form of a label (which transfers control to that label) or a code block. A code block consists
of one or more macro commands enclosed in curly brackets. The following are some
examples of code blocks:
IF $O,{ PRint #2,"online^m" },1,{ PRint #2,"offline^m" }
WHile (1),{ DO “Online:Send Break” WT 2,””,{ BReak } }
IF !$A,{
NOte “Not in terminal mode”
EXit
}
WHile (SEqual <LEft &0,1>,“ ”),{ SEt &0=<MId &0,1> }

Macro Commands
ProTERM supports many different macro commands and functions, all of which are listed
below. Function names are surrounded by either “<>” or “()” indicating whether the
function returns a numeric (such as “(ANd)”) or string (such as “<ANswerback>”) result.
The commands and functions are listed together in alphabetical order. The macro summary
at the end of the chapter divides the commands and functions by type. The following
notation is used throughout all command and function listings:
num_expr
str_expr

Any valid numeric expression (like 4+$0).
Any valid string expression (like "hello").
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#device
label
{ block }
[ item ]
[ …. ]
x|y

Any valid device channel (like #2).
Any valid label reference (like @a).
A code block (like { EXit }).
The item in brackets is optional (like [ num_expr ]).
There can be multiple items of previous type.
Either “x” or “y” are valid.

(ANd)
The (ANd) function returns 1 if its arguments are all “true” or 0 otherwise. An argument has
a “true” value if it is non-zero (otherwise it is “false”).

Syntax: (A Nd num_expr, num_expr [,num_expr] [,…])
IF (ANd (EQual $1,$2),(EQual $3,$4)), ~5
* if $1=$2 and $3=$4 goto ~5 *
SEt $0 = (ANd $1,$2)
* if $1>0 & $2>0, $0=1 else 0 *
IF (ANd $1,$2,$3), { PRint #2,"all true" }
* if $1>0 & $2>0 & $3>0,print *

<ANswerback>

The <ANswerback> function requires no arguments and returns the Answerback string for
the current system entry in the Dial menu. Since the Answerback string is rarely used, this is
a simple way to save system specific parameters for use with macros. The Answerback string
can contain control characters encoded using caret-prefix notation.

Syntax: < A Nsw erback>
PRint #2,"Current Answerback String:"+<ANswerback>
@@N PRint <ANswerback> EXit * send answerback to host *

(AScii)
The (AScii) function returns the ASCII value of a string character in the range 0…127. The
AScii function always returns the ASCII value of the first character of the string.

Syntax: (AScii str_expr)
PRint #2,<FOrmat "ASCII(%S) = %D^M",&0,(AScii &0)>
* show ascii value of &0 *

BAr

When a macro is initially executed, macro trace mode is disabled. BAr is used to control
macro trace mode as well as display status messages. The “BAr 0” command can be used to
hide the “AutoLogon Macro Running” message which is displayed after a connection with a
remote system. The “BAr 1, "Message"” command displays a message in the status bar. The
“BAr 2” or “BAr 3” command enables the normal or single step macro trace mode starting at
the point of insertion. Single-Step mode displays every macro command in the status bar and
waits for a keypress before it is executed. The BAr command is a useful tool for troubleshooting macros as they are developed.

Syntax: BAr num_expr
BAr 0
BAr 1,"Message"
BAr 2
BAr 3

; disable macro trace (hide macro status)
; display msg in status area
; enable macro trace mode
; enable macro trace mode with single-step
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(BIts)
The (BIts) function returns the binary-and of two values. Since numeric values are 16 bits,
this function returns a 16-bit result.

Syntax: (BIts num_expr, num_expr)
PRint #2,<FOrmat "7 & 3 = %d^m", (BIts 7, 3)>
IF (BIts (MOdem), 2), { PRint #2,"DCD is High^m" }

BP

The BP (beep) command sounds a single bell, a three-bell sequence or enables the siren. The
siren can be disabled by a local keypress or by using the “BP 3” command.

Syntax: BP num_expr
BP 0
BP 1
BP 2
BP 3

* beep the bell once *
* sound the 3-bell sequence *
* turn on the "siren" *
* turn off the "siren" *

BReak

The BReak command causes the macros to exit from awhile-loop or repeat-loop even though
the loop condition may not yet be satisfied. If a BReak command is used outside of a whileloop or repeat-loop, it has no effect. The BReak command is useful for exiting a loop when
an unusual condition has been encountered (other than the loop condition).

Syntax: BReak
WHile ($1),{
WT 1,"exit",{ BReak }
SEt $1=$1-1
}
WHile ($1),{
WT 1,@34,"exit"
BReak
@@34
SEt $1=$1-1
}

* while $1 is non-zero *
* if "EXIT" rcvd, break out of while *
* count down iterations *

* while $1 is non-zero *
* if "EXIT" not rcvd in 1 sec, goto @34 *
* break out of the loop

* count down iterations *

CAll

The CAll command calls a subroutine and then returns to the point following the CAll
command. Any label can be called as a subroutine and an EXit statement returns to the
statement following the CAll. ProTERM can support eight levels of subroutine calls.

Syntax: CAll label
CAll ~label
CAll %label
CAll @key
CAll @label

* call a System Macro element *
* call a Macro File label *
* call a Global Macro key *
* call a Global Macro label *
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CHain
The CHain command transfers execution to a Macro File. The named Macro File is loaded
and execution continues at the start of the file (or at a label if one is passed).

Syntax: CHain str_expr [,label]
CHain "macro.file",%32

<CHar>

The <CHar> function returns a string consisting of a character specified by its ASCII value.
An optional second argument allows an entire string of such characters to be created.

Syntax: <CHar num_expr [,num_expr]>
PRint #2,<CHar 33,40>+"^m"
PRint #2,<Char 65>

CLose

* print 40 ! characters *
* print ASCII char 65 (A) *

The CLose command closes an open text file. CLose should be used on a file previously
opened with the OPen command. The file closed corresponds to the one previously opened
using that same channel. Therefore, if “OPen #5,"testfile"” was the last open command,
“CLose #5” closes testfile.

Syntax: CLose #device
CLose #5

COntinue

* close the file opened with OPen #5,"filename" *

The COntinue command immediately repeats the condition test in a while-loop or repeatloop. It has the same effect as a GOto to the closing bracket in a loop. This does not just
restart the loop, but also tests the loop condition. If the loop condition is no longer true,
execution continues beyond the loop.

Syntax: CO ntinue
SEt $1=10
WHile ($1),{
WT 1,"exit",{ GO @23 },
"stop",{ COntinue }
SEt $1=$1-1
@@23
}

*
*
*
*
*

set $1 to 10 *
while $1>0 do the {} stuff *
if EXIT rcvd, goto @23 *
if STOP rcvd, do WH ($1) *
count down $1 *

* loop back and test WH ($1) again *

NOTE: In the above example, receiving either “exit” or “stop” has the same effect. When
“exit” is received, the macro will GOto the closing curly bracket which restarts the while
statement. When “stop” is received, the macro uses COntinue to restart the while statement.

CReate
The CReate command creates an empty text-file. CReate should be used prior to an OPen/
CLose if you want to use a new file.
Syntax: CReate str_expr
CReate "testfile"

*create a text-file called testfile *
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<DAte>
The <DAte> function requires no arguments and returns the current date as a string. If the
date is available it is in the format “DD-MMM-YY”, otherwise “<NO DATE>” is returned.
Since the result is a string, the date can be manipulated using other string functions like LEft,
MId and RIght.

Syntax: <D A te>
PRint #2,"Today's Date: "+<DAte>+"^m"

DElete
The DElete command deletes a file from disk. If the file does not exist, then the command
does nothing and no error message is generated.

Syntax: DElete str_expr
DElete "testfile"

DO

* delete a file called testfile *

The DO command allows a macro to “run” ProTERM. It can issue all ProTERM commands
and operate the program just as a user can. The two DO arguments tell ProTERM which
command to execute (required) and what arguments to pass (optional).

Syntax: D O str_expr, str_expr
DO "pulldown:command","field1:<arg1> field2:<arg2> [button]"
DO "online:parms","line:<off> [ok]"
DO "mi:pre","[xfer] ask ymodem:1 [ok] [ok]"
DO "mi:read","<%spt3.global> [ ]",<path>

The first string argument tells ProTERM which command to execute from the pull-down
menus. The command is specified by “pulldown:command.” The text for both the pull-down
menus and the command is not case sensitive and works on a first-match basis. For example,
m, M, mi, MI, mis, MIS, misc, and MISC all match the Misc pull-down menu.
The second string argument tells ProTERM which parameters to select within the command.
This command is optional and if not supplied, then the user must manually supply the
parameters to the command. Argument values take the form “field:value” where field is the
name of a parameter to set. The value specifies the new value for the parameter. If the field is
a toggle switch, then value is 0 (Off) or 1 (On). If the field is a radio button, then value is 1
for the first selection, 2 for the second, and so on. If the field is a pop-up, list, file selection,
or input then the value is the appropriate string enclosed by “<” and “ >”. The name of the
button to be activated is enclosed in brackets (“[” and“]”). In addition, a set of empty
brackets “[ ]” always presses the default button (the left-most) and is the same as pressing
COMMAND-RETURN. In order to make passing arguments easier, the second argument
accepts the same formatting commands as the FOrmat function (see below).
Certain ProTERM commands behave slightly differently when executed from a DO command
instead of the keyboard. The changes are designed to aid macro programming by making the
commands more predictable. The following lists the commands which behave differently:

Send: Protocol, Receive: Protocol
The protocol routines always operate in “query mode” if additional parameters are supplied
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(beyond the pathname window). For example: DO "receive:xmodem-1k","<> []
rec:<binary> []" always initiates a Binary II download.

Receive Protocol
If a single file is downloaded, then additional parameters may be supplied to assign the
filename. For example, DO "re:zm","<> [] [] new:<xyzzy> []" would download a file and
save it under the filename xyzzy. In addition, after a protocol receive, the strings variable
“&0” contains the filename under which ProTERM saved the file. Numeric variable “$0”
returns 1 if the name was assigned from a Binary II header.

O nline: Editor Capture, O nline: Printer Capture
The capture commands normally act as toggles, however when invoked from a macro, they
can be turned off, on or toggled. The command DO "online:editor" toggles Editor capture
mode, DO "online:editor","[]" always turns Editor capture on and DO
"online:editor","[cancel]" always turns Editor capture off. The Printer Capture command
operates in the same way.

M isc: Read Globals
When the command DO "mi:read","[cancel]" is used, the Global Macros are unloaded from
memory. This makes all of the Global Macro memory available for string variable storage.

M isc: Transfer Stats
When called from a DO "mi:tr","[]", this command returns the last used protocol type in
“&0” and the CPS performance in “$0”.

File: Q uit
When executed from a DO command, the Quit command is replaced with the Launch
command. With Launch, it is possible to execute another application of your choice directly
from ProTERM. To launch a different application, use a command of the form:
DO "fi:quit","path:</pathname> prog:<appl name> []"

Dial: all dialing options
When a remote host system is dialed from a DO command, execution of the macro continues
immediately after dialing. The Dial command does not display the “Unable to Connect”
message. To dial a remote system, use DO "dial:sysname","[dia]" and then check “$O” to
determine whether a connection was made or not. Continuous redial works in the same way
except ProTERM attempts “$R” redials before it cancel’s the attempt. Again, check “$O” to
determine whether a connection was made.

M isc: M acro File
Do not use the Macro File command from a DO command as it will result in an error
message. Instead, use the CHain command (see CHain above).

(EOf)
The (EOf) function returns 1 if the specified device is at the end of file. This is normally only
used with file device #5.

Syntax: (EO f #device)
IF (EOf #5),{ PRint #2, "At EOF^m" }

PART TWO — THE MAJOR FEATURES

MACROS

187

(EQual)
The (EQual) function compares two values and returns 1 if they are equal or 0 otherwise.

Syntax: (EQ ual num_expr, num_expr)
IF (EQual $2,$3),{ PRint #2,"$2 and $3 are equal^m" }

(EXist)

The (EXist) function checks to see if a file exists. If it does, it returns the filetype, or zero if
the file does not exist. If the file has a filetype of zero, the value one is returned. Keep in
mind this command returns the decimal filetype (1…255). A translation from the decimal
filetype to the three-character abbreviations is available in most ProDOS programming
manuals.

Syntax: (EXist str_exp)
IF (EXist "xxx"),{DO "FI:DEL","<xxx>[]"}
* if xxx exists, delete it *
PRint #2,<FOrmat "Filetype (xyzzy): %d^m",(EXist "xyzzy")>
* if 0, no such file *

EXit

EXit returns from a subroutine or terminates a macro. If a subroutine is executing then EXit
exits that subroutine, otherwise it terminates the macro. “EXit 1” terminates a macro
regardless of whether a subroutine is executing or not.

Syntax: EXit
EXit
EXit 1

<FOrmat>

* return from a subroutine or exit macro *
* exit macro immediately *

The <FOrmat> function creates a string based on a format string which acts as a template
for the arguments. By placing expression specifiers of the form “%type” in the format string,
strings, numbers and characters can be displayed. Valid expression types are “S” for string,
“C” for character or “D” for decimal number (“%%” allows the percent sign to be printed).
Expressions which correspond to items in the format string must follow the format string.

Syntax: <F Ormat str_expr [,expr1] [,…]>
PRint #2,<FOrmat "Date: %s %s^m", <DAte>, <TIme>>
SEt &3 = <FOrmat "%s %d", &1,$1>
PRint #2,<FOrmat "ASCII Value %d is %c^m", $0, $0>

GEt

The GEt command gets one or more characters of input and stores those characters into
string or numeric variables. An optional timeout value (expressed in seconds) controls the
maximum amount of time GEt waits for input. When GEt is used with a numeric variable, the
ASCII value of the character is returned in the variable. In the case of a timeout, a string
variable returns empty (no value, length equals zero) and a numeric variable returns 256.
One interesting application of the GEt command is to load binary data from a file.

Syntax: GEt #device [,num_expr], var [,var] [,…]
GEt #2,5,&0
GEt &0

* wait 5 secs for char from console *
* get a char from the modem *
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GEt #5,0,$1,$2
GEt #5,&0,&1,$0

* read 2 bytes from a file *
* read 3 bytes from a file *

NOTE: The syntax of the GEt command is not always clear. Because the timeout value is
optional and the input variables can be numeric, a command like “GEt #2,$0,$1” is not well
defined. A programmer might want this to mean “get two bytes and put them in $0 and $1.”
However, this command actually uses the value of “$0” as the timeout and gets a single byte
and puts it in “$1”. This can have the original desired meaning by rewriting it as “GEt
#2,0,$0,$1”.

GOto
The GOto command transfers control from one point in a macro to another. The parameter
supplied to GOto is the label where execution should continue.

Syntax: G O to label
GOto ~label
GOto %label
GOto @key
GOto @label

(GT)

* goto System Macro label *
* goto Macro File label *
* goto Global Macro key *
* goto Global Macro label *

The (GT) (greater-than) function compares two values and returns 1 if the first value is
greater than the second value or 0 otherwise.

Syntax: (GT num_expr, num_expr)
IF (GT $2,$3),{ PRint #2,"$2 > $3^m" }
IF !(GT $2,$3),{ PRint #2,"$2 <= $3^m" }
NOTE: To check if a value is greater-than or equal to another value, negate the result of the
less-than function (i.e., !(LT $2,$3)).

IF
The IF command tests the condition of a variable and executes code based on the result.
Multiple conditions can be tested with the IF command so it functions like an If-Else-If.
Order of evaluation is always left-to-right. If multiple conditions are true, the code corresponding to the left-most true condition is executed. A condition is considered true if the
numeric expression is non-zero. By adding a final expression of “1”, that expression always
evaluates as “true” and the corresponding label or code is executed.

Syntax1: IF num_expr, label [,num_expr, label] [,…]
Syntax2: IF num_expr, { block } [,num_expr, { block }] [,…]
IF $1,{ PRint #2,"yes^m" },1,{ PRint #2,"no^m" }
* if $1>0 print yes else no *
IF $O,@T
* If $0>0, goto global macro T *
IF (SEqual &0,"one"),{ PRint #2,"&0 is ONE^m" },
* if &0="one", print ONE *
(SEqual &0, "two"),{ PRint #2," &0 is TWO^m" },
* if &0="two", print TWO *
(SEqual &0,"three"),~5 * if &0="three", goto ~5 *
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INput
INput data into variables. The input is controlled by a “format string” which directs how data
is assigned to variables. The format string consists of prompt characters and variable
specifiers. The device parameter specifies which device the input comes from. Input from the
modem or console allows simple editing (backspace and line-cancel). An optional time-out
controls the maximum time which is spent waiting for input. If the time limit is exceeded,
numeric variables return zero and string variables are empty.

Syntax: INput #device,[num_expr,] str_expr, var [,var] [,…]
INput #2,"%S^M%D",&1,$2
* get two input lines: string & number *
INput #2,"%D,%D,%D",$1,$2,$3
* get 3 numbers divided by commas *
INput #2,"%S^m%D",&0,$2
* get str on line 1, num on 2 *
INput #2,5,"%s",&0 * wait 5 seconds for a string *

Variable specifiers have the form “%type” where type “S” is string and “D” is decimal number
(“%%” allows the percent sign to be used as a prompt). The INput command always inputs at
least one line of data. For each “^M” used as a prompt, an additional line of data is input.

(INstring)
The (INstring) function checks to see if one string is a sub-string of another. The first
argument string is searched for within the second argument string. If a match is found, the
position of the start of the sub-string is returned, otherwise zero is returned. Note, if a string
occurs starting at the first position, INstring returns 1. This is different from the MId function
where 0 refers to the first character of the string.

Syntax: (INstring str_expr, str_expr)
PRint #2,<STring (INstring "PL","APPLE")>
SEt $0=(INstring "XF","APPLE")

JSr

* prints 3 *
* sets $0 = 0 *

The JSr command is used to call an assembly language program in memory. This command
should only be used by an expert programmer! When passed numeric arguments, the first
value is assigned to A, and the second value is assigned to Y/X (Y is high). When a string
argument is passed, the string is zero-terminated at $1000 and A=$10, X=$00, Y=string
length (without terminator).

Syntax1: JSr num_expr [,num_expr] [,num_expr]
Syntax2: JSr num_expr, str_expr
JSr 4096,27,258
JSr 8192,"Hello World"

KEy

* jsr to $1000; A=27, X=2, Y=1 *
* jsr to $2000; A=$10, X=0, Y=11 *

The KEy command “stuffs” a keypress in the Editor or Scrollback and can choose commands
which do not appear on pull-down menus (command which cannot be invoked with DO).
The KEy command can stuff both normal keystrokes and COMMAND keys. Only a single
keypress can be stuffed with each KEy command.
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Syntax: KEy str_expr
KEy "^b"
KEy "#1"
KEy "##"
KEy "#^H"

* stuff a ctrl-b *
* stuff a COMMAND-1 *
* stuff a # character *
* stuff a COMMAND-Left ARROW *

<LEft>

The <LEft> function returns the left part of a string. The number of characters returned is
controlled by the second argument (zero is not a valid argument).

Syntax: <LEft str_expr, num_expr>
PRint #2,<LEft "APPLE", 3>

(LEn)

* print "APP" *

The (LEn) function returns the length of a string in characters. The result will be in the range
0…250.

Syntax: (LEn str_expr)
PRint #2,<STring (LEn "HELLO")>

(LT)

* print 5 *

The (LT) (less-than) function compares two values and returns 1 if the first value is less than
the second value or 0 otherwise.

Syntax: (LT num_expr, num_expr)
IF (LT $2,$3),{ PRint #2,"$2 < $3^m" }
IF !(LT $2,$3),{ PRint #2,"$2 >= $3^m" }
NOTE: To check if a value is less-than or equal to another value, negate the result of the
greater-than function (i.e., !(GT $2,$3)).

MArk
MArk sets the position of the read/write pointer within a file. It is normally only used with file
channel #5. If no argument is specified, the read/write pointer is placed at the end of the file
(ready to append new data).

Syntax: M Ark #device [,num_expr]
MArk #5
MArk #5,0
MArk #5,35

(MArk)

* append to a file *
* position to the start of a file *
* position to byte 35 of the file *

The (MArk) function returns the read/write pointer position of a file. Currently, only file
channel #5 can be used with this function.

Syntax: (M Ark #device [,num_expr])
PRint #2,<FO "File position = %d^m",(MArk #5)>
* show file pos *
SEt $0=(MArk #5)
* get current file position *
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MEm
MEemory allows a byte or bytes of memory to be changed. This command should only be
used by an expert programmer. Changing the contents of the wrong memory location can
cause unpredictable and undesired results! When passing a hex string, white space is ignored
within the string.

Syntax1: MEm num_expr, num_expr
Syntax2: MEm num_expr, str_expr)
MEm 49168,0
* clear keyboard buffer ($C010) *
MEm 4096,"a9 03 4c 05 08" * save code in memory *
MEm 4096,"a9034c0508" * alternate form of above *

(MEm)
The (MEmory) function returns the value from a byte of memory. This function should only
be used by expert programmers.

Syntax: (MEm num_expr)
IF (LT (MEm 49152), 128) { PRint #2,"No key waiting^m" }

<MId>

The <MId> function returns a substring starting from a position specified relative to the
left side of the string. The first character position is zero and thus the mid-string from
position zero is the original string. Note, this is different from the INstring function which
considers one as the first character position. An optional second argument selects the
maximum number of characters to return.

Syntax: < MId str_expr, num_expr>
PRint #2,<MId "APPLE",3> * this prints "LE" *
PRint #2,<MId "APPLE",1,3> * this prints "PPL" *

(MOdem)

The (MOdem) function returns the status of the serial port. This is a bit-encoded field. When
a bit is on, it has the following meaning:
Bit
0
1
2
3

Meaning when on:
Port is ready to transmit
Carrier detect is high
Data set ready is high
Clear to send is high

Syntax: (M O dem)
IF (BIts (MOdem),2),{ PRint #2,"DCD is High^m" }

NOte

NOte displays a note on the console. The argument is a string which can contain RETURN
characters to designate a new line. Make sure none of the lines exceed 70 characters in
length. The final line does not need to be terminated with a RETURN. Note the string
supplied to NOte must be longer than 10 characters or else nothing happens.
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Syntax: N O te str_expr
NOte "Hello World" * display hello world and wait for a keypress *

OPen

OPen opens a text file so it can be read and written using the INput and PRint commands.
After a file has been opened and its data used, it must be closed with CLose.

Syntax: OPen #device, str_expr
OPen #5,"testfile"
WHile !(EO #5),{
INput #5,"%s",&0
PRint #2,&0+"^m"
}
CLose #5

(OR)

* open the file called TESTFILE *
* while not at the end of the file *
* load a line of text into &0 *
* display the line of text *

* close previously opened file TESTFILE *

The (OR) function returns 1 if any of its arguments are “true” or 0 otherwise. An argument
has a “true” value if it is non-zero (otherwise it is “false”).

Syntax: (OR num_expr, num_expr [,num_expr] [,…])
IF (OR (EQual $1,$2),(EQual$3,$4)),
{ PRint #2,"$1=$2 or $2=$3 (or both)^m" }
SEt $0 = (OR 3,$5)
* set $0=1 (since 3 is > 0) *

OVerlay

The OVerlay command is used to load in and execute an assembly language program. This
command is for use by expert programmers only! OVerlay loads a binary file up to 3K in
length at $1000 and then executes it.

Syntax: O Verlay str_expr
OVerlay "pt3.convert"

(PArtial)

* run pt2.2 converter *

The (PArtial) function checks to see if one string is a partial match of another. The comparison checks the entire contents of the first string against the left-side of the second string.
Only as many characters as appear in the first string must match the second. The comparison
is not case sensitive (upper and lowercase match each other). In addition, the first string can
contain “?” (question-mark) characters to match any character in the corresponding position
in the second string.

Syntax: (PArtial str_expr, str_expr)
IF (PArtial "B", "b 27"),{ PRint #2,"yes^m" }
* print "yes" *
IF (PArtial "A", "ABC"),{ PRint #2,"yes^m" }
* this prints "yes" *
IF (PArtial "B", "ABC"),{ PRint #2,"yes^m" }
* this doesn't print "yes" *
IF (PArtial "","xyzzy"),{ PRint #2,"^"^" always matches anything^m"
}
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<PAth>
The <PAth> function returns one of ProTERM’s preset file pathnames. The five paths which
can be returned are: the ProTERM root directory (0), the download path (1), the upload path
(2), the Editor path (3) and the AutoSave path (4). When used without an expression, the
path function always returns the root directory. If the preset pathname is blank in the
preferences window, then the ProTERM root directory is returned for that path (the same as
<PAth 0>).

Syntax: <PA th [num_expr]>
PRint #2,"ProTERM's Root Directory: "+<PAth>+"^m"
PRint #2,"Download Path: "+<PAth 1>+"^m"\

<PHone>

The <PHone> function requires no arguments and returns the phone number string for
the current system.

Syntax: <PHone>
PRint #2,"Current Phone Number: "+<PHone>

POp

POp removes a return address from the subroutine stack. If the stack is already empty, no
error occurs.

Syntax: PO p
CAll %45
PRint #2,"Hello World^m"
EXit

* call a subroutine *
* print Hello World *
* done with macro *

%%45
* start of subroutine *
IF $3,{
* if $3 is non-zero, bail-out of macros *
POp
* pop the return address *
EXit
* exit macro since no return address *
}
PRint #2,"INput @45^m"
* show we’re in the subroutine *
EXit
* Return to caller *

PRint

PRint sends a string to a device (if the device is not specified, it is sent to the remote system).
An initial delay and character pacing parameter control the rate at which data is sent in 1/
100th of a second. To display a more complicated formatted expression, use the FOrmat
function as the string to print.

Syntax: PRint [#device,] [num_expr,] [num_expr,] str_expr
PRint #2,"hello^m" * display the string "hello" on the console *
PRint 50,10,"@D^M"
* use initial delay of 50/100 sec, pace of 10/100 *
PRint #2,<FOrmat "It is: %s %s^m",<date>,<time>>
* show date & time *
PRint #5,"hello^m"
*save hello to the open disk file*
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PUsh
PUsh places a return address on the subroutine stack. When a subsequent EXit is encountered, control transfers to the point specified by the PUsh command.

Syntax: PUsh label
PUsh %4

* push macro label %4 on the stack *

(RAndom)

The (RAndom) function returns a random number in the range 0…65535. The random
number generator returns all 65536 values in a periodic sequence (i.e., if the generator
returns the number 5, that number will not occur for another 65535 cycles).

Syntax: (RA ndom)
PRint #2,<FOrmat "Random Number: %d^m", (RAndom)>

REpeat

REpeat executes a block of code and then tests a condition. If the condition is false, the block
of code is executed again. Unlike other commands, repeat-until requires two keywords: the
first is at the start of the loop and the second before the condition test.

Syntax: REpeat { block } UNtil num_expr
SEt $1= 3
REpeat {
PRint #2,<FOrmat "%d^m",$1>
SEt $1=$1-1
} UNtil !$1

<RIght>

* set counter to 3 *
* repeat block of code *
* show the value of $1 *
* decrease value of $1 *
* repeat until $1 is zero *

The <RIght> function returns the right part of a string. The number of characters returned
is controlled by the second argument (zero is not a valid argument).

Syntax: <RIght str_expr, num_expr>
PRint #2,<RIght "APPLE", 3>

<SCan>

* this prints "PLE" *

The <SCan> function scans a line of data from the console screen. Any particular line can
be scanned by specifying the line number as a parameter (the screen is numbered 0 to 23;
line 24 is the Status Bar). By default, SCan returns the contents of the line containing the
cursor. Characters which normally display as mouse-text are returned as characters in the
range 0…31. Inverse characters are returned in the range 128…255.

Syntax: <SCan [num_expr]>
PRint #2,<FOrmat "The current line: %s^m", <SCan>>
PRint #2,<FOrmat "The Status Bar: %s^m", <SCan 24>>

(SEqual)

The (SEqual) function returns 1 if two string values are the same. The compare routine is
case sensitive and white-space is checked. Both strings must be the same length in order to
match.

PART TWO — THE MAJOR FEATURES

MACROS

195

Syntax: (SEqual str_expr, str_expr)
IF (SEqual &1,"HELLO"), { PRint #2,"&1 = HELLO^m" }

SEt

SEt allows you to set the value of a variable. Both string and numeric variables can be set.

Syntax1: SEt $num_expr=num_expr
Syntax2: SEt &num_expr=str_expr
SEt $4=12
SEt &2="Hello"
SEt $R=5

* set numeric variable 4 to 12 *
* set string variable 2 to Hello *
* set macro redial limit to 5 *

<STring>

The <STring> function converts a numeric value into a string of digits. The string value is
returned without leading spaces.

Syntax: <STring num_expr>
PRint #2,<STring 12345>+"^m"

SYnc

* print 12345 *

SYnc attempts to sync-up with a remote host system which requires character(s) to be sent at
intervals in order to detect the correct baud rate. The string is sent at a specified interval (the
default is two seconds) until there is some sort of response from the host. This is commonly
used at the beginning of logon macros.

Syntax: SYnc [num_expr,] str_expr
SYnc "^m"
SYnc 1,"@D^m"

<SYstem>

* send return every 2 seconds, until response *
* send @D^m every second until response *

The <SYstem> function requires no arguments and returns the current system name string.

Syntax: <SYstem>
PRint #2,"Current System Name: "+<SYstem>

<TIme>

The <TIme> function returns the current time if it is available in “HH:MM:SS” format.
Because it is a string, it can be manipulated using other string commands like LEft, MId and
RIght.

Syntax: <TIme>
PRint #2,"The Current Time Is: "+<TIme>+"^m"

<UPper>

The <UPper> function returns a string with all lowercase letters converted to uppercase.

Syntax: <UPper str_expr>
PRint #2,<UPper "testing^m">

* print TESTING *
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(VAlue)
The (VAlue) function returns the numeric value of a string. Numeric strings can contain
spaces and periods between the digits, but no symbols or other printable characters (periods
are treated as spaces).

Syntax: (V Alue str_expr)
SEt $0 = (VAlue "12345")
SEt $0 = (VAlue "1 2 3")
SEt $5 = (VAlue "27ABC")
SEt $3 = (VAlue "hello world")
SEt $3 = (VAlue "12.34")

VIdeo

*
*
*
*
*

$0
$0
$5
$3
$3

=
=
=
=
=

12345 *
123 *
27 *
0*
1234 *

The VIdeo command issues video commands which alter the local console. Most commands
operate on the current cursor location (the cursor can be moved with XY and read from $X,
$Y). There are thirteen video commands:
Num
0
1
2
3
4
5
6
7
8
9
10
11
12

Use
Clear the entire screen.
Clear to the beginning of the screen.
Clear to the end of the screen.
Clear the entire line.
Clear to the beginning of the line.
Clear to the end of the line.
Scroll the screen up one line.
Scroll the screen down one line.
Delete the line.
Insert a line.
Delete the cursor character.
Insert a space at the cursor.
Inverse the character at the cursor.

Syntax: VIdeo num_expr
VIdeo 0
VIdeo 8

* clear the screen *
* delete the line with the cursor *

WHile

WHile allows a loop be executed without the use of labels. In a while loop, a condition is
tested and the loop executed based on the result of the test. The COntinue command can be
used to transfer execution back to the test of the while condition. The BReak command can
be used to explicitly exit a loop. The WHile command is useful for situations in which the
number of iterations of the loop is dependent on a calculation. Also see the REpeat-UNtil
command.

Syntax: W Hile num_expr, { block }
SEt $1=5
WHile ($1),{
PRint #2,<ST $1>+"^m"
SEt $1=$1-1
}

* set counter $1 to 5 *
* while $1 is non-zero *
* print the value of $1 *
* count down $1 *
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WIndow
The WIndow command draws a window frame and positions the cursor to the first position
within the window. Window coordinates are given by the upper-left corner and the width/
length. Make sure the coordinates are valid before attempting to draw the window.

Syntax: WIndo w num_expr, num_expr, num_expr, num_expr
WIndow 20,8,40,9
* draw a window at 20,8 with width=40,len=9 *

WT

WT (wait) causes the macros to wait for a string or strings from the remote system. WT
requires one or more parameters, separated by commas. Although only a single time-out
value can be set, multiple strings can be entered. When an incoming string matches or the
time-out expires, the code following that item is executed. If a blank string is entered as an
argument, any incoming data matches the string. This is normally used to detect the absence
of incoming data.

Syntax1: WT [num_expr] [,label] [str_expr][,label]
[,str_expr][,label] [,…]
Syntax2: WT [num_expr] [,{ block }] [str_expr][,{ block }] [,str_expr][,{ block }] [,…]
WT 5
* wait 5 seconds *
WT 5,{PRint #2,"t/o^m"},"-->"
* if --> not seen in 5 secs, print t/o *
WT "HELLO"
* wait for the string HELLO *
WT 6,"HELLO"
* wait for 6 seconds or HELLO *
WT 3,""
* wait 3 seconds or any incoming data *
WT "YES",%1,"NO",%2
* wait YES/NO, link to %1/%2 *

(XOr)

The (XOr) function returns 1 if an odd number of arguments are “true” or 0 if an even
number of arguments are “true” (logical exclusive or). An argument is considered “true” if it
is non-zero (otherwise it is false). The XOr function always evaluates all of its arguments and
returns a result based on the number of arguments (odd, even) which are true.

Syntax: (X Or num_expr, num_expr [,num_expr] [,…])
IF (XOr $1,$2),{ PRint #2,"$1>0 or $2>0 (but not both)" }
SEt $0=(XOr $3,$5) * $0=1 if $3>0 & $5=0 or $3=0 & $5>0 *

XY

The XY command positions the cursor to the coordinates specified by the parameters. Valid
horizontal coordinates are in the range 0…79 and vertical coordinates are in the range
0…23. Coordinates which are out of range are placed at their maximum values.

Syntax: XY num_expr, num_expr
XY 0,0
XY 79,23

* move cursor to upper-left corner *
* move cursor to lower-right corner *
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Macro Summary
The following summary gives a list of all the different macro commands and functions as well
as the system variables.

Macro Commands
BAr
BP
BReak
CAll
CHain
CLose
COntinue
CReate
DElete
DO
EXit
GEt
GOto
IF
INput
JSr
KEy
MArk
MEm
NOte
OPen
OVerlay
POp
PRint
PUsh
REpeat
SEt
SYnc
UNtil
VIdeo
WHile
WIndow
WT
XY

Enable/Disable macro trace mode.
Sound the speaker.
Break out of a while-loop.
Call a macro subroutine.
Chain to a Macro File.
Close a disk file.
Retest the condition of a while-loop.
Create an empty text-file.
Delete a file.
Execute a ProTERM command from a macro.
Exit a subroutine or macro.
Input a single character to a variable.
Transfer execution to a label.
Evaluate an expression and branch on the result.
Input a number or string to a variable.
Call an assembly language routine.
Stuff a keypress (used in Editor/Scrollback).
Set file read/write position (set mark).
Poke a byte into memory.
Show user a message.
Open a disk file.
Load and call an assembly language routine.
Pop a return address from the subroutine stack.
Print a string to the modem (or any other device).
Push a return address on the subroutine stack.
Repeat a code block until a condition is satisfied.
Assign a value to a variable.
Get the attention of a remote system.
Repeat a code block until a condition is satisfied.
Do a video command like clear the screen.
While a condition is true, execute a code block.
Draw a window frame & move cursor to upper-left.
Wait for a string from the modem.
Move cursor to x,y position.

Numeric Functions
ANd
AScii
BIts
EOf
EQual
EXist

Return 1 if all values are non-zero.
Return the ASCII value of the first character of a string.
Return the binary-and of two values.
Return 1 if device is at end-of-file.
Return 1 if two values are equal.
Return the filetype of a file if it exists.
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INstring
LEn
LT
MArk
MEm
MOdem
OR
PArtial
RAndom
SEqual
VAlue
XOr

Return 1 if value1 is greater-than value2.
Return the position of one string within another (0=no match).
Return the length (in characters) of a string.
Return 1 if value1 is less-than value2.
Return the current file position.
Return the contents of a memory location.
Return the modem port status.
Return 1 if any arguments are non-zero.
Return 1 if string1 occurs at the left of string2.
Return a random number between 0…65535.
Return 1 if two strings match identically.
Return the numeric value of a string.
Return 1 if an odd number of values are non-zero.

String Functions
ANswerback
CHar
DAte
FOrmat
LEft
MId
PAth
PHone
RIght
SCan
STring
SYstem
TIme
UPper

Return the Answerback string for the current system.
Return a character based on its ASCII value.
Return the current date string in “DD-MMM-YY” format.
Return a formatted string.
Return the left-part of a string.
Return the mid-part of a string.
Return a ProDOS pathname (0…4).
Return the phone number string for the current system.
Return the right-part of a string.
Return the contents of a screen line (scan a line).
Return a string of digits based on a number.
Return the name of the current system.
Return the time string in “HH:MM:SS” format.
Return a string in uppercase.

Label Syntax
~num
@@key
@key
@@num
@num
%%num
%num
~0

References System Macro (num = 1…10).
Declare a Global Macro keyboard binding (key = A…Z).
References @@key declaration (key = A…Z).
Declare a Global Macro label (num = 1…99).
References @@num declaration (num = 1…99).
Declare a Macro File label (num = 11…99).
References %%num declaration (num = 1…99).
Continue execution at end of current command.

System Variables
$A
$B
$C
$D

Current autosave (receive ascii) status: 0=off, 1=on, 2=hold.
Modem line speed (DCE): 110…57600.
Scrollback data capture characteristics.
Current program area: 0=term mode, 1=editor, 2=scrollback.
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$F
$H
$I
$J
$K
$M
$N
$O
$P
$Q
$R
$S
$T
$V
$W
$X
$Y
$Z

Last file operation result: 0 = no errors.
Number of seconds required for last transfer.
Number of errors during last transfer.
Number of files sent/received during last transfer.
Number K-bytes sent/received during last transfer.
NOTE: This variable is only updated after DO "MI:TR","[]".
Hide local messages: >0 = hide message (such as disk errors).
Number of numeric variables available.
Online flag: >127 = online.
ASCII-send prompt timeout (0…255) = 0…2.55 sec.
Quiet mode: >0 = don't display incoming data on screen, don't show cursor during
input, don't flush screen on connect.
Redial limit: max times to redial from macros (0=no limit).
Number of string variables available (each is 80 chars).
Last file transfer status: 0 = no errors.
Contains the memory address of the first string variable &0.
Result of last button press: 0=default button, >127=cancel.
Current horizontal cursor position (read only).
Current vertical cursor position (read only).
Current display mode for channel #2 (0=normal, 64=mousetext, 128=inverse).

Turnkey Macro Operation
When ProTERM is run, the first thing it always does is execute global macro “@@1”. If this
macro is not present, then it has no effect. By always running “@@1” at program startup, it
is possible to make changes to ProTERM which occur every time it is run.
After Global Macro “@@1” is run, ProTERM checks to see if a startup filename was passed
by a program launcher (like ProSel or the GS/OS Finder). If a filename of the form
“PTD.name” is passed, ProTERM immediately dials that system. If the filename has any other
form, then ProTERM attempts to run it as a macro file (the file must be in the main ProTERM
directory). If no filename is passed, ProTERM looks for two default files. If there is a dialing
entry called PTD.STARTUP, then ProTERM dials it immediately. If there is a macro file called
PT3.STARTUP, ProTERM runs it immediately. Otherwise, ProTERM goes to the Main Menu
and waits for a command.

Converting ProTERM 2.2 Macros
Many macros can be converted from ProTERM 2.2 to ProTERM 3 with little or no change.
While ProTERM 3 macros represent a super-set of the ProTERM 2.2 macros, there are
changes to certain commands which require some adjustment. The following points outline
the major changes needed to make ProTERM 2.2 macros operate under ProTERM 3.
• Change all System Macro references from number to ~NUMBER (TILDE-NUMBER)
(that is, change GO 5 –to– GO ~5).
• Replace all occurrences of DI with PR.
• All DO commands must be rewritten to use ProTERM 3 syntax.
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• System variables are a potential problem. For more details, check the Macro Variables
section of this chapter.
• The auto-increment/decrement set command must be changed (i.e., SE $0+ needs to
be changed to SE $0=$0+1).

Special Global Macros
As was mentioned earlier in this chapter there are 127 labels available to the Global Macros
from “@@1” to “@@127”. The labels in the range “@@65” to “@@90” correspond to
key bindings “@@A” to “@@Z” and the labels in the range “@@97” to “@@122”
correspond to key bindings “@@a” to “@@z”. In addition to these dual purpose labels,
labels “@@1” to “@@9” are reserved for special use by ProTERM. These labels do not
need to be defined. If they are, they should be used as documented below. As mentioned in
the preceding Turnkey Macro Operation section, the label “@@1” is called every time
ProTERM is run. In addition, several other labels have special uses and others are reserved
for future expansion. The following list of Global Macro labels are special and should only be
used for their designated purposes:
@@1

Used as a turnkey started macro. Executed immediately after
ProTERM is run.
@@2 This macro is called whenever the mouse button is pressed while
pointing to the date.
@@3 This macro is called whenever the mouse button is pressed while
pointing to the time.
@@4 This macro is called whenever the mouse button is pressed while
pointing to the 10-characters left of the date.
@@5 This macro is called after a protocol send is completed.
@@6 This macro is called after a protocol receive is completed.
@@7…@@9 Reserved for future expansion.

PART TWO — THE MAJOR FEATURES

202

C H A P T E R N I N E

PART TWO — THE MAJOR FEATURES

THE MENUS

203

Part Three
T H E

M E N U S

PART THREE — THE MENUS

204

P A R T T H R E E

PART THREE — THE MENUS

THE APPLE MENU

205

The Apple Menu
CHAPTER TEN
This chapter details the commands in the Apple Menu. These commands can be accessed by
choosing them from the Apple Menu with the mouse or by pressing COMMAN D- TILDE ( ~)
and using the ARROW Keys and the RETURN key to select them. The Apple Menu is available
in Terminal, the Editor or Scrollback modes.
About ProTERM

About ProTERM

Key Function
Screen Saver

About ProTERM presents version, copyright and memory utilization information for
ProTERM. Press any key or click anywhere on the screen to exit this command. Four different
memory utilization parameters are displayed:
• Scrollback Buffer is the amount of memory available for use by Scrollback.
• Editor Buffer is the amount of memory available for the Editor (the maximum is 46K).
• The Transfer Buffer is the amount of memory available during protocol transfers (the
maximum is 63K).
• The Code-Cache Buffer is the amount of memory available for ProTERM to keep
recently used code modules in memory (the maximum is 63K).
See Index: Preferences for more information about ProTERM memory utilization.

Key Function
The Key Function command provides a way of practicing the keystrokes needed for the
different terminal emulations. Since different keyboards require different keystrokes to
generate the keys needed for emulation, this command allows those keys to be tried offline.
Just press a keyboard combination, and Key Function displays the name of the resulting
keypress. For example, pressing OPTION-5 on a normal Apple IIGS keyboard displays “F5”
while on a Apple IIe keyboard it displays “Keypad 5”. The Key Function command is another
method of illustrating the information contained on the emulation keyboard maps.
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Screen Saver
The phosphor on the inside of the monitor screen is light sensitive and after long periods of
use can deteriorate and become less effective. If anunchanging screen image is projected for
long periods of time, eventually the image burns into the phosphor. A burned image can
even be seen when the monitor is turned off. A screen saver operates by waiting for a period
of non-activity and then clearing the screen so there is nothing to burn into the phosphor.
The ProTERM Screen Saver waits for a predetermined period of non-activity and then clears
the screen. It then displays the letters of the word ProTERM bouncing around the screen
(because a changing image does not damage the phosphor). The screen returns to its
previous display as soon as the mouse is moved, a key is pressed or data is received from the
modem. The following parameters control the operation of the Screen Saver.

Screen Saver Enabled
When checked, the Screen Saver activates after a predetermined amount of non-activity (see
Timeout Before Activation below). When NOT checked, Screen Saver is disabled and never
activates.

Timeout Before Activation
The number of minutes the Screen Saver waits before it activates. Times can be set from a
minimum of one minute to maximum 30 minutes. To change the time, highlight this field,
press the DELETE key to clear the current information and enter the new time from 01 to 30.

Never Activate and Activate Now
If your computer has a mouse, the Screen Saver routine can be controlled by placing the
mouse in the corners of the screen. The corners for controlling this action are named Never
Activate and Activate Now. The Screen Saver default is set up so placing the mouse pointer
in the lower left corner of the screen prevents activation of the Screen Saver as long as the
mouse remains there. Placing the mouse in the lower right corner makes the Screen Saver
activate immediately (where immediately is about 8 seconds).
To edit the Never Activate, and Activate Now Corners, TAB to the radio buttons and use the
ARROW keys to select the one which indicates your corner of preference.
NOTE: Only one radio button in a in a section can be selected at a time. When another in the
same section is selected, the previous selected one is deselected.
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Current object
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Upper-Right
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Lower-Right
Mouse pointer

Cancel

Screen Saver
Window

Buttons

Saving the Changes
Changes made to the Screen Saver effect only the current ProTERM session. As with other
personal preferences made to ProTERM, to make the changes permanent, it is necessary to
save the new preferences. Choose the Preferences command from the Misc menu and choose
the Save button. This saves the new Screen Saver and other ProTERM preferences.
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The File Menu
CHAPTER ELEVEN
ProTERM takes full advantage of Apple’s ProDOS Operating System. All ProDOS storage
devices are supported along with the hierarchical directory structure. ProTERM additionally
supports the concept of a “parent directory” and “slot/drive naming” which are not a part of
standard ProDOS, but make using it much easier. For more information on using ProDOS
with ProTERM see the chapter, Using ProDOS . The commands documented in this chapter
are available from the File menu. Most of these commands make use of theFile Selection,
Batch Selection or Path Selection windows explained inThe ProTERM User Interface chapter.

File
Copy Files
Delete Files
Emulate Files
Print Files
Rename Files
Set File Info
View Files
Catalog
New Directory
Format Disk
Q uit

Q

Copy Files
Copy Files, copies one or more files from one directory to another. To copy files, choose
Copy Files from the File menu. From the batch selection window, use SPACEBAR and/or
OPTION-ARROW to tag one or a list of files to be copied. If a directory is tagged, all files
within that directory are copied along with the directory itself. After the files to be copied
have been tagged, press the Copy button. A path selection window will be displayed which
allows the destination of the files to be specified. Select the destination directory, press Copy
and ProTERM will copy the files. As it copies files, ProTERM displays a status window telling
how many files remain to be copied. If the file being copied is a directory or already exists in
the destination directory, ProTERM prompts for confirmation before continuing.

Delete Files
Delete Files deletes one or more files or directories. To delete files, choose Delete Files from
the File menu. From the batch selection window, use SPACEBAR and OPTION-ARROWS to
tag the list of files to be deleted. If a directory is tagged, all files within that directory are
deleted along with the directory itself. After the files to be deleted have been tagged, press
Delete to delete the tagged files. ProTERM prompts for confirmation prior to deleting the
files in a tagged directory.
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Emulate File
Emulate File displays the contents of a text file using one of the terminal emulations. This
command is normally used to view text files which contain embedded emulation codes such
as ProTERM Special Emulation movie files. In addition, Emulate File also allows large text
files to be loaded into Scrollback, where they can be viewed, printed, clipped, etc. To
emulate a file, choose Emulate File from the File menu, select the file to be emulated from
the file selection window and press the Emulate button. ProTERM will then display a window
of emulation options. After selecting the Emulate File parameters, press Emulate and
ProTERM will emulate the file.
NOTE: After setting the Emulation Parameters up once, subsequent files can be viewed
quickly by pressing COMMAND-RETURN as soon as the Emulate File window opens.
COMMAND-RETURN activates the default button in any ProTERM window.
While ProTERM is emulating a file, there are several commands which can be used to control
the speed of the display:
• The Left-ARROW slows down the display.
• The Right-ARROW speeds up the display.
• The SPACEBAR pauses the display.
• The ESCAPE key cancels the display.
NOTE: Emulate File should not normally be used while online with a remote host system
because it may reset emulation parameters which were previously set by the remote host. If
ProTERM suspects using this command may cause a problem, an alert message is displayed.

Setting Up to View Emulation
The following parameters may be set from the Emulate File option window:

Emulation
The Emulation parameter selects which terminal emulation will be used when ProTERM
processes the file. When emulating a file which contains terminal emulation codes, select the
corresponding emulation. For example, to display ProTERM Special Emulation movie files,
select ProTERM Special Emulation. If the file does not contain emulation codes, select No
Emulation.

Add Linefeed to Return?
This parameter selects whether ProTERM should append a LINEFEED to each RETURN
character encountered in the file. Because some emulation files are captured with the
LINEFEED characters missing, it is necessary to have a mechanism to add them back in. If
Emulate File results in all the data being displayed on a single line, try turning the
Add
Linefeed to Return? parameter on. Normally this parameter needs to be on when viewing
ProTERM Special Emulation movie files.

Save Data Into Scrollback?
This parameter controls whether the data which is displayed on the screen is also saved as
part of Scrollback. If Emulate File is being used to load a file into Scrollback, theSave Data
Into Scrollback? parameter should be turned on.

PART THREE — THE MENUS

THE FILE MENU

211

Print File
The Print File command prints the contents of a file from disk. To print a file, choose Print
File from the File menu, select the file to be printed and press the Print button. Select the
desired print options (generally, these can be left at default) and press the Print button. To
cancel printing, press the ESCAPE key. Print File also converts the optional dot-command
processing and margin control. For more information on the Print Parameters window, see
the Index: Print; Parameters.

Rename Files
The Rename Files command renames one or more files or directories. Choose Rename Files
from the File menu, and from the batch selection window, use SPACEBAR or OPTIONARROWS to tag (apply checkmark by selecting the file adn pressing SPACBAR) one or more
files to be renamed. If a directory is tagged, just the directory itself is is renamed (as opposed
to the contents of the directory). After tagging the files and directories, press the Rename
button. For each file or directory tagged, ProTERM displays a window with the current
filename and a text entry field for the new name. Enter the new name and press Rename.
Repeat until all the tagged files and directories are renamed.

Set File Info
Set File Info changes the filetype, auxiliary filetype and access (whether file is locked or
unlocked) for one or more files. This is especially useful for changing files which have been
downloaded and stored to disk with an incorrect filetype. To change the file information,
choose Set File Info from the File menu. From the batch selection window, use SPACEBAR
and OPTION-ARROWS to tag one or more files. If a directory is tagged, all files within that
directory will be tagged as well. After the file(s) are tagged, press Set Info and ProTERM will
allow the file parameters to be changed for each tagged file (see below). After entering the
file parameters, press Set Info to apply the changes or press Skip to move to the next file
without making any changes.

Use Same Info For All Files?
Set File Info has two modes of operation determined by the setting of Use Same Info For All
Files? When this option is checked, all selected files are affected by the changes made. That
is, ProTERM prompts for the file information once and applies it to all tagged files. If this
option is not checked, ProTERM prompts for the information for each individual file.

Filetype
A file’s “Filetype” determines what kinds of programs can access a file, and theFiletype
parameter allows this value to be changed. The Filetype parameter can be entered using a
textual equivalent (such as “TXT”, “LBR” or “BIN”) or by its hexadecimal value. For example,
to change the filetype to “LBR”, enter the text “LBR” or the hexadecimal equivalent “$E0”.
Either way, when the file is later displayed in a file selector or catalog, the filetype will display
as “LBR”. When the Filetype parameter is left blank, ProTERM does not change the filetype.
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File Access
The File Access parameter determines whether a file is “locked” or “unlocked.” When locked,
a file cannot berenamed, written to or deleted:
• To lock a file, enter “L” in this field.
• To unlock a file, enter “U” in this field.
• Leave this field blank to keep the File Access unchanged.

Auxiliary Filetype
The Auxiliary Filetype parameter determines the auxiliary filetype of a file. This is expressed
as a 16-bit hexadecimal value (such as $8000). ProTERM does not change the Auxiliary
Filetype when this field is left blank.

View File
View File allows the keyboard or mouse to be used to page through the contents of one or
more files. To view files, choose View Files from the File menu. From the batch selection
window, use SPACEBAR and OPTION-ARROWS to tag files for viewing. If a directory is
tagged, all files within that directory are viewed. After the files have been tagged, press the
View button and ProTERM will display the contents of the first file. The following explains
the function of the buttons and the status information present at the bottom of the view
window.

View File Information
In the lower right corner of the View window, ProTERM displays the current FILENAME, the
current screen number and the current/total bytes ,(number of total characters) in the file.
The Screen indicatornumber can be used in conjunction with the Goto button in order to
resume viewing a file at a previously known screen position. Press theGoto button and a
Goto window will open allowing you to enter the screen number to go to. The byte indicator
gives a general “feel” for the relative position within the file.

Next
The Next button advances to the next screen of the file. At the final screen, the Next button
does not advance any further but displays an “[End of Data]” message instead.

Prev
The Prev button backs up to the previous screen of the file. At the first screen, the Prev
button does not backup any further. A “[Start of Data]” message is displayed at the top of the
first screen.

Goto
The Goto button positions to a specific screen number within a file where a “screen” is equal
to 20 lines of text. The screen number indicator in the lower right corner of the View
window can be used for reference.
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Edit
Starting from the current screen, the Edit button allows one or more screens of data to be
loaded into the Editor. When the Edit button is pressed, a window prompts for the number
of screens to be loaded into the Editor. In the View file area, a “screen” is equal to the
amount of data which View displays on one screen (20 lines). IfNumber of Pages to Copy: is
left blank, ProTERM loads from the current screen until the Editor is full or the end of the
file is encountered, whichever occurs first. When View Files is used from Terminal mode,
Edit appends data to the end of the current Editor document. When used from within the
Editor, Edit inserts data into the document at the current Editor cursor position.
NOTE: The View file command is also available from within the File menu in the ProTERM
Editor.

Done
The Done button cancels the viewing of the current file and displays the next file (if more
than one file was tagged). If the current file is the last (or only) one tagged, thenDone
cancels View.

Cancel
The Cancel button cancels the viewing of the current file and returns to terminal mode,
regardless of whether additional files are tagged or not.

Catalog
Catalog displays the names of all files within a directory along with information about each
file including the size in blocks and bytes, the modification and creation dates and times, and
the main and auxiliary filetypes. To catalog a directory, choose Catalog from the File menu.
From the pathname selection window, select the directory to catalog and press the Catalog
button. ProTERM displays up to sixteen files in a window. The Next and Prev buttons are
used to display those respective windows in the directory. Pressing Next moves forward one
window and Prev moves back one window. When finished viewing the catalog, press ESCAPE
or the Cancel button.
ProTERM 3.1
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New Directory
New Directory creates a new directory within a directory, sometimes referred to as a “subdirectory.” To create a new directory, choose New Directory from the File menu, select the
directory in which to create the new “sub” directory, enter a name for the new directory and
press the New button. ProTERM creates the new directory using the specified name.

Format Disk
Format Disk formats a 5.25" or 3.5" floppy disk for the storage of ProDOS files. To format a
disk, choose Format Disk from the File menu, specify the slot/drive location of the disk to be
formatted and select the Format button. ProTERM prompts you to insert the disk to be
formatted into the drive, and asks for a name for the new volume. The volume name must be
a valid ProDOS filename and should not include a leading or trailing slash. After entering the
volume name, press the Format button to format the disk. If any problems are detected
during the formatting process, an alert message is displayed. If the disk was previously
formatted as a ProDOS volume, ProTERM shows the old volume name and requests
permission to erase it.

Quit
The Quit command causes ProTERM to exit to the “ProDOS quit code.” Keep in mind
quitting from ProTERM looses the contents of the Editor and Scrollback forever. If you wish
either of these to be saved, do so prior to quitting ProTERM. To quit ProTERM, choose Quit
from the File menu and press the OK button. Documentation on the ProDOS Quit Code is
available in the Apple ProDOS Users Manual available from Apple Computer.
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Press the TAB key
to place the cursor
in the Edit System
Parms window.

The Dial Menu
CHAPTER TWELVE
Dial
Create System
Q uick Dial
Rotary Dial
The InTrec BBS

This chapter offers additional information on how to customize and dial your System entries.
“Systems,” are the files containing the name, phone number and all parameters relating to a
specific host computer. System parameters (sets of values for each system) are explained in
more detail along with additional information on different dialing modes in different parts of
this manual. See the Index: Dial. Also see Parms.
Installations at the system level are for, and allow customizing of each individual host system
you will be calling.

Editing System Parameters
“System ” is a name
for the computer
hosts you call. Its
also called a service.

“Parms” is a short
way of saying
parameters which
is a set of values.

Besides the basic parameters (parms or values) which are entered for each system when it is
created, there are three additional windows of parameters which can be customized. All of
these parameters have been assigned default values which work for most applications and do
not require changing unless you would like to customize them for a specific need. To get to
the Edit System Parms menu, choose the name of the system from the Dial menu.

System Number
Each system must have a System Phone Number associated with it. Normally, phone numbers
are no different than you would dial to make a voice call, but for special situations, the
phone number can be up to 32 characters long and can contain several “meta–characters”
(special dialing instructions for the modem) in addition to the digits of the phone number.
ProTERM always defaults to dialing phone numbers using Touchtone™. If your phone
system does not support Touchtone dialing, then insert a “P” as the first character of the
phone number to force pulse (rotary) dialing. The actual list of valid characters varies from
modem to modem, but the following table lists those supported by almost every modem
(consult your modem manual in the dialing section for an exact list of valid dialing
characters).
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Most parameters
are already set to
default, when in
doubt, accept them.

Meta characters are what make up the phone number as seen by your modem. Actually, they
are the instructions ProTERM sends directly to the modem within the dialing string. The “P”
used to change the default of Touchtone dial to rotary dial is a meta character.

Meta Characters
Character Function
T
P
0…9
#
*
,
W

Dial subsequent digits in tone mode.
Dial subsequent digits in pulse mode.
Dial the digits 1,2,3,4,5,6,7,8,9,0.
Make the pound–sign tone (touch–tone only).
Make the asterisk tone (touch–tone only).
Pause for two seconds.
Wait for a second dial tone before continuing.

Your Default System (Main System Called)
After you have several systems entered, you’ll see them alphabetically arranged. Your favored
system may be buried in the list, but you can make one favored system to always be the
default (automatically selected as you boot into ProTERM).

Creating your
“ default”
system.

The System Name must be activated by at least opening theSystem Parms window for that
system. This tells ProTERM this is the current system. After having selected this system press
the ESCAPE key to go to ProTERM’s Main menu screen. Choose the Misc pulldown menu,
then choose Preferences, and press the RETURN key. When the Preferences window opens,
notice Save is already chosen. Pressing the RETURN key closes the window and saves all
personalized changes you have just made throughout ProTERM. In this case, the system you
chose will now be the default system and will be chosen every time you boot ProTERM.

Call Waiting
To disable Call Waiting for a single call, insert1170, (1-1-7-0-,) at the start of the phone
number. Note the comma is part of this special number string. An example phone number
might look like, 1170,123-4567. The special number “1170,” sends a signal to your local
phone company to temporarily disable the Call Waiting and the comma “,” tells ProTERM to
wait 2 seconds while the change is being processed by the phone system’s equipment. The
rest of the number is then dialed normally. This option only disables Call Waiting for the
duration of one call. Call Waiting is reinstated automatically at the completion of the call.
The “1170,” routine works with both tone and pulse phone lines in many parts of the United
States. You may also want to try the Touchtone version of entering*70, in place of the 1170,
which also works in many parts of the USA.
NOTE: If you have problems with this option, consult your local phone company for the
procedure to temporarily disable Call Waiting.
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Baud Rate: 9600

Data Format: 8 N 1

Break Time: 50 /100

Emulate: ProTERM Special
Delete Key: Emulate
Connect Time:
Dial

Duplex: Full

Flow Off: ^S Flow O n: ^ Q
Answerback:

Backspace: Emulate

√

Status Bar?

45

Redial

Save

Macros

Parms

Cancel

System Parameters
Window

Baud Rate (BPS)
The term “Baud Rate” is actually incorrect terminology. In truth, BPS (bits per second) is the
correct term to refer to the speed of a modem. In the days of 300 baud modems, the two
terms meant the same thing. However, in the case of higher speed modems, BPS refers to the
speed of the modem and baud refers to a characteristic of the modem signal. Even though
the term baud rate is a redundant term and technically incorrect we’ve chosen to use it at
this time because it is the contemporarily accepted and familiar term.
Baud Rate is a pop-up window and the selectable rates are; 110, 300,1200,2400,4800,9600,
19,200, or 38,400.
NOTE: ProTERM lists 38400 as a valid baud rate selection. This rate is only available when
using a modem connected to the Apple IIGS Modem Port. In addition, using this speed is not
generally recommended. Currently there are very few modems available which can actually
sustain data transfer rates anywhere near this speed. Most of these modems send short bursts
of data at this speed, but have only a net throughput of around 19200. It is much easier for
the software to communicate with a modem which is consistently sending data at 19200 than
with a modem which sends short bursts at 38400.

Data Format
ProTERM supports data formats of “7E1, 7O1, 8N1, 8N2, 7E2, 7O2” (see the Index: Data
Format for more detail). The most common data format is “8N1” which works with most all
of the systems in use today.
The Format option controls how data is “packaged” when it is transferred to a service. By far,
the most common format used is “8N1” which stands for “8 data bits, no parity, 1 stop bit.” A
few services also use the “7E1” format which stands for “7 data bits, even parity, 1 stop bit.”
The rest of the formats are rarely ever used.

Supported Data Formats
7E1
7O1
7E2
7O2
8N1
8N2

7 data,
7 data,
7 data,
7 data,
8 data,
8 data,

even parity,
odd parity,
even parity,
odd parity,
no parity,
no parity,

1 stop
1 stop
2 stop
2 stop
1 stop
2 stop

PART THREE — THE MENUS

218

C H A P T E R T W E L V E

Duplex
The Duplex parameter controls how ProTERM handles data typed at the local keyboard.
• Full duplex systems (the most common) echo back characters which are sent to them.
Therefore, all data typed at the local keyboard is sent only to the remote system and not
to your monitor. On a full duplex system anything entered at the keyboard is only seen
after it is echoed back from the remote system.
• Half duplex systems do not echo back the characters sent to them. To enable you to see
what you are typing when using a half duplex system, all data typed at the local
keyboard must be simultaneously displayed locally as it is sent to the remote system, if
ProTERM is set at Half Duplex, what is typed locally is being sent directly to the monitor
as well as to the host. Also see the Index: Duplex
What happens if the wrong duplex is used? If a half duplex system, such as GEnie™ was
called using full duplex, GEnie would react to your commands because the commands are
received, but the commands would not be displayed on your monitor. On the other hand, if
you called a full duplex service such as CompuServe™ with half duplex selected, you would
see double characters when you type; one copy being displayed as it is sent directly from the
keyboard and the other echoed from CompuServe. Also see the Index: Duplex.

Break Time
Some host systems allow the use of a Break Signal to stop action in certain situations. The
break signal acts as an interrupt to gets the attention of a remote system when it is busy
doing other things. When do you need to take a “brake?” If you encounter a situation where
data just seems to scroll and scroll without end, sending the break signal will sometimes stop
the display and return the system to a command prompt. TheBreak Signal parameter
controls the length of time (duration) the break signal being is sent. The default Break Signal
default setting is 1/2 second. COMMAND–B sends the Break Signal to the remote host.

Flow Off & Flow On
Because there are times when ProTERM is not able to accept incoming data from a remote
system, a mechanism calledFlow Control is used to regulate the flow of data. The flow
control parameters are used to specify how the flow of incoming data can be stopped and
restarted. When left blank, ProTERM selects flow control characters based on your modem
configuration. To override ProTERM’s default settings and use a specific flow control
technique, use the following notation:
Notation
^char
char
R0
R1
D0
D1

Method Meaning
software Send CONTROL– char
software Send char
hardware Drop RTS
hardware Raise RTS
hardware Drop DTR
hardware Raise DTR

Emulate
Terminal Emulation refers to making ProTERM emulate, or “function like,” a specific type of
stand–alone terminal. If the system requires the use of a certain type of terminal, select the
corresponding terminal emulation from the list. If the system does not require emulation,
select No Emulation. Split–Screen Chat emulation is used on real–time conferencing systems
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and allows outgoing messages to be composed in one area of the screen while incoming
messages are displayed in another. For more detail, see the Index:Emulation.

AnswerBack
The AnswerBack parameter is used in conjunction with the Emulation parameter. IfNo
Emulation is being used, then this parameter is not used. Otherwise, its use is explained in
detail elsewhere in this manual, see the Index:Emulation. Also check for the specific
terminal by name.

Delete Key
The DELETE Key is conveniently located at the upper–right corner of all Apple II keyboards
which makes it ideal for use as a “backspace” key during text entry. You may notice that
different systems require different characters to be sent for this purpose. Since almost all
systems require either a DELETE or a CONTROL-H character, this parameter allows the
DELETE key to send either of these values. If you’re not sure of which value to send, set this
parameter to Emulate. Don’t be afraid to experiment. You might find setting this parameter
to Send BS (Send Backspace) on CompuServe, Delphi and GEnie make their online text
editors much easier to use. Also see the Backspace parameter below.

Backspace
The Backspace parameter allows an incoming backspace character to be treated in a
destructive or non-destructive manner. In destructive mode, the backspace causes the cursor
to move left one character and destroys the underlying character. In non-destructive mode,
the cursor moves left, but the screen is not changed. For most systems, this should be set to
Emulate. However, for systems such as CompuServe, Delphi and GEnie, you may find the
Destruct setting is preferable.

Status Bar
The Status Bar keeps you up to date as to current status of ProTERM. It displays useful
information including the amount of data in the Editor and Scrollback, the current baud rate
(BPS), the connection status and the date and time. Only 24 lines can be viewed at one time
on the Apple computer. When the status bar is turned on, it displaces one line of possible
text leaving 23 lines available for viewing incoming data. All 24 lines of incoming data can be
displayed by turning the status bar off. TAB to entry and press the SPACEBAR to toggle the
Status Bar [√]parameter on and off. For more information see the Index:Status Bar.

Hold the
OPTION key
down to stop the
“countdown.”

Connect Time
The Connect Time controls the amount of time the local modem waits for a connection when
calling the remote system. Since most modems support busy signal detect, there is no
penalty associated with setting the Connect Time too long. However, if the Connect Time is
set too short, the modem may fail to make a connection because ProTERM cancels the
attempt before the connection is completed. The default Connect Time of 45 seconds works
well for the slower (300, 1200 & 2400 BPS) applications but higher speed modems need
more time to negotiate logon procedures. Times of a 60 seconds or even more may be
required. Experiment with the system in question until it works. Press and hold the OPTION
key to stop the countdown.
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Parms – More System Parameters
By selecting the Parms button from the Edit System Parms window, another window of
System Parameters can be displayed. While the parameters listed on theParms window are
less frequently used than the main parameters, they allow additional customizing of
ProTERM for a specific system’s needs. As with all ProTERM parameters, all of these
parameters are pre-assigned with default values which are adequate for most applications.
For more detail see the Index: System Parameters.

Per Minute and Per Hour Cost
In order to allow online costs to be displayed and recorded, ProTERM has fields to indicate
the Per Minute and Per Hour Cost for accessing a system. Normally, per minute cost is used
to enter calling charges such as long distance or network phone connect charges, while per
hour cost is used to enter host access charges. Whenever ProTERM displays the resulting
charges, both fields are taken into account using the formula:
total_cost = (per_minute+(per_hour/60))*minutes_online)

Show Cost

The Show Cost option causes the connect costs to be displayed on the top line of the display.
As connect time increases, the connect cost is updated.

Log Cost to Disk
Press TAB until the cursor selects this option, then press the SPACEBAR to place a checkmark
[√] here. When this option is used, a file named PT3.LOG is created in the ProTERM
directory. The Log Cost option causes a summary line to be appended to the PT3.LOG file at
the termination of a connection. The summary line displays the system name, connection
time and connection cost. The PT3.LOG file should be periodically deleted or moved to
another disk as it starts to grow in size. Otherwise, it continues to grow and grow, using up
disk space as it grows. A special note for those using a 5.25" disk: Since they are so limited in
storage size, it is important to remove this file often. The file can be copied to another disk
using the ProTERM File copy utility. This file can be deleted from the ProTERM directory and
the next time the option is used, it will create a newPT3.LOG file.

When in doubt,
accept the
installed
defaults.

Default Data Capture Mode
Online data can beCaptured to the ProTERM Editor, printer or written to a disk as a file,
using two different methods.
• Char(acter) Mode: If the data contains control characters or emulation codes, they are
saved as part of the data.
• Line mode: An “image” of the data as is seen on the screen is captured. Using this
mode, all emulation and control codes have already been processed and the captured
data looks just like what was displayed on the screen. Processing and removing control
characters is important if it the text is to be sent to a printer. Control characters are
what gives a printer its instructions and strange instructions out of context can cause
printer difficulties.

ASCII Send Parameters
The next six parameters (Send Width, Send Prompt, Send Mode, Fix Blank Lines, Char Pace
and Line Pace) all control ASCII send options. A more detailed explanation of each
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parameter along with ASCII send technique is provided elsewhere in this manual. See the
Index: Transferring Files.
Note: ASCII stands for American Standard Code for Information Interchange. A standard 7–
bit code is used to establish compatibility among data services.

Send Width
The Send Width parameter controls the width of lines sent to a system during an ASCII send.
Also when working with system, it sets the ProTERM Editor Ruler to the system’s data width
in the ProTERM Editor. So when text is composed while working with this system, it will be
preset to the correct margins. Most systems use a width of 80 characters, but some
commercial online services use a line width of less than 80. Once this parameter has been
set, it will be used as the default value for ASCII sends (file transfers) and the Editor when
using this system.

Send Prompt
A Send Prompt is a character which some systems provide during an ASCII send (a text
upload from the ProTERM Editor or from disk), to inform (prompt) the sender the host is
ready for the next line to be sent. This allows individual lines to be sent very quickly while
the pace between lines is controlled by the remote system. Common prompt characters
include “>” and “:”.
The next time you are using the system you wish to send ASCII text to, check what (if
anything) is used as a new line leader as you are typing. For example, you may see a line
prompt which looks like “1:” or maybe “1>” or as noted above, just the prompt will show as
a new line is available. The reason using a “send to prompt” is important to you is, the
prompt is the signal the host has processed the last line and is ready for a new one. When
you send to a prompt, the file is being uploaded as efficiently as is possible. You are not
waiting too long and you are not sending so fast as to overwhelm the system which usually
causes missing characters especially near the beginning of each line.
Some systems do not show a prompt. Some do not show a prompt automatically and some
that do show a prompt, allow the prompt to be changed. Check the individual system help
files for details. An example of a system which does not show a prompt but will show one on
request is a GBBS BBSystem such as the InTrec BBS. To turn the prompt on, when using a
GBBS system enter the dot command “.P” (PERIOD-P) and press RETURN. Now every time a
line is entered, you will get a “>” for a prompt. Although the prompt can be seen on the
screen during the upload, the prompt will NOT be a part of the final text. A neat trick you
can use when sending a file to a system which does show a prompt on request is to imbed
the request in your text. To do this, enter “.SC.P” on the first line of the document at the very
top of the text.

Send Mode
ProTERM supports ASCII sends in both Line Mode and Character Mode:
• In line mode, ProTERM sends an entire line of data, waits for an optional send prompt
if the Send Prompt parm has a character in it, and then sends the next line.
• In character mode, ProTERM waits for the echo of each individual character (full duplex
systems send back a copy of every character sent to them) before sending out the next
character.
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If a pressing RETURN exits the host
editor then “FIX
Blank Lines! ”

Fix Blank Lines
A favorite telecom text format is to separate paragraphs with a blank line. However, certain
host systems can create a problem when these text formats are uploaded as ASCII text files.
These systems look for and screen out consecutive RETURN characters and when found,
these host systems interpret the second RETURN as the end of the file and attempt to save
the file to disk. How it works: When a paragraph ends, it has a RETURN character on the end
of it. If there is a blank line between paragraphs, then the blank line is normally made by a
second consecutive RETURN character. Therefore to upload an ASCII text file to one of these
systems, the paragraphs must either NOT contain blank lines between them, or the host
system needs to be fooled into thinking there are no blank lines. This is done by inserting a
SPACE character just before the second RETURN character. The host system sees the first
RETURN character, and then it sees the SPACE character and the second RETURN shows up,
but the system did not see two consecutive RETURN characters so the scheme works.
The Fix Blank Lines parameter converts consecutive RETURN characters (blank lines) as the
data is being sent. The text is screened for “RETURN-RETURN” characters to a “RETURNSPACE-RETURN” sequence. A SPACE character on the new line is placed ahead of the second
RETURN character making the host think the “fixed-line” was a legitimate paragraph.

Char Pace
The Character Pace feature controls the rate at which data is sent to a remote system during
an ASCII text file send. When in Character Send mode, this selects how many characters may
be sent before the echo of the first character is received. In Line mode, this represents the
send speed as a percentage of the current baud rate (BPS).

Line Pace
After a line of data has been sent, theLine Pace parameter controls the delay before the next
line is sent. The parameter is expressed in 1/100 of a second.

Protocol Transfer Parameters
The following six parameters (Protocol Speed, Duplicate Filename, Upload Options,
Download Options, Auto Protocol Start and Zmodem–Resume) all control Protocol Transfer
options. A more detailed explanation of each parameter along with protocol transfer
technique is provided elsewhere in this manual, see the Index: Transferring Files.

Protocol Speed
The Protocol Speed parameter selects the relative speed at which the remote system can
process protocol transactions. By dropping the speed down to slow, ProTERM will wait
longer for responses from the remote system than normal.

Duplicate Filename
When certain receive protocols are used, the remote system can supply filenames for the
new files. However, if a filename already exists in your directory, ProTERM must make a
decision either to delete the existing file and replace it with the new one or to rename the
new file. The Duplicate Filename parameter allows you to control that decision. IfRename is
used, the current name will have a period and a three character number affixed to it.
Example: If “MY.FILE” existed and was downloaded again using theRename option, the
second name would be “MY.FILE.001” the next would be “MY.FILE.002” and on and on to
.999.
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Upload Options
The Upload Options parameter controls how files are sent to a remote system. ProTERM
supports both Xmodem/Ymodem ProDOS extensions as well as Binary II encoding:
• None – Files being sent are transferred without intervention.
• ProDOS – Transfers ProDOS files with all attributes and extensions if it is available in
the protocol.
• Binary II – Encodes the files into a Binary II envelope during the transfer.
• Both – Uses both ProDOS and Binary II methods. The file will be treated as a ProDOS
file and will be encoded with Binary II.
• TXT/BNY – Text files are uploaded as TXT files. All other files are encoded with Binary
II.
• Query – Is a manual mode which presents a window asking for the operator to chose
the transfer options for each transfer session.
NOTE: See Index: Binary II for more on .BIN & .BXY.
NOTE: If the file being sent is already Binary II encoded, ProTERM will not “double–wrap”
the file.
NOTE: See the Index – Binary II ,* for more information on how and why this function is
used in telecommunications.

Download Options
The Download Options parameter controls how files are received from a remote system.
ProTERM supports both Xmodem/Ymodem ProDOS extensions as well as Binary II decoding:
• None – Incoming Binary II files are saved without change and the encoding headers are
saved as part of the file data.
• Binary II – The Binary II encoded files are decoded and files are saved as the original
ProDOS filename, filetype, file status and other attributes just as they were before they
were encoded with Binary II. This does not effect non–Binary II files and they are saved
normally and without intervention.
• Query – Is a manual mode which presents a window asking for the operator to choose
the options before the files are received.
The Xmodem/Ymodem ProDOS extension decoding is always done by ProTERM and does
not require a parameter.
NOTE: See the Index – Binary II , for more information on how this function is used in
telecommunications.

Auto Protocol Start
The Auto Protocol Start parameter controls whether ProTERM automatically detects
Zmodem or Kermit transfers. When either a Zmodem or Kermit send command is initiated
on a remote system, ProTERM can detect the start of the transfer and will begin the receive
process without further intervention from the user. When this parameter is set toZmodem
or Kermit and the command is initiated, the file immediately starts to transfer to the default
download path. It is important to have theDefault Pathnames set (see Preferences in the
Misc menu, also see Index: Preferences) or ProTERM will chose the directory used last or
where the ProTERM files are, as a default pathname.
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Zmodem–Resume
If a Zmodem download fails part way through a transfer, it is possible to resume the transfer
where it failed. If this parameter is turned on, and a file is downloaded with the same name
as one that failed, ProTERM automatically resumes the transfer and downloads the remaining
portion of the file.

System Macros
By selecting the Macro button from the Edit System Parms window, a window of system
macros can be displayed. Each system has ten system macros associated with it. Macro
operation is explained in detail elsewhere in this manual, see the Index:Macros.

AutoLogon Macro
When ProTERM connects with a system, this parameter allows one of the macros to be
executed to allow for automatic logon. To disable automatic logon, simply set this parameter
to “Off.” If you would like ProTERM to create anAuto Logon Macro for you, set this
parameter to Learn. During your next call to the system, ProTERM will record the procedure
you use to logon, and subsequent logons will be automatic. See the Index: AutoLearn.

Macro Elements
There are 10 Macro Elements for each system and each element can contain up to 63
characters. The macros can be activated from terminal mode by the key sequence displayed
to the left of the macro. Pressing the COMMAND key and one of the numbers, activates the
applicable macro. While there are no “wire–frames” around the macros, each line is a
standard text entry field and the normal text entry and editing commands apply. See the
Index: Macro and AutoLearn Macro. For more detail on how these work. For editing details,
see the Index: Text; windows; editing.

Saving System Changes
To stop the
countdown
Connect Time:
Hold the OPTION
key down.

After making any changes to a system entry, the changes need to be saved to disk. Changes
are automatically saved if the system is either dialed or redialed after the changes are made.
If you’re not going to dial the system immediately, select theSave button to save the
changes. This saves the changes and returns to the Main Menu.

Dialing a System
Dialing a System is simple once it has been created and customized. By selecting either the
Dial or Redial button from the Edit System Parms window, the system can be dialed in a
single dialing attempt or by using a continuous (redial) mode.

Dial
When the Dial button is selected, ProTERM dials the system and attempt to make a
connection. If the connection attempt is not successful, the Unable to Connect window is
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displayed showing three buttons: Dial, Redial and Cancel. Select the Dial button to attempt
another connection with the system. If the connection attempt fails, ProTERM returns to this
window. Select the Redial button to begin a redial sequence which will continue to dial until
a connection is established or the sequence is canceled.

Redial
When the Redial button is selected, ProTERM continuously redials the system until a
connection is established or the redial operation is canceled. To cancel the redial operation,
select the Cancel button or press ESCAPE while ProTERM is trying to make a connection.
Selecting the Dial button during a continuous redial places ProTERM back into single dial
mode (see explanation above inDial).
NOTE: Upon making a connection after a continuous redial, ProTERM sounds the bell three
times. There is a parameter in the setup screen which allows the connect sound to be
disabled or to changed to a “siren.”

Quick Dial
Quick Dial is a feature which allows a system to be dialed quickly and simply without going
through the process of entering all of the system parameter information. Quick Dial numbers
are a “one-shot” operation. The number can be Dialed or Redialed but if another Quick Dial
number is entered or you quit from ProTERM, the information in Quick Dial will be gone.
Nothing in the Quick Dial menu is saved whenPreferences are Saved.

Rotary Dialing List
The Rotary Dialing List is an efficient method for calling a group of systems which is
especially helpful for serious BBS users. Using Rotary Dial, ProTERM calls a system from a list
and if busy, calls the next system on the list. When ProTERM is unable to connect with a
system, it dials the next system in the list. After connecting to a system, that system is
removed from the rotary dialing list.
To use the Rotary Dialing List, choose Rotary Dialing from the Dial menu. This displays a
window with your system list. Use the ARROW keys and SPACEBAR to select the list of
systems to dial (a checkmark √[ ] is displayed to the left of a marked system). When all of the
systems have been selected, select the Rotary button. ProTERM will dial the first system in
the list. If a connection is not made, ProTERM will cycle through the dialing list calling
different systems until a connection is made.

Using ProTERM without a Modem
ProTERM can be operated without a modem through the use of the “Null Modem Driver.”
Possible applications for this include the direct transfer of files between different computers
connected with cables or demonstrations of ProTERM or BBS software. To operate without a
modem, use the Install command and select the “Null Modem Driver.”
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When operating with the Null Modem Driver, ProTERM operates normally with the following
exceptions:
• When ProTERM first starts, it sends the modem init string to the remote system, but
does not wait for a response.
• When ProTERM “dials” a system, it sends the phone number string to the remote system
and immediately goes online.
•The Hangup command drops DTR to break the connection.

NOTE TO SysOps:
System files are saved in the ProTERM PT3.DIAL directory as a file name like
“PTD.SYSTEM.NAME. Each file is a complete System file for each entry called. It contains all of
the attributes, even the AutoLogon Macros. The power of PTD files lies in their structure of
being complete, but loose and independent of each other. This gives you the capability of
using them as a marketing tool for your system. You could create one of these “PTD.” files
for a BBS system complete with the phone number and a guest AutoLogon macro or even
make the AutoLogon macro to log a new user on to the point where the new user takes over
to enter their personal information. Upload your BBS-PTD file to various other system
libraries making it readily available to potential users. The new prospective user could
download the file and copy it into their PT3.DIAL directory. When they start ProTERM again,
your file would be on their directory ready to select, call and run the AutoLogon macro. Your
not only giving them the phone number, your giving them everything they need to call your
system!

PART THREE — THE MENUS

THE ONLINE MENU

227

The Online Menu
CHAPTER THIRTEEN
O nline
Parameters

L

Time Connected
Editor Capture
Printer Capture
AutoLearn Macro
Paste to Modem
Send Break

W
C
P
N
V
B

Hangup

H

Use the
Online menu
to experiment and
find what parameters work best for
the host system
being called.

remote system. While some of this information has already been covered elsewhere in this
manual, this chapter provides in depth information for working withOnline Parameters.
Entries in here are grouped according to the order of the commands as they are presented in
the Online menu, COMMAND-L from the Main ProTERM menu. Additional references on
specific entries may be found in the Index.
By going to the Online menu while you are actually connected to the host you can
experiment to see which effects work best. When parameters for the host system are found
to be the ones always preferred, change them in the System Parms window for that host.
Then whenever that system is called, the parameters will be set.
This chapter deals with all the commands available while Online, in
terminal mode, with a

Online Parameters
The Online Parameters window allows access to, and change of communication parameters
which are NOT specifically pre-set to the system being called. All of the options, with the
exception of Line Status, found in Online Parameters may be also be set as defaults in the
individual system’s defaults.

Baud Rate (BPS)
The Baud Rate parameter controls the speed at which ProTERM communicates with the
modem through the modem port. Keep in mind this is the port speed and not the
connection speed. There is no way to tell the modems to change speed after the connection.
This parameter changes the rate at which ProTERM communicates with the local modem.
NOTE: ProTERM lists 38400 as a valid baud rate selection, but is only available when using
the Apple IIGS Modem Port. In addition, using this speed is not generally recommended.
Currently there are very few modems available which can actually sustain data transfer rates
anywhere near this speed. Most of these modems send short bursts of data at this speed, but
only have a net throughput of around 19200. It is much easier for the software to communicate with a modem which is constantly sending data at 19200 than with a modem which
sends short bursts at 38400.
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Data Format
ProTERM supports Data Formats of:
7E1, 7O1, 8N1, 8N2, 7E2 and 7O2 .
Respectively, these stand for:
7 data bits Even parityOne stop bit.
7 data bits Odd parityOne stop bit.
8 data bits No parity One stop bit.
8 data bits No parity Two stop bits.
7 data bits Even parityTwo stop bits.
7 data bits Odd parityTwo stop bits
NOTE: ProTERM’s default of 8N1 is the most common data format, and it works with almost
all systems in use today:
• Parity – A way of checking the accuracy of transmitted data by counting the number of
bits which have the value of 1.
• Data bit – The character that is the actual data being transmitted.
• Stop bit – One or two bits that signal the end of the transmission of a byte.
Also see the Index: Data Format and Duplex.

Duplex
The Duplex parameter controls how ProTERM handles the data typed at the local keyboard.

Full Duplex
The most common are full duplex systems where all data typed at the local keyboard is sent
only to the remote system. The Full Duplex parameter only shows the data received from the
remote system.

Half Duplex
When using a half duplex system, all data typed at the keyboard is not only sent to the
remote system, but it is also sent directly to the local console to be displayed on the monitor.

Break Time
Some systems make use of a break signal which can be sent by the user get the attention of
the host system in certain situations. This parameter controls the duration of the break
signal. The default setting is 50/100 (1/2) second. The actual break signal is sent via the
COMMAND-B command. See the Index; Break; Time, or Break; Signal, for other references.

Flow Off & Flow On
Because there are times when ProTERM is not able to accept incoming data from a remote
system as fast as it may be available, a mechanism called “flow control” is used to regulate the
flow of data. The flow control parameters are used to specify how the flow of incoming data
can be stopped and restarted. When left blank, ProTERM selects a flow control method based
on the characteristics of your modem. To manually specify a technique, use the following
notation:
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^char
char
R0
R1
D0
D1

Emulate

Method
software
software
hardware
hardware
hardware
hardware
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Meaning
Send CONTROL- char
Send char
Drop RTS
Raise RTS
Drop DTR
Raise DTR

Terminal Emulation refers to making ProTERM function like, or emulate, a stand-alone
terminal. If the system requires the use of specific type of terminal, select the terminal
emulation from the list. If the system does not require emulation, selectNo Emulation. For
users of real-time conferencing systems, there is an emulation called “Split-Screen Chat”
which allows outgoing messages to be composed in one area of the screen while incoming
messages are displayed in another. For more information on emulations and their use, see
the Index: Terminal; Emulation.

AnswerBack
The AnswerBack parameter is used in association with the Emulation parameter. No
If
Emulation is being used, then this parameter is not used. For more information on
AnswerBack, refer to the specific terminal. See the Index: Terminal; Emulation.

Delete Key
The Delete key is conveniently located at the upper-right corner of all Apple II keyboards
which is ideal for correcting typing errors and we’re used to seeing this function as a
BACKSPACE/DELETE key. However, when calling remote hosts, you’ll find different host
systems have different needs and require different characters to be sent to create the effect of
deleting a character from the screen. Many, if not most, systems will work as expected by just
using the default Emulate, but others may require either a delete or backspace character to
be sent to create the desired effect. The three choices for the Delete Key are:
• Emulate: Emulate allows the host to function with its normal commands as but also
considers the influence of any system Emulation (see Emulation) you may have in
effect.
• Send DEL (Send Delete): Causes your terminal to send a Delete character to the host.
• Send BS (Send Backspace): Backspace is just a CONTROL-H character which moves the
cursor one space to the left without disturbing the character it moves to the left of.
Since hosts differ in their methods of creating a desired effect, they may not interpret a Send
Backspace or Send Delete and give you the desired results therefore, it may be necessary to
change the Delete Key in combination with theBackspace commands to get the desired
effect.
For systems such as CompuServe Delphi or GEnie, Send DEL is usually preferred. Also see
Backspace which has a related effect.

Backspace
The Backspace parameter allows an incoming backspace character to be treated as:
• Emulate: Emulate allows the host to function with its normal commands as but also
considers the influence of any system Emulation (see Emulation) you may have in
effect.
• Non-Dest: The cursor moves to the left one character but leaves the character intact on
the screen.
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• Destruct: The cursor moves one character to the left deleting the underlying character
as it moves.
For systems such as CompuServe, Delphi and GEnie, the Destruct setting is usually
preferred. Also see Delete Key which has a related effect.

Status Bar
The ProTERM Status Bar displays useful information including the number of characters in
the Editor and in Scrollback. It shows the current Baud (BPS), the Connection Status and
the date and time. If the status bar is turned on, it is displayed with 23 lines of incoming data
beneath it. Certain emulations, VT-100 for example, need all 24 lines of the display screen. In
fact some may show their command prompt on the very top line and if the Status Bar is on
the screen, the prompt line may be hidden. Turn the Status Bar off if all 24 lines of the
screen are needed: Place the cursor on the Status Bar? selection box check box and press the
SPACEBAR to toggle the [ √] checkmark off. When set and the emulation is encountered
during the call, the Status Bar will disappear and all 24 lines will be visible and usable by the
emulation.

While using
ProTERM parms
menus, holding the
COM MAND key and
pressing RETURN
key saves all
changes and closes
thewindow immediately!

Auto Protocol Start
When either a Zmodem or Kermit send is initiated on a host system, ProTERM is capable of
detecting the start of the transfer as the host begins and can begin theReceive File process
automatically and without further intervention from the user. This parameter controls
whether ProTERM detects Zmodem or Kermit transfers or None. For information on this
parameter, see the Index: Transferring Files and alsoZmodem and Kermit.

Line Status
The Line Status parameter controls whether ProTERM is in anOnline or an Offline state. In
the Offline state, the Main Menu is displayed, and all local keypresses are assumed to be
commands directed at ProTERM. When set to Online, ProTERM is in terminal mode and local
keypresses are sent to the remote system. To direct local keypresses (commands at the local
console) to ProTERM when in the Online mode, the COMMAND key must be held down
while entering a valid ProTERM command.

Time Connected
The Connect Time command displays a special and separate Connect TimeStatus Line which
shows the connection duration and cost. The display continues to update until the command
is selected again, at which time the display toggles off (is removed). The total cost is
computed according to the following formula:

total_cost = (per_minute+(per_hour 60))*minutes_connected)
Per Minute Cost
Per Minute Cost is normally used to calculate calling charges (i.e., long distance or network
charges). The cost must be entered in an “x.xx” style format (i.e., “1.10” or ”0.10” is legal
while “1.1” or “.10” is not). If the field is left blank, ProTERM assumes no per minute cost.
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Per Hour Cost
Per Hour Cost is normally used to calculate service access charges. The cost must be entered
in an “x.xx” style format (i.e., “1.10” is legal while “1.1” is not). If the field is left blank,
ProTERM assumes no per hour cost.

Editor Capture
Editor Capture toggles the redirection of incoming data to the Editor as well as the screen.
Incoming data may be sent to the Editor in one of two selectable modes.

Copy Raw Incoming Characters
When Copy Raw Incoming Characters is selected, all incoming data is sent to the Editor
exactly as it was presented and without processing. In this mode all control characters and
emulation codes are preserved as part of the data.

Copy Entire Processed Lines (Default)
By contrast to the above, Copy Entire Processed Lines sends processed lines of text to the
Editor. The parameters for processed data is to never:
• Contain control characters.
• Exceed 80 characters in width.
• Contain any emulation codes.
The stored data is an image of the data as it was displayed on the screen. An “image” is
considered as “plain” ASCII text characters (this is normally the mode which should be
used).

Printer Capture
Normally, incoming data goes only to the monitor, but it can be desirable to have data go to
the printer as you view it on the monitor.Printer Capture (or Printer Online) toggles the
redirection of incoming data to the printer as well as the screen. Incoming data may be sent
to the printer in one of two selectable modes. COMMAND-P toggles the printer on or off to
control whether data is printed while on line.

Copy Raw Incoming Characters
When Copy Raw Incoming Characters is selected, ALL incoming data is immediately sent to
the Editor without being changed (processed), and all CONTROL characters and emulation
codes are passed through as part of the data.
NOTE: Since CONTROL codes are also used to send instructions to the printer, this can have
the side effect of causing the printer to take on its own personality, doing creative incantations such as changing type size and style, rolling out sheets of paper, or refusing to function
at all.

Copy Entire Processed Lines (Default)
By contrast to the above, Copy Entire Processed Lines sends processed or “filtered” lines of
data to the printer. The parameters for processed data is to never:
• Contain control characters.
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• Exceed 80 characters in width.
• Contain any emulation codes.
The stored data is an image of the data as it was displayed on the screen. An “image” is
considered as “plain” ASCII text characters and is normally the mode which should be used.

AutoLearn Macro
The AutoLearn Macro command allows ProTERM to “watch” as you go through certain
keystrokes for example, when calling a service, and then issuing the commands to log on and
navigate to the level of the service where you always want to be taken when you call. After
watching you, ProTERM will duplicate the same actions you just executed, and create a small
program called an auto-logon macro which will issue all of those same commands when you
press a single key.
An AutoLogon macro is created from the Maco section of the Dial window, and an AutoLearn
macro is created from the Online menu, but they do the same kind of work, the AutoLogon
macro is just more specialized.
When chosen, the AutoLearn command asks for a starting macro element (line) in which to
begin to build the macro (the AutoLogon macro automatically uses line one). If you already
have an AutoLogon macro built for the system you are calling, it probably starts at element 1
(line 1). To see which Macro Elements are used or available, enter COMMAND-D to go to the
Dial List. From the Dial List, choose the system you’re concerned with and choose Macros.
The list of ten Macro elements are shown in the Macro window of the individual system.
Select any available or empty line. If something does not go just right, try again, just repeat
the process. Also see the Index: Macros; autolearn.

CONTROL-X always
clears text entry
windows fast and
easy.

After entering the number for the starting macro element, ProTERM returns to terminal
mode to “watch” what you type to the remote system. Enter the commands to the host
carefully and deliberately and keep in mind any mistyped keys or DELETE-key strokes
become part of the macro. Also remember it is easy to start over and try again.
When you are finished issuing commands to the remote system, choose the AutoLearn Macro
command again. ProTERM will create a macro which will send the same keystrokes as you
just entered. The macro can be activated by holding the COMMAND key down and the macro
number which was originally entered. You can enter as many of these as needed for each
system until all ten Macro Elements are full. For more information see the Index:Macros.

Paste To Modem
The Paste To Modem command allows a quick way to send the contents of the clipboard to
the remote system. This command sends the current clipboard contents to the remote
system. Although this feature is really meant to be used with a limited amount of text, usually
just a few lines, approximately 250 characters, the size of the clipboard, can be copied or cut
(see the Index: Copy, Cut and Paste) and pasted to the host through the modem. Larger
amounts of text will normally work as long as a reasonable allowance for pacing is used (see
Index: Parms). Pressing the ESCAPE key during a paste cancels the operation. This feature is
very handy for cutting and pasting numbers or other abstract strings such as online addresses
which can be difficult to remember.
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Send Break
The Send Break command sends a break signal to the remote system. The duration of the
break signal is controlled by the break time parameter in the Online Parameters window or
the Edit System Parms window. The break duration is expressed in 1/100 of a second with
the default time being 50 or 1/2 second. The maximum valid break time is 99/100 of a second
(almost a full second). For more information, see the Index:Break.

Hangup
The hangup command forces ProTERM to disconnect from the remote system. As has been
previously mentioned, it is generally more courteous to tell the remote system to disconnect,
but this command allows ProTERM to break the connection. If ProTERM does not return to
the main menu after this command, then ProTERM is unable to communicate with the
modem for some reason. In such cases, it is often best to turn the modem off and on and
then choose hangup again.

Pause Mode
Use COM MAND SPACEBAR to stop
incoming data.

The Pause command is not available from the pull-down menus but is activated by pressing
COMMAND-SPACEBAR. This command stops incoming text from being displayed. When
Pause mode has been activated, the status bar showsPaused in place of Online. Any
subsequent keypress or click of the mouse will resume data output. Keep in mind while you
are paused, activity time-outs imposed by the remote system are probably in effect and the
host may terminate the call unless your interaction resumes within a given period of time.
NOTE: Many users use CONTROL-S to pause a remote system. While this works with lowerspeed modems, many high-speed modems use hardware handshaking. When the COMMANDSPACEBAR command is used, ProTERM can stop the data from the remote system regardless
of the technique being used.

Printing the Screen
From any point in ProTERM, it is possible to print the entire contents of the screen.
Everything visible (windows, the status bar, etc.) is printed. This process is often referred to
as a “screen dump.” To print the screen, make sure your printer is on and ready, and press
OPTION-CONTROL-P. There are no messages displayed or windows opened by this
command. ProTERM simply and quickly prints the screen and then returns to business as
usual.
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NOTE: If the screen being printed has any inverse spaces (such as on the status bar), these
characters print as asterisks “*” to distinguish them from normal spaces. In addition, if the
command is used with ProTERM’s Main Menu visible, it will not print because the Main
Menu disappears when these keys are pressed and unless there is something on the screen,
there is nothing to print and the printer rolls out a blank “screen-full” of paper.

Toggle Online
Toggle
On/Off line.

A special Global Macro which works with the key combination OPTION-T is provided in the
default PT3.GLOBAL Macro file which will toggle the modem on and off line each time it is
pressed.
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The Send &
Receive Menus
CHAPTER FOURTEEN
The ability to exchange files with a wide range of hosts from bulletin board systems to large
commercial services and other terminal programs is one of ProTERM’s most powerful
features. The design of ProTERM’s ASCII Send command is powerful and easy to use and
supports “on-the-fly” text formatting. ProTERM supports the Xmodem, Ymodem, Zmodem
and Kermit file transfer protocols, can exchange single or multiple (batch) files, automatic
Binary II encoding and decoding, and even resume from failed Zmodem downloads. This
chapter is divided into six generalized sections and discusses the following features:
• General Overview
• Sending with Protocols
• Sending ASCII Files
• Receiving with Protocols
• Receiving ASCII Files
• Selecting a Protocol
• Binary II and Archives
• Protocol Information

General Overview
“ ASCII”
is an acronym.

The word “ASCII” is an acronym for “American Standard Code for Information Interchange.”
ASCII is a name for the actual text information you see on the screen when connected to a
remote host system or when using the ProTERM Editor. In the United States, ASCII is the
most common way of representing text in digital form. The ASCII code set contains 128
characters: 96 printable characters (text) and 32 non-printable characters (control characters). See the Index: ASCII Chart for a complete ASCII character list.
Both ASCII and protocol transfers are valuable and needed in communications, one could
not replace the other, and ProTERM has both.
• Using the Paste to Modem command, sending text directly from the Editor, or
using the Send ASCII command to send a text file are examples of ASCII transfers.
• Using Send Xmodem or Receive Zmodem to transfer files to/from a remote host
system are examples of protocol transfers. Protocol transfers always send a file
from disk whereas ASCII transfers can send text directly from the ProTERM editor
or from a disk.
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ASCII Transfer Defined
Typing online is a
simple form of
ASCII send and
receive.

Protocol is just a
matter of both
sides following a
set of understood
rules.

Simply stated, an ASCII transfer is the process of sending or receiving a string (phrase) of raw
text characters (such as your type-written name) from one computer to another. There are
no checks or balances. If an “a” is sent, then hopefully an “a” is received, then a “b” is sent
and hopefully it arrives, and so forth. If an error such as a line-noise spike occurs during the
transfer, the error becomes part of the transferred file. This is not to imply ASCII transfers are
inferior, for certain purposes they are superior to protocol transfers. A simple example of an
ASCII transfers is the text from a remote host system being displayed on your system, or
when you are typing commands to a remote host.

Protocol Transfer Defined
The alternate method of transferring files is called a protocol transfer. A protocol is to file
transfering what accounting is to a business. Protocols check for errors and prevents
mistakes. Simply stated, a protocol is a set rules understood and obeyed by both sides during
a transfer. When a file is sent with a transfer protocol, it is guaranteed to arrive in exactly the
same condition it was sent. Even if a glitch such as a line-noise spike occurs on the phone
line, the protocol’s accounting procedure takes corrective measures to resend the damaged
part of the data thus insuring an accurate transfer.
While protocol transfers are highly specialized for what they are designed for, they cannot
replace ASCII transfers. They are both valuable and different tools.

Protocols are
discussed in detail
later in this chapter.

Send
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

Data transferred via a protocol transfer is continually checked by comparing the data sent, to
the data received. During the transfer, a “portion” (called a packet) of the file is measured,
the data is counted in the measured packet, and the packet and its accounting information is
transferred. On arrival, the packet’s statistics are checked against its accounting data, and if
both ends agree that the packet was transferred successfully, the next packet is sent. When a
problem is found with a packet, the packet is transferred again, and again if necessary, until
the transfer is successful or the until the transfer is canceled due to lack of progress. This
process continues until the entire file is transferred.

Send ASCII
ProTERM has a variety of modes and options for sending text to a remote host system, and
can send a normal text “TXT” or AppleWorks word processing “AWP” files without any
special conversion. Sending ASCII text is really very simple. Using the default settings already
setup by ProTERM, an ASCII transfer might look like:
• After logging onto a remote host system, prepare the host to accept the ASCII text. This
is often done by entering the host’s text editor where text is normally entered while
online.
• Choose ASCII from the Send menu.
• If given the choice, choose File or Editor to indicate where the text should be sent from.
If the text is stored on disk, enter the filename and press the Send button.
• At the Send ASCII parameters window make whatever changes are required for the
particular remote host system (these parameters are explained in detail below) and
press the Send button.
• If necessary, the send can be canceled by pressing ESCAPE prior to or during the send.
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Sending ASCII text is just that easy. The following explains the operation of the Send ASCII
parameters. At the end of this section there are examples of using Send ASCII with some
specific remote host systems.

Send Mode
ProTERM offers two different methods of sending ASCII text: Character Mode and Line
Mode:
• Character Mode, sends a character and ProTERM waits for that character’s echo to be
received from the remote host system before sending the next character. Since
characters sent to the host are only echoed by full-duplex systems, character mode can
only be used with full-duplex systems (see Index: duplex).
• Line Mode sends the data using sends the data using preset timing values. Both modes
allow an optional prompt character to be specified. Line mode is used by default
because it is generally faster and more flexible than character mode.

Send Prompt
ProTERM’s defaults are chosen to work with as many remote host systems as possible
without modification, but this can result in text being sent at a less than optimum rate on
some services. One of the fastest and most robust ways to sending ASCII text is to use a
“prompt” character to tell ProTERM when to send. When a prompt character is specified,
ProTERM waits for that character to be received from the host before sending. Some systems
provide a prompt by default while others can be instructed to send a prompt. If the prompt
character for the host system is known, enter the character as the Send Prompt value.
Otherwise, leave this field blank.
Some host systems have difficulty receiving ASCII text at higher speeds, but this problem can
be controlled by using a Send Prompt. Systems providing a prompt character (a particular
character which appears on every line as soon as the host is ready to receive the next line)
are the easiest to control. Generally, the fastest technique to send ASCII text is to instruct
ProTERM to send the next line of text as the prompt character is presented. This process
works well because the pace is controlled by the remote host system, since it controls when
the prompts are sent. Some systems do not allow this method of ASCII transfer while others
allow choices among several prompt characters. Here are some examples of some Send
Prompts used by different host systems:
1: This example shows lines with a COLON
2: prompt.

> This example shows lines with a GREATER-THAN
> prompt.

Some systems show the lines numbered and some do not. The numbers are not a part of the
prompt because they change with each new line. In these cases the “>” or “:” character can
be used as the prompt character.
NOTE: Sending to a Send Prompt is an optimum method of uploading text. If you are
sending to a Send Prompt, try setting Line Send Pace and Character Pace to zero by leaving
their values blank.
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NOTE: Some BBSystems send a prompt if instructed to do so. For example, the original
versions of GBBS “Pro” display a “>” prompt into the message editor if the dot command
“.P” (PERIOD-P) is entered on a line by itself followed by RETURN. As with all send prompts,
the prompt character does NOT show up in the final text and is only visible while sending a
message. The “.P” can be the first line of text sent to the message editor to automatically turn
on prompt mode.

Text Width (Send Width)
While the default of an 80 character line width is generally acceptable, certain systems have
maximum line size limitations of less than 80. When a line of text is sent which contains
more characters than the remote host system allows on one line, some character loss may be
noted.
When sending text to systems offering a send prompt (CompuServe, GEnie and others), you
may feel more comfortable using a shorter line so formatted text appears without lines
wrapping as they are sent. Consider the composition of the line and how it fits on the screen.
The first four or so spaces of the line are often used up with a prompt like “12>”. By setting
the Text Width to 72, each line is sent without being wrapped. ProTERM automatically
inserts RETURN characters where needed so none of the lines exceed the specified width.
RETURN characters are always inserted at word breaks so words are not split. Some remote
host systems reformat the text after it is received, so the shorter lines end up as full length
lines anyway.

Change Blank Lines To SPACE+RETURN
Some remote host systems use two consecutive RETURN characters to indicate the end of a
message. This can be very frustrating if you use the convention of separating paragraphs with
a blank line, because this results in two RETURN characters being sent (one to end the
paragraph and another for the blank line). The Change Blank Lines to SPACE+RETURN
parameters solves this problem by sending a SPACE followed by a RETURN character to
indicate a blank line. When ProTERM encounters the end of a paragraph, it sends a RETURN
to end the paragraph followed by a SPACE followed by a RETURN to create the blank line.
The text appears in the message just as it was sent, but two consecutive RETURN characters
are never sent. Turning this parameter on, “tricks” the host into allowing paragraphs to be
separated with a blank line. This parameter is turned on by default, and should be left on
unless there is a specific reason to turn it off.

Character Send Pace
Depending on the send mode used, Line or Character, this parameter has two different
meanings.

Character Send Pace and Line Send M ode
When the Send Mode (above) is set to Line, the number shown here is the percent of the
port speed at which data is sent. For example, if the character send pace is set to 50 during a
2400 baud connection, ProTERM sends the data at 50% of 2400 baud which is 1200 baud.
Setting this parameter to zero allows ProTERM to send at full speed. A setting of 80-90 is
adequate for most systems. If you experience sporadic character loss during ASCII transfers
with a particular service, try decreasing this value in increments of 5.
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NOTE: When determining the speed to Send text, ProTERM uses the speed at which the two
modems are communicating for reference, and this speed is displayed in the ProTERM Status
Bar during the connect.

Character Send Pace and Character Send M ode
When the Send Mode (mentioned earlier) is set to Char, each of the two digits (right and
left) set a different character pacing parameter. The digit on the left (in the “tens” column)
controls the number of “outstanding” characters which are sent before ProTERM looks for
the return of the echo from the first character. The digit on the right (in the “ones” column)
controls the time ProTERM waits for an echo before it assumes the echo was lost and sends
the next character. For example, a value of 32 allows 3 outstanding characters with a timeout
of 1.2 seconds per character. The actual values of the right digit is approximately .4 (four
tenths) of a second, e.g., 0=.4, 1=.8, 2=1.2 and so on. Always use numbers for these values
— other characters will cause unpredictable results.

Line Send Pace
After each line of text is sent, ProTERM can wait up to one second before sending the next
line of data. This parameter specifies the wait in one/hundredths of a second. If a Send
Prompt is being used (see Send Prompt above), then this delay takes place after the prompt
is received. A delay of 5 (five one/hundredths or one twentieth of a second) is not uncommon. If Line Mode is used without a Send Prompt, this parameter is very important, as it
controls how fast the lines of text are sent to the host. If the lines are sent too fast, character
loss can occur. If the lines are sent too slow, time is wasted waiting for the transfer to finish.
To find the minimum delay needed by a remote host system, start with a line pace of 50. If
no text is lost during the send, drop the pace to 25 for the next transfer attempt. Continue to
adjust the send pace by halving the value each time a transfer is successful and taking the
mid-value between those which did, and did not work.
NOTE: Sending to a Send Prompt is an optimum method of uploading text. If you are
sending to a Send Prompt, try setting Line Send Pace and Character Send Pace to zero by
leaving their values blank.

Interpret Dot-Commands
Dot Commands are a formatting power-tool that allow easy formatting with professional flair.
This ProTERM power feature allows you to format documents “on-the-fly” as they are being
sent. This means a completely formatted document containing margins, text justification and
paragraph margins can be formatted offline and sent with full formatting. Just like printing a
document with dot-commands, but the finished document is sent to the remote host system.
For most applications, this parameter should always be turned on unless you will be sending
data which contains periods in the first character position (on the left margin) then this
option may need to be turned off. For more information, seeIndex and Quick Reference
cards: Dot-Commands.
NOTE: ProTERM understands and uses conventional Dot Command language. DotCommands designed for other software may not be interpreted correctly by ProTERM. See
the Index: Dot-Commands.
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Sending your first
message.

Send ASCII Review
ProTERM allows Send ASCII to be customized for the needs of each remote host system, but
the default settings generally work as they are. Trying using the settings outlined below when
using Send ASCII for the first time. As you learn the “tricks” of each host, change the
parameters as needed and save them for future use. To change the Send ASCII parameters
for a system and make them permanent, select that system from the Dial menu and press the
Parms button. Change the parameters for that system as needed and press the Save button.
The changed values will become the new defaults for that system.

Common Send
ASCII Settings.

To send ASCII text, choose ASCII from the Send menu and press File (to send a file from a
disk) or Editor (to send a document from the Editor). The most commonly used parameters
are already set to allow ProTERM to be used as-is. Change only those parameters actually
needing change. Once the parameters are set, press Send to send the text to the remote host
system. The following steps could be used to send ASCII text to a host:
• Enter the remote host systems editor where you would normally begin typing a letter
while online.
• Choose ASCII from the Send menu.
• Select the file to send.
• Set the Send Mode to Line (the default).
• Leave the Send Prompt blank (the default).
• Set the Character Pace to 80 (the default).
• Set the Line Pace to 20 (the default).
• Press the Send button.

OPTION+CONTROL+P
prints the screen,
and is a good way
to print help
menus.

Receive
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

As Send ASCII is transfering text to the remote host system, the progress can be followed
because the text is also displayed on your local screen. When the text transfer is finished,
some additional input is generally needed to inform the host the transfer is finished. Enter
and Send the needed commands to the host required to save the text. Different hosts use
different commands, refer to the host’s online help files for needed commands. The
command generally must be entered on the left margin in order to work. Here are the
commands used by several popular remote host systems:

• GBBS and ProLine Systems
• CompuServe (message system)
• CompuServe (mail system)
• GEnie Information System

.s
/post
/send
*s

.h=menu
/exit=menu
/exit=menu
*h=menu

Experiment with the hosts you call until you feel comfortable with them. Find out early how
to delete or kill your own posts by reading the host’s help menu. Try using Send ASCII to
send messages to the host. If you don’t like what you see, kill the message and try it again. Its
a great way to gain proficiency with the Send ASCII routines.
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Receive ASCII (AutoSave)
Receive ASCII is also referred to as “AutoSave” and provides a way to save information to a
file as it is displayed on the screen. Although transferring a file using Receive ASCII follows a
protocol with regards to receiving and storing the file, it does no error checking and so is not
formally considered a protocol transfer. To start Receive ASCII you need to be connected to a
remote host system and then follow these steps:
Note: Also see Scrollback which is a type of AutoSave that is always in effect, and always
saving text when you are online.
• Choose ASCII from the Receive menu.
• Select the ProDOS path to save the file. See the Index: ProDOS; about pathnames for
more information.
• Select a file to append to, or type a filename for the new file and press theSave As
button.
• Select the appropriate Receive ASCII parameters (explained below).
• Press OK to begin Receive ASCII.
• Send the appropriate commands to the remote host system to display the desired
information.
• When all of the needed information has been displayed on the screen, choose ASCII
from the Receive menu again.
• Press the Close button to save the text to the file and turn offReceive ASCII.
ProTERM 3.1 2.25K edit
File Selector System

9.50 sbk

9600 baud Offline 09-FEB-96 14:52:36

Receive ASCII
Pathname
Filename

Files shown
in directory
can be selected
or a new name
typed in.
Choose to continue

Menu bar

/HARD1/MY.FOLDER

Window

FORUM.NEWS
..<Parent Dir>
AMER.SPORTSNEWS
BIZ.LETTERS
CRTEST.FILE
GAME.README
GOLF.ARTICLE
POSTAL.RATE

Save AS

Cancel

Text field
DIR
TXT 3
DIR 9
AWP 14
TXT 57
TXT 5
TXT 1

04-APR-91
05-FEB-93
05-APR-92
03-MAY-91
04-FEB-92
11-FEB-93

Receive ASCII
File Window
Mouse pointer

Receive ASCII Parameters
These settings are generally correct for most services. Although you do not have to make any
changes to have it work correctly for you in most instances, changes can be made to match
up with those services needing differnt values. To receive ASCII text to a file, choose ASCII
from the Receive menu. Select the name for the file and press Save As. Select the appropriate
parameters (listed below) and press OK. If the selected filename is already in use, ProTERM
prompts you to Delete or Append to the existing file.

Save File As Type
This field allows the filetype of the file to be selected. ProTERM can save either “TXT” text
files or “AWP” AppleWorks® word processor files. AppleWorks files have other characters
(referred to as “overhead”) which are used for formatting and other customizing by the
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AppleWorks program. By selecting “TXT” or “AWP” respectively, the file is saved to disk as
that filetype. If an existing file is being appended to, this field has no effect because the
filetype of the existing file is preserved. Also see the Index: Preferences; saving personal
changes to make this a permanent preference.

If in doubt, press
RETURN to use the
default.

Copy Raw Incoming Characters
This is the default capture mode and allows the data to be saved just as it is without
processing, conversion or filtering. All control characters and emulation characters are saved
as part of the text. The text is stored without change just as it comes from the remote host
system. This parameter is marked with a dot [•] when it is on.

Copy Entire Processed Lines
This capture mode saves processed (converted or filtered) lines of text. Processed text never
contains control characters, exceeds 80 characters in width or contains any emulation
characters. It is basically a copy of the data as it is displayed on the screen. This parameter is
marked with a dot [•] when it is on.

ProTERM 3.1

2.25K edit

9.50 sbk

9600 baud O ffline 09-FEB-96 14:52:36
Filename entered
in previous window.

Receive ASCII
Radio Button
select one or
other with
ARROW keys.

Filename: F ORU M. NEWS

Pop-up window
shows TXT or AWP

Save File as Type: TXT
Copy Raw Incoming Characters
Copy Entire Processed Lines

Receive ASCII
Parameters

Suppress Control Characters?
Display Capture Status Bar?
OK

Hold

Cancel
Mouse pointer

Suppress Control Characters
This option is used in conjunction with the Copy Raw Incoming Characters parameter. As the
unfiltered characters are received, ProTERM saves the data “as is” with this parameter
unchecked. When Suppress Control Characters is checked [ √] (turned on) the incoming text
is filtered and all control characters except RETURN and TAB are removed before the text is
saved.

Display Capture Status Bar
Receive ASCII is normally enabled and a special status bar displays the progress of the
transfer (see Receive ASCII Status Bar below). By removing the checkmark from this
parameter, the status bar is disabled (not displayed). When the status bar is disabled, there is
no visible indication of the progress of Receive ASCII or even that it is operating.

Receive ASCII Status Bar
Once Receive ASCII is enabled, an additional highlighted status line is displayed at the top of
the screen. This shows the current status of Receive ASCII and changes as new text is
received. As text is received by ProTERM, it is saved into a buffer which acts like a “text
reservoir.” Except for the fact the disk access light may be seen occasionally as the file is
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saved to disk, the saving of text is transparent to the user. When the text buffer becomes full,
the text is saved to the file, and the process of filling the buffer starts again. As new text is
saved it is appended to the file and the file grows larger. When Receive ASCII is disabled, the
text remaining in the buffer is saved to the disk file. The information in the Receive ASCII
status bar from left to right is:
• Bytes Free shows the size of the text storage buffer in characters (bytes). Bytes Free
decreases as the buffer fills. The size of the this buffer (memory reservoir) is dependent
on the available memory. This is one of the several parts of ProTERM which works more
efficiently when additional memory is available. When the buffer is full, the data is saved
to disk and it starts to fill again. ProTERM stops all incoming text as the file is being
saved. After the save is complete, the buffer is emptied and the process starts over again.
As additional ASCII text is Received, it is appended to the same file.
• Bytes Used shows the size of the text in the storage buffer in characters This field
increases as ASCII text received to the buffer.
• Current File Size shows the size of the file in “K” (thousands of characters). Each time
the file is saved to disk, this figure increases to show the new size of the file.

ProTERM 3.1 2.25K edit 9.50 sbk 9600 baud O ffline 09-FEB-96 14:53:12
RECEIVE ASCII: Bytes Free: 64879, Bytes Used:
145, Current file size: 3:60K

Recive ASCII
Sta tus Ba r

Number of
Bytes Free
in buffer.

Number of
Bytes Used
in buffer.

Size of File
(in bytes)
sa ved to
disk.

Welcome to the InSync BBS
You have 2 letters waiting.

Mouse pointer

Receive ASCII Status
Bar

[ ] Main Command (? = Help): _

Receive ASCII “Hold” Mode
After Receive ASCII has been enabled, it can subsequently be disabled or placed onHold.
Choose ASCII from the Receive menu to disable or temporarily put the Receive ASCII
command on Hold. Press the Close button to disable further data from being saved to the
file. Press the Hold button to temporarily stop saving data to the file. Hold places Receive
ASCII in a kind of neutral condition. When Receive ASCII has been put on Hold, a subsequent Receive ASCII command starts saving data to the file again.
NOTE: Receive ASCII text files are saved as one file and the file can get to be very large. See
the commands Print File and View File to work with large files or parts of large files.

Using Scrollback Instead of
Receive ASCII
If adequate memory is available to ProTERM, Scrollback offers an attractive alternative to
Receive ASCII. Because all text displayed on the screen is also saved in Scrollback, it is
possible to let text accumulate into Scrollback and then save it to a file. Provided there is
enough memory to allow Scrollback to record all of the information during your call, this
method of saving incoming text is effectively the same as using Receive ASCII in “capture
line” mode. See the Index: Scrollback for more information.
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Send
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

Sending with a Protocol
ProTERM supports four main protocols, Xmodem, Ymodem, Zmodem and Kermit as well as
five related protocols, Xmodem CRC, Xmodem-1K, Xmodem-4K, Ymodem-G and Ymodem4K. The advantages and disadvantages of each protocol are discussed later in this chapter. To
send a file or files to a remote host system, the host must first be given a command to begin
its “protocol receive cycle” (this command will vary from system to system, see the host
service’s help menus for directions). During this selection process the desired protocol is
selected from the host’s menu. Wait until the remote host system is ready to receive, and
then choose the desired protocol from the ProTERM Send menu. The exact same protocol
must be chosen on the host and within ProTERM.
Once the protocol has been chosen from the ProTERM Send menu, a file selection window is
displayed. One or more files (Xmodem transfers only single files) can be selected at this time.
When all the files have been selected, press the Send button. Depending on how your
preferences (parameters) are set, ProTERM either begins the protocol transfer or asks for
additional protocol send parameters. The protocol send parameters are listed below.

Text and Binary Mode
Zmodem and Kermit have separate send modes for text and binary files (Xmodem and
Ymodem send only in binary mode). When using Zmodem and Kermit protocols, ProTERM
allows you to select which mode you would like to use. The “Text” and “Binary” selections
send files in the respective mode regardless of the actual filetype. The “Auto” selection (only
available with Zmodem) determines the mode based on the filetype of each file sent. In Auto
mode, text files (type “TXT”) are sent in text mode while all other filetypes are sent in binary
mode. When a file is sent in text mode, the protocol changes the contents of files. The
sending system takes the files and converts them into a special format, sends the special
formatted data to the receiver, where the receiving system converts the data back into text
and saves it. In binary mode, the contents of a file are transferred without any formatting or
conversion.

The default parameters are generally
acceptable as they
are.

Send Options
ProTERM supports five different Send Options which control the way files are encoded and
sent during the transfer process. Both the ProDOS protocol extensions and Binary II encode
ProDOS-specific file information (such as exact filesize, filetype, auxiliary filetype, etc.) and
send this information along with the file:
• None: is the default option. It uses neither the ProDOS protocol extension nor the
Binary II encoding option.
• ProDOS: sends using the ProDOS protocol extension for Xmodem and Ymodem. This
option has no effect with Zmodem or Kermit.
• Binary II: encodes the file with a Binary II header and will operate with any protocol.
• PDOS/BNY2: uses both ProDOS and Binary II encoding (Xmodem and Ymodem only).
• TXT/BNY: encodes all non-text files with a Binary II header.
All the protocols support Binary II encoding, but Xmodem and Ymodem are the only ones
which support ProDOS protocol extensions. ProDOS protocol extensions should only be
used when sending to other Apple II hosts. Most large commercial services such as
CompuServe and Genie require all Apple II uploads be encoded with Binary II. If the file
which is being sent is already encoded with Binary II, ProTERM does not encode the file
again.

PART THREE — THE MENUS

THE SEND & RECEIVE MENUS

245

NOTE: If a file has been encoded with a Binary II header and then encoded again with some
other header type, ProTERM will encode with Binary II again if that option is set. ProTERM
can only detect Binary II if it was the most recently used encoding technique.

Protocol Speed
The protocol speed parameter is used to give ProTERM an idea of the response speed of the
remote system. The Fast setting is recommended for general use. When using services where
response times are slow, set this option to the Medium or Slow settings. This instructs
ProTERM to slow down the pace and wait longer for responses from the remote system
during a protocol transaction.
When all protocol options have been specified, press the Send button to begin the transfer.
It is important to note the options listed above can be changed for a particular system entry
in the Dial menu. To change the parameters for a particular system, choose the system’s
entry from the Dial menu and press the Parms button in the Edit System Parms window.
Change the Upload Options and Protocol Speed parameters to customize the protocol send
parameters for that particular system.

Note on
Defaults.

Receive
ASCII
Xmodem
Xmodem CRC
Xmodem-1K
Xmodem-4K
Ymodem
Ymodem-G
Ymodem-4K
Zmodem
Kermit

NOTE: IMPORTANT! Even though ProTERM offers literally hundreds of parameter combinations and preference changes, the normal telecom user can usually just accept the defaults
(what is normally already set) by just pressing the RETURN key. Most of these options are
provided for telecom users who want to customize the software for specialized applications.

Receiving with a Protocol
ProTERM supports four main protocols, Xmodem, Ymodem, Zmodem and Kermit as well as
five related protocols, Xmodem CRC, Xmodem-1K, Xmodem-4K, Ymodem-G and Ymodem4K. The advantages and disadvantages of each particular protocol are discussed later in this
chapter. To receive a file or files from a remote host system, the host must first be given a
command to start sending files. This command will vary from system to system, but is
generally a selection from their individual version of a “download menu.” When the host
indicates it is ready to send the file, choose the desired protocol from the Receive menu.
Since a protocol is a strict set of rules used to transfer a file, the receive protocol chosen
from the Receive menu must be the same as the protocol chosen on the remote host system.
Once the protocol has been chosen, a pathname selection window is displayed. The default
pathname is controlled by the Download Pathname parameter in the Preferences window
(see Index: Preferences). Select the pathname (volume and directory) for the incoming file or
files and press the Recv button. Depending on the protocol being used and your current
preferences, ProTERM either begins receiving the file or asks for the following additional
parameters.

Receive Options
ProTERM supports two different receive options which control the way files are decoded
when they are received: When set to None, an incoming file is saved exactly as it was sent.
When set to Binary II, the Binary II wrapper is removed (if present) and the file is saved
using the filename and ProDOS file information supplied in the wrapper (see Binary II later
in this chapter for more information). If the file is sent with a ProDOS protocol extension, it
is detected by ProTERM automatically and the supplied ProDOS file information is used.
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Protocol Speed
The protocol speed parameter is used to give ProTERM an idea of the speed of the remote
system. Use the Fast setting unless you experience problems transferring files from slow
remote host systems. If difficulties are experienced when using services where response
times are slow, set this option to the Medium or Slow settings. This tells ProTERM to wait an
additional period of time for the responses from the remote system during a protocol
transaction.

Duplicate Filenames
When a file is received, there is a chance it could have the same filename as one of your
existing files in the same directory. This parameter allows you to select the action taken in
the event of a duplicate filename. If set toReplace, the original file is deleted and the newly
received file is saved in its place. If set toRename, the received file is renamed so it does not
conflict with an existing filename. This is done by appending a version number to the new
filename. For example, if the fileXYZ is being received but already exists in the same
directory, the new file is saved asXYZ.000. If the file were received again, the name given
would be XYZ.001 and the file numbers would continue to increment asXYZ.002 up to
XYZ.999.
NOTE: When a Binary II encoded file is received, ProTERM attempts to save the file using the
(file’s original) name as supplied within the Binary II wrapper, since that is the file’s real and
intended name. However, if that filename is already in use in that directory, ProTERM saves
the file using the (external) name of the Binary II file. There is good reason for this; the
Binary II filename is not visible until after the file is received, and the operator should be the
one to make this choice of this file is named. ProTERM will NEVER replace a filename
(possibly destroying a valued file) in this situation.

Default Filetype
The Default Filetype parameter allows the filetype to be specified in the event it is not
supplied by the protocol or during the Binary II encoding process. The most common
default filetypes are “TXT” or “BIN”. After a file is received, if necessary, its type can be
subsequently changed by using the Set File Info command in the File menu.
NOTE: When using the Kermit protocol the default filetype has the additional function of
determining the receive mode (text or binary). Since the Kermit receive mode must match
the Kermit send mode, it is important the default filetype parameter is correctly set to “TXT”
or “BIN” when receiving files with Kermit.

Protocol Receive Filename
If a file is received using Xmodem and it is not Binary II encoded, when the transfer is
complete, ProTERM send a prompt to enter a filename. ProTERM displays the name which
the file was saved as (generally of the form “UNKNOWN.xxx”) along with a text entry window
to enter a new name. The new name may be any valid ProDOS filename. ProTERM assigns
the filename “UNKNOWN.xxx” if the field is left blank .
NOTE: The Ymodem, Zmodem and Kermit protocols all send the filename along within the
file data so it is not a concern. Binary II encoded files also contain a the filename. The
Xmodem protocol by itself does not pass the filename information.
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NOTE: When choosing a protocol, choose in reverse alphabetical order: Zmodem, Ymodem,
Zmodem and Kermit. Generally speaking, this is in the order of ease of use, automation and
“smartness.”

Transfer Preferences
All protocol parameters have default values which can be set from the system entries in the
Dial menu or by the Preferences command in the Misc menu. To change any of the default
parameters described below, choose Preferences from the Misc menu and press the Xfer
button. This displays the Transfer Preferences window . After making changes to this
window, press the OK button and then the Save button. The Transfer Preferences window
with its default values is shown below.
ProTERM 3.1

2.25K edit

9.50 sbk

9600 baud Offline 06-FEB-96 17:54:23

Transfer Preferences
Ask Xmodem O ptions? Default Filetype: BIN
Ask Ymodem O ptions? Default Filetype:

BIN

Ask Zmodem O ptions? Default Filetype: BIN
√ Ask Kermit O ptions?

Default Filetype: TXT

Xfer Complete Sound: Beep

Mode: Text

Check Disk-Space on Receive?

Force Xmodem 1K/4K Sends?
Use Zmodem CRC-32?

Mode: Auto

Force Zmodem 1K Sends?

Add .BNY/.BXY During Uploads?

Transfer Preferences
Window

√ Interpret Dot-Commands in Send ASCII?
OK

Cancel

Ask Protocol Options
When any of the “Ask Options” checkboxes are toggled “On” with a checkmark [√], an
additional window of parameters is displayed after a protocol send or receive is chosen. This
is the same window of parameters which can also be displayed by setting the Upload Options
or Download Options fields to Query in a Dial menu system entry.
The additional protocol send parameters are:
• Send Mode (Text, Binary or Auto).
• Send Options (None, ProDOS, Binary II, PDOS/BNY2, TXT/BNY).
• Protocol Speed (Fast, Medium, Slow).
The additional protocol receive parameters are:
• Receive Options (None or Binary II).
• Protocol Speed (Fast, Medium, Slow).
• Duplicate Filenames (Replace or Rename).
• Default Filetype (TXT, BIN, etc.).

Default Filetype
Each protocol family can have a separate default filetype. When the “Ask Options” toggle is
checked [√] “On”, the filetype shown in this window is displayed as the default and can be
changed before each protocol receive.
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Mode
Each protocol family which supports a send mode can have the default set here. When the
“Ask Options” toggle is checked on [ √], the send mode selected in this window is displayed
as the default and can be changed before each protocol send.

Xfer Complete Sound
The Transfer Complete Sound parameter can be set to None (no sound), Beep (three beeps)
or Siren (a long wailing sound). At the completion of a protocol send or receive, ProTERM
makes the announcement with the selected sound via the computer speaker.

Check Disk-Space on Receive
At the start of a protocol receive, this parameter instructs ProTERM to check if adequate disk
space is available to save a file. Since file size information is sent at the beginning of Ymodem
and Zmodem transfers, this option works only with those protocols. (Obviously, if the file
length is not supplied, ProTERM is unable to determine the amount of disk space required
by the file.) ProTERM cannot know if the file being received will replace an existing file and
thus free up disk space. If a received file will not fit on disk, then ProTERM displays a Disk
Full error message.

Force X/Ymodem 1K/4K Sends
Xmodem and Ymodem packet size is normally determined by a special string (phrase) of
information sent by the receiver to inform the sender of its capabilities. By setting this
parameter, Xmodem-1K, Xmodem-4K and Ymodem-4K send files using their respective block
sizes even if the receiver does not indicate the ability to receive them. This option should
only be used if you understand why you should change use it, and are certain the host has
the capability to process the desired block size but does not send out a capability string.

Use Zmodem CRC-32
Zmodem does error correction by performing a special computation on the data and sending
the computation result along with the data. The receiver performs the same computation on
the data, and compares its result to the what the sender indicates was sent. Zmodem
supports two such computations known as CRC-16 and CRC-32. The CRC-16 algorithm is
slightly faster and requires slightly less data, but is susceptible to undetected errors
(undetected errors are measured in thousands of years for CRC-16 and millions of years for
CRC-32).

Add .BNY/.BXY During Uploads
This parameter acts globally for all protocol sends and tells ProTERM to add “.BNY” or
“.BXY” extensions to filenames. For example, when this option is turned on, a file called
“MYFILE” sent with Binary II encoding turned off becomes “MYFILE.BNY”. The designation
between “.BNY” and “.BXY” indicates whether the file is a Binary II encoded file, or a Binary
II encoded ShrinkIt file. Neither extension is added if Binary II encoding is disabled. The
default for this preference is set to Off and it should not be changed unless it is needed by all
systems you call.

Interpret Dot-Commands in Send ASCII
This parameter controls the default setting for this same parameter in the Send ASCII
window. Since this parameter does not interfere with normal applications or files, it should
always be left on, so documents containing ProTERM dot-commands can be correctly
formatted as they are sent.
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Transferring Files
Between Computers
Transferring a file refers to transmitting between computers (systems). The modems are
usually connected via a call using telephone company as a go between and we think of as
being the standard, but it is not the only way to transfer files between computers.

Direct Connect
Computers can also be connected together by using a length of phone wire between two
modems. Set one system in an Unattended mode (awaiting a call) and set the other system to
dial the waiting system using just an asterisk “*” for a phone number. The asterisk fools
ProTERM into thinking there is a real phone number available to dial and when this “phony”
number is dialed, it is enough to announce to the other system that it is being called so it
goes online and the two systems are then connected. This configuration operates the same
as a conventional call, using modems and phone lines — The called system is a host and the
calling system is the terminal. The connect speed will be set by the speed of the slowest
speed on either modem.

Even More Direct
Another alternative is to use a special null modem cable directly between the two system
serial ports without using a modem. For more on this see the Index: Null modem. THe
connect speed can be set at 4800 or 9600 for an Apple IIc, up to 19,200 for a super serial
card and up to 57,600 for an Apple IIGS.

File Transfers —
What to Expect the First Time
Explaining what you might see, and what you might expect the first times you call a system is
difficult. Every system is designed by an individual and every one will be different. There are
some generic commonalities which we can mention that will hopfully make the new world of
telecommunication more friendly and familiar during those first attempts to exchange files
with that other computer.

The Exchange
File transfers are meant to move files from one computer to another. What happens after the
exchange depends on the type of file, if it has been altered for transfer, and what machine it
is to be used on. This will be covered one step at a time.

The Type of File
The full range of kinds files available is beyond the scope of this brief mention, but a few are
listed here to illustrate the example. Some files, such as the one you’re reading are text (TXT
filetypes) files and are meant to be read, printed, edited and so forth. Others may be used as
games, puzzles, utility types to assist us in various needs such as copying, or spell checking.
Others are more complex, and important to our needs, such as word processors, data bases
and spread sheets. All of these files can be transferred from one computer to another.

W ill The Files W ork O n The O ther Computer?
Just because a file can be transferred from one system to another, doesn’t mean it can be
used on that system. An example could be made of many BBSystems. They are repositories of
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many machine types of files. Macintosh, IBM, Apple and more can be found side by side in
the same libraries. But being stored in this environment, and being functional in that
environment is a very different situation. Apple II files can be uploaded and stored on a Mac
or IBM system, downloaded by another Apple II computer and they will be totally functional.
A text file uploaded to one of these other machine types, can usually be read by the text file
reader application for that machine as they are very generic. That is about where it stops
though. An Apple game or word processor, cannot be functional on a Mac or IBM.

Selecting a Protocol
ProTERM supports four protocol families along with five protocol extensions. With nine
protocol choices available, it is often difficult to judge the proper choice. The following list
of the ProTERM protocols explains the situations in which each should be used. The
important detail to remember is, the sending and the receiving protocol must always match.
If the remote host only supports Xmodem-1K, then ProTERM must also use Xmodem-1K.

Protocols means
“ follow the rules.”
Both Systems MUST
be set the same.

NOTE: Just because ProTERM has the ability to use a particular protocol does not mean it
can be used. Both sides (ProTERM and the remote host system) must have the same
capabilities and use the same protocol.

Xmodem
Xmodem sends with 128-byte packets and uses a 1-byte checksum for error checking. It can
automatically detect and use the Xmodem ProDOS extension if the remote host supports it.
Xmodem should be used only when no other version of Xmodem or Ymodem or Zmodems
protocols are available.

Xmodem CRC
Xmodem CRC requests CRC-16 error checking be used instead of the 1-byte checksum. If
ProTERM is the receiver, make sure the host service supports Xmodem CRC before choosing
it. If it does not, the protocol will time-out waiting for something to happen. ProTERM can
automatically detect and use the Xmodem ProDOS extension if the remote host system
supports it. Xmodem CRC, if avaialable, should be used instead of standard Xmodem.

Xmodem-1K
Xmodem-1K requests CRC-16 error checking and 1K packets. This gives much better
performance than standard Xmodem because of the reduced handshaking overhead.
ProTERM can automatically detect and use the Xmodem ProDOS extension if the remote
host supports it. If available, Xmodem-1K should be used instead of Xmodem CRC.

Xmodem-4K
Xmodem-4K requests CRC-16 error checking and 4K packets. This gives an additional
performance increase by further reducing the number of handshakes over Xmodem-1K.
ProTERM can automatically detect and use the Xmodem ProDOS extension if the remote
host supports it. Xmodem-4K should be used if it is available. In a high-error environment,
the errors will force the larger packets to be resent resulting in what could be a much slower
process than if smaller packets protocol were used.
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Ymodem
Ymodem uses 128/1K packets and CRC-16 error checking to transfer data. If the remote host
supports it, Ymodem automatically transfers the ProDOS file information. Unlike Xmodem,
Ymodem supports batch transfers. If Ymodem is available on your host, use it instead any of
the Xmodem protocols.

Ymodem-G
Ymodem-G should only be used when an error-free connection has been established with
the remote host system and your modem supports hardware handshaking. Ymodem-G is not
an error-correcting protocol and if an error is detected, the transfer is canceled. Ymodem-G
is only for use in select situations. Ymodem-G is the fastest protocol supported by ProTERM
(even faster than Zmodem).

Ymodem-4K
Ymodem-4K uses 128/1K/4K packets and CRC-16 error checking to transfer data. Ymodem-4K
automatically transfers the ProDOS file information if the remote host system accepts it. If
this protocol is available, it should be used in preference to Ymodem unless you are in a
high-error environment. Because of the large packet size Ymodem-4K, errors force more data
to be retransmitted than Ymodem.

When available,
Zmodem is the best
choice.

Zmodem
Zmodem is the most powerful protocol supported by ProTERM. If the remote host system
supports Zmodem, then it should be used. In a high-error environment, Ymodem may give
better results depending on the responsiveness of the remote host system. If Zmodem seems
to take an excessive amount of time to recover from errors, Ymodem may offer better all
around performance.

Kermit
Kermit communicates with almost any remote host system, but is slow. On large mini and
mainframe systems, Kermit is often the only protocol available. If one of the other protocols
is available, it will generally be much faster than Kermit. Kermit was not designed for speed,
its major objective is to support most any communications environment. SeeKermit later in
this chapter.

Binary II and Archives
When files are to be transferred to a remote host system, two popular techniques used in
order to prepare file for the “journey.” The first technique, called “Binary II encoding”
provides a method of keeping the ProDOS attributes intact. The second technique, called
“archiving” (sometimes called “shrinking”), is used to compress and group files to increase
the efficiency of the transfer and storage. Most archived files are also Binary II encoded.

Binary II
Binary II encoding is a method of turning a file into a self-contained unit by placing the file
information into a “wrapper.” The primary reason for this wrapper is to allow ProDOS files
to be stored on non-ProDOS computer systems and still maintain all of the ProDOS file
attributes. When such a file is downloaded and the Binary II wrapper is removed, the file
returns to its original form. Because of the way Binary II “wraps” a file, it can be generically
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stored on most any system without damage or loss of content. This process is sometimes
referred to as putting the file into a “plain brown wrapper” or an “envelope.”
Binary II encoding provides a protective means of sending the “attributes” of a file, such as
the filename and ProDOS information (filetype, file status, etc.) and of course the file itself,
to almost any system. Files uploaded with Binary II wrapper to a non-ProDOS based host can
be successfully downloaded to another ProDOS based system and be perfectly usable after
the Binary II wrapper is removed. Any file can be encoded with Binary II. Files uploaded to a
ProDOS based system generally do not require Binary II encoding. Although shrinking (using
an archiving application) allows files to be combined and can save file transfer time, it is not
a prerequisite to using Binary II.

Binary II and ProTERM
Adding and removing Binary II wrappers to files is normally a transparent process in
ProTERM. By default, ProTERM always checks during a download to see if the file has a
Binary II wrapper. If it does, the wrapper is removed during the download, and the file is
stored using its original name. Adding a Binary II wrapper to a file is simply a matter of
setting the Upload Options to Binary II for a system entry in the Dial menu. Archived files
still need to be unpacked with an archive utility such as ShrinkIt after downloading.

Archiving
Archiving refers to placing one or more files, directories or disks into a single archived file.
This process also compresses the data in the files so the resulting archive is smaller than the
sum of the original files, saving both disk space, and transfer time. The archive utility,
ShrinkIt for example, that created the archive file must be used to remove the files from the
archive and save them back to disk in a usable form.
Some remote host systems request the person sending the file to consider the size or the
type of the file being uploaded before shrinking because shrinking a very small file can be
counter productive. Unless there is a reasonable space savings, or more than one file is to be
maintained in a “set,” the hassle of archiving is not justified. In addition, text files are often
not archived or even Binary II encoded because ASCII text format is generic to all computers.
By uploading text files without any encoding or archiving, the file is usable to all computer
users regardless of the type of computer. Check the individual host requirements and
guidelines before uploading files.
Archive applications are often referred to as file compression utilities. ShrinkIt, for example,
can make files smaller and even pack several files, directories or whole disks into one
“archive” file. Placing files in archives is optimal for transfer via modem since smaller files use
less disk space and take less time to transfer. Since an archive allows several related files or
an entire disk to be packed together into a single file, related files and directories remain
together in their proper order. When they are removed from the archive, they are restored to
their original condition.
ShrinkIt is a popular Apple II FreeWare utility program used for archiving Apple ProDOS and
GS/OS files. It is available from user groups, other Apple computer users, most BBSystems
and the Apple II areas on the major online services. As a convenience to ProTERM owners
and since there is ample room available, the ProDOS 8 version of ShrinkIt is included on the
ProTERM 3.5” disk in the “/UTILITIES” directory. This version works only with ProDOS 8
files, not GS/OS specific files. A GS/OS version of ShrinkIt is available from the above listed
sources.
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Binary II versus Archiving
Binary II and Archiving are different tools for different jobs. If a ProDOS file which had not
been Binary II encoded were uploaded to a remote host system such as GEnie, CompuServe
or PC based system, the file would stored in what could be considered a hostile environment. When the file was downloaded, it would no longer have the ProDOS attributes it
started with and probably would not function as expected. On non-Apple based hosts, files
typically are archived and Binary II encoded. Files stored on Apple Bulletin Board Systems
are typically archived to save space and transfer time.

Unpacking an Archive
When an archive is downloaded, it needs to be processed to make the file usable. If the file is
Binary II encoded, ProTERM removes the Binary II wrapper during the download process
and saves the just archived file. The archive itself must then be converted to a normal file
using an archive utility like ShrinkIt.

Archive Suffixes
When an archived file is saved to disk, it normally has a special suffix appended to filename
to indicate what kind of archive utility was used to create it. The following is a list of both
current and obsolete archive suffixes (listed alphabetically):

.ACU
The .ACU archive format was once used by America Online. These files can be unpacked with
ShrinkIt.

.BNY
.BNY indicates a file with a Binary II wrapper which is not shrunk. The Binary II format is not
really an archive format. It is a protective “envelope” used to preserve ProDOS file attributes
during uploading and downloading. ProTERM can automatically add and remove Binary II
wrappers during protocol file transfer. ShrinkIt can also remove the Binary II wrappers from
files.

.BQ Y
.BQY indicates a “squeezed” (compressed) file within a Binary II envelope. These files were
created with an older utility program called “BLU”. When these files are downloaded with
ProTERM, the Binary II wrapper is removed and a “.QQ” or “.SQ” file remains (see below).
“BQY” files can be unpacked with ShrinkIt.

.BXY
BXY indicates a shrunk disk, a file or a group of files within a Binary II wrapper (a NuFX
archive within a Binary II envelope). This is the format currently required for new uploads to
the Apple II libraries on most online systems including GEnie and CompuServe. When these
files are downloaded by ProTERM, the Binary II wrapper is removed and a “.SHK” file
remains (see below). These files can be created and unpacked with ShrinkIt.

.Q Q
When a Binary II envelope is removed from a “.BQY” file, the squeezed files it contains have
the suffix “.QQ” or “.SQ”. These files can be “unsqueezed” with ShrinkIt.

.SDK
SDK indicates a shrunk disk with no Binary II wrapper. This is a “NuFX” format. The disk can
be “unshrunk” to another disk with ShrinkIt.
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.SHK
SHK designates a shrunk file with no Binary II wrapper. This files can be created and
unpacked with ShrinkIt. It uses what has been designated as a “NuFX” format.

Protocol Information
A protocol in computer terms is a predefined method of executing a communications task. A
protocol is a standard, or set of rules for sending or receiving data to or from a remote host
system. The following is a short discussion of protocols and some historical development
notes.

Both sides agree to
a set of rules.

What is a Protocol?
When a file is transferred with a protocol, it simply means both the sender and receiver obey
a set of rules while transferring a file. The protocol type (Xmodem, Ymodem, Zmodem,
Kermit and even ASCII) determines the exact rules to be used during a transfer. The
following is an example of a very simple protocol:
1: Send a line of text.
2: Terminate each line with a RETURN character.
3: Wait for a “:” character and when it appears, repeat step 1.
4: After all the text is sent, send the “.S” command to complete the transfer and save the file.
This simple example illustrates the concept behind a protocol. As long as both sides
understand the rules, the file is transferred correctly. Each side knows what to expect from
the other for each different condition. The biggest problem with this example protocol is
that any interference on the phone line can introduce random (garbage) characters into the
file as it is being sent. Such a problem could even cause the prompt to get lost bringing the
transfer to a halt. To eliminate these kinds of problems there are classes of protocols which
have “error detecting” and “error correcting” capabilities.

Error-Detecting Protocols
Most file transfer protocols employ some form of error detection. This is normally done by
having the sender break the file data into small units called packets, performing a special
arithmetic computation on the data in the packet, and sending the result of the computation
along with the packet. When the receiver gets the packet, it also performs the same
computation and compares its result to the sender’s. If they match, the data in the packet is
assumed to be free of errors. If they don’t match, an error has occurred in the transmission
of the data packet, and a request is made for the packet to be resent.
The ProTERM protocols use two different types of error detection algorithms. The first
protocol is called “checksum” and involves adding the values of all data in the packet, then
sending the remainder of the total divided by 256 (64 in case of Kermit). The second
protocol is called “CRC” (short for Cyclic Redundancy Check) and involves treating the data
as a long integer number and dividing it by a large prime number. The probability of CRC-16
failing to detect a single 1-bit error is so small if files were transferred at 9600 BPS, 24 hours
a day, it would take approximately 3000 years to fail the detection the error. Using CRC-32,
this figure increases to over 100 million years.
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Error-Correcting Protocols
In addition to being able to detect errors, most file transfer protocols can also correct errors
as well. In such protocols, when the receiver detects an error in a packet (using the
technique described above), the receiver tells the sender to resend that packet. When the file
transfer is finally completed, all of the data in the file is correct since the receiver instructed
the sender to resend any packets not “passing the test.”

Fault-Tolerant Protocols
In addition to the error problems caused by a noisy phone line, there are also communication failures (i.e., the modem is disconnected from the remote system midway through a
transfer). Protocols which have the ability to recover from these kinds of errors are called
“fault-tolerant protocols.” With such protocols, after the communications failure has been
repaired (i.e., the modem is reconnected with the remote system), the transfer can be
restarted from the point at which the failure occurred.

Protocol Development History
ProTERM supports four different protocol families (Xmodem, Ymodem, Kermit and
Zmodem) along with several different derivations. The following outlines the development
of these protocols along with their contributions to telecommunications.

Xmodem
The most popular and widely implemented of the error-free protocols is Xmodem, which
was developed in 1977 by Ward Christensen and was designed to run under CP/M, the most
popular operating system of the day. As a result of its early introduction, ease of implementation, and good performance, Xmodem has probably become the most widely implemented
microcomputer protocol. The Xmodem protocol standard is very simple:
• The protocol requires an 8-bit serial port.
• Data is sent in 128-byte packets.
• Each data packet is prefixed by a 2-byte packet number.
• Each data packet is followed by a 1-byte checksum.
• Receiver responses are simple 1-byte control characters.
• The protocol is receiver driven.
• A simple timing scheme avoids deadlock.
One drawback to Xmodem was, it did not send the filename along with the file and thus it
was not possible to do “batch” transfers. However, an extension to Xmodem was developed
which allowed the filename to be sent along with the data. This is commonly referred to as
Xmodem Batch or MODEM7 (MODEM7 was the name of the first CP/M program to
implement the new batch-mode Xmodem). Because the filename transfer was not as clean
and simple as the rest of Xmodem and filenames needed to be in CP/M format (an eight
character filename with a three character extension), Xmodem Batch was never widely used
outside of the CP/M environment.
Since Xmodem used only a 1-byte checksum to do error checking (all the bytes in a packet
were added together, the total was divided by 256 and the remainder was the “checksum”),
undetected errors could occur during transfers. To correct this problem, an extension to
Xmodem called a 2-byte CRC-16 was developed which substituted the Xmodem CRC 1-byte
checksum. By using CRC-16 with Xmodem’s small 128 byte packets, the chance of undetected errors dropped to almost zero.
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With the addition of CRC-16, Xmodem was quite reliable. However, the small 128 byte
packets caused the protocol to be slow. It was found the handshake between packets (the
point at which the receiver tells the sender to send the next block or to resend the current
block due to an error) was actually quite slow. Therefore to minimize the number of
handshakes between the sender and receiver, Xmodem-1K was developed. In this extension,
1024 (1K) byte packets, were used instead of 128 byte packets which were eight times
smaller. With this protocol, files required only 1/8 the number of handshakes as were
previously used. Since handshakes are needed but non-productive, and consume a large
amount of the transfer time, the efficiency was greatly improved.
Unlike CP/M, both Apple DOS 3.3 and Apple ProDOS files contain special information (such
as file type and locked/unlocked status) which is not actually part of the file. In addition,
Apple ProDOS has several other parameters, such as exact file length, also not a part of the
file. Since Xmodem was developed for CP/M, no provisions were ever made for “machine
specific” information.
When ASCII Express “The Professional” was released for DOS 3.3 by Southwestern Data
Systems, it was the first Apple communications program with the ability to send files using
Xmodem and still retain the proper file type. To accomplish this, ASCII Express added
another extension to Xmodem to send the filetype before the data was sent. This extension
to Xmodem is now commonly called Xmodem DOS.
Later, when the ProDOS version of ASCII Express was released, the same problem was faced
again. However, unlike DOS 3.3 which needed only one additional filetype byte, ProDOS
required an extra 23 bytes to send the filetype, auxiliary filetype, modification date/time,
creation date/time, access and exact file length. To accomplish this, Xmodem ProDOS was
developed which sent an additional identification sequence at the start of the file, and an
extra packet at the end with the additional parameters.
With all of the extensions and modifications to Xmodem, things were starting to become a
little confused. Each new extension generally tried to support all previous extensions with
varying degrees of success. The Xmodem batch facility had never worked particularly well,
and fallback from CRC-16 to checksum error checking was somewhat unreliable. Fortunately,
Chuck Forsberg designed Ymodem, which incorporated the best extensions to Xmodem,
cleaned up batch mode and added the facility for special file information.

Ymodem
Ymodem was basically a combination of Xmodem with CRC (no checksum mode), both 128
and 1K packets and an initial data packet with the filename, exact file length and modification date. Because the name was changed from Xmodem to Ymodem, there was no longer
any obligation for backwards support. This was very important because it allowed Ymodem
to start with “a clean slate.”
The main improvements of Ymodem are; 1) the protocol uses a standard data packet to send
the filename along with any machine specific information, 2) it always uses CRC error
checking, and 3) due to its new name, it is not obligated to support Xmodem and its
derivatives. This last fact was actually very important considering the number of Xmodem
derivatives which had accumulated. Ymodem implementation supports both 128 and 1K
blocks and is significantly faster than Xmodem.
One option known as Ymodem-G was offered as part of the initial protocol release and
allowed Ymodem to operate in “streaming mode.” In this mode, the sending protocol would
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divide the file into packets and send the error detection information as in normal Ymodem.
However, it would not wait to handshake with the receiver after every packet. This made
Ymodem-G incredibly fast, but gave up the ability to do error correction. If even a single
error is detected during a Ymodem-G transfer, the entire transfer must be canceled.
Normally, Ymodem-G is only used with error correcting modems where the hardware
insures an error free connection.

The development
of Kermit.

While Xmodem and Ymodem were both running well with microcomputers, they both
required an asynchronous 8-bit communications path. In the meantime, file transfer was also
a problem for users of mini and mainframe systems which commonly operate in 7-bit
communications environments and have special timing needs. Frank da Cruz and Bill
Catchings of Columbia University came to the rescue with a new protocol called Kermit.

Kermit
Kermit’s design philosophy was radically different from Xmodem and Ymodem. Kermit was
specifically designed for character-oriented communications links, taking into account the
requirements of diverse operating environments including: buffering, duplex, parity,
character set, etc. Kermit sends everything in packets, including the control sequences for
the remote system, unlike Xmodem’s single control characters. Kermit normally uses only 96
of the 256 ASCII characters. Control character and high-bit characters are sent using a special
“prefixing” method. While Kermit tends to be much slower than Xmodem or Ymodem, it can
communicate through almost any environment. As with Xmodem, Kermit has no provisions
for sending machine specific information such as file type.
Unlike Xmodem and Ymodem which are “binary” mode protocols (the data is unchanged
after it is transferred), Kermit also supports a “text” mode. The important factor here is,
different computers store text files differently. On Apple computers, text files are stored with
just a RETURN at the end of each line. On PC Compatible computers, text files are stored
with a RETURN + LINEFEED at the end of each line. On computers which run UNIX, text
files are stored with just a LINEFEED at the end of each line. When Kermit’s text mode is
used, the end of line character(s) are converted for use on the receiving system.
With the first release of ProTERM, a new extension to Ymodem was included to allow
ProDOS specific information to be included as part of the initial filename packet. Ymodem
ProDOS used the same parameter ordering as Xmodem ProDOS, but the parameters were
placed in the second half of the Ymodem filename packet.
With the development of packet-switched networks (such as PC Pursuit), high-speed errorcorrecting modems and slow responding hosts, Xmodem and Ymodem began experiencing
performance problems. Because Xmodem and Ymodem require a handshake after each
packet, their performance will decrease as transmission latency increases. (Latency is is not
the measure of capacity, it is the time required to send a character from one point to
another.

Zmodem
In order to attain high performance in high latency environments, Zmodem was developed
by Chuck Forsberg. Unlike Xmodem and Ymodem, Zmodem does not handshake after each
packet is sent. It sends packets without waiting for an immediate response from the receiver.
If the receiver detects an error, it transmits the position of the error back to the sender which
will begin resending from the position of the error. In high-latency situations, Zmodem can
offer such substantial performance increases it can double the transfer speed of Ymodem.
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Besides having excellent latency characteristics, Zmodem also supports both text and binary
mode transfers and control prefixing. Thus it can operate in many environments under
which Xmodem and Ymodem cannot, though it still requires an 8-bit data link. Unlike the
other protocols, Zmodem can also resume a transfer previously failed part way through. The
only drawback to Zmodem is, it can be slow at error recovery due to the streaming nature of
the sender. However, with error correcting modems, this becomes less of an issue.
More recently, extensions for Xmodem and Ymodem have been developed which increase
the maximum packet size from 1K to 4K. This cuts down on the amount of handshaking
done by a factor of 4 which helps improve performance in high-latency environments.

Error Messages
The following is a list and description of the ProTERM protocol error messages. There is
often more than one cause for an error message, and this guide is designed simply to give a
general idea as to the status of a transfer in progress. At the end of each error description,
the protocol(s) which can generate the error are listed in parenthesis.

Block Number Complement Mismatch
The block number and its complement did not match. ProTERM sends a NAK and wait for
the sender to respond. (Xmodem/Ymodem)

Block Number Out of Sequence
ProTERM received a data packet which was out of sequence. ProTERM sends a NAK packet
and wait for the sender to resend the packet. (Xmodem/Ymodem/Kermit)

Checksum Does Not Match Data
ProTERM received a data packet which contains an error as identified by a checksum
mismatch. ProTERM sends a NAK packet and wait for the sender to resend the packet.
(Xmodem/Kermit)

CRC Does Not Match Data
ProTERM received a data packet which contains an error as identified by a CRC check.
ProTERM sends a NAK packet and wait for the sender to respond. (Xmodem/Ymodem/
Zmodem)

Data Subpacket Too Long
ProTERM received a Zmodem data subpacket longer than 1024 bytes. ProTERM sends a
ZRPOS to force the sender to begin resending from the point of the error. (Zmodem)

Got Subpacket Instead of Header
ProTERM was waiting for a Zmodem header packet but received a data subpacket instead.
ProTERM sendd a ZRPOS to force the sender to begin resending from the point of the error.
(Zmodem)

Got ZRINIT Instead of ZACK
ProTERM sent the ZFILE filename packet and received a ZRINIT packet instead of a ZACK
packet. ProTERM immediately resends the filename packet. (Zmodem)
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Got ZRPOS: Resending Data
ProTERM received a ZRPOS error packet and begins resending the data from the point
specified in the packet. (Zmodem)

Got ZRPOS at EOF
ProTERM sent the ZEOF end of file packet and received a ZRPOS packet instead of a ZACK
packet. ProTERM immediately begins to resend the data from the point specified in the
packet. (Zmodem)

Invalid ProDOS Signal Packet
ProTERM received a ProDOS signal packet from the sender which contained an error.
ProTERM sends a NAK and wait for a new packet. (Xmodem)

Position Of Sender Is Invalid
ProTERM received a ZDATA packet containing the wrong data. ProTERM sends a ZRPOS to
force the sender to begin resending from the point of the error. (Zmodem)

Resent Packet Due to NAK
ProTERM received a NAK (negative acknowledge) from the receiver and is resending the data
block. (Xmodem/Ymodem)

Timeout After CRCW Packet
ProTERM sent a CRCW data packet and requested the receiver respond once it was received.
No response was detected from the receiver. (Zmodem)

Timeout After Sending EOF
ProTERM sent the ZEOF end of file packet and has not received a response from the receiver.
ProTERM will wait for a ZRPOS packet from the receiver and start sending data from that
point. (Zmodem)

Timeout During Data ACK/NAK
ProTERM sent a block of data and has not received a response from the receiver. ProTERM
will send the block again and wait for a response. (Xmodem/Ymodem)

Timeout During Filename ACK/NAK
ProTERM sent the filename packet and has not received a response from the receiver.
ProTERM waits for another startup character before sending the filename packet again.
(Ymodem)

Timeout During Filename Send
ProTERM sent the ZFILE filename packet and has not received a response from the receiver.
ProTERM waits for a new ZRINIT packet before sending the filename packet again.
(Zmodem)

Timeout During Parms Handshake
ProTERM has timed out waiting for the receiver to prompt it to send the ProDOS parms
packet. The parms packet exchange is normally initiated by the receiver. (Xmodem)
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Timeout During EOF ACK / NAK
ProTERM sent the end of file message and has not received a response from the receiver.
ProTERM sends the end of file message again and wait for a response. (Xmodem/Ymodem)

Timeout During Transfer End
ProTERM sent the ZFIN end of transfer packet and has not received a response from the
receiver. ProTERM sends the end of transfer packet again and wait for a response. (Zmodem)

Timeout Requesting ProDOS Parms
ProTERM requested the sender send the ProDOS parms packet but has received no response.
(Xmodem)

Timeout Waiting For Block Number
ProTERM is waiting for the block number of a data packet from the sender but has received
nothing. ProTERM sends a NAK and waits for the sender to respond. (Xmodem/Ymodem)

Timeout Waiting For CRC
ProTERM received a data packet but timed out waiting for the accompanying CRC information. ProTERM sends a NAK packet and waits for the sender to respond. (Xmodem/Ymodem/
Zmodem)

Timeout Waiting For Packet Data
ProTERM is waiting for a data packet from the sender but has received nothing. ProTERM
sends a NAK and wait for the sender to respond. (Xmodem/Ymodem/Zmodem/Kermit)

Timeout Waiting For Packet Header
ProTERM is waiting for a data packet header from the sender but has received nothing.
ProTERM sends a NAK and waits for the sender to respond. (Xmodem/Ymodem)
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The Misc Menu
CHAPTER FIFTEEN
Misc
Editor
Scrollback

E
Z

Answer Phone
Unattended U
Macro File
Read Globals
Transfer Stats
Preferences
Install

The Misc Menu contains all of the different ProTERM commands which were, in fact,
“miscellaneous” and did not have any direct association with any other menus or features. In
addition, some of the ProTERM features, the ProTERM Editor and Scrollback, for example,
are so large there are individual chapters covering them and their individual parts. For
information on ProTERM other commands, see the introductory chapters and also look in
the Index under the appropriate command name.

Editor
I

Due to its size and complexity, the Editor is discussed in a chapter of its own. See the Index
or Table of Contents: Editor.

Scrollback
Due to its size and complexity, Scrollback is discussed in a chapter of its own. See the Index
or Table of Contents: Scrollback.

Answer Phone
The Answer Phone command is used to establish a connection with an incoming modem call
and then go into terminal mode such that the system on each end of the call are each in
control. Terminal mode allows the users on either end to interact with their individual
computers, with both computers acting as local terminals and remote hosts at the same time.
Since both systems are in a direct connect terminal mode, users can communicate by typing
messages to one another. It is recommended both users set Duplex to Half Duplex in the
Parameters window in the Online menu. When Duplex is set to FULL, typing on the local
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keyboard is sent to the remote computer, but is not displayed on the local screen. As a result,
both users can type to each other, but neither can see their own typing. For more information on half and full duplex and how they work see Index:Duplex. Since terminal mode is a
manual operation, both users must coordinate operations such as file transfer via “on-screen
chat.” To transfer a file one user must instruct their software to send a file while the other
user instructs their software to receive a file. For a more automated call of this type, see the
Index: Unattended.
To allow an incoming call to be answered in terminal mode, chooseAnswer Phone from the
Misc menu. The Connect Time parameter has a default time of 30 seconds which is usually
more than adequate time for a modem to make a connection, though this time can be
changed as needed. After entering the connect time press OK and ProTERM will wait for an
incoming call. To cancel the waiting process, press the Cancel button or the ESCAPE key and
ProTERM will return the Main Menu. To force ProTERM to answer the phone (even if it has
not rung) and attempt a connection, press Answer. Once a call comes in and a connection is
established, the screen is cleared and ProTERM enters terminal mode.
NOTE: It is possible to change from a voice to a data call without hanging up. See Index;
Data; to voice calls, changing.

Call-Back or “Secure” Systems
To provide an additional level of security, some systems use a technique referred to as “callback” or “secure call-back.” When you register with one of these systems, you are given
password information which acts as your credentials or “key” to the system. Part of this
registration process requires you to supply the phone number of your modem phone line.
To logon to this type of system, call, connect and enter account and password information
like any other system. However, unlike most other systems, after verifying the account and
password information, the system disconnects and then calls back at the pre-supplied phone
number. When the system calls back, your modem answers the phone and makes a
connection and the logon process is complete.

Using ProTERM with Call-Back
To use ProTERM with a call-back system, usCreate System to create an entry in theDial list
for the host system. Set up all relevant parameters:Phone Number, Baud Rate, Data Format,
Emulation, and whatever other parameters applying to your calling the host system. Dial the
system and logon according to the host system's procedure. When the system disconnects
and instructs you to setup your modem to receive a call, choose theAnswer Phone command
from the Misc Menu. Leave the Connect Time at its default value and pressOK. When the
system calls back, ProTERM will answer the phone and establish the connection. You will in
terminal mode where and ready to work.

Automating the Call-Back Process
Just as it is possible to write a logon macro to automatically logon to a remote host system, it
is also possible to automate the call-back process. UseAutoLearn to create a logon macro for
the system. This will automate the sending of the account and password information. Select
the system entry from the Dial menu and press the Macros button. Press TAB to highlight the
last line which contains data and append a “\” (backslash) to end of that line. Then press TAB
once more (to advance to a blank line) and type:
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WHile $O { WT 1 } DO "Misc:Answer","[]"

This addition to the logon macro consists of two parts:
• The WHile command waits until the remote system has disconnected.
• The DO command “pulls” the Misc menu down, chooses Answer Phone, presses OK
and waits for the call-back.
Just this much will take care of logging you into your secure system, but macros can do much
more for you in making the work easy and enjoyable. Now that you are able to see how they
work and what they do, you may want to customize your calls even further. Searching data
bases, printing or navigating through the host system are just a few ideas of how macros can
assist and ease some of the more redundant chores. See the Index or the Table of Contents:
Macros for more information regarding macros.

Unattended
Due to its size and complexity, Unattended mode is discussed in a chapter dealing with
incoming calls. See the Index; Unattended.

Macro File
The Macro File command is discussed in the Macros chapter. See the Index or the Table of
Contents: Macros.

Read Globals
The Read Globals command is discussed in the Macros chapter. See the Index or the Table of
Contents: Macros.

Transfer Stats
The Transfer Stats command is discussed in the Send & Receive Menus chapter. See the
Index: Send and its sub-headings, orReceive and its subheadings, or the Table of Contents:
Send & Receive Menus.

Preferences
There are many different parameters, options and default values throughout ProTERM which
influence how it operates. Collectively, these are all referred to aspreferences since they
represent the preferred way in which ProTERM should operate. Some parameters like HotKeys can be changed directly from thePreferences command while others like Screen Saver
timing are changed by other commands. However, regardless of where a parameter is
changed, the Preference command is used to save those changes. When the Preferences
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window is saved, the ProTERM Editor andPrint Parms settings are also saved as the defaults
for the next time ProTERM is started:
• Selecting OK in the Preferences window allows you to exit Preferences without saving
any current changes to disk, but allows these changes to remain in effect during the
current session. When you quit from ProTERM, unsaved changes are lost.
• Pressing the Cancel button or the ESCAPE key cancels any preference changes.
• To revert back to ProTERM as it was before the changes, see Loading and Saving
Preferences.

Loading and Saving Preferences
ProTERM maintains preferences for many different parameters throughout the program.
These preferences can be saved at any time so they become the default values the next time
the software is run. Conversely, the existing preferences can be replaced by those which
were active at the time the software was run. Finally, there is also a way to delete the saved
preferences and return the software to “factory defaults.”

Saving Preferences
When preferences are saved, all preferences (all of the changes which have been made to
ProTERM and not only those in the Preferences window), are saved as currently set. To do
this, choose the Preferences command from the Misc menu and choose the Save button. The
next time ProTERM is run, it will use the same preferences as are currently in effect. The first
time this is done a file named “PT3.PREF” is created. When subsequent preference changes
are save, the “PT3.PREF” file is updated.

Loading Preferences
When ProTERM is run, it loads “PT3.PREF” which contains the preferences as they were last
saved, and uses them to establish the current default values (see Saving Preferences above).
If changes are made to current preferences, but the Save button has not been chosen in the
Preferences window, the preferences can be changed back to the way they were when
ProTERM was run in this session by reloading the saved preferences file. To reload the saved
preferences, choose the Preferences command from the Misc menu and press the Load
button. The preferences will reset to the way they were when ProTERM was started in this
session.

“Factory” Preferences
At some point, the preferences may get changed to the point it is desirable to set them back
to the “factory settings” — the way they were on the original ProTERM diskette. To do so,
delete the file named “PT3.PREF” from the directory containing your ProTERM files and then
Quit and rerun ProTERM. The “PT3.PREF” file can be deleted using the Delete command in
the File menu.
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Changing Preferences
There are three windows of preferences containing more than 40 different options which
can be changed from the Preferences command. Each different preference is listed below
along with a brief description. The main window of preferences can be changed by choosing
the Preferences command from the Misc menu. The additional two screens of preferences
can be changed by pressing the Xfer or Misc buttons in the main preference window.
ProTERM 3.1
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Preferences
Default Pathnames (Must be full pathnames):
Download: /RAM5
Upload:

/HARD1/ DATA

Editor:

/HARD1/TXT.FILES

Autosave:

/HARD2/TEMP

Springback:

Download?

√ Use Mouse?

Upload? √ Editor?

Horizonal Mouse Scale: 2:1

Autosave?

Vertical Mouse Scale: 4:1

Maximum Memory Use 2000 K Continuous Connect Sound: Beep
√

Enable Hot-Keys?
Save

Preset the pathnames you use
most.

Load

Preferences Window

Cache Dialing List? √ Restore /RAM on Exit?
OK

Xfer

More

Cancel

Default Pathnames
Default Pathnames allow preferred directories to be specified for use with different functions
of ProTERM. For example, the Download pathname allows downloaded files to be saved to a
preset directory and all subsequent download operations will default to that directory. All
pathnames must be entered as full pathnames with a leading slash such as /MY.VOLUME/
UTIL.FILES.
NOTE: If a default pathname field is left blank, ProTERM uses the most recently accessed
directory as the default directory.

Do w nload Pathname
The Download pathname selects the default directory in which ProTERM will save files
received when using protocol transfers.

Upload Pathname
The Upload pathname selects the default directory from which ProTERM will send files when
using protocol transfers.

Editor Pathname
The Editor pathname selects the default directory ProTERM will use when loading or saving
text from the Editor or Scrollback.

A utosave Pathname
The Autosave pathname selects the default directory ProTERM will use when saving data
using the Receive ASCII command.

Pathname SpringBack
The SpringBack parameters control whether the Default pathnames are used as temporary or
permanent defaults. When a SpringBack pathname parameter is toggled on, ProTERM will
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“spring back” to the default pathname each time the corresponding command is chosen. For
example, when the Download SpringBack is enabled and a protocol receive function is
chosen, ProTERM first defaults to the Download pathname as set in the preferences window.
If the pathname for the download is changed while setting the parameters for the receive
operation, then when the operation is finished, ProTERM will “SpringBack” to the set
Download pathname. If SpringBack is not enabled and the pathname is changed while
setting the receive parameters, the download pathname takes on the new “changed” value
and will not be changed back to the path specified in the preferences window until ProTERM
is quit and restarted.
NOTE: When SpringBack is not used, previously saved pathnames can be reset to their
defaults using the Load command. See Loading Previously Saved Settings at the beginning of
this chapter.
NOTE: If the corresponding pathname parameter is left blank, the SpringBack parameter has
no effect.

SpringBack: Do w nload?
The Download SpringBack parameter controls whether ProTERM returns (springs-back) to
the set Download pathname when a pathname has been changed during a protocol receive
operation. If this parameter is not selected, the pathname will remain the same as in the last
operation.

SpringBack: Upload?
The Upload SpringBack parameter controls whether ProTERM returns (springs-back) to the
set Upload pathname when a pathname has been changed during a protocol send operation.
If this parameter is not selected, the pathname will remain the same as in the last operation.

SpringBack: Editor?
The Editor SpringBack parameter controls whether ProTERM returns (springs-back) to the
set Editor pathname when a pathname has been changed during a load or save operation. If
this parameter is not selected, the pathname will remain the same as in the last operation.

SpringBack: A utosave?
The Autosave SpringBack parameter controls whether ProTERM returns (springs-back) to the
set Autosave pathname when a pathname has been changed during an ASCII receive
operation. If this parameter is not selected, the pathname will remain the same as in the last
operation.

Use Mouse?
If your system has a mouse but you do not want to use it in ProTERM, deselect this
parameter by removing the checkmark. The mouse will have no effect and the pointer will
not be displayed.
Note: It is difficult for ProTERM to know if the Apple IIc has a mouse or not. In some
circumstances, a mouse may be indicated when even though it is not present. Actions such as
the ProTERM Screen Saver acting as if the mouse pointer was jammed in a corner to always
have the Screen Saver on can occur. If you own an Apple IIc without a mouse, it is advised
the [ √ ] Use Mouse? parameter NOT be checked.
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NOTE: This parameter does not take effect unless the preferences are saved and ProTERM is
quit and restarted.

Horizontal Mouse Scale
This parameter controls the relationship of distance the mouse must be moved as to how far
the pointer moves on the screen. When set 1:1, a short mouse movement moves the pointer
a long distance. When set 8:1, the mouse must be moved farther to move the pointer the
same distance. The default is 2:1.

Vertical Mouse Scale
This parameter controls the relationship of distance the mouse must be moved in order to
move the pointer on the screen. When set 1:1, a short mouse movement moves the pointer a
long distance. When set 8:1, the mouse must be moved farther to move the pointer the same
distance. The default is 4:1.

Maximum Memory Use
This parameter controls the maximum amount of memory ProTERM allocates for its own
use. In most situations it should be set to the amount of memory in the computer (or
higher). This makes all of the computer memory available for use by ProTERM. However,
there are several situations where it is beneficial to restrict ProTERM’s memory use. Users of
Apple Memory Cards can use this parameter to partition memory between the RAM drive and
ProTERM. Apple IIe bank-switched RAM card users can use this parameter to keep ProTERM
away from RAM drive memory in the event the RAM drive software is not recognized by
ProTERM. Apple IIGS GS/OS users may wish to keep a small amount of memory free for use
by Init/DA’s.

Continuous Connect Sound
This parameter selects the alert sound ProTERM makes after making a connection in the
continuous redial mode:
• None No sound on connect.
• Beep
Makes “bell” sounds three times.
• Siren Make a “siren” sound.
The siren is particularly useful if you like to start a continuous redial and then leave the
room because it easily attracts your attention when the connect is made. To stop the siren,
press any key.

Hot-Keys makes
ProTERM FAST!

Enable Hot-Keys?
The Hot-Keys option allows ProTERM commands to be executed with a single keystroke. For
example, pressing COMMAND-“Letter” where letter is the first character of a button name,
the action is immediate at the press of a key without the need to press an additional RETURN
key. This feature makes ProTERM responsive and quick. The single keystrokes allow you to
move through your normal routines quickly.

Alphabetize Files?
When ProTERM displays a file selector, it normally alphabetizes the files. By disabling this
preference, files are listed in the order in which they occur in the directory. Keep in mind
when alphabetization is disabled, partial filename matching is also disabled (that is, when
you type in an incomplete filename, the closest matching filename is no longer selected).
The default is for files to be alphabetized but this can be defeated by using the CONTROL-X
command in file selection windows. CONTROL-X toggles alphabetization on and off.
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Restore /RAM on Exit?
Normally, ProDOS maintains a 64K ram-disk called /RAM on your system. When ProTERM
runs, it disables /RAM because it uses the memory allocated to this ram-disk. When disabled, /
RAM is not restored when ProTERM quits. The only advantage to disabling this option is it
increases the Editor size by 512 bytes.
NOTE: Some applications require /RAM be present when run even though they do not
actually use the RAM-drive. If this option is disabled and such an application is run, it may
make the complaint your computer does not have 128K.

Transfer Preferences
ProTERM contains one entire window of (preferences related to file transfer. To change any
of the transfer preferences, press the Xfer button in the Preferences window, change the
desired preferences and press OK. The individual transfer preferences are discussed in the
Send & Receive Menu chapter. See the Index: Transfer Preferences.

Even more
preferences!

More Preferences
The More Preferences window contains addition ProTERM preferences. To change any of the
preferences in the More Preferences menu, select the More button from the Preferences
menu. After changing the desired preferences, select the OK button to return to the
Preferences menu.
ProTERM 3.1
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More Preferences
√

Display Modem " C O N NECT" Messages?

√ Allow Emulation Printer Access?
Attributes to display in inverse:
Dim √ Reverse

Bold

Underline

Flashing

Allow Editor to Save Ruler?
Pan Editor on Cursor Movement: N one
Replace Editor Selections on Typeover?
Autoclear Scrollback Selections?
OK

Cancel

More Preferences
Window with
Default Values

Display Modem “CONNECT” Messages?
Normally, ProTERM keeps the incoming communication information hidden from the
modem. When this parameter is enabled, ProTERM includes the modem “connect” messages
at the start of a connection. This is useful for users of high-speed modems which return
protocol and error correction information as part of the connect message.

Allow Emulation Printer Access?
Many of the emulations offered by ProTERM include printer support. This means the remote
host can send data directly to your local printer. If you do not want the remote host to have
access to your printer, disable this parameter.
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Check Attributes to Display in inverse
Apple II computers only support normal and inverse (reverse) video, but ProTERM allows
you to specify how special emulation attributes should be displayed. For example, when
ProTERM is emulating a VT-100, the remote host may tell ProTERM to display data in
underline mode. Since the Apple II computer does not support showing underline
characters on the screen, ProTERM must either display the data as normal or inverse text.
The following five parameters allow you to specify how ProTERM will display emulation
attributes.

Bold Video
When a remote host tells ProTERM to display data in bold video, this parameter determines
whether the data is displayed as normal or as inverse.

Dim Video
When a remote host tells ProTERM to display data in dim video, this parameter determines
whether the data is displayed as normal or as inverse.

Reverse Video
When a remote host tells ProTERM to display data in reverse video, this parameter
determines whether the data is displayed as normal or as inverse.

Underline Video
When a remote host tells ProTERM to display data in underline video, this parameter
determines whether the data is displayed as normal or as inverse.

Flashing Video
When a remote host tells ProTERM to display data in flashing video, this parameter
determines whether the data is displayed as normal or as inverse.

Allow Editor To Save Ruler
Pan Editor on Cursor Movement
The ProTERM Editor has the ability to display up to 249 characters on one line by panning
the screen. This preference controls how the Editor acts when the cursor is moved “off of the
screen.” When set to None, the Editor never “pans” (scrolls) automatically. When set to
Horiz, the Editor pans when the cursor is moved horizontally, but not vertically. When set to
All, the Editors pans anytime the cursor is moved off the screen.

Replace Editor Selection on Type-over?
The ProTERM Editor does not have an “undo” command, so selections are not automatically
replaced when a key is pressed. This is simply to avoid the mistake of pressing a key while
text is selected and deleting the data by mistake. When this preference is enabled, ProTERM
will replace a selection of text with a keypress. When the text is deleted in this manner, it is
lost. This a very convenient and powerful editing tool, but it must be used with care.

Auto-Clear Scrollback Selections?
This parameter allows ProTERM to automatically deselect Scrollback selections after a
command is executed. When this parameter is disabled, the Scrollback selection must be
manually deselected by pressing one of the ARROW keys.
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Warranty and Service
APPENDIX A
THIS WARRANTY IS EXPRESSLYIN LIEU OF ANY AND ALL WARRANTIES EXPRESSED OR
IMPLIED. NEITHER INTREC SOFTWARE NOR PROTECH SOFTWARE, INC. MAKE ANY
WARRANTY, EITHER EXPRESSED OR IMPLIED, TOWARDS THIS SOFTWARE, THE ACCOMPANYING MANUAL, QUALITY, PERFORMANCE, OR USEFULNESS TOWARDS AN APPLICATION. THIS SOFTWARE IS PROVIDED IN “AS-IS” CONDITION. NEITHER INTREC SOFTWARE INC. NOR PROTECH SOFTWARE, INC. SHALL BE HELD RESPONSIBLE FOR ANY
DAMAGES OR LOSSES CAUSED BY THE DIRECT OR INDIRECT USE OF THIS PRODUCT.
Every reasonable effort has been made to ensure this software product functions properly
and this software will perform substantially as described in this manual. While we cannot and
will not accept any liability for direct or indirect damages which the user may believe this
software has caused.

Mail your
warranty
card now!

InTrec Software Warranty
and Technical Support
With the change of ProTERM from a commercial product to Freeware status, InTrec is no
longer able to providedirect, one-on-one technical support. Support for this product has
been regulated to the community of users who will benefit from it’s availability. A specific
support forum has been setup at http://16sector.com/forum/ and there will undoubtedly be
other avenues.
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Modems and Cables
APPENDIX B
Getting modems connected and operational is usually easy, because with ProTERM, you can
just choose the modem from the menu. If your modem is not one listed on the Install menu,
hopefully it is designed to be compatible with one of the popular models on the list, and
choosing one of them will work. When the modem does not function as expected, solving
the problem can be a frustrating experience. Many different models of modems are being
sold, and most attempt to be “more or less ‘AT’ compatible.” Add the variables of all of the
different cable styles available and the task can be seems to get more and more complex.
Hardware compatibility is often one of the most difficult and frustrating problems a
computer owner can face. Just because equipment physically connects together, means it
will work — NOT! This Appendix is meant to be a general guide to assist in the installation of
modems and their serial port interfaces as well as a diagnosis and construction guide for the
cables used to link the equipment together. As noted later, cables are very often the center of
the problem and if a “correct cable” is needed to solve the problem, information on where to
acquire ready-made modem cables is at the end of this appendix.

Modem Support
ProTERM supports many different modems directly from itsInstall Modem menu. The
following list gives a brief description of each modem driver and how it works. This
information is somewhat technical and is intended for those who either are using a modem
not directly supported by ProTERM 3 and need technical information, or want in depth
information about the modem driver (the programming code used to instruct modems) they
are using. ProTERM modem drivers are updated on a continuing basis. This list was current
at the time this manual was printed but the information is always changing and up to date
information is available by calling the InTrec BBSystem. See Index:InTrec BBS.
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ProTERM’s
Hardware Support
The Hardware listed here is what has been tested with ProTERM over the years. If you have
something not listed here, you will still be able to use it, in most cases just as it is. Most
hardware is compatible with some of the brands listed here. This section alone is an
incredible asset with regards to getting your modem working with the Apple II and in it’s
day, was well worth the price that ProTERM once sold for, alone.

Modem Drivers
• Apple Modem 300: Same as Hayes Smartmodem 300.
• Apple Modem 1200: Same as Hayes Smartmodem 1200.
• Apple Personal Modem: Same as Hayes Smartmodem 1200.
• AE Datalink 1200 (internal): Same as Hayes Smartmodem 1200 with Apple Super Serial
Card.
• AE Datalink 2400 (internal): Same as Hayes Smartmodem 2400 with Apple Super Serial
Card.
• AE Datalink II Express: Same as Hayes Smartmodem 2400.
• Boca Research 14.4KBPS (RTS/CTS): Same as the Hayes Smartmodem V9600 except
error correction is disabled on low-speed calls using the dial string “ATN0&Q6DT”.
• CTS Fabri-Tek 2424ADH/AMH: Same as Hayes Smartmodem 2400.
• Epic 2400 Classic II: Same as Hayes Smartmodem 2400 with Apple Super Serial Card.
• Epic 2400 Mini: Same as Hayes Smartmodem 2400.
• Epic 2400 PLUS: Same as Hayes Smartmodem 2400.
• Generic 2400 Baud Driver: A special modem driver which attempts to use as few
“modem specific” commands as possible. Only one init string which can be edited by
the user is sent to the modem. The driver does not contain any &-commands (there are
two in the init string, but they can be removed by the user). This driver works with a
wide range of “almost Hayes compatible” modems.
• Generic 9600 Baud Driver: A general 9600 baud driver which does not try to use any
“modem specific” commands. This driver sends the init string at 9600 baud. The
modem dials using a standard ATDT string at the baud rate specified in the system
parameters. The CONNECT string returned by the modem is used to adjust the connect
speed.
• Generic Fixed-Speed (RTS/CTS): A high-speed modem driver for use with modems
which exclusively use speed-buffering (locked serial port rate). This driver sends the init
string at 9600 baud. It sends an ATDT command at whatever speed the dialing
parameters are set for. The resulting CONNECT message is used only to display the
connect rate on the status bar. ProTERM never changes the serial port rate after getting
a CONNECT message.
• Generic MNP3 Driver (RTS/CTS): A high-speed modem driver for use with modems
equipped with MNP and use the \-commands to control operation. In particular, the
modem must support \N and \J to use this driver. Calls placed at 300..2400 have error
correction disabled; calls at 4800..9600 have error correction enabled, but connect at
the “line” rate; calls at 9600+ communicate with the modem at the calling speed
regardless of the actual connect speed. To enable error correction/data compression,
this driver uses the \N3 command.
• Generic MNP6 Driver (RTS/CTS): A high-speed modem driver for use with modems
equipped with MNP and use the \-commands to control operation. In particular, the
modem must support \N and \J to use this driver. Calls placed at 300..2400 have error
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correction disabled; calls at 4800..9600 have error correction enabled, but connect at
the “line” rate; calls at 9600+ communicate with the modem at the calling speed
regardless of the actual connect speed. To enable error correction/data compression,
this driver uses the \N6 command.
• Hayes Personal Modem 1200: Same as the Hayes Smartmodem 1200. This modem has a
cable with a Mini DIN-8 connector which plugs directly into the Apple IIGS. The cable
connects the carrier detect pin of the computer to the ring-indicator of the modem. The
ProTERM Apple IIGS Modem Port driver ignores the status of carrier detect so this is not
a problem.
• Hayes Personal Modem 2400: Same as the Hayes Smartmodem 2400. This modem has a
cable with a Mini DIN-8 connector which plugs directly into the Apple IIGS. The cable
connects the carrier detect pin of the computer to the ring-indicator of the modem. The
Apple IIGS Modem Port driver ignores the status of carrier detect so this is not a
problem.
• Hayes Smartmodem 300: This is just a simple single speed modem driver. The ATDT
command is sent to the modem at 110 or 300 and a CONNECT message tells ProTERM
to go online.
• Hayes Smartmodem 1200: This driver supports both 300 and 1200 baud operation. The
ATDT is sent at the dial speed and the CONNECT message causes the baud rate to be
set to the corresponding value.
• Hayes Smartmodem 2400: This driver supports 300, 1200 and 2400 operation. Calls at
higher than 2400 baud are clamped to 2400 baud. The CONNECT message allows the
call to fallback to a lower baud rate.
• Hayes Smartmodem V9600 (RTS/CTS): A high-speed modem driver for the Hayes Vseries products. This driver requires the use of a hardware handshaking cable. Calls
placed at 300..2400 have error correction disabled and dial using “ATN0&Q0DT”. Calls
at 4800+ have error correction enabled and dial using “ATN1&Q5DT”. With high-speed
calls, this driver allows the modem to use a separate port and carrier rate.
• No Modem in System: Allows ProTERM to be used without a modem.
• Novation Professional 2400: Same as Generic 2400 Baud Driver with a custom init
string.
• Null Modem Driver: Allows ProTERM to be used in a “direct-connect” situation.
• OKIDATA Okitel 9600: Same as Generic 9600 Baud Driver with custom init string.
• OKIDATA Okitel 9600 (RTS/CTS): Same as Generic Fixed-Speed Driver with custom init
string. NOTE: The Okitel 9600 can also be configured as the Generic MNP \N3 Driver
which allows more flexibility in calling.
• Prometheus Promodem 1200: Same as Hayes Smartmodem 1200.
• Prometheus Promodem 1200A: Same as Hayes Smartmodem 1200 with Apple Super
Serial Card.
• Prometheus Promodem 2400A: Same as Hayes Smartmodem 2400 with Apple Super
Serial Card.
• Prometheus Promodem 2400 Mini: Same as Hayes Smartmodem 2400.
• Quality Computers Q-Modem 2400: Same as SupraModem 2400/Hayes Smartmodem
2400.
• SupraFaxModem Plus (RTS/CTS): Same as Hayes Smartmodem V9600.
• SupraFaxModem v32bis (RTS/CTS): Same as Hayes Smartmodem V9600.
Note: Modems with a ROM revision older than 1.2F should get the newer ROMs in order
to correct a problem with carrier detect.
• SupraModem 2400: Same as Hayes Smartmodem 2400.
• SupraModem 2400 Plus: Same as Hayes Smartmodem 2400 with custom init string.
• SupraModem 2400 Plus (RTS/CTS): Same as Generic MNP Modem driver with custom
init string.
• US Robotics Password: Same as Hayes Smartmodem 1200.
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• US Robotics Courier 2400: Same as Generic 2400 with X7 instead of X3 in the init
string.
• USR Courier HST/HST Dual: Same as Generic 9600 Baud Driver with custom init string.
• USR HST/HST Dual (RTS/CTS): A high-speed modem driver for the USR HST products.
This driver requires the use of a hardware handshaking cable. Calls placed at 300..2400
have error correction disabled; calls at 4800..9600 have error correction enabled, but
connect at the “line” rate; calls at 9600+ communicate with the modem at the calling
speed regardless of the actual connect speed. The driver now recognizes the connect
16800 message.
• Zoom/Modem MX 2400R: Same as Hayes Smartmodem 2400.

Init String Warning
While ProTERM allows the modem init string to be changed, it is important to understand
the implications of such changes. In particular, don’t change E0 to E1. Doing so “breaks” the
disconnect detection mechanism. Carrier Detect is always set to &C0 since many serial cards
use it as receiver enable. There is no benefit to setting it to &C1 and will potentially create
problems. Data Terminal Ready is always set to &D0 since the Apple IIGS serial port uses this
same pin for hardware handshaking. When using a serial card which supports separate DTR
and RTS or using a modem which does not require RTS, &D2 can be used. However, there is
no particular benefit to doing so since ProTERM can hangup the modem regardless of how
DTR is set.

DTR is ignored (or
forced high) and
DCD is always high.
NOTE: Some
switches are sliders
& some rockers.

Modem Switches
Most of the modems sold today no longer include dip-switches to select the modem’s
options. Instead, options are selected by the software by sending special (softswitch)
commands to the modem. Some older modems still contain dip-switches however, and if you
are using a modem which does have the “hard switches” and are experiencing problems with
operation, make sure the switches are set for the following options: DTR is ignored (or
forced high) and DCD is always high (“high” or “true” is synonymous with on).

Serial Cards
DB25 and RS232
are used
interchangeably.

Slot 2 is the standard or accepted
conventional
modem slot.

The only serial cards supported by ProTERM are those cards which are compatible with the
Apple Super Serial Card. Most of these cards have two parts which need to be configured:
• A connector or jumper block which specifies whether the card is to be connected to a
modem or printer.
• Switches or jumpers which determine how certain electrical signals and interrupts are
handled.
Serial cards are normally installed in computer slot 2 when being used to communicate with
a modem. When the card is installed, a short “pig-tail” connector (supplied with the card) is
attached to the card. This “adaptor” is generally a short (2 to 6 inch) cable, with a “D shaped”
25 pin connector on one end and a “card-edge” connector on the other. The edge connector
plugs into the card’s matching receptor and the larger end attaches to the computer’s backplane. The cable from the modem, usually a DB-25 (also called an RS232), plugs into this
back plane connector.
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Most serial cards use either a jumper block device, see the Apple Super Serial Card, or dual
connectors, see the Practical Peripherals SeriALL Card and the Applied Engineering Serial Pro
illustrations in this chapter. The jumper block, should be set in the “Modem” position,
pointing upwards (towards the telephone poles) in the case of the Apple Super Serial Card.
If a card has dual edge card pin connectors, the cable should be connected to the connector
labeled “Modem.”

Easy setting to
remember …☞
ALL are UP –except
the first and the
last!

SW1

Apple Super Serial Card
Properly Configured for
Telecommunications Use

SW2

ON
OFF
MODEM

PRINTER

Example Off or
Switches: (Open)

On or
(Closed)

Note: Some serial cards have switches that slide up & down and some have switches that
rock back & forth.

ON
OFF

ON
OFF

Example Off or
Switches: (Open)

Printer

Note the two card
edge connectors.
You want
“ MODEM.”

Some Super Serial Compatible Cards have eight switches per bank instead of seven. In such
cases, the eighth switch on each block is usually not connected. Pretend this switch does not
exist and set the remaining seven switches using the configuration shown above.

Modem

Interrupts MUST be
enabled
(turned on).

Practical Peripherals
SeriALL Card
Properly Configured
for Telecommunications Use

On or
(Closed)

Printer
Modem

Make sure switch 2
on the left switch
bank is in the
closed position.

Example Off or
Switches: (Open)

On or
(Closed)

Applied Engineering
Serial Pro Card
Properly Configured
for Telecommunications Use
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NOTE: The Applied Engineering Serial Pro Card comes shipped with interrupts disabled
which prevents it from operating a modem with ProTERM. Make sure switch 2 on the left
switch bank is in the closed position before using the Serial Pro with ProTERM.

Modem Cables
Cables differ from application to application, and even though the connectors on the cable
ends are the same, and the cable has the exact same external appearance, the internal wiring
can be completely different. The connections between the wires and pins determine how the
cable operates. For more information regarding problems caused by cables, seeIndex:
Unable to Init Modem.
Disclaimer: InTrec Software does not guarantees the accuracy of this information and may
not be held responsible for damage resulting from its use.

DB25 is a “ D ”
shaped connector
with up to 25 pins.
Also called a RS232.

There are many different types of modem cables made for many different applications. The
following information lists three different cable configurations which will connect any Apple
II family computer to a standard DB25 connector (99% of all modems on the market have
this configuration). If you are using a modem which does not have a DB25 connector and an
adaptor cable is not available, contact InTrec Technical Support for more information on
assembly of a cable for that modem. Each cable is specified in terms of a connector at each
end (a diagram of different connector types and pin numbers is shown below) along with
which pins are connected to which.

Note the “ * ”
marking the
essential
connections.

The cable pinouts listed below have all been tested and are known to work. However, they
are not the only cable configurations which will work. However, just because a cable does
not match the pinouts given below does not mean it will not work, many other cable
configurations which may work just as well. All of the pinout configurations here include an
asterisk (*) marking certain connections important to telecommunications. These indicate
connections which MUST be made in order for the cable to operate with a modem. If
ProTERM will not communicate with the modem and the cable does not at least show the
continuity of these connections, then the cable is most probably the source of the problem
(see Cable Diagnosis below and Index: Trouble Shooting). The connections not showing an
asterisk are not necessarily critical to the operation of the modem. However, these other
connections can affect the performance of options such as Hardware Hangup and Hardware
Handshaking. If you have a question about your cable, feel free to call InTrec Technical
Support with the pinout configuration, we may be able to tell you what the cable supports.

Constructing or Checking a Cable
Cable construction requires the two end connectors, a length of multi-wire cable and some
minimal electronic working tools such as solder and a soldering iron or a crimper, pliers, a
screwdriver and wire clippers. Connect the pins listed in the cable chart using the pin
numbering information shown on the connector chart. When you finish, check and recheck
the connections. It is easy to make mistakes in this kind of work. After the cable is constructed, follow the directions under Diagnosing a Cable to verify the cable was put together
correctly — Then check it again.
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9 10 11 12 13

14 15 16 17 18 19 20 21 22 23 24 25

5

1
DB–25 (RS232) Male
13 12 11 10 9 8

7 6

2

5 4 3

2

3

4

1

25 24 23 22 21 20 19 18 17 16 15 14

Din–5 Male
DB–25 (RS232) Female

6 7 8
3 4
1

5

8 7 6
5

5

2

4
2

1 2
6

1

3

4

7 8

5

5

3

2

Din–5 Female

Mini Din–8
Female

Mini Din–8
Male

1
4

3

Diagram of Popular
Connector
Styles Showing Pin
Numbering.

4 3
9 8 7

9

DB–9 Male

2

1
6

DB– Female

NOTE: While many D style connectors have pin numbers molded into the insulation material
at the base of the pins, many MINI DIN-8 and DIN-5 connectors do not or if they do, the
numbering scheme is different than cables used by Apple computers (for the correct pin
number arrangements see the Diagram of Popular Connector Styles below).

Standard Modem Cable
with Hardware Handshaking
From: Serial Port with female DB25 25-pin connector.
To: Modem with female DB25 25-pin connector.
Needed: 2 DB25 Connectors, 8 conductor cable.
Male
DB-25
Pins

Male
DB-25
Pins

2

2

TD*

3

3

RD*

4

4

RTS

5

5

CTS

6

6

DSR

7

7

GND*

8

8

DCD

20

20

DTR

Standard
RS-232
Signal

Standard Modem Cable
with Hardware
Handshaking

Not connected on DB-25 cable ends:
Pins 1,6,9-19,21-25

Apple IIc, Laser 128, Laser 128EX Modem Cable.
From: Internal Modem Port with female DIN-5 connector.
To: Modem with female DB25 25-pin connector.
Needed: 1 Male DIN-5, 1 Male DB25, 5 conductor cable & spare small pieces of wire.

PART FOUR — REFERENCE

284

A P P E N D I X B

Wiring Diagram Definitions
TD
RTS
DSR
DCD

Transmit data.
Ready to send.
Data set ready.
Data carrier Detect.

Male
Din-5
Pins

Male
DB-25
Pins

2

2

TD*

4

3

RD*

3

7

GND*

5

6

DSR

1

RD
CTS
GND
DTR

Receive data.
Clear to send.
Signal ground.
Data terminal ready.

Standard
RS-232
Signal

4

RTS

20

DTR

Apple IIc
Modem Cable

Not connected:
Pins 1,5,8-19,21-25

NOTE: Because of Apple IIc, Laser hardware limitations, true bi-directional flow control
cannot be supported. Connect computer pin 5 to modem pin 6 (DSR) to use RTS-only
(input) flow control. If computer pin 5 to modem pin 5 is connected, ProTERM will perform
pseudo-RTS/CTS flow control within the limitations of the hardware.
* Indicates connections which MUST be made for the cable to operate with a modem. See
Modem Cables in this chapter.

Hi-S peed
“ handshaking ”
cable.

Apple IIGS, IIc+ Modem Cable
with Hardware Handshaking.
Apple
Mac
Signal

Male
Mini Din-8
Pins

Male
DB-25
Pins

Standard
RS-232
Signal
GND*

GND

4

7

RxD+

8

4

RTS

HSKo

1

20

DTR

HSKi

2

5

CTS

TxD-

3

2

TD*

3

RD*

8

DCD*

RxD-

5

TxD+

6

GPi

7

N ot C onnected

Not connected on
Mini Din-8 cable end:
Pin 6

Need a special
telecom cable?
See the end of
this Appendix.

Apple IIGS, IIc+
Modem Cable
with Hardware
Handshaking.

Not connected on
DB-25 cable end:
Pins 1,6,9-19,21-25

NOTE: This cable supports hardware handshaking only on the Apple IIGS. The Apple IIc+
Modem Port has the same limitations as the Apple IIc Modem Port in regards to hardware
handshaking.
NOTE: This cable requires “short circuits” to be placed in the cable. This consists of creating
a “Y” connection between the three pins. On the MINI DIN-8 end, pins 4 and 8 should be
connected to each other as well as to pin 7 of the DB25. On the DB25 end, pins 4 and 20
should be connected to each other as well as to pin 1 of the MINI DIN-8.
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* Indicates connections which MUST be made in order for the cable to operate with a
modem. See Modem Cables earlier in this chapter.

Connecting Two Computers Directly
There are situations where it is often desirable to directly connect two computer modem
ports together for the purpose of sending data back and forth. The device shown below is
commonly referred to as a “null modem adapter.” It has the effect of making previously
incompatible cables compatible. The idea is to setup both computers with modem cables
and then connect the two modem cables together with the Null Modem Adapter. The
adapter can be constructed with either gender connectors on each end. The most common
configuration is Male/Female or Female/Female.
From: Apple Super Serial Card with female DB25 25-pin connector in one computer.
To: to an Apple Super Serial Card with female DB25 25-pin connector in a second
computer..
Needed: 2 Male DB25 connector, 6 conductor cable, small pieces of spare wire.

Standard
RS-232
Signal

DB-25
Pins

DB-25
Pins

2

3

TD

3

2

RD

4

4

RTS & CTS

5

5

”

6

6

DCD, DSR & DTR

”

8

8

20

20

”

7

7

GND

Null Modem
Adaptor

Not connected: Pins 1,9-19,21-25

A cable may
NOT be what it
seems to be!

Troubleshooting & Cable Diagnosis
Cable type is determined by both physical appearance (the type of connectors used on both
ends) and internal wiring (often referred to as the “pinouts”). While the connector types can
be determined from visual inspection, internal wiring is another matter. Unfortunately, a
cable can have exactly the right “look” but not be able to work in the desired capacity.
Cables designed especially for printer use and cables designed for modem use can look
exactly alike externally but are wired differently. One example of physical similarity is a cable
used between the ImageWriter I and a serial card and a cable used to drive a modem with a
serial card. These two cables look identical externally but when you compare the two wiring
diagrams shown in this Appendix, you can easily see that neither cable can replace the other
because they’re wired differently. There are literally hundreds of cable designs and its much
too easy to mix them up if they are judged by physical appearance alone. Unless they are
clearly marked, once they‘re separated from their original packaging, they can only be
distinguished by electrical diagnosis (discussed below).
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More than ninety percent of the phone calls to the InTrec Tech Support department stating
modem initialization failure, occur because the customer has a cable designed to be used
with a printer. In almost every case, the customer doesn’t believe they could have the wrong
cable, because, “The dealer sold me the right one” or the package was marked “modem
cable” meaning it has to be correct. Apparently, unfortunately and seemingly, some dealers
look at a cable’s connectors, and if they match up with the computer and the modem —
“That’s the right cable.” As often happens, after some checking, we often get a call or letter
thanking us for pointing out the problem, verifying that the cable was wrong. We therefore
include the following information on how to electrically diagnose a cable to find its
“pinouts.” See Index: Unable to Init Modem for more details.
Great care is taken to write the following in “layman-speak,” so hopefully you will be able to
easily understand it. The easiest way is to check continuity is to use a device called a
continuity tester such as an Ohm meter or a device with a light or buzzer indicator which
gives notification when the two probes are touched together and complete a circuit (circle of
electricity). “Continuity” means the electricity continues. A continuity tester can be as simple
as a flashlight battery with wires taped to each of a battery's connecting poles and a light or
buzzer in the circuit. When the wires are touched to complete the circuit, the light or noise
indicates the circuit is complete. A continuity tester can be purchased for only a few dollars
from a mass merchandising auto parts store. You can purchase the similar device from
electronics store, but the price is usually higher. Just keep in mind the device you need has
to have a power supply (such as battery) of its own and when you touch the two probes
together, it should light, buzz or swing a needle to indicate continuity.
To use the device, touch one probe to a pin on one end of the cable while touching the
other probe to each pin on the other connector to find the continuity between the pins
(which pins are connected). Note that is not unusual for a single pin on one end to be
connected to more than one pin on the other end, or even the same end (see the cable
diagram for your computer and modem). Make a list of all pins connected to each other.
When complete, this list is called the “pinout” for the cable. You can compare this to see if it
matches (or comes close to) the pinouts listed above. If you find pins seem to be “switched”
(that is, RD goes to TD and TD to RD) you most probably have a printer cable and not a
modem cable. Instead of checking the entire cable, you can generally just check RD and TD
to determine whether it is a modem or printer cable. If RD, TD and GND are connected
correctly, but other pins are not, you can call InTrec Technical Support to find out if it will
work with ProTERM.
NOTE: When finding the pinouts of a cable with DB25 connectors, you only need to check
pins 2 through 8 and 20 since they are the only ones used for serial communication.

Printer Hookup
If your printer is already functioning with other software, don't make any changes. If you are
having trouble getting ProTERM to work with your printer, see Appendix B: Troubleshooting.
If your printer is not attached to your system (or does not work with any of your software),
then read on. The following shows the configuration of an Apple Super Serial Cards for use
with a printer. Try setting the jumper block and switches to the positions shown in the
illustration and then use the appropriate cable shown below.
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Apple Super Serial
Card properly
configured
for Use with a
Printer

On or
(Closed)

NOTE: Some Super Serial Compatible Cards have eight switches per bank instead of seven.
In such cases, the eighth switch on each block is usually not connected. Pretend this switch
does not exist and set the remaining seven switches using the configuration shown above.

Cable Sources
Make sure the supplier understands your needs when you buy a cable. Cables from other
than Apple computer supply sources may not understand what is really needed for the job.
Some cables generically supplied in the market may look right, but are wired differently. If
they tell you they have a cable that “looks right,” try another source.
Correctly wired data cables may be difficult to find, InTrec Software also stocks and sells the
right cable for your communication needs. Call, write or FAX for information on availability
and pricing.
InTrec Software, Inc.
3035 East Topaz Circle
Phoenix, AZ 85028-4423
602/992-5515 – Sales (Voice)
602/992-0232 – FAX
602/992-1345 – Tech Support (Voice)
602/992-9789 – BBSystem
proterm@intrec.com – Internet

Printer Cables
There are many different types of printer cables for many different applications. The
following is a list of cables allowing the Apple Super Serial Card to connect with an Apple
ImageWriter I or ImageWriter II printer.

Apple Super Serial Card to Apple ImageWriter II.
From: Apple Super Serial Card with female DB25 25-pin connector.
To: Apple ImageWriter II with female MINI DIN-8 connector.
Needed: 1 Male DB25, 1 Male MINI DIN-8, 6 conductor cable, small pieces of spare
wire.

PART FOUR — REFERENCE

288

A P P E N D I X B

Male
Mini Din-8
Pins

Printer Cable

Male
DB-25
Pins

3

2

5

3

4

7

8

6

2

8

1

20

Not connected on
Mini Din-8 cable end:
Pins 6 & 7

Apple Super Serial to
Apple ImageWriter II

Not connected on
DB-25 cable end:
Pins 1,4,5,9-19 & 21-25

Apple Super Serial Card to Apple ImageWriter I.
From: Apple Super Serial Card with female DB25 25-pin connector.
To: Apple ImageWriter I with female DB25 25-pin connector.
Needed: 2 DB25 Connectors, cable with 8 wires.

Male
DB-25
Pins

Printer Cable

Male
DB-25
Pins

2

3

3

2

4

5

5

4

6

20

7

7

20

6

Apple Super Serial
to Apple ImageWriter I

Not connected on DB-25 cable ends:
Pins 1,8-19 & 21-25
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Troubleshooting
APPENDIX C
Every attempt has been made to make ProTERM intuitive, easy to use and as dependable as is
possible. However, if a problem is encountered, this Appendix lists some common problems
and solutions. If you are unable to find a solution here, you can call InTrec Technical
Support, see the Index: Technical Support, or you may want to contact your local Apple
Computer user group. See the Index: user groups.

General Startup Problems
ProTERM
won’t boot.

Message: UNABLE TO FIND A ".SYSTEM" FILE
Message: UNABLE TO FIND PRODOS

Rule of thumb:
Never install any
device in slot three.

Certain hardware configurations can prevent ProDOS from booting correctly. For example,
in almost all cases, hardware of any kind should
never be installed in slot 3 because it is
reserved and used by the computer. Devices claiming they can be used in slot three are
probably just tapping power. However if you are having problems, ANY device used in slot
three is highly suspect .

Hardware Troubleshooting
When a hardware problem is suspected, the easiest way to isolate it is to remove any and all
unneeded hardware from the computer. For example, the bare essentials needed to run
ProTERM are the modem and serial card in slot 2 (if needed) and a disk drive in slot 6 or 7. If
you have a hard drive and still have problems, depending on the nature of the problem
(conflicting desk accessories or inits in GS/OS for example) it may be necessary to boot from
a floppy and ProDOS 8 to make sure some unsuspecting CDEV or INIT or hard-drive
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software is not causing the problem. An Apple IIe also requires an 80 column card in the
“AUX SLOT” (slot zero).

Message: “ProTERM cannot run without
a 65C02 Processor.” –or–
Message: “Relocation/Configuration Error”
If you have an Apple IIe and get a message “ProTERM cannot run without a 65C02
Processor” or “Relocation/Configuration Error” when you boot ProTERM, your Apple IIe was
manufactured prior to mid 1980s and has never had an “Apple IIe Enhancement Kit”
installed. Another way to check this is to turn your computer on without putting a disk in the
drive and note the message on the screen. If you see “Apple ][ ” on the screen, the computer
does not have the enhancment chip set. If you see “Apple //e ” on the screen, the machine
does have the enhanced chip set installed. The Enhancement Kit is a set of four chips which
includes a more efficient (65C02) processor, a newer character generator ROM (with
mousetext characters), and firmware ROMs (which allow BASIC to understand lowercase.)
State of the art Apple II software such as ProTERM requires this chip set. The Apple IIe
Enhancement Kit is available from Apple dealers and the large Apple II mail order dealers.
The kit includes an easy to follow set of set of installation instructions. Tools needed: Finger
nail file or small screwdriver to pop the chips up.
The enhancement kit allows the Apple IIe computer to:
• Run state of the art software.
• Efficiently show pull down menus.
• Show icons (pictorial characters such as Open or Closed Apple or file folders).
• Scroll faster with select applications.
• Show smooth-looking character graphics.
• Speed-up select applications.
• Run without having to stop what it is doing and check each device periodically. Devices
can ask for the attention of the computer directly. Software which asks for these
interrupts can run up to 30% faster.
• Boot ProDOS from devices from other than the 5.25” disk drive.
• Understand commands in AppleSoft BASIC which are typed in upper or lower case.
• Have the ability to use a built in mini-assembler for programming.

128K is minimum
but 256K makes
a dramatic
difference in
the operation
of ProTERM.

Message: “ProTERM must have a
minimum of 128K memory.”
An Apple IIe with 128K of memory is not what is being referred to as “enhanced” (see above)
although ProTERM does require a minimum of 128K of memory. If you see the message
“ProTERM must have a minimum of 128K memory” you will need to put at least a 64K
memory card in the Aux-slot (slot 0) of the Apple IIe. The 64K built into the computer plus
the 64K on the card equals 128K. While 128K is the bare minimum required to run ProTERM,
ProTERM can make good use of any additional memory as well. If you need to purchase a
memory card, we strongly recommend getting one which can be expanded to at least 256K.
A 256K memory expansion card will dramatically improve ProTERM’s performance and ease
of use. See the Index: Hardware Requirements.
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Message: “Please insert the program disk…”
A 3.5, /RAM or hard disk is being used and you get the message: “Please insert the program
disk (flip disk) and press RETURN.”
This message is given when the PT3.DIAL directory is missing or incorrectly named. To
correct the problem, either copy the file “PT3.DIAL” from the original disk or create a
directory named “PT3.DIAL.” This directory is where ProTERM stores all of the system entry
files. These files contain the information about the systems you call such as phone numbers,
macros, parameter information. Because of storage space limitations, the PT3.DIAL directory
is on the “Program Disk” or second side of the 5.25" PT3 disk. There is ample room on a
larger disk for all of the PT3 files, consequently when ProTERM gets to the point of loading
this segment and can’t find the PT3.DIAL directory, the first assumption is the 5.25" Program
Disk needs to be put online.

ProTERM Locks-Up or Freezes while
Initializing the Modem.
The cable may not be firmly attached to computer and modem. Double check the cable is
firmly attached and the modem powered on. Reboot the system and try starting up ProTERM
again.
Use a disk utility to delete the file “PT3.BIOS” from the ProTERM disk. After ProTERM is run
again, it will boot into theInstall menu. Reconfigure the software and try again.
If booting from GS/OS, there can be an accessory file (Inits, CDevs and DAs) conflict. Try
booting into GS/OS with the SHIFT key held down to suppress the accessories. It is even
better to turn the machine off and boot directly to a copy of the ProTERM disk. If this cures
the problem, remove the accessories and reinstall them one at a time until the offending
one(s) are found.

Character Loss
If booting from GS/OS, there can be accessory file (Inits, CDevs and DAs) conflict. Try
booting into GS/OS with the SHIFT key held down to suppress the accessories. Actually the
best way to do this is to turn the machine off and boot directly from a copy of the ProTERM
disk. If this cures the problem, remove the accessories and reinstall them one at a time until
the offending one(s) are found. Screen savers and other “time related” accessories are often
the source of the problem.

Isolating
Modem
Problems.

Message: Unable to Initialize Modem
Testing the hardware using the Null Modem Driver can help to isolate the problem. The
following steps will help narrow the problem by connecting the hardware (computer/cable/
modem) directly as a “dumb terminal” which is analogous to being in BASIC.SYSTEM in a
telecom application. When ProTERM is using the Null Modem Driver, the Init: window will
be blank, there is no attempt to do any kind of “modem control.” Instead, all characters
typed at the console will be sent directly to the modem without additional processing or
influence from ProTERM. This “native” mode allows direct control of the hardware.
Effectively, ProTERM is removed from the test, there is no influence from the software other
than to be able to send direct commands from and to the hardware.
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• Choose the Install button from the Modem Failure (ProTERM was unable to init your
modem what would you like to do?) window and ProTERM will enter into theInstall
Hardware mode.
• Choose the Modem button and then instead of choosing your regular modem, choose
Null Modem Driver from the list.
• If you are using a modem attached to the Apple IIGS, IIc or Laser 128 Modem Port,
select the appropriate modem port driver. Otherwise, select the appropriate serial card
for the modem port.
• After installing theNull Modem Driver, choose the OK button and ProTERM will display
the Main Menu.
• Choose the Online menu and then the Parameters command.
• Use the TAB key to move the cursor to Baud Rate the Online Parameters window.
• Using the ARROW keys, set the baud rate at or below the highest supported by your
modem.
• Set the line status to Online and select the OK button. If you have a modem with a baud
rate of less than a 2400 press the caps lock down.
At this point, you will have a blinking cursor and a blank screen. Press the RETURN key 3 or
4 times. The receive and or send lights should both flash. Type “ATZ” and press the RETURN
key, then type “AT&F&W” and press the RETURN key. Type “AT” and press the RETURN key,
you should see “OK” on the screen and the SD and RD lights on the modem (if available)
should flash when the RETURN key is pressed. If you do not get an “OK” message displayed
on your screen, you could have one of the following problems:
NOTE: When your computer is set to null modem, the software is out of the picture and just
the hardware is trying to “talk” to itself. If you don’t get the expected results, the problem is
in the hardware.
By far, the most common problem encountered by first-time users is related to cables which
are either not connected or wired correctly. Unfortunately, it is not possible to determine the
type of cable from external visual inspection. The problem occurs so often because a data
cable, the one needed here is identical, in external appearance, to a printer cable. Internally,
where it really counts, they’re wired differently. If the modem lights do not blink when you
type, and the cable is properly connected and the software is correctly configured, see the
Index: Cable; diagnosis, to learn how to analyze your cable and verify it is correct. If you are
in need of a “correct” data cable for your system, see the Index:Cable; sources.
If the modem SD and RD lights flash but no response is received from the modem, check to
see if the modem has switches. If it does, make sure they are set for DTR override and DCD
override. If your modem can be set with “soft-switches” and can interpret Ampersand
commands, you can also try typing AT&C0&D0&W while in the null modem command state
(see above) which may correct the situation. Note that some modems claiming “Hayes
compatibility” do not have Amper commands.
If the modem SD and RD lights flash but no response is received from the modem (or one
character is displayed after your keys are pressed — and not necessarily corresponding to
the key(s) pressed), check to make sure the modem (if internal) or serial card has interrupts
enabled. This is normally controlled by a switch on the card. See the Index:Serial Card.
So many brands and models of modems are being manufactured today it is difficult to keep
up with all of the features or in some cases, non-features. The standard “flag” you should
look for is Hayes¤ or “AT” compatibility and then hope the modem actually meets those
standards.
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Unable to Connect with
a Remote System
Call the other
modem with your
voice phone.

The connect time may be set too short. Increase the connect time by 10 seconds, call again,
and see if a connection is established with the remote system. Call the host system using the
voice phone and listen to the sequence of events to determine what is happening and how
long the connect takes as you listen. Don’t be afraid to call this way, the only thing can
happen is you will eventually hear the squeal of the modem as it attempts to make the
connection. It will hang up and reset after you hang up your phone.
The baud rate may be set incorrectly. Perhaps the baud rate is set wrong for the system being
called. Always set the baud rate on the high side. ProTERM will step down, but cannot step
higher than it is set or than the modem will allow.

To extend the
“Connect Time”
while waiting to
connect, hold the
OPTION key down.

Maybe you are not calling a modem. Try calling the number with a normal voice telephone
and listen for a modem to answer with its high pitched tones. Check the number of rings. If
more time is needed before the called system answers, increase the Connect Time in the
System Parameters window to a number of seconds that will exceed what the called system
needs. Maybe it does not answer at all. If the line is answered, is it a person or answering
machine or does it send a high pitch tone like a modem does when it answers?
Perhaps the number is not dialing correctly. If you are going through a switchboard or
dialing long distance, you may need to adjust the dialing sequence by adding time between
certain sequences. Do you have to enter a “9” to get an outside line? See the Index: MetaCharacters for more information.

Hanging Up

The Hangup Command Fails
The modem timing may not be exactly what ProTERM expects. Modem timing varies not only
between manufacturers, but even between models of the same manufacturer. If your modem
is not hanging up (terminating) and giving you theMain Menu, at the end of a call, add
“S12=35” to the end of the modem Init: string in the Install window.

Excessive Hangup Delay
There are two techniques used by ProTERM to have the modem hangup. The faster
technique involves using the DTR signal to reset the modem. Check to see if your modem
has dip-switches. If it does, check the modem manual and set DTR Override to Off to speed
up the hangup process.

Failure to Detect Disconnect
When ProTERM gets a “NO CARRIER” message, it performs a check to see if the message was
from the modem or the remote system. If the modem init string has been changed and an E1
or Z or &F is added, the NO CARRIER check incorrectly indicates the message was from the
remote system, not the modem. If Z or &F is added to the init string, it should be followed
by an E0 (E-zero) to avoid this problem.
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File Transfer Problems

High-Speed Zmodem/ASCII Sends Fail
The modem cable may not support hardware handshaking. The Zmodem protocol requires
the use of hardware handshaking when used with a high-speed modem. See the Index: highspeed; cable, for pinouts of cables which support hardware handshaking and can be used
with high-speed modems. Also see the Index: cable; source, for sources of special cables.

Printing Problems

Printer
problems.

The Printer Is Not Printing
The first thing to do is to verify the printer is working correctly with software other than
ProTERM. If the printer is not working with any software, then check the following:
• Power the printer off and back on and try printing again.
• Verify the printer cable is correctly and firmly attached at both ends.
• Will the printer do a self test? See the printer manual.
• Verify the printer is not out of paper.
• Verify the printer error light is not on.
• Verify the printer select light is on.
• Verify any printer A-B switch boxes are set correctly.
If the printer works with other software but not with ProTERM, then check the following:
• Verify ProTERM has been installed for the printer card.
Go into the Install window and verify ProTERM is correctly configured for the printer
interface card being used.
• Try installing the Pascal 1.1.1 Printer Driver.
The Pascal 1.1.1 Printer driver is very versatile and works with many printer interface
cards. If this printer driver fails, try the Generic Printer Driver (below).
• Try installing the Generic Printer Driver.
The Generic Printer Driver is the most versatile printer interface driver which ProTERM
supports. If the printer still fails to function, call InTrec Technical Support for help.

Not sure the printer works at all
• Turn the system off.
• Remove all disks from all drives and turn the system on.
• While holding the CONTROL key down, press and release the RESET key, then release
the CONTROL key. The booting disk drive light should go out.
• Turn the printer on.
• Type PR#1 and press the RETURN key. The printer should make a slight noise as it
“comes to attention” and advances the paper one line.
• Type “PRINT” followed by RETURN.
If the printer prints:
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…the printer card, cable and printer are seemingly working together okay. In this case, the
problem may be the way ProTERM is installed. Go back through the ProTERM installation
procedure again and recheck your configuration. If the printer did not respond, then the
problem is most likely hardware related since the test does not use any software.

The Printer Does Not Advance Paper
If the printer prints on the same line and does not advance paper, your printer needs to be
set to add linefeeds, or Generic Printer Driver w/Line Feeds should be selected. You may also
wish to check your printer interface card manual in reference to line feeds. Any one of the
above can cause the problem.

Printer Double Spaces Between Lines
If the printer double spaces, your printer needs to be set to NOT add linefeeds, or Generic
Printer Driver (without linefeeds) should be selected. You may also wish to check your
printer interface card manual in reference to line feeds. Any one of the above can cause the
problem.

RAM Problems

ProTERM Doesn’t Recognize
RAM Disk Software
RAM Drive Software may not have been installed prior to running ProTERM. When ProTERM
is first run, it will allocate all system memory for its own use. If a RAM Disk Driver is not
present, then ProTERM will assume all memory is available for use. Make sure RAM Drive
Software has been installed prior to running ProTERM to protect your Ram Disk contents.
ProTERM may not recognize the RAM Disk Software. ProTERM has been designed to
recognize and honor the presence of RAM Drive software from Applied Engineering,
Checkmate Technology and Glen Bredon, but there are other versions of RAM software
available which are not as standard. If ProTERM shows more RAM than should be available,
call InTrec Technical Support for information on keeping ProTERM away from your RAM
Disk. Also see the Index: RAM and memory, and their various cub-categories; also see
Preferences: Maximum Memory Use.
NOTE: Whenever ProTERM is run, the small 64K RAM disk which is created by ProDOS will
be destroyed. This memory will be used for Scrollback and the Editor.

ProTERM Is Not Utilizing
RAM Card Memory
ProTERM may not support your RAM card. While it has been designed to take advantage of
the three major styles of RAM Cards (Apple IIGS Memory Expansion, Apple II Bank Switched,
and “Slinky” Ram Cards), there are RAM Cards which use their own access protocol. Contact
InTrec Technical Support for information on the latest RAM Card support.
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If an Apple IIGS is being used, is there a RAM card set aside? ProTERM will not use any RAM
which has already been spoken for.
There may be a problem with the memory on the card. If some of the RAM is bad, ProTERM
may not recognize the memory. Try running the RAM test software supplied with the card.

ProTERM Crashes
Upon Entering Scrollback
Some IIGS RAMcards have jumpers which tell the IIGS how much RAM is on the card. If
these jumpers are set incorrectly to indicate the card contain more memory than it actually
does, ProTERM can crash as it enters Scrollback.
If an expansion RAM Card contains bad RAM, then ProTERM can crash upon entry to
Scrollback. This is because ProTERM stores data in the RAM Card. If that data becomes
corrupted due to bad RAM, ProTERM can crash. Try running the diagnostic software which
came with the RAM card to diagnose problems and identify bad RAM.

General Problems

Garbage
characters
on the screen.

Incoming Data is Garbled
ProTERM defaults to a data format (often referred to as parity) of 8N1 because most systems,
especially those involving Apple computers use a data format of 8 data bits, no parity and 1
stop bit. The computer you are calling may be using 7E1, 7E2, 7O1, 7O2, or 8N2. Double
check the format of the remote computer and change ProTERM to that format if necessary.

Random Garbage Characters
Are Displayed
Just like people, modem’s have individual personalities. When certain modems connect, they
just don’t like to talk to each other and they generate a lot of garbage characters. The way to
identify this phenomenon is to see if the garbage characters are confined to the use of a
particular system. If they are, then very little can be done to correct the problem.
The ability of a modem to transfer data without errors is partially dependent upon the
quality of the phone line on which it is operating. Phone lines which experience frequent
“pop” or “hiss” noises are guaranteed to generate a lot of garbage characters. Try using a
regular voice phone call to “sample” the line. Try some voice calls on the same line and listen
carefully for transient noise. Sometimes it only happens on certain calls and hanging up and
calling again solves the problem. See Line Noise below.
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Line Noise
Line noise is often heard as clicks or slight hisses during a voice phone call but is displayed
by ProTERM as something like “}g}b}}” and can be one of the most annoying and
frustrating aspects of telecommunications. These bursts often contain the curly bracket
character “}” and seemingly come from nowhere. Line noise can often be confusing and is
sometimes severe enough to terminate a call. Because it is difficult to establish which end of
the connection the line noise is being generated on (sometimes just your computer
experiences the noise and other times both you and the remote host experience it), trying to
edit out or work online with line noise can be almost impossible.
Before you spend any real effort or money to find the problem, make sure the problem is not
a result of natural causes such as wet phone lines, electrical storms or sunspots. Evaluate the
problem over a period of at least a week to see if it is connected to some natural phenomenon.
The first thing to establish is if your line noise problem is actually related to your local phone
service. If you only encounter line noise when calling particular systems, then the problem is
most probably on the other end of the call. In such cases, there is nothing which can be
done locally to correct the situation. However, if you seem to get line noise regardless of
which system you call, it is most probably a problem on your end. When you make local
voice calls, listen carefully to your phone for any unusual noise. If you can hear static,
hissing, buzzing or clicking noises on the phone, there is a good chance these are what you
are seeing on your monitor. If you do not hear anything suspicious, try borrowing a different
modem from a friend. If a different modem does not demonstrate line noise problems,
chances are the problem is with your modem. Check all other possibilities before assuming
the phone lines are the problem. Trying to track down a nonexistent phone line problem
can be very difficult.
Once you have established you are experiencing a problem with your phone lines, you must
decide how to solve the problem. It is important to understand the phone company
maintains phone line quality up to your house at no extra charge. However, problems within
your house are not the responsibility of the phone company unless you subscribe to an
optional “wire maintenance plan.” This is a monthly service sold by the phone company in
which they will take care of any needed maintenance or repair with the phone wiring within
your house. If you believe you have a problem with your phone wiring and you have such a
plan, it is best to call the phone company and let them find the problem. After all, that is the
point of the service.
If you do not subscribe to a wire maintenance plan, you must determine where the source of
the line noise problem lies. If you call the phone company to complain of poor phone
quality, and the problem is found to be within your house phone wiring, you may have to
pay the phone company an extra service charge for the call. The following guide should help
you determine whether the problem is inside or outside of your house. If it is inside, we
outline procedures for correcting many common problems.
Line noise can be caused by something as simple as a loose connection or oxidation at wire
terminals (such as the connecting screws in the phone jack wall interface.) Bad connections
like this increase the resistance making it more difficult for the needed signal to get through
the line. Over a period of time, connections can oxidize and even corrode if the area is
damp, especially at the junction of two dissimilar metals such as copper wire and steel
screws. Sometimes noise can be lessoned or even eliminated by removing the wall jack cover
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and loosening and retightening the wire connectors. If there seems to be a question about
the connectors being oxidized, some cleaning or scraping, or in extreme cases replacement
of the wall jack interface may be needed to correct the problem.
Your modem is probably not connected to the only phone jack in your house. Keep in mind
anywhere the phone wires are connected to a phone jack, there could be a problem. This
condition may be even worsened if your computer is “downline” from the problem (the
phone line comes into the house and joins a connector which has developed problems and
from there continues to your modem phone jack.) If any of your phone jacks have problems,
regardless of their location, they may contribute to the problem.
Unless you’re leasing your phones, the phone company does not own the phones in your
house. What this means is phone maintenance is your responsibility. Since most people
don’t spend money to keep phones in perfect condition, it is possible they may experience
problems over time and become the cause of line noise problems. Disconnect any phones
not needed while tracking down the source of the problem. Once you have the problem
isolated, you can get your phone system back to normal.
Unplug a voice phone set and take it outside to the box where your phone line comes to
your house. The various phone companies are trying to establish a convention of having the
wire pair from the phone company end in a box with a female modular phone jack. This box
is mounted on the outside of the house as an interface between the phone company’s
incoming wires and your house phone wiring. Therefore, the house wiring can be disconnected by unplugging this male jack. With the house wiring disconnected, plug a voice
phone directly into this female jack or if you prefer, get a phone extension wire long enough
to reach from this junction box to where you use your phone or computer.
After connecting up to the outside jack, see if you still experience the same line noise
symptoms. If the line noise is gone, it’s a pretty safe bet the problem is in the house wiring. If
the noise is still present, you may want to call the phone company service department and
inform them of your findings and how you arrived at your conclusions. Let them know you
believe the problem is before the phone line gets to your house. If you have done your
homework as noted above, you have some pretty conclusive evidence.
When individuals do their own phone wiring, they often neglect to check the polarity of the
wires when hooking up phone jacks. Standard house phones use two wires called “tip” and
“ring.” While it may not seem to make any different which wire is which, it actually does. By
switching tip and ring differently at different phones, it is possible to cause an audible hum
on the phone line. While this doesn’t normally degrade the quality of the phone line, it
seems it may make a modem more susceptible to line noise.
If you want to make sure your phone wires are not switched, you can get a phone line
indicator device from many hardware stores or Radio Shack™ for less than $10. Just plug
this device into the wall phone jack or extension cord in question. It will show red if the
wires connected to the jack are reversed and green if they are correct. If the wires are
reversed, you can take the phone jack apart and correct the wiring.
If you make up your own phone extension cords or repair them, note one side of the flat
phone “modular-type” or “base cord” wire has a marker or “runner” on one side of it. Make
sure this marker goes into each of the two modular phone jacks the same. If it goes into one
with the marker on the clip side, then it must do the same on the other end or the pair will
be twisted as noted above. It will still work, but may cause a quality deterioration in some
situations and in telecommunications, we need all the help we can get.
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NOTE: Phone extension cords are often called “base cords” and are available in 6 to 100 foot
lengths and can even be joined with modular female connectors to attain additional length.

A Point of Interest in Phone Wire and Wiring
We want to thank the US West Phone Company for their assistance, direction and patience
during our investigation of line noise and phone wiring. There is no need to feel secretive
about hooking up your phones or modems. In general, the phone companies have agreed
upon standards for home and small business phone wiring and are in the process of
adapting to and making these standards available to the public.
The standard for internal wiring has recently changed. The phone company is now
recommending internal wiring of either three or six pair twisted wire. Each wire pair is
twisted and then all pairs are twisted. Strip a piece of the wire back and examine how the
wires are arranged relative to pairs and groups of pairs. The significant difference here is
control or dampening of external interference. This wire has just recently become available
but not too difficult to find. Check local electronic supply companies, many of them stock
this wire in bulk. If you have additional questions, contact InTrec Technical Support and/or
your local phone company.
Do all of the checking possible before you call the phone company. Because noise problems
can be random and evasive, achieving noise free lines could include more than one visit from
the phone company. It could be expensive if the problem is in the house, and you are unable
to locate it yourself. As noted earlier, unless you have a wire maintenance plan, wiring repair
within your house is not a free service. It is not uncommon for the phone company to charge
a fifty dollar minimum which usually covers the first half hour. Another alternative is to hire
an independent contractor or home repair expert to assist in resolving the problem if you
think it is in your house wiring.
If the phone company tells you, “We only guarantee voice quality lines, not data transmission
integrity,” you may want to consider the following: 1200 and 2400 BPS modems are
designed for use with normal voice quality phone lines. Telecomputing from home is not
special; it is commonplace. It represents a service no different than normal pickup and
delivery service by the various package carriers. Don’t let the phone company try to convince
you a modem is a “business” item. Kids doing homework via online encyclopedias, families
accessing the local library card catalogs, at home banking, shopping, and personal stock
brokering, even FAX machines all represent legitimate “personal” telecommunication
applications. Telecommunications is no longer the exception, it’s the rule.

Minimum Line Testing Requirements
as Set by the FCC
The FCC imposes certain minimum standards on the phone company to maintain a certain
level of quality in their lines. Lines not meeting these standards can be a source of considerable difficulty in the transfer of data between computers. A noisy line can even make it
difficult to make the “handshake” connect with a host.
When a customer complains to the phone company about line noise, the local phone service
may offer to sell a service known as “line conditioning.” The idea behind this service is, the
phone company will regularly “balance” and correct line problems and keep the standards of
the phone line above what is required for normal voice quality. However, 2400 BPS (and
many higher speed modems as well) are designed for use with “normal” voice quality phone
lines. If your phone lines meet the minimum voice quality requirements as set forth by the
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FCC, there should be no reason why your modem should experience excessive line noise.
Keep in mind “line conditioning” is different from a “dedicated line.” Line conditioning
involves improving the quality of your existing phone line while a dedicated line is a separate
additional phone line usually for a distinct purpose.

Other Problems & Solutions
User groups offer excellent local support and current information on services such as local
BBServices. Most Apple user groups even offer personal assistance and training on a wide
variety of computer related questions, including telecommunications and especially
ProTERM. To locate the Apple computer user group nearest you, call 1/800-538-9696 Ext.
500. For other user group references in this manual, see the Index: user groups.
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ASCII Character Chart
APPENDIX D
ASCII (American StandardCode for Information Interchange, pronounced “AS-KEE”) — A
standard 7-bit-plus-parity binary code set used to establish compatibility among data services.
The following ASCII character chart shows the decimal and hexadecimal values for all 128
ASCII characters: 96 printable (text) characters and 32 non-printable (control) characters. To
compute a “high-bit” ASCII value, add 128 to a decimal value or $80 to a hexadecimal value.

Caret Prefix Notation
To enter one of the 32 Control Characters (ASCII characters 0 though 31 as well as the
DELETE character 127) as parameters, ProTERM uses a convention calledcaret prefix
notation. This is a method of notating (writing) text in which the caret “^” character is used
to represent a control character through its association or influence of the character
immediately adjacent to it. Control characters always require a two-character sequence, the
caret character and the influenced character. For example, a RETURN character
CONTROL-M,
is represented as “^M” (CARET-M). To find the prefix notation for a needed control
character, locate the character in theASCII Character Chart and look under the column
labeled Prefix. To insert a normal (non-influencing) caret character that is not a “controlnotation,” use “^” (CARET followed by SPACE). This differentiates between the caret
acting as a control character prefix and the caret representing itself. For example, the string
“^GREG” is evaluated as “CONTROL-G” R E G while “^GREG” is evaluated as,
“CARETGREG.”
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ASCII Character Chart
ASCII Character List 00-63
DEC

HEX

CHAR

Key

Prefix

DEC

HEX

CHAR

Key

Prefix

00
01
02
03
04
05
06
07
08
09
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31

00
01
02
03
04
05
06
07
08
09
0A
0B
0C
0D
0E
0F
10
11
12
13
14
15
16
17
18
19
1A
1B
1C
1D
1E
1F

NULL
SOH
STX
ETX
ET
ENQ
ACK
BEL
BS
HT
LF
VT
FF
CR
SO
SI
DLE
DC1
DC2
DC3
DC4
NAK
SYN
ETB
CAN
EM
SUB
ESC
FS
GS
RS
US

Ctrl-@
Ctrl-A
Ctrl-B
Ctrl-C
Ctrl-D
Ctrl-E
Ctrl-F
Ctrl-G
Ctrl-H
Ctrl-I
Ctrl-J
Ctrl-K
Ctrl-L
RETURN
Ctrl-N
Ctrl-O
Ctrl-P
Ctrl-Q
Ctrl-R
Ctrl-S
Ctrl-T
Ctrl-U
Ctrl-V
Ctrl-W
Ctrl-X
Ctrl-Y
Ctrl-Z
Ctrl-[
Ctrl-\
Ctrl-]
Ctrl-^
Ctrl-_

^@
^A
^B
^C
^D
^E
^F
^G
^H
^I
^J
^K
^L
^M
^N
^O
^P
^Q
^R
^S
^T
^U
^V
^W
^X
^Y
^Z
^[
^\
^]
^^
^_

32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63

20
21
22
23
24
25
26
27
28
29
2A
2B
2C
2D
2E
2F
30
31
32
33
34
35
36
37
38
39
3A
3B
3C
3D
3E
3F

!
"
#
$
%
&
'
(
)
*
+
,
.
/
0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?

SPACE
!
"
#
$
%
&
'
(
)
*
+
,
.
/
0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?

SPACE
!
"
#
$
%
&
'
(
)
*
+
,
.
/
0
1
2
3
4
5
6
7
8
9
:
;
<
=
>
?
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ASCII Character List 64-127
DEC
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95

HEX CHAR
40
41
42
43
44
45
46
47
48
49
4A
4B
4C
4D
4E
4F
50
51
52
53
54
55
56
57
58
59
5A
5B
5C
5D
5E
5F

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^
_

Key

Prefix

DEC

HEX

CHAR

Key

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^
_

@
A
B
C
D
E
F
G
H
I
J
K
L
M
N
O
P
Q
R
S
T
U
V
W
X
Y
Z
[
\
]
^SPACE
_

96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
121
122
123
124
125
126
127

60
61
62
63
64
65
66
67
68
69
6A
6B
6C
6D
6E
6F
70
71
72
73
74
75
76
77
78
79
7A
7B
7C
7D
7E
7F

`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
{
|
}
~
DEL

`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
{
|
}
~
DELETE

Prefix
`
a
b
c
d
e
f
g
h
i
j
k
l
m
n
o
p
q
r
s
t
u
v
w
x
y
z
{
|
}
~
^?
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Using ProDOS
APPENDIX E
ProTERM’s design takes full advantage of Apple’s ProDOS Operating System. All ProDOS 8
storage devices are supported, along with the hierarchical directory structure. ProTERM
additionally supports the navigation concept of using a “parent directory” as well as “slot and
drive naming.” These conventions are not normally a part of standard ProDOS, but make
using it much easier. Additional information on ProDOS is available in the Apple
ProDOS
User’s Manual published by Apple Computer.

About ProDOS
The syntax of
filenames and
structure of directories is controlled
by ProDOS not by
ProTERM.

ProDOS (an acronym made from the wordsPro+Disk Operation System) is the name of the
operating system developed by Apple Computer to support the Apple II family of computers.
An operating system is a special program used to start the computer, and as ProDOS loads, it
gives the computer instructions on how to operate and use other software such as ProTERM.
Apple’s ProDOS operating system provides a uniform interface between applications
(ProTERM is an example of an application) and storage devices such as floppy, RAM and hard
disks used with those applications. Whenever ProTERM requires any type of disk access, the
instructions are actually given to ProDOS and it performs the appropriate action to read and/
or write from a storage device. The syntax (method of filename and pathname arrangement)
of communicating filenames and the structure of directories is controlled by ProDOS not by
ProTERM.

Directory
What is a
formatted disk?

When a volume, also referred to as a disk or device, is first formatted, it is given a name and a
file directory. This directory is referred to as the volume or root directory and anything saved
on that volume has an address in, and is accessed through that directory. An analogy to
formatting a disk would be to think of a vacant piece of land where a contractor plans to
build an apartment complex with a central mail box. He grades or levels the land, surveys the
site, determines the exact size, establishes roads and walks, and makes arrangements for
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each blocked off area to have an address. Think of the entire complex as a disk volume. The
root directory could be thought of as the central mail boxes of the apartment complex. Think
of each of the apartment buildings as a folder or directory (also called subdirectories) in this
analogy. Each apartment is given a name, and several families (think of them as files) are in
each apartment. The centrally located mailbox contains the address locations (directory) for
each apartment building and each family. When folks move in, the information is changed on
the central directory, just as when a file is saved to disk, and the root directory contains the
name, file type and address of that file. When apartments become vacant (files are erased),
they make space available and the root directory contains all of that information and record
activity.

Directory,
subdirectory and
folder are synonymous.
A PTD. filename file
is a ProTERM Dial
File.

Directories as Folders
Directory is a name synonymously used as folder such as you are use to seeing in a file
drawer system. Directories provide a way to keep related files together, just as a folder does
in a file drawer. With other files in their respective folders, the files can all be together on
one disk, but still be separated from non-related files. Any directory visible by cataloging a
disk’s “root directory” is referred to as adirectory. If Catalog is chosen from the File menu, a
list of files is seen and this list is referred to as a file catalog. If the ProTERM disk /PT3 is
cataloged, the files which make ProTERM run are shown. One of the files is a directory
named PT3.DIAL, and it contains the phone numbers and macros for each of the remote host
systems you call. While looking at the catalog of PT3, if the PT3.DIAL directory is highlighted
the RETURN key pressed, this directory will be opened revealing a group of ProTERM Dial
Files you have hopefully created by now. Each file has a “PTD.” prefix. If you had created a
host system entry for the InTrec BBS, it would appear as in the PT3.DIAL directory as
“PTD.INTREC” (or whatever name you gave the InTrec file, would be appended to “PT3.”).

Subdirectories
As noted above, a directory within a directory is sometimes referred to as a subdirectory, but
this name is not as popular as it was in the past, and is not often used. A directory within a
directory is more commonly referred to as just a directory. Placing directories within
directories does not change them in any way, it just allows files to be grouped logically
forming a hierarchy and finer division.

ProDOS Filenames
A ProDOS file can have a filename from one to fifteen characters. Short ProDOS filenames are
recommended simply because they are easier to remember and less likely to have mistakes
when typed. Four letter words make good ProDOS names. They are long enough to be
meaningful and short enough to type quickly with fewer mistakes. ProDOS filenames must
start with an alphabetical character. After the first character, alpha letters, numbers and
periods are allowed, but other symbol characters such as SPACE, COMMA, HYPHEN or PLUS
etc. are not permitted. Although the ProDOS operating system is not case sensitive and files
are normally displayed in UPPER case, filenames can be referenced in either upper or lower
case. If an invalid character is entered as part of the filename, ProTERM will truncate (end)
the name at the first non-valid filename character.
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ProDOS Name Examples:
/MY.DISK.12
/PROTERM/DATA2

Periods work well as spaces.
Showing subdirectory.

Examples of illegal ProD OS names:
/1MORE.DISK
Name must start with alpha character.
/MY DISK
Name cannot contain spaces.
/DATA,DISK’S:
Only periods are allowed for punctuation or delineation.
/DATA.DISK.FOR.PROTERM
Only 15 characters allowed.
ProDOS, like most other contemporary operating systems, supports a hierarchical (also
referred to as a “tree” or “branching”) type of directory structure. Theroot directory is a list
of the files seen when a disk is catalogued or listed. A root directory is the file directory put
on the volume when it is formatted. A freshly formatted disk does not show any files of
course because none exist in its new directory, but the empty catalog can be viewed. A root
directory is the base or starting point of every disk. As files and directories are added, they
are all listed in the root directory. When a new directory (folder) is created in the root
directory, files can also be placed in this “second” level. A new directory can be created
within this new directory and it would be considered a third level and so on.
The root directory for a volume can be found by cataloging the different storage devices
available to your computer (online) which would include any floppy disk drive, RAM-disk,
hard drive, etc.). Select the volume and show the files contained on the volume.
To summarize, each storage device can contain both files and directories (subdirectories)
which in turn contain other files and other directories. Because ProDOS is hierarchical (tree
or storage cabinet like), a storage device can contain multiple identically named files as long
as each of these files are in different directories. The convention of organizing the directories
and files, starts at the root (main) directory, files and directory names are written in a “string”
referred to as a pathname.

A slash is used as a
separator.

A directory name is
often shown with a
leading slash, such
as /PT3.

A full pathname would indicate the name and location of a file starting from the “root” of the
file system. It begins with a slash followed by a volume name, the name of the file or
directories leading to the file. The forward slash /() is used as a delimiter to separate the
volume, directory and filenames. For example:
/MY.VOLUME/LETTERS/PERS.LETTERS/MOMS.LETTER
…would reference a file called /MOMS.LETTER which is in /PERS.LETTERS which is itself in /
LETTERS which is located on a storage volume (device or disk) called /MY.VOLUME. (The
slash marks (/) are element separators (dividers) and are referred to as delineators or
delimiters. Only the /SLASH is used and never the \BACKSLASH. When a slash is included as a
filename, such as /MY.VOLUME that file is usually assumed to be a directory.

Understanding Pathnames by Example
A pathname can be thought of in terms of an electronic file cabinet or a road map which
provides directions to ProDOS to locate a file. Just as a map provides a list of street names to
take you from one place to another, a pathname provides navigational information to find
files within your computer system. A pathname always begins with the name of the storage
media device (a floppy disk, RAM-disk or hard drive) because ProDOS knows where to find
these devices. A pathname can only include one volume at a time, it can never address two
different device or drives. In addition, every volume online (available to be cataloged), must
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Files, Folders and Volumes

/C O C KA TIELS

60 Meg Hard Drive
/HA RD1

30 Meg
Partition

/FA N C Y

/FA MILY.FILES
/EXPEN SE

/A DDRESS.LISTS

Files in a
Subdirec tory

/BIRDS
/DO MESTIC

/W ILD.BIRDS

/HA RD2

/G A MES

/DO VES
/FIN C HES

/C A G ED.BIRDS

30 Meg
Partition

Volumes (drives)
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have a unique name, because ProDOS cannot deal with duplicate volume names or duplicate
filenames in the same directory.

A pathname can be
compared to a
road-map.

ProDOS cannot locate duplicate volumes. Beyond the volume name, the individual
components of the pathname act much like street names so ProDOS can navigate the
directories and find your file. Consider the pathname:
/HOME/MY.ROAD/I.15.FWY/BASE.STREET/SIDE.AVE/DESTINATION

Saving a file to a
directory is like
putting it in a
folder.

Following this analogy of a map, to get from one place to another, certain streets are
followed. If an outline were written on how to follow this “path,” each new direction would
probably be written on a new line for clarity. ProDOS pathnames must be on the same line
and each new direction is separated using a forward slash for a delimiter. The number of
characters in a complete pathname cannot exceed 64.
In the context of a map, this can be read as follows: start atHOME, take MY.ROAD to
I.15FWY, take I.15FWY to BASE.STREET and takeBASE.STREET to SIDE.AVE where DESTINATION is the location (where you are trying to go). In terms of ProDOS this reads, start at
device HOME, find directory MY.ROAD, within MY.ROAD find directory I.15FWY, within
I.15FWY find directory BASE.STREET, within BASE.STREET find directory SIDE.AVE and within
SIDE.AVE locate the file named DESTINATION (the file you want).
Different points of view give better perspective of a model. The following is a different way to
look at the same problem:

The similarities of a
file drawer system
is a good comparison a hierarchal
system such as the
ProDOS operating
system.

Computer storage devices can also be thought of as electronic file cabinets where the
individual drawers represent entries in the main directory and folders within the drawers are
directories (directories inside of directories). Just like a file cabinet, it is also possible and
desirable to put folders inside of folders. ProDOS has a limitation that must be watched,
particularly on large disks. The main ProDOS storage device (root) directory, has a maximum
limitation of 51 entries files or directories. However, other than the limitation of disk size
and within practical reason, there is no limit imposed on the number of files or subdirectories which can be stored in a sub-directory (folder). Don't confuse file size versus disk
storage size and number of directories allowed in a root directory. One large file could fill a
disk’s storage capacity but the root directory only has space for the quantity of 51 entries
(files or directories), without regard of their size.

When a disk is
formatted, a directory is also created
to store and record
filenames.

Using the analogy shown below, the catalog of a root directory is like a listing of the file
drawers on the in a file cabinet. The cabinet is a volume and each drawer would be
considered directory in that volume. Looking inside of a drawer could reveal files and other
folders (sub-directories). As noted above, once inside a directory or sub-directory, the
problem of how many files can be stored no longer exists. Hundreds of files can be put into
a directory (the drawer in our analogy) or subdirectories (folders nested inside of another).
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/BIRDS

FILE CABINET OR DISK/VOL NAME

/DOMESTIC.BIRDS
/CHICKENS

DIRECTORY (DRAWER1)

DIRECTORY
/CHIC.VARIETIES
/WILD.BIRDS
DIRECTORY (DRAWER2)
MOCKINGBIRDS
/DOVES
WHITE.WING
INCA
/WRENS
CACTUS
/CAGED.BIRDS
FINCHES
DOVES
/COCKATIELS DIRECTORY/FOLDER
COMMON
FANCY

DIRECTORY
FILE
DIRECTORY/FOLDER
FILE
FILE
DIRECTORY/FOLDER
FILE
DIRECTORY (DRAWER3)
FILE
FILE
FILE
FILE

An Example ProDOS Volume
The above example shows the directory structure of a ProDOS disk and represents the
contents of a single electronic file cabinet. To find the file:
/BIRDS/CAGED.BIRDS/COCKATIELS/FANCY”
(Volume)
(Directory)
(Directory)
(File)
ProDOS would locate the storage device (file cabinet) BIRDS, locate the directory (drawer)
CAGED.BIRDS, locate the sub-directory (folder) COCKATIELS and locate the file FANCY.

Selecting
“<Parent>”
always searches
upwards.

Selecting the file
type “ DIR” always
searches downwards (opening the
chosen the directory).

The Current Directory
ProTERM allows the use of partial pathnames as well as full pathnames as noted earlier in
this chapter.
When using a command on a file requiring action (opening sending, etc.), ProTERM always
references the most recently used directory, the “current directory” first. This is true unless
Springback is set to on in the Preferences window, and then the reference always springs
back to the directory as set up in the Preference window. For details on these features, see
the Index: Preference and or Springback.
The current directory is always the starting reference when moving up or down from the
current directory.
When referencing files within the current directory, the current directory is already a part of
the pathname. That is, if the filename or part of the filename is typed without any leading
information such as a slash or other part of a pathname, this references the file within the
current directory. To move up and out of the directory, select ..<Parent> and ProTERM will
move upwards to the next highest directory level. To move down from the current directory
into, or opening a directory within the current selected directory, select a file showing the
file type “DIR” and press the RETURN key. When a file or a directory is selected, the default
choice becomes “<Select Dir>.” That is, pressing the RETURN key chooses and opens
(selects) the “current file or directory.”
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When moving down in a directory (adding the next lower subdirectory to the pathname), the
slash is not used. Typing the name of the directory without a leading slash “attaches” that
directory to the pathname. A name with a leading slash causes the file selection process to
look up and out of the current directory for another directory with thename
/
just typed. A
filename without a leading slash causes ProTERM to look in the current directory. In other
words, typing a name without a slash, is either requesting access to a file, or a directory
within the current directory. The easy alternative is to choose the file or directory from the
file selection list.

<..Parent Directory>
The current directory of files is the list of files and directories currently inside of the current
parent directory. ProTERM shows the current files in the current “..<Parent> Dir.” and
Choosing ..<Parent> Dir causes ProTERM to search upward for a new parent directory.
Choosing parent directory again will cause the search to go higher and higher until the final
level or root directory of the volume is reached, and then ProTERM will go to the final level,
and poll (look for) all available devices (disks or volumes) online (available to your
computer). The list will be displayed, and at that point you can choose the volume you want
from the list. You can then choose “Select” to open the volume. If you choose to change the
disk in the drive and want to poll the drives again, choose ..<Parent> or just type a single
slash and press the RETURN key, this is the same as choosing ..<Parent> until all root
directories were cataloged.

Moving Through Pathnames
Fast and Easy
ProTERM introduces three naming concepts not normally found in ProDOS:
1. Reference a parent directory by entering two periods in a row (..) in the file
selection window. Entering the two periods and pressing the RETURN key instructs
ProTERM to seek the Parent Directory. Choosing “Parent” always searches to the
next higher level. This procedure is common in other operating systems. As an
example of how this works, press COMMAND-F, press the “C” key to choose Catalog
and press the RETURN key. The default choice is “<Select Dir>” and pressing the
RETURN key would catalog the current directory. However, if two periods were
typed and the RETURN key pressed, ProTERM searches upward to the next higher
directory. Continuing this would cause ProTERM to search higher until the highest
level of the volume is reached and then all available drives would be polled. This can
be carried further, if you were deeper in a directory and wanted to move up two
levels of directories, two periods a forward slash and two more periods (../..) would
cause ProTERM to search two levels higher. For each two periods and slash entered,
the upward search level is increased by one level.

Parent
Directory is any
directory
directly above a
subordinate directory.

2. Move to the highest level and poll all drives online by entering a lone forward slash
“/” in the Text Selection window and press the RETURN key.
3. Allow a storage device to be referenced by its Slot/Drive location (“/S,D” whereS is
the Slot number and D is the Drive number) will reference the device connected at
that location. To accessslot six, drive one, “/6,1” is entered in the filename text box.
That drive will accessed and the volume in that drive will be listed by name.
Combining the functions of ProDOS and ProTERM provides many different ways to
reference a file. The following is an example file system.
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Entering “/” as a
filename shows the
names of all online
drives.

Either of the following pathnames could be used (are legal) to access a volume named /
BIRDS used in slot seven.
/BIRDS/CAGED.BIRDS/FINCHES
/7,1/CAGED.BIRDS/FINCHES
This example shows a directory with three subdirectories:
/BIRDS/CAGED.BIRDS
/DOMESTIC.BIRDS/CHICKENS
/WILD.BIRDS/MOCKINGBIRDS
Assume we are in the subdirectory /CAGED.BIRDS and want to move to the subdirectory /
MOCKINGBIRDS. Entering the notation of two periods would raise us to the level of the /
BIRDS parent directory and then entering a slash and the pathname, it would look like this:
../WILD.BIRDS/MOCKINGBIRDS
…and would take us up one and down two levels to /MOCKINGBIRDS.

Moving up, down
and laterally within
directories.

ProTERM 3.1

5.25K Edit

12.50 Sbk

2400 Baud O ffline 08-FEB-96 18:54:21
Window
MenuBar

Selected directory

Parent directory
File selector

Text field

Catalog Directory

“Select”a file
from this
directory
(choose here or
downwards)

/BIRDS/

This figure shows
the file selection
method.

CAGED
. . <Select Dir>
DIR
. . <Parent Dir>
DIR
CAGED
DIR
D O MESTIC
DIR
PREDAT ORY.BIRDS DIR
WILD.BIRDS
DIR

Catalog

1
9
14
57

04-AUG-91
05-AUG-91
05-O CT-90
03-JU N-91

Cancel

Move to the
next higher
“Parent” directory
(choose next higher)

Example File
Selection “Catalog”
Window

Scrollbar
Mouse pointer

Buttons

ProTERM often makes reference to a “Parent Dir” (Dir is short for directory). If the current
directory is:
/MY.VOLUME/DIR1/DIR2
…then the parent directory would be just above it:
/MY.VOLUME/DIR1
If the current volume is:
/MY.VOLUME
…then the parent directory would be:
/
NOTE: Entering a slash alone causes all the drives on the system to be polled (looked at) and
all storage devices connected to the system would be listed by volume name for selection.

File Selection
Whenever a command requires a filename to be selected, ProTERM displays the File
Selection Window. This window consists of a text entry field, a current pathname indicator, a
list of files in the current directory and two or more buttons. In some cases, the window also
includes items to specify options such as a file type. The items in the window behave exactly
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as any other dialog items except for the relationship between the filename input field and
the filename list. The difference is explained below.

Navigating
the ProTERM system.

Using the
File Selection
windows.

Selecting a File with the Keyboard
There are two methods for selecting a file from the keyboard. The first uses the ARROWS and
RETURN to “navigate” through the file system and locate the desired file. Select <Parent
Dir> to search upward in the hierarchy or select aDIR (directory) to search (down into) that
directory. Using this method, it is possible to navigate to any volume or directory throughout
your system.
After selecting the directory, choose the desired filename and press the RETURN key to cause
the desired action on the file. If you are creating a new file, after the directory has been
chosen, just start typing the new filename and you will see the filename appear in the Text
Input Field. When finished typing, press the RETURN key to save the new file. If you prefer to
save the file as an AppleWorks file, when theSave Filetype as Type: is selected, use the
ARROW keys to toggle the value in the widow from TXT to AWP. The file will be saved as an
AppleWorks word processor file and can still be opened by the ProTERM Editor as a TXT file
if desired. (To make a change like this permanent, see the Index: Preferences.)
The second method for selecting files involves typing the complete or partial pathname, or
just the filename, if you are in the directory the file where the file is stored. Try this just to
see how easy it is. Choose Open from File menu and just start typing in a filename that you
know exists on the currently active disk. As soon as the first character of the name is
detected, ProTERM highlights the Input Field and continues to accept input. When a
pathname is entered, ProTERM processes the pathname until it finds the path it can follow to
locate the file. If the pathname also contains a filename which already exists, or even the first
letters of a filename, that file or a file with a similar name is selected. To return from the
input field to the file list, press TAB. To cancel press ESCAPE. To select a file in the current
directory:

Typing part of a
filename will
position you at the
location of the file.

Naming and
saving files.

File selection
methods.

• Use the ARROW keys to highlight the filename and press the RETURN key.
• Type all or part of a filename and press the RETURN key.
• Type the first letter of the filename followed by pressing the RETURN key. This will
position the selector near the desired filename. You can then use the ARROWS to select
the actual name.
• COMMAND-1…9 will position the selector within the directory. 1 positions to the start
of the directory, 9 to the end, and 2 through 8 place you at points respectively between
the top and bottom.

Selecting a File Using the Mouse
To select a file with the mouse pointer, select the directory containing the file. If the
directory containing the file is not open, use the Scrollbar to scroll the files, double click on
the directory name to open it, then select the file itself. To change directories, double-click
on the “Parent Dir” entry to move to the parent directory or on a directory entry to move
into that directory.
NOTE: The list of files displayed by ProTERM is normally determined by the filetype of the
files. For example, in the view file command, only text files and AppleWorks files are
displayed, because other files are generally not applicable in this area of ProTERM. However,
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ProTERM can view any file (it will treat it as text file regardless of the type). To enable
ProTERM to display ALL of the files in the current directory, press CONTROL-Z while the file
list is selected.

Double-click on the
filename or directory to open it.

Batch Selection
The batch selection window looks identical to the file selection window but allows multiple
files to be selected instead of just one. The technique for navigating through directories is
the same as for File Selection. Any file or directory within the current list can be “tagged” as
part of the batch. Files which are tagged will have a checkmark√]
[ displayed next to them.
ProTERM will not allow the “Parent Dir” entry to be tagged, but if any other directory is
tagged, ProTERM may perform the commanded action upon the directory or the files
contained within. This will vary from command to command. The following can be used to
tag files as part of a batch:
SPACEBAR
OPTION-ARROW
OPTION-CLICK
OPTION-DRAG
CONTROL-A
CONTROL-N

Toggles the tag of the highlighted file plus moves the cursor in
last used direction.
Toggles the tag of the highlighted file plus moves the cursor in
the arrow direction.
Toggles the tag of the file being clicked.
Sets the tags of the files from the initial press of the mouse
button through dragging, selecting and release.
Tags all the files.
Tags none of the files (“untags” all).

Path Selection
Some commands require that only a directory is specified, not an actual filename. In such a
case, the Path Selection Window will be displayed. While similar in design to the File and
Batch Selection windows, the Path Selection Window includes a <Select Dir> entry in the
file list. The techniques for navigating through directories are the same as for File Selection
(which see). Once the desired directory has been selected, choose the <Select Dir> entry.

Duplicate Files
If ProTERM attempts to create a new file, and a file of the same name already exists, the
Duplicate Filename window is displayed. From this window. ProTERM allows the existing file
to be deleted or the command to be canceled. Depending on the command which is
executing, an option to append the new data to the old may also be displayed. If selected,
ProTERM will preserve the original file appending the new information to the end of the
existing information.

File Locked
If ProTERM tries to write to a locked file, the File Locked window is displayed. From this
window, you can cancel the command or unlock the file which will allow the command to
continue. For more information on locking and unlocking files, see the Index:Set File Info.
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Available Services
APPENDIX F
Many services are available with easy access and each will provide varieties of different types
of information. From academic to reference, entertainment to business, the amount of
information available is overwhelming. You only need to choose which service to call. This
chapter suggests several popular commercial services as well as some probable free services
you may find in your own community.

The InTrec BBS
There are two major reasons one might choose to call the InTrec BBS:
1 If you have never called an online service before, we have enclosed step by step
instructions for you to call and sign on to the BBS, just so you can go through the steps
and understand the process. (See the enclosed BRIGHT YELLOW CHEAT SHEET)
2 The InTrec BBS is the official support site for InTrec Software products. New information
about InTrec products is always released first to the InTrec BBS and the InTrec Web site
(which see below).
Even though the BBS may be a long distance call, you may find it beneficial to call periodically and use the Global QuickScan feature to quickly retrieve new information. The InTrec
BBS also provides online technical support for registered ProTERM owners. Special message
boards and software libraries allow discussion and software transfers.
While there is no charge to access the InTrec BBS, the call is to a Phoenix, Arizona phone
number and normal long distance charges apply to callers outside of the Phoenix, Arizona
area. Calling during the low-cost evening and weekend hours is popular with most long
distance callers.
InTrec Bulletin Board Service 602/992-9789
Speeds to 14,400 bps (v.32bis support).
24 hours a day — 7 days a week.
Voice Tech Support: 602/992-1345 Mon-Fri 8 AM-5PM MST.
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Internet: proterm@intrec.com
Technical assistance is limited to registered ProTERM licensees.

Local Bulletin Board Services
The most difficult part of making your first call is finding the number for the first local
bulletin board service (BBS). However, many services include references or even complete
lists of other bulletin board services in the same area, so once you find one, it will generally
lead you to others.
Look through your local newspaper, computer magazines, and the local small pulp
magazines referred to as “shoppers” for local bulletin board service references. Also, check
your phone book yellow pages under “Computer-Bulletin Boards” for a listing of local
services. If you find a local BBS number, but the subject matter of the service is not of
interest, explore that service for references to other services. Since telecommunications is a
general interest, you will experience a certain “domino effect.” Once you find one, you find
others, which leads to still others.
Local Apple user groups are an excellent information source, and often have their own local
bulletin board services. To locate the Apple computer user group nearest you, dial 800/5389696. You will be asked for your Zip code and the operator will provide you with information on user groups close to your area.

Most Internet
connections require
VT-100 emulation.

Investigate Telecom Academia
Many local libraries now have their card catalogs and some research facilities in a computer
database, and many have these databases available online as a local modem call. In addition,
colleges, universities and other academic institutions have educational services and even
encyclopedias online and available to the community. Call these institutions (on your voice
phone) and ask about telecom access. Ask them for the phone number, data format, speed
(bps) and whether they require the use of an emulation such as VT-100 or ANSI to access
their service. With that information, you can set up a ProTERM connect file for the service,
and you are ready to connect to the library, search card catalogs for books and subjects of
interest and even edit and print a “shopping” list. You can often even make arrangements
with your library to pick up the books, have them sent to a local branch or even delivered,
depending on the services they offer.
Also check local availability of a Freenet provider in your area. These are free Internet
accounts often available to local residents through local universities.

Internet
The most popular and fastest growing areas of communications is the Internet. The Internet
is made up of thousands of computers, located throughout the world, all connected to one
another. That is the power of the Internet; one computer on the Internet can communicate
with other computer also on the Internet. With ProTERM and a modem, your own computer
can be a part of that system.
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IMPORTANT: Send us your email address. Email a note to proterm@intrec.com with a note
saying “Here’s my email address!” We’ll put you on our newsletter email list.
An Internet service provider (ISP) is an organization usually local in large metro areas. They
are usually commercial, but some are free. The ISP has a computer connected to the
Internet, and by accessing their computer via modem, you can in turn access Internet
services. Most ISPs charge a monthly fee which includes a number of hours of access each
month. If you can find one in your local area, you can avoid long distance changes and the
cost is that of the provider.
To connect to the Internet using an Apple II computer, it is necessary to have access to a
“dial-up shell account.” The popular PPP accounts cannot be used with Apple II computers,
so you will need to be able dial directly to the service. Tell your ISP you want a dial-up shell
account so that you can use the Pine mail system and the Lynx Web browser. Those are the
important facts you’ll need when you sign up for an Internet account using an Apple II
computer. Also see the Index: VT-100 emulation. This emulation is needed for most parts of
the Internet.

Some Internet resources include:
• Email (electronic mail) on the Internet is similar to Email on a BBS, however, it is much
more powerful on the Internet due to its international size. There are millions of users
on the Internet located worldwide, and you can send mail to any one of them if you
know their Internet (email) address.
• NetNews is like the message area on a BBS except that messages can be read and posted
from any computer on the Internet. Like Email, NetNews is special because of the size of
the Internet. There are hundreds of distinct “news groups” each focused on a particular
topic.
• FTP is like the file transfer area on a BBS. FTP allows files (such as public domain
software) to be transferred from one computer on the Internet to another. If using an
Internet service provider, FTP is used to transfer files from the Internet to the service
provider, and then a protocol transfer (such as Zmodem) is used to send the files from
the service provider to your computer. Normally, you will use the Internet Lynx system to
send the file via FTP to your home directory, and then you can download the file from
your home directory to your computer.
• Cyberspace is a term that can be thought of as the place where your email is as its being
sent. Think of a phone conversation taking place between callers, wires, satellites,
computers and switching stations. It is not where the people are, but where the actual
communications information is when it is enroute from one point to another. When
people converse through cyberspace, each person is in a different physical location, but
they are “all together” in cyberspace.
Unfortunately, understanding how to utilize the Internet is beyond the scope of this manual,
but there are hundreds of books on and about Internet, and many more being published. In
addition, user groups are an excellent resource for finding out about this fast growing
resource. To locate a user group in your area, see the Index: User groups.
The important parts of the Internet to an Apple II user are the Lynx, web browser, Pine mail
and Usenet (like an Internet level BBS with literally thousands of interest forums).

PART FOUR — REFERENCE

318

A P P E N D I X F

The Major Commercial Services
Large commercial services available for national and international calls include CompuServe
Information Service (CIS), Delphi, Genie, Dow Jones News/Retrieval. Locally, you can call
services such as libraries, city government and local bulletin board services. At this time,
Delphi is the most active text based system that can be accessed using ProTERM A2.
NOTE: The following is provided as a service to ProTERM owners and does not constitute an
endorsement or recommendation to use these firms or services. Information is based upon
that provided to us by ProTERM users currently using these services. While every attempt has
been made to make this information as correct as possible, this information may become
incorrect over time as the services change their features.
These services are not free, but Delphi has several time to cost ratio packages, talk to their
sales peole to find the one that satisfies your needs. Some services also provide a new user
practice area where there is a reduced or no charge “safety net” area.
The online commercial services generally stop the charges during the time files are being
uploaded (sent to them). This encourages callers to share non-copyrighted programs and
text information with other callers. The services allow this “free time” because when the files
are subsequently downloaded by other callers, they are charged for the time.
When signing up for one of these services, be sure to read and understand the agreements.
By agreeing, you are signing a contract that usually includes a monthly charge and perhaps
even an additional hourly charge.
The large commercial services can usually be accessed through local phone numbers in most
metropolitan areas. In such cases, the phone call is free (though there are changes for
accessing the service). If there is not a local phone number for the service, then you must pay
long distance rates as well as the changes for accessing the service. Some services have an
800 number which is used on the first call to determine a local access phone number. Some
also have special 800 numbers at an extra charge for rural customers who do not have direct
access to the service nodes located in the metropolitan area.

CompuServe
Note: CompuServe has eliminated all text access except for one very small Apple II forum.
To sign up for CompuServe:
1. Choose Create a System from the ProTERM File menu.
2. Enter a system name of CompuServe.
3. Enter a system number of 1-800-346-3247.
4. Set the Baud Rate to 2400 or higher.
5. Set the Connect Time to 45.
6. Enter a “Save Name As:” COMPUSERVE and select the Save button.
7. Select the Dial button to call CompuServe.
Important: Do not miss step #8 or #14
(depending whether you are just signing on for the first time, or if you already have a CIS
account and just signing on with ProTERM with an existing CIS account.
8. After connecting with CompuServe, press CONTROL-C (press and hold the CONTROL
key then press the C key and release both). A prompt should appear on the screen.
9. At the “User ID” prompt type “PHONES” and press the RETURN key.
10. CompuServe will ask you to enter you local area code and phone number. After doing
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this, CompuServe will respond with a local access phone number for your area.
11. Type BYE to disconnect from CompuServe.
12. After the disconnect, choose CompuServe from the ProTERM Dial menu.
13. From the ProTERM Main menu, select Dial, and select your new CompuServe entry
from the Dial menu. With the CompuServe Edit System Parms window open, press the
TAB key until the System Number field is selected. Press the DELETE key to delete the
800 number dialed earlier, and enter the local access number provided by CompuServe
in step 10.
14. Have your credit card handy for reference, and press the RETURN key to dial. After
making the connection with CompuServe, and when the screen clears, press
CONTROL-C to allow the CIS host to detect your carrier and you will get the :User ID:”
prompt.
15. At the User ID: prompt CompuServe will ask for your user number and password.
16. Enter 177000,2000 — press RETURN.
17. EnterEXPLORE/WORLD and — RETURN.
18. When asked for the Agreement number, enter: LC1297 — press RETURN.
19. When asked for Serial Number, enter: 44877211— press RETURN.

See the Index:
AutoLearn macros
to learn how to
create an
AutoLogon Macro.

As you proceed you will be asked for name, address and billing information. You will also be
given an opportunity to read the CompuServe service agreements.
For more information contact:
CompuServe Customer Service
800/848-8990NOTE: If your interest is for Apple II use, files and overall help and assistance,
Delphi offers the largest and strongest Apple II support area. Delphi also offers Internet
connections and service for Apple II users.

Delphi
How to Sign up for
Delphi Online
Service

The Command key,
used to be called
“Open-Apple.”

Note: At this time, Delphi offeres the most value for the text based software such as
ProTERM.
Delphi can give you direct connect to the Internet where you can browse the Web with your
Apple II computer. Delphi also gives you the largest Apple II user community online
anywhere. Large discussion forums and software libraries. You not only have access to the
files, but you’re with a friendly group where you can discuss your needs and request
assistance. This is a warm, enthusiastic group of helpful folks, and they’re waiting for you to
ask for assistance - They are anxious to assist, and actually thrive on questions asked by new
users, so consider their needs, and ask LOTS of questions. ;–)
Steps 1 thru 12 are automatically done for you if you do this:
1. Press D on the keyboard
2. Choose Delphi from the Dial menu
3. Press Return to dial.
Specific Delphi signup tips for ProTERM users:
1. Press the COMMAND key and then press the D key to open the Dial menu.
2. Choose Create System from the Dial menu — RETURN.
3. Enter a system name Delphi — RETURN.
4. Enter a system number of 1-800-695-4002.
5- Set the Baud Rate to 2400 or higher to match your modem.
6- Set the Connect Time to 45.
7- Enter a Save System Name: of DELPHI, press RETURN to select the Save button, and
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save this information. A larger window will open.
8. Select the Dial button to dial Delphi.
9. When you connect with Delphi, press the RETURN key a couple of times.
10. You will see:
+: JOINDELPHI
Please enter your password: _
11. Type the introductory Password:INTRECSOFT and press RETURN.
12. Follow the online signup instructions to establish your account.
NOTE: If at any time you want to quit the signup process for Delphi, enter /exit and press
RETURN. The process will stop with no signup having taken place.
You will be asked personal information to sign up your new Delphi account, and you will
need a credit card to complete the process.
As you go through the Delphi signup process, you will be given a phone number to dial
Delphi from your area. You will be asked to enter a name you will want to be known by as
you use Delphi. This name will also become your email address on Delphi. It can be anything
you like, from 3 to 12 letters and numbers, with no spaces or other punctuation. Once
chosen, it can NEVER BE ALTERED OR CHANGED, so choose carefully!
You will also be asked to choose a password, have one ready. Your password can be changed
anytime you like.
When you are given your local Delphi phone number and your logon and password
information, you will want to enter that information into the Delphi service dialer:
1. Press COMMAND+D and choose Delphi - Press RETURN.
2. Press TAB until the cursor is in the Phone Number field
3. Press DELETE until the entire 800 phone number is deleted
4. Type the new phone number in the phone number field.
5. Press COMMAND+M which should select the Macros button - Press RETURN
6. You should see:
Macro to Execute after Logon: 1
7. Press the right facing ARROW key one time and that will change the “1” to “Learn” to
enable ProTERM to watch you log on to Delphi on your next call.
8. Press COMMAND+S and press RETURN to save this information.
9. You should be at the “System Parms” window for Delphi.

Logging onto Delphi the first time with your o w n account
If you followed steps 1-9 above, you are ready to call and teach ProTERM how to log you on
automatically from now on.
1. Press RETURN to dial.
2. When the screen opens, follow the steps you learned while signing onto Delphi. Enter
your keystrokes carefully and slow because ProTERM is watching everything you do,
even when you make a mistake, ProTERM records that as part of the process. If you
make a mistake, it is not a problem, because you can always go back and set the
ProTERM macro to Learn and do it again until you get it right.
3. When you get to the Delphi main menu, enter:
go com a2 for <=(This translates as: GO COMputing, Apple II, FORum.)
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...and press the Return key. This places you in the Delphi Apple II user forum.
4. Press COMMAND+N to tell ProTERM to record the macro script it just learned.
Now you are ready to explore Delphi. Press the ? key for help.
Note: ProTERM Emulation for Delphi should be set to DEC VT-100 emulation.

ProTERM Mac & A2
Calling Delphi Using SprintNet
1.
2.
3.
4.
4.
5.
6.
7.

Enter the SprintNet number in the ProTERM Phone Number field.
Press the RETURN key to dial.
When you connect, press the RETURN key twice to notify SprintNet you are there.
Hold the SHIFT key down, and press the 2 key and then press the D key. This prints
@D on the screen. Press the RETURN key.
When you see “TERMINAL=” press the RETURN key.
When you see “@” type C DELPHI and press the RETURN key.
At "Username:" enter your membername (given during signup), and press the
RETURN key.
When you see "Password:" enter your password (given during signup) and press the
RETURN key.

Welcome to the Delphi Main menu. Press ? for help menus.
Leave all ProTERM default settings as you found them, and Delphi will work fine. The
standard default settings are: 8N1 (8 Data Bits, No Parity 1 Stop Bit), Duplex Full, Echo No,
RTS/CTS enabled.
See the ProTERM user manual Index: AutoLearn macros to learn how to create an AutoLogon
Macro.
For more information and assistance, about Delphi Services, contact:
Delphi Member Services
800/695-4005

Dialog
Dialog is a business oriented online system with high end data bases related to any business
need. Dialog may be a little expensive for the average user, but the wealth of information is
certainly worth the cost of the service when the information is needed.
Dialog Information Services, Inc., 3460 Hillview Ave, Palo Alto, CA 94304, 800/334-2564

Genie
Note: The strong Apple user community that were once Genie A2, are now on Delphi A2
1. Choose Create a System from the File menu.
2. Enter a system name of Genie.
3. Press the TAB key and enter a system number of 1-800-638-8369 (or 1-800-387-8330 in
Canada).
4. Set the Baud Rate to 2400 or 9600.
5. Set the Connect Time to 45.
6. Enter a Save System As: name of GENIE and select the Save button.
7. Set the Duplex to Half.
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8. Select the Dial button to dial Genie.
9. When you connect with Genie, enter HHH (three H characters) but do not press the
RETURN key.
10. When the U#= prompt is displayed, enter XTX99458,PROTERM and press RETURN.
11. Have a credit card ready. In the U.S., you may also use your checking account number.
12. After the requested information is entered, Genie will provide you with your own
personal user identification information; password and local access phone number for
use in all subsequent calls.
13. After disconnecting from this first Genie call, choose Genie from the ProTERM Dial
menu. Press TAB and change the System Number from the 1-800 number to the local
access number provided during the Genie signup account and select theSave button.
See the Index: AutoLearn macros to learn how to create an AutoLogon Macro for use
with Genie.
For more information contact:
Genie Customer Service
800/638-9636
GE Information Services
PO Box 6403
Rockville, MD 20850-1785
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Index
system parameters 220
width 221

A
A60SEC.WORKOUT 126
About ProTERM (menu)
key Function
ScreenSaver

99

About telecom getting started 29–36
ACK/NAK 259
ACU defined 253
Address, your online 77, 78
ADDS Viewpoint Emulation 152
Advanced users 65
Airlines, Compuserve
bid sheets 108
Alphabetized Listing, changing 49
Anchor-point
scrollback 128
ANSI BBS 152
Answer phone 135, 261
Answerback 145, 229
macro 170, 182
toggle Split Screen Chat. See Split Screen
Chat
Apple
menu 205
super serial card, printer 287
super serial card, telecom 281
system disk utilities 60
Apple guide, the 29
Apple IIe, enhanced 38
AppleWorks filetypes
opening 99
saving 241
Archive suffixes defined 253
Archiving 252
ASCII
char pace 222
character chart 301, 302
data receiving 241
defined 221, 235
download 241
fix blank lines 222
line pace 222
macros commands 182
reply mode 91
send
first time - new user 240
,formatted files; print to disk
from editor 101
mode 221
prompt 221

101

upload; determine text selection
size 107
ASCII Express
Greg Schaefer involvment 256
ASCII or protocol? – Transferring
Files 235
Ask protocol options 247
asynchronous 257
AT
or Hayes compatible 32
AT or Hayes compatible 63
Auto protocol start 223, 230
Auto-clear scrollback 269
AutoLearn macro 94
Autolearn macro 162, 164, 232
Compuserve 164
Telenet example 166
Autologon macro 224
Autosave
pathname 265
receive ASCII 241
receive ASCII macro 169
springback 266
Autoselect keyboard 65
AUX slot – slot zero 290
Auxiliary filetype 212
available memory 110

B
Backspace 146
set delete key option 219
Batch selection
example window 46
files 314
Baud
rate 227

BBS

BPS explained 217
changing/setting 73
defined 32
getting started tutorial 73
high speed (notation) 217
speed & bps 32

30, 37
analogy of 78
explained 34
InTrec 71, 315

special access for PT3 owners 276

local services 316

Binary II 223
defined 251
downloading 246
encoding, about 244
receive 245
Unnattended mode 144
Blank Lines change to Space+
Return 238
BNY
.BXY add during uploads 248
defined 253
Bold video 269
Boot
see startup
Bottom margin, editor; printer 117
Bps
baud rate
explained 217
speed 32

BQY defined 253
Break
signal 218
time 218, 228
Browse, scrollback 81
Buffer
code-cache 39
defined 243
Bulletin Board System. See also BBS
See also BBS 37
Bulletin board system
explained 34
Buttons
defined 47
example window 46
BXY defined 253
BYE terminating a call 80
Byte defined 33

C
Cable
db-25 62
diagnosis of modem 285
hardware handshaking Apple IIgs – Hispeed 284
problems, identifying 292
sources 287
Call waiting 216
Call-back system 136, 262
autologon macro 136
Cancel - view file button 213
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Capture data 220
character mode 220
line mode 220
Catalog a file 213
Changed your address? Tell us! 275
Char pace ASCII 222
Character
loss 291
mode; capture data 220
send pace 238
Chat
split-screen 158
editing 158

unattended mode 142
Check Box
function/use 48
Check box
example window 46
Check disk-space, receive 248
Checksum 254
Choices
defaults 245
Click defined 46
Click-drag 129
Clipboard
cut & paste 107
size & function 107
Clock
cards 40
install 65
Closed Apple key as Option Key 44
Code blocks 181
Code-Cache
buffer memory 205
Code-cache buffer 39
Command
+H hangup 80
+Z scrollback 127
key. See also Cross Reference Cards
key as open apple key 44
mode 171
Commenting macros 177
Commercial
services 318
software 36
Common settings 240
Compatibility
about 39
AT or Hayes 63
CompuServe
autologon macro example 164
backspace parm 219
customer service info 319
delete key use 219
duplex 218
hints on easy use. See also Split Screen
Chat
sign-up, first call procedure 318

terminate call macro 164
Connect
sound 267
time 219, 230
extend countdown time 219
setting 73

Continuous
editor printer no form feed 117
redial 225
Control
+M return character 180
+notation 301
+Z to show all files 314
character 301. See also ASCII;
Character Chart
editor, embedding 112
editor, find in text 105
ImageWriter, printer control 119
notation 145
removing 220
strip from editor 118

printer codes 112, 119
Converting
macros 2.2 to 3.0 200
phone numbers
system macros 70

Copy
entire processed lines

231

ASCII receive 242

files 209
host dialing systems 92
ProTERM
on large disk 58, 59, 60, 61
to other disk 54–70
write protected disks 53

raw incoming characters 231
ASCII receive 242

Cost
log to disk 220
per min/per hour 220
Coyright
software 36
CP/M 255
Crashes or lockup in scrollback 296
CRC 255, 258
protocol 254
CRC-16 254, 255
CRCW 259
Create system & getting started 72
Current directory 310
Cursor
example 98
movement
commands 114
pan screen 269

position 110
Customer assistance 53
Customizing ProTERM; saving

personal Preferences 216
Cut & paste
clipboard 107
undo 98
Cyberspace 317

D
Damaged disks replacing 274
Data
bit 228. See also byte defined
cable 292
capture 220
format 217, 228
trouble shooting 296

incoming garbled 296
subpacket 258
to voice calls, changing from 135
DB25
Also RS232 282
cable 62
DCD 280
DEC
VT-100 145, 154
Compuserve, airlines 75

VT-52 153
Default
current, save 264
entry 51
when in doubt accept 51

filetype 246, 247
pathnames 265
personalizing 80
resetting 264
saving 80
editor 119

selecting a dialing default 80
service 93
values setting 263, 264
Defaults 245
Defaults, saving 216
defective disk warranty 273
Delete
a system 93
editor 112
files 209
Key 146, 229
set parameters/host 219, 229

text, Editor 114
Delimiter ProDOS pathname 307
Delphi
backspace parm setting 219
Delete key use 219
hints on easy use. See also Split Screen
Chat
sign-up procedures, first call 319
special dot-commands 126
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Device channels macros 181
Dial 224
& system's bps 217
a system 77, 224
getting started tutorial 72
list
customizing 92
multiple or rotary dialing 225

macro, all dialing options 186
meta characters; phone # & customizing 216
redial 225
remote host system 71
Dialog Information Services 321
Dim video 269
Dip switches 280
Direct connect. See also Null modem
dumb terminal; null modem 63
null modem 225
via null modem 249
Directory
and ProDOS 305
current 310
Disabilities, persons with iv, 30
Disabling printing 124
Disconnect
failure to detect 293
immediate 80
Disk
contents
3.5" 59
5.25" 58
hard disk (files needed) 60

formatting defined 305
sizes (relative) & new user notes 58
utilities
Apple system disk
ProDOS 209

60

Disk format
practice session 84
Document
determining size 107
Done button 213
Dot-commands 120
interpret; Editor 118
printer control 125
reference. See also Quick Reference
Cards
send ASCII 248
special characters 125
special commands 126
summary 121
Download
Binary II 246
options parms window 223
pathname 265
receive options 245
springback 266

Drag defined 46
Drive, slot, name 209, 305
Drivers
defined 61
DTR 280
Dumb
modem 291
terminal null modem, direct-connect 63
Duplex 135, 218, 262
see full & half 228
Duplicate
file 314
filename
parms window 222
when downloading 246

E

keyboard
Commands 110
navigating 110–111
Selecting Text 112

large documents 98
left margin; printer 116
line format 103
lower case 102
memory size 97
menu bar 99
movement commands 110–111
navigating
within line of text 111
within page of text 111

new document
open

99

document normal 99
non-text files 99

Edit
menu; strip controls 104
text fields; commands 48
tutorial. See A60SEC.WORKOUT on PT3
Master Disk
view file button 213
Editor
about the 97
ASCII, send 101
buffer 97
capture 231
clear 102
clear the, macro 169
close document 100
control character
find in text 105
insert in text 111
strip 118

copy 102
cursor
movement commands 114
position 110

cut 102
defaults, saving 119
delete
space right of cursor 111
text 112, 114

other commands 115
overstrike/insert toggle 111
page numbers 124
pan on cursor movement 269
paragraph format 103
paste 102
pathname 265
print
command 100
preview 100
to disk 101

printer
bottom margin 117
continuous form 117
eject final page 118
init string 118
justification 123
line spacing 123
page breaks 123
page length 117
text emphasis 124

pull-down commands 99
quit 101
quit from 98
reference. See also Quick Reference
Cards
replace
find and 105
selection on type-over 269

dot-commands
about 120
interpret 118

edit large files 113
embedding control characters 112
find & find next 104
getting started 98
insert
a space right of cursor 111
overstrike toggle 111
text 111
text, special commands 114

reply format 103
right margin & printer 116
ruler 105, 108
save
changes 264
command 100
preferences changes 119
Ruler 269

save as 100
scrollbar, show 106
segmented loading 113
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select

reference. See also Quick Reference
Cards
selecting 218

text 112
w/mouse 113

select all 102
selection size 106
show special 106
springback 266
tab, setting 105
text selection commands 115
top margin & printer 117
tutorial. See A60SEC.WORKOUT: see PT3
Master Disk
upper case 102
using the, 98
wide docs, panning 107
Effects, strange while calling with
emulation 76
Eject final page, editor preference 118
Electronic mail. See Email
Email 30, 34, 78, 317
receiving & sending 90
Embedding
commands 112. See also Special
Commands: Dot Commands
control characters
editor 112

Emulation 34, 210, 229
& status bar 146
ADDS Viewpoint 152
and line noise 76
ANSI BBS 152
backspace 146
capture problems related to, 146
change while online 76
Compuserve; DEC VT-100 75
DEC
VT-100 154
VT-52 153

delete key 146
getting started tutorial 75
Heathkit H-19 155
installing new 160
inverse video 269
keyboard 148
maps. See also Quick Reference Cards

Lear Siegler ADM-3a/5 156
no emulation 156
of a file 210
speed control 210

online changing 76
printer 151
access allow

268

programming
ProTERM special

ProTERM special
emulation 156
InTrec BBS 75

157

& changing

75–78

split screen chat 158
editing 158

TeleVideo 910+
terminal 145

160

emulation 151

TTY 156
using 76, 145
Enable hot-keys 267
Encyclopedias & libraries 316
Enhanced
Apple IIe 38
kit for Apple IIe, 65C02 Processor 290
kit for Apple IIe, 65C02 processor 38
EOF 259
Error correcting protocols 255
Error message
block number; out of sequence 258
checksum does not match Data 258
complement mismatch block number 258
CRC does not match data 258
data subpacket too long 258
flip disk; hard, /RAM or 3.5 disk 291
got
subpacket instead of header 258
ZRIN instead of ZACK 258
ZRPOS at EOF 259
ZRPOS: resending data 259

insert program disk 60
invalid ProDOS signal packet 259
position of sender invalid 259
protocol transfers 258–260
re-sent packet; due to NAK 259
timeout
after; CRCW packet 259
after; sending EOF 259
during data ACK/NAK 259
during EOF ACK/NAK 260
during filename ACK/NAK 259
during filename send 259
during parms handshake 259
during transfer end 260
requesting; ProDOS parms 260
waiting for block number 260
waiting; for CRC 260
waiting; for packet data 260
waiting; for packet header 260

unable to load ProDOS 59
Exec macro 172
Execution of macro file 172
Exfer. See also Transfer
Extended keyboard install 65
Extra slot feature modem port,
GS 54

F
Factory settings & resetting preferences 264
Failure, hardware (modem) 67
Fault-tolerant protocols 255
File
access 212
batch selection 314
delete 209
display alphabetized 267
example window 46
list
alphabetized, changing 49
without alphabetization 50

locked 314
non-text, load & change 99
path select 314
print 211
quit macro 186
rename 211
select w/mouse 313
selection 312
selector 50
set info 211
show all 314
transfer
getting started 235
practice session 83, 84
unattended 142

Filenames & ProDOS 306
Filetype 211
change & set file info 99
Find 104
and replace spaces 105
control characters in editor 105
next 104
Fix blank lines, ASCII send 222
Flashing video 269
Flip disk-error message; hard, /RAM
or 3.5 disk 291
Flippy 58
flip-side. See flip-disk: flippy
flip-side or two-sided disk 57
Floppy disk defined 58
Flow off & flow on
flow control 218, 228
Footers & headers, Editor;
printer 124
Force Xmodem 1K/4K file send 248
Format 217
disk 214
defined 305
practice session

84

Formatted files, print to disk; ASCII
send 101
Formfeed normal, editor;
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INDEX
printer 117
Freenet 316
Freeware 36
explained 35
Freeze or Lock-Up on boot up 291
FTP 317
Full duplex 218, 228
Function keys 65
those not listed 154

G
Garbage characters – line
noise 296
GBBS
using a send-to prompt 221, 238
Generic printer driver, printer port;
Install 64
GEnie
customer service info 322
delete key use 219
duplex 218
first call sign-on procedures 321
hints on easy use. See also Split Screen
Chat
Genie
backspace parm setting/getting 219
macro
terminate example 165

Getting started
intro to telecom 29–36
loading drivers; Init modem 66
telecommunication - file transfer 235
tutorial
baud rate 73
dial 72
emulation 75
new user 71
save system as: 74
system names 72

Global macros 167
defined 162
Goodbye – terminating a call 80
Goto - view file button 212
GS/OS & character loss 291
Guarantees 273

H
Half duplex 218
hiding passwords with 164
see duplex 228
Handicapped. See physically
challenged
Hangup 233
command – cutting loose 80
delay 293

terminating a call 80
unattended 142
Hard drive, boot ProTERM – how
to 61
Hard-spaces 48
find and replace 105
used for reply format 104
Hardware
adding new drivers 40
cables and connections 277
clock cards 40
getting support for 40
handshaking cable, hi-speed 284
install
lock-up 68
verify 66

minimum 38
adding extra RAM 290

modem failure 67
optional 40
requirements 38
support 40

ASCII character chart 302
catalog files & utilities 213
dot-command imbedded
Ruler 109, 125
editor ruler 106
editor status bar 109
enter a system window 73
example of a byte 33
file
selection catalog example
transfer example 83
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hardware summary window 66
Heathkit H-19 keyboard mapping 155
Lear Siegler ADM-3a/5 156
main menu 67
modem selection window 63
more preferences window 268
page margins
set by dot commands 122
set by print parms 117

popular modem connectors
port

policy 278

trouble-shooting 289
Hayes or AT
compatible 39, 63
Header
& footers, editor; printer 124
space 117
Heathkit H-19 emulation 155
Help
getting started intro 29
local assistance 36
requesting help on a system 78
High speed
cable 284
modems 32
Zmodem/ASCII sends fail 294
Host systems & analogy to library 79
HotKeys 263
enable 267

I
Illustration
ADDS Viewpoint Keyboard emulation 152
ANSI BBS Keyboard Emulation 152
Apple
II keyboard mapping 149
IIGS Extended Keyboard Mapping 149
IIGS Keyboard Mapping 149

Apple super serial card
printer 287
telecom 281

Applied Engineering Serial Pro 281

283

selection window 64
slot selection window 64

practical peripherals seriALL Card config
for mode 281
preferences windows with Default
Values 265
print parameters window 116
ProDOS Volume example 310
ProTERM
editor screen 98
special emulation keyboard 156

Receive
ASCII Status Bar 243

receive
ASCII (parms) window 242
ASCII file window 241

screen saver window example 207
scrollback window 128
system parameters window 75, 217
TeleVideo 910+ 160
transfer preferences window 247
transfer status window 85
unattended access menu example 141
VT-100 keyboard mapping 154
VT-52 keyboard mapping 153
window example 46, 47
ImageWriter printer control 119
Impaired vision device; TextalkerGS 42
Incoming
calls 135
data garbled 296
Init
modem; getting started & loading
drivers 66
string & editor, printer 118
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Inserting text, editor 111
Install
boot directly into 68
clock 65
external modem port 63
hardware 65

maps. See Quick Reference Cards
pull-down menu access 45
selecting files 313
selecting text in editor 112
selection 65
Keywords 178

lock-up 68

L

keyboard 65
new emulations 160
printer
init 120
port 64

ProTERM 63
PT3.1 69
PT3.1 replacing PT3.0 69
verify Hardware 66
InSync Software
becomes InTrec Software iv
Interface ProTERM
& user 37
saving defaults 216
working with 216
Internet 316, 317
Interpret dot-commands; Send
ASCII 239
InTrec
BBS 71
special access for PT3 owners
user support 92, 315

276

software
…from InSync Software

iv

Intro to telecom, getting started
36
Inverse (reverse) video emulations 269
ISP 317

29–

J
Justification, editor & printer 123

K
Kermit 246, 251, 257
protocol 254
Key Function 205
Key function, screensaver, About
ProTERM menu 99
Keyboard
autoselect 65
commands 45
editor commands 110
emulation 148
equivalents 45
equivalents & shortcuts 43
explanation of special keys 44
install 65

Label
declarations 177
macros 199
references 178
Large files
editing 113
load & view 210
Laser keyboard, Install 65
Latency 257
Launch a program, Macro 169
Lear Siegler ADM-3a/5 emulation 156
Left margin, editor & printer 116
Library
card catalog & encyclopedia 316
online libraries explained 78
re; emulation needs 75
Line
format 103
mode capture data 220
pace ASCII 222
send pace 239
send prompt 237
spacing printed 123
status 230
Line noise
& emulations 76
causes & effects 297–299
garbage characters 296
phone company 297
Linefeed to return, add 210
List object 49
List of materials 41
Lists, example window 46
Literal
numbers 179
strings 179
Load previous settings defaults 264
Loading drivers, init modem; getting
started 66
Lock files & file access 212
Lock-up
freeze on boot up 291
hardware install problems 68
scrollback. See crashes or lockup in
Scrollback
Log cost to disk 220
Lurking 34

Lynx

317

M
Macintosh LC
install ProTERM 54
Macro 161–171
& commas 177
& white-space 177
answerback 182
autolearn 94, 164, 232
Also autologon

162

autologon. See Macro: AutoLearn
Compuserve 164
example Compuserve 164
example GEnie 164

callback system 137, 263
code blocks 181
commands 181
converting
2.2 macros to 3.0
old to new 70

200

defined 93
device channels 181
elements 224
example pt3.clock 94
file 171
example pt3.clock
exec 172
execution 172

173

formatting 177
global 167
defined

162

how to create 176
labels 199
numeric functions 198
reference. See also Quick Reference
Cards
strings
CHar 184
DAte 185
FOrmat 187
functions list 199
MId 191
PAth 193
RIght 194
STring 195
TIme 195
UPper 195

summary 198
system 166
defined

162

system variables 199. See also Quick
Reference Cards
terminate example
Compuserve 164
GEnie 165
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trace mode 176
updating to PT3.1 70
variables 179
writing 174
Master Disk
pt3.dial 62
Master disk
archive, write protected
Maximum memory use
Memory
cards 38
cards supported 39
maximum memory use
minimum requirement
adding exta RAM

string, changing 65
troubleshooting 291

267
38

290

answer phone 261
editor 261
preferences 263
scrollback 261

serial cards 280
supported 39
switches 280
types 32
MODEM7 (CP/M) 255
More preferences; more default
settings 268
Mouse
or no mouse? toggle on/off 266
pointer example 98
scale (speed) 267
select files 313
selecting files in editor 113
selecting with 46
using 44
Movement, editor commands 110–
111

N

read globals; macro commands 186
transfer stats; macro commands 186
Mode 248
Modem
cable
diagnosis 285
grass-roots 282
IIc, Laser to DB25 283
IIc+ – DB25 284
popular connector 283
sources 287
standard DB25 – DB25 283

compatible
63

configurations 282
"connect" Messages
display 268

NAK 258
Navigating, a sample system 77
NetNews 317
New directory 214
New user
notes on disk sizes 58
ProTERM tutorial getting started 71
Next
view file button 212
No emulation 156, 229
No Modem 63
Non-text files, load & change 99
Notation-control 301
Null modem 39. See also Direct
Connect. See also Direct
Connect
direct connect 225, 249
dumb terminal 63

cut & paste to 91
defined 31
external
install modem port
installing 280

O
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& serial cards 40
gs; extra slot feature 54
install external modem 63
,paste to 91
slot number 64

56
267

MenuBar
Commands 130
examples. See also Quick Reference
Cards
using with emulations 146
Menubar 45
Meta characters 215, 216
reference. See also Quick Reference
Cards
Minimum requirements 38
65C02 processor/128K 290
Misc
miscellaneous menu 261

AT or Hayes

Cards
variables 179

init
leave it on 68
popular connector
port

driver 225, 292
for non-AT compatible 63

driver, trouble Shoot'g
63

failure 67
hardware & switches 280
hardware support policy 278
high-speed & clock driver 65
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modem init problems 291

Numeric
expressions 180
functions in macros 198
reference. See also Quick Reference

Object 46–47
illustration example 46
text fields window 47
Online
emulations, changing 76
InTrec addresses 275
macros commands 186
menu 227. See also Quick Reference
Cards
offline, macro toggle 171
parameters 227
reply 91
services 37
major

318

time
per min/per hour

220

toggle 234
Online Parameters 171
Open
AppleWorks files 99
large files 113
non-text files 99
text files 99
Open Apple key as command
Key 44
Opening
non-text files 314
Operating system 37
Option key. See also Cross Reference
Cards
as closed apple key 44
global macros “a” through “Z” 169–171
Other commands, editor 115
Other function keys 154
Overstrike & insert in editor 111

P
Page
length & editor, printing 117
numbers in header or footer 124
numbers, printing from the editor 124
Panning
pan editor on cursor movement 269
wide docs
editor screen features

107

Paragraph format 103
Parameter
defined 74
Parameters
explained 71, 74
save current defaults 264
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system 220
Parent
“dir” defined 312
directory 209, 305, 311
and batch selection 314
and mouse 313
navigating between 310

Parity 228
Parms
more system parameters 220
window
download options 223
duplicate filename 222
protocol speed 222
upload options 223

Password 78
hide using half duplex 164
unattended 139, 143
Paste
cut to clipboard 107
through the modem port 91
to editor from scrollback 131
to modem 232
Path
selection. See also File: Selection
unattended 140
Pathname
about ProDOS… 307
default 265
default settings
download, upload, editor &
Autosave 265

moving around in 311
navigating 310
springback 265
understanding 307–314
Pause
mode 233
text flow 78
PC Pursuit 257
Per Hour
per min; online time 220
Per hour
cost 231
Per minute cost 230
Performance, improving with
RAM 38
Personalizing ProTERM, saving
personal changes & P 216
Persons w/disabilities 30
Phone
company 29
& line noise 297
& telecommunications

31

numbers
converting System Macros

70

wire tips & recommendations 299
Physically challenged 30. See also

Textalker-GS; Impaired vision
device
Pine 317
Pop-up
example window 46
windows 43
windows; function/use/navigating 49
Port
& serial cards; modem 40
gs, extra slot feature for modem 54
printer & interface cards 40
PPP 317
Practice session
file transfer 83, 84
Preferences
changing 265
editor, saving changes 119
more 268
reset to "factory settings" 264
saving personal changes 216
scrollbar on/off 106
selecting default dialing service 93
transfer 268
Press (key)
defined 46
Preview, view file button 212
Print
file 211
parameters
defined 116
window values defined

116–119

print wide commands 170
screen 93, 233
scrollback 131
selection 131
selection, text 100
to disk & ASCII send, formatted
files 101
Printer
bottom margin & editor 117
cable 287
hookup

286

capture & printing while online 231
changing formats 119, 120
continuous form & editor 117
control
characters & ImageWriter 119
codes 112

controlling the 119, 120
dot-command control 125
double spaces all text 295
editor
eject final page 118
footers & headers 124
justification 123
left margin 116
page breaks 123
right margin 116

text emphpasis 124
top margin 117

emulation 151
formfeed normal 117
Init & Install window 120
init string 118
line spacing 123
not advancing paper 295
not printing, troubleshooting 294
not working 294
online; printing incoming text 231
port
install generic printer driver 64
interface cards 40

problems, troubleshooting 118
serial card for ImageWriter II 287
sheet feeder 118
wide documents 118
Printing
disabling 124
wide documents 120
Problems getting started, Troubleshooting and more 289
ProDOS
about 305
about pathnames 307
and directory 305
and filenames 306
and subdirectories 306
disk utilities 209, 305
extensions 244
quit code 91
root directory 307
Programming w/ProTERM Special
Emulation 157
Prompt, send to, & GBBS Pro 238
ProTERM
3.1
replacing PT3.0 69

on large disk 58, 59, 60, 61
special emulation 76
special emulation programming 157
tutorial
getting started 71

update files 62
Protocol
ask options 247
checksum 254
CRC 254
defined 236, 250, 254
in detail

82

development history
error

255–260

correcting 255
free 255
messages 258

example & definition 79
explained
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INDEX
defined

82

family default filetype 247
fault-tolerant 255
Kermit, defined 254
or ASCII when transferring files 235
parameters Parms window 222
ProTERM, defined 254
selecting a 250
send
mode 244
parameters 247

speed

245, 246

parms Window 222

transfer
defined 236
parameters window 222

used by ProTERM 3 82
PSE See ProTERM Special Emulation 156
PT2x Macros & phone #
convert to PT3 70
PT3.
1
replace PT3.0 on floppies
replacing PT3.0 69

BIOS

69

70
60, 61

Macro File example 94, 169, 173

CONVERT
Converting old macros

DIAL

70

74

creating new systems 62
error message 291
on floppy disk 69
On hard & large disks 60
updating to PT3.1 69

GLOBAL 168
PREF 62
PT3.
Install PT3.1 over PT3.0 62

WELCOME 139
PT3.BIOS 61
PT3.SYSTEM 61
PTD
files 69
explained 69, 74
SysOp Note: market your BBS 226

Public domain software
explained 35
Pull-down
menus

keyboard, access from 45
windows 45

windows 43
Pulse (rotary) dialing

73

QQ, defined
Query 223
Quick
dial 225

253

hard-spaces

reference cards. See also Quick
Reference Cards

reference cards 45. See also separate
Reference Cards
Quick tip!
scrollback 131
Quit 214
ProTERM 91
system; disconnect, immediate 80

R
Radio button
example window 46
function & use in navigating 48
RAM
available 295
card memory
not seen 295
RAM software not used 295

68, 69

delete to start over 68
Saved changes 61

CACHE
CLOCK

disks 274
Replicating systems
Reply
dend ASCII 91
format 90, 103

Q

disk software 295
maximum memory use 267
memory & minimum requirements 38
problems & trouble-shooting 295
restore on exit 268
Receive
a file tutorial 84
ASCII
data 241
macro 169
status bar 243
using Scrollback 243

Binary II 245
check disk-space 248
download options 245
macros commands 186
options unattended 140
receive file practice 82
w/protocol 245–249
Receiving and sending Email 90
Redial 225
a system feature 77
Reference cards. See separate
Reference Cards
Registered owners, Special access to
BBS 276
Rename, files 211
Replace in editor
selection on type-over 269
text 105
Replacement disks, damaged
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92

104

offline 91
tutorial. See A60SEC.WORKOUT: PT3
Master Disk
Reposition cursor in scrollback
capture problems related to emulations 146
Requirements, hardware 38
Resident macros, See macros
Global 167
Restore /RAM on Exit 268
Return a disk
how to 275
instructions 273
Return character, macros; command 180
Reverse Video 269
Right margin, printer; editor 116
Root directory & ProDOS 307
Rotary
(pulse) dialing 73
dialing list 225
RS232 282. See also DB25
Ruler
editor 105, 108
example 98
saving 269

S
Save
a system's info to disk 77
as 100
as: text selection 100
current defaults 264
data into scrollback 210
file as: filetype 241
selection as 100
system as: getting started tutorial 74
system changes 224
Save Selection As
from Scrollaback 130
Screen
dump; print the screen 233
print 93, 233
Screen saver
about ProTERM menu; key function 99
explained 206
timeout before activation 206
Scrollback 80–84, 127–134
anchor-point 128
as receive ASCII 243
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auto-clear 269
browse 80, 81
buffer 127
buffer memory 205
capture problems related to emulations 146
convert to text 130
crash or lockup 296. See crashes in
Scrollback
customizing capture 147
entering, navigating 127
find; locating online sessions 133
highLight-bar 127
how it works 81
load & view files 210
menu bar commands 129–134
about ProTERM 130
add to editor 131
copy 131
find 132
find next 132
find what 132
ignore case in search 132
new 130
open file 130
print selection 131
quit scrollback 131
save as 130
save selection as 130
scrollback hints 133
toggle scrollbar 133
whole words only 132

minimizing online time 133
navigating 81
keyboard/mouse 128

online or offline 81
paste 131
print 131
quick tip! 131
reference. See also Quick Reference
Cards
save data, into 210
save selection as text 130
selecting 128
keyboard 129
mouse 129
size 128

size 81
using 127
Scrollbar
example 98
preference on/off 106
show 106
toggle on/off 108
Scrollbox example 98
SDK, defined 253
Search & replace in editor 105
Segmented Loading, Editor 113

Select
defined 46
file
batch 314
keyboard 313
mouse 313
path 314

text
and save as 100
determine selection size 106
editor 112
editor, keyboard 112
in editor w/mouse 113
print selection 100
replace on type-over 269

Send
ASCII

dot-commands 248
reply 91
text selection size 107
text to a prompt 237

Binary II 244
break 233
change blank lines to
space+Return 238
character send pace 238
common settings 240
force Xmodem 1K/4K 248
high-speed; Zmodem & ASCII sends
fail 294
interpret dot-commands 239
line
prompt 237
send pace 239

macros commands 185
mode 237
ASCII 221

options

244

unattended 140

PDOS/BNY2 244
protocol send mode 244
send file practice 82
send mode 237
text to ASCII prompt 221
text width
change 238

to a prompt 237
to GBBS Pro prompt 238
TXT/BNY 244
unattended 142
width 221
with a protocol 244–249
Serial
defined 33
card

33

Serial Card
configuration 281
dip switches 281

installing 280
jumper blocks 281
modem slot assignment 280
printer configuration 287
Serial card 280
& ports; modem 40
and Mac LC. See also Macintosh LC:
Install ProTERM
Serial number 41, 53
SeriALL card
config'd for telecom 281
SerialPro card
config'd for telecom 281
Service
commercial 318
defalt dialing 93
or system 72
Set file Info
filetype change 99
Set file info 211
Shareware 36
Shareware explained 35
Sheet feeder, printing 118
SHK defined 254
Show
all files for selection; control+z 314
cost 220
special 106
Shrinkit 60, 252
Siren, connect sound 267
Size of document 107
Slot, Drive, Name 209
Slot, drive, name 305
slot zero, AUX slot 290
Soft switch 280
Software, telecom explained 34
Software updates 274
Solid apple as option key; explained 44
Sound
exfer Complete 248
exfer complete 267
Space 48
Spaces
find & replace 105
Special
characters. See also Embedding:
Commands
add power to ASCII upload 125
dot commands 125

commands
dot commands 126
modem commands 126

emulation 156
programming

157

interest groups (SIGs)
for telecom

72

needs, persons w/disabilities
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INDEX
and telecom 30

Speed & ProTERM, optimizing
performance 43
Split screen chat 158
a navigational aid 159
Springback
autosave 266
download 266
editor 266
pathname 265
upload 266
Startup from
3.25" floppy 60
a 5.25" floppy 59
hard drive 61
Status bar 146, 230
setting on/off 219
turn off for emulation 76
VT-100 emulation 76
Stock trading 30
Stop bit 228
String
expressions 180
functions in macros 199
variables 179
Strip controls
edit menu 104
see controls strip 118
Students and telecom 30
Subdirectories and ProDOS 306
Suggested further reading 126
Suggestions (from you) for improvement 276
Suppress control chars 242
SysOp
market your BBS w/PTD files 226
System
address 77
ASCII send parameters 220
copying or duplicating 92
delete a 93
dial & baud rate 217
dialing list, change sorting 72
entry, saving the 74
macros 166, 224
converting phone numbers 70
defined 162

name; getting started tutorial 72
number
getting started 73
specifications 215

Parameters
Editing 215

parameters 220
editing 74

variables & macros 199

T
Tab
editor, setting 105
spaces convert to real spaces 107
TDD 30
Technical support 53, 274
troubleshooting 289
user groups-local assistance 37, 300
warranty 53
Telecommunications
file transfer, getting started 235
help 36. See also user groups
Telecommuter
defined 29
Telephone companies 31
TeleVideo 910+ emulation 160
Terminal
emulation 145–146, 151, 229
mode 77, 135, 227, 261
commands 230
defined 230

Terminate
a call 80
connection with courtesy 80
macro example
Compuserve 164
GEnie macro 165

Text
emphasis in printer; Editor 124
fields 46
editing commands 48
example illustration 47
explained, also see: Quick Ref
Cards 47

files opening 99
flow, pausing 78
selection commands 115
window, editing 47
Textalker-GS; Impaired vision
device 42
Thumb slide, Scrollbox 106
Time
connected 230
online per min/per hour 220
Toggle
online/offline 234
online/offline macro 171. See also
PT3.GLOBAL
Tools for telecom 133
Top margin, printer; editor 117
Transfer
buffer memory 205
errors & line noise 296
files 235–260
ASCII or Protocol? 235
direct between computers 249

333

parameters “parms” window 222
preferences 247, 268
send & receive practice 82
Trouble shooting 289
cable diagnosis modem 285
hardware 289
install still doesn’t work 68
printer Is not printing 294
technical support 289
unable to connect 293
TTY emulation 156
Tutorial 72
baud rate, getting started 73
dial, getting started 72
emulation, getting started 75
files on disk 126
“hands on”. See A60SEC.WORKOUT
learning ProTERM 72
receiving a file 84
save system as, getting started 74
system names, getting started 72
Two-sided disk. See flippy
Type-over, replace editor selection 269

U
Unable
to connect trouble-shooting 293
to load ProDOS; error message 59
Unattended. See also Split Screen
Chat
access 137
calling into 140
chat 142
commands 141
connect time 139
directory 142
example 143
file transfer 142
hangup 142
help 141
inactivity timeout 139
log 141
mode 68
password 139
path 140
receive 144
options 140

send

142

options 140

view (file) 142
welcome file 139
Underline video 269
Undo command 98
Unlock files & file access 212
Update files; note on PT3.BIOS 62
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Upload
options parms window 223
pathname 265
springBack 266
US Sprint. See Telenet
Usenet 317
User groups 37
how to locate 300
support & assistance 72
technical support 300
User interface 43–51
& pull-down windows 43
Utility
disk, ProDOS 60, 209
programs 60

Write protected 53
master disks 54, 56
Writing a macro 174

V

Y

Verify hardware install 66
Video
bold 269
dim 269
flashing 269
reverse 269
settings for emulations 269
underline 269
View
file 212

Ymodem 251
-4K 251
-G 251, 256
ProDOS 257
Ynable
to init modem troubleshooting 292

from the editor 113
Information 212

unattended 142
Virtual
keyboard 148
keyboard explained 148
Voice to data calls, changing
from 135
VT-100 145. See also DEC: VT100; Status Bar

X
Xfer complete; sounds
Xmodem 250
-1K 250, 256
-4K 250
batch 255
CRC 250
DOS 256
history 255
XT/BNY 223

248

Z
ZACK 258
ZDATA 259
ZEOF 259
ZFILE 258, 259
ZFIN 260
Zmodem 251
CRC-32
use

248

Resume 224
ZRINIT 258, 259
ZRPOS at EOF 259

W
Warranty 274
& service 273
card 53, 273
special access to BBS 276
validation 274
Welcome file in unattended 139
Wide documents
panning & working with 107
Printing 120
Window 43
object 46
example window
text fields 47

46

parts defined 46
Word processor. See Editor: about
the
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